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1
About this manual

Intended use of this manual
This manual is an integral part of the device and describes its intended use. It
should always be kept in a place accessible to users, and information indicating that
place should be available close to the equipment. Observance of the manual is a
prerequisite for proper performance and correct operation and ensures patient and
user safety. Information which refers only to certain versions of the product(s) is
accompanied by the model number(s) of the product(s) concerned. The model number
is given on the device plate of the product.

The list below indicates the compatible products (brands, models and descriptions
as applicable) with which this manual is to be used. Other products are covered
by the manuals that were delivered with those products or with the CARESCAPE
monitors with software versions earlier than v2.4. Refer to those manuals for proper
performance and correct operation to ensure patient and user safety.

● CARESCAPE Monitor B850 B1
● CARESCAPE Monitor B650 B1
● CARESCAPE Monitor B450 B1
● CARESCAPE Monitor B850–LI B1
● CARESCAPE Monitor B650–LI B1
● CARESCAPE Monitor B450–LI B1
● CARESCAPE Monitor B850–RM B1
● CARESCAPE Monitor B650–RM B1
● CARESCAPE Monitor B450–RM B1
● CARESCAPE Monitor B850–SW V2.4
● CARESCAPE Monitor B650–SW V2.4
● CARESCAPE Monitor B450–SW V2.4
● CARESCAPE 19 inch Display D19KT
● CARESCAPE D19KT VER01
● E-COP-01
● E-COPSv-01
● E-sCAiO-00
● E-sCAiOV-00
● E-sCAiOVX-00
● E-sCO-00
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● E-sCOV-00
● E-sCOVX-00
● E-sCAiOE-00
● E-sCAiOVE-00
● E-miniC-00
● E-MASIMO-00
● E-NSATX-00
● E-PP-00
● E-PT-00
● E-PSMP-01
● E-ENTROPY-01
● E-NMT-01
● E-BIS-01
● E-BIS-01–JA
● Patient Data Module
● Patient Data Module GS
● PRN 50–M+
● Frame F5–01
● Frame F7–01
● 2069156–001 Bedrail Hook Unit, B450
● 2017098-001 E-PORT PDM to Host 5 ft
● 2017098-003 E-PORT PDM to Host 15 ft
● 2017098-005 E-PORT PDM to Host 25 ft
● 2017098-007 E-PORT PDM to Host 45 ft
● USB Remote Control
● USB Remote Control l GER
● USB Remote Control FRE
● USB Remote Control SWE
● USB Remote Control SPA
● USB Remote Control ITA
● USB Remote Control DUT
● USB Remote Control DAN
● USB Remote Control NOR
● USB Remote Control POR
● USB Remote Control POL
● USB Remote Control CZE
● USB Remote Control FIN
● 2040427-001 Cable Frame to CPU 0.6 m
● 2040427-002 Cable Frame to CPU 1.5 m
● 2040427-003 Cable Frame to CPU 3.0 m
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● 2040427-004 Cable Frame to CPU 4.0 m

● 2017842–001 DS1 Sync to Unterm 15 ft Cable

● 2024696-001 DS1 Field Termination Kit

● 2024565–002 Splitter Sync DS1 Male to 3 DS1 FEM

● 2023808–002 Cable Assy Sync DS1 to Datascope 95

● M1043105 Monitor Quick Mount

● M1051025 PSM Module Bus Adapter

● M1049197 Short PSM Pole Mount

● M1051023 Long PSM Pole Mount

Intended markets of this manual
This manual is not intended for U.S. FDA-regulated markets because the modules
E-sCAiOVE and E-sCAiOE, Respiratory Module License, and certain supplies and
accessories are not cleared for use by the U.S. FDA.

Intended audience of this manual
This manual is intended for clinical professionals. Clinical professionals are expected
to have a working knowledge of medical procedures, practices and terminology
required to provide patient care. Using the device should never replace nor impede
the human intervention and required patient care provided by clinical professionals.

Training requirements
No product-specific training is required for the use of the CARESCAPE monitors.

Manual conventions
This manual uses the following styles to emphasize text or indicate action.

Item Description

bold Indicates hardware terms.

bold italic Indicates software terms.

italic Indicates terms for emphasis.

> Indicates menu options to select consecutively.

GE For technical documentation purposes, the abbreviation GE is
used for the legal entity names, GE Medical Systems Information
Technologies, Inc. and GE Healthcare Finland Oy.

select The word select means choosing and confirming.

NOTE Note statements provide application tips or other useful
information.

Monitor naming conventions
In this manual, the CARESCAPE Monitor B850, CARESCAPE Monitor B650 and
CARESCAPE Monitor B450 are referred to as “the monitor” when a function or a feature
applies to all three. For describing monitor-specific issues, the monitors are referred
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to as B850, B650 and B450, respectively. Where possible, the following icons are
also used to help identify the monitor:

Icon Explanation

All Bx50 monitors: B850, B650, B450.

B850 and B650 only.

B650 and B450 only.

B850 and B450 only.

B850 only.

B650 only.

B450 only.

Acquisition module naming conventions
In this manual, the following naming conventions are used to refer to different
modules and module categories:

● PDM: Patient Data Module

● PSM: Patient Side Module, E-PSMP

● E-modules: All modules with the prefix E-. In parameter chapters, E-modules refers
to those modules that measure the parameter(s) in question.

● Cardiac output and SvO2 E-modules: E-COP, E-COPSv

● Pressure E-modules: E-PP, E-PT

● CARESCAPE respiratory modules: E-sCO, E-sCOV, E-sCOVX, E-sCAiO, E-sCAiOE,
E-sCAiOV, E-sCAiOVX, E-sCAiOVE

● Single-width airway module: E-miniC

● Specialty E-modules: E-NMT, E-BIS and E-ENTROPY

● SpO2 E-modules: E-NSATX, E-MASIMO
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Illustrations and names
This manual uses illustrations as examples only. Illustrations in this manual may not
necessarily reflect all system settings, features, configurations, or displayed data.

Names of persons, institutions, and places and related information are fictitious; any
similarity to actual persons, entities, or places is purely coincidental.

Related documents
● CARESCAPE B850, B650, B450 Supplemental Information Manual

● CARESCAPE Monitor B850 Service Manual

● CARESCAPE Monitor B650 Service Manual

● CARESCAPE Monitor B450 Service Manual

● Module Frames and Modules Service Manual

● CARESCAPE Network Configuration Guide

● Marquette 12SL ECG Analysis Program Physician's Guide

● CARESCAPE Modular Monitors Mounting Solutions

● User documentation for displays

● Unity Network Interface Device (ID) Operator’s Manual

● CIC Pro Clinical Information Center Operator’s Manual

● CARESCAPE Central Station User’s Manual

● Supplement for E-EEG-00 with CARESCAPE monitors

Ordering manuals
A paper copy of this manual will be provided upon request. Contact your local GE
representative and request the part number on the first page of the manual.

Trademarks
GE, GE Monogram, and CARESCAPE are trademarks of General Electric Company.

12RL, DINAMAP, IntelliRate, Multi-Link, MUSE, Trim Knob, UNITY NETWORK, D-lite,
D-fend, and Entropy are trademarks of General Electric Company or one of its
subsidiaries.

Third party trademarks
Covidien, BISx, Bispectral Index, BIS, and Nellcor are trademarks of a Medtronic
company.

Masimo SET is a trademark of Masimo Corporation.

Manufacturer responsibility
GE is responsible for the effects on safety, reliability, and performance of the
equipment only if:

● Assembly operations, extensions, readjustments, modifications, servicing, or
repairs are carried out by authorized service personnel.
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● The electrical installation of the relevant room complies with the requirements
of the appropriate regulations.

● The equipment is used in accordance with the instructions for use.

WARNING SAFETY HAZARD. To avoid risks to personnel and patient,
or damage to the equipment, only perform maintenance
procedures described in this manual. Unauthorized
modifications can lead to safety hazards.
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Safety message signal words
Safety message signal words designate the severity of a potential hazard.

DANGER Indicates a hazardous situation that, if not avoided, will result
in death or serious injury.

WARNING Indicates a hazardous situation that, if not avoided, could
result in death or serious injury.

CAUTION Indicates a hazardous situation that, if not avoided, could
result in minor or moderate injury.

NOTICE Indicates a hazardous situation not related to personal injury
that, if not avoided, could result in property damage.

Safety symbols
Symbol Explanation

General warning sign. ISO 7010.
This symbol is identified by a yellow background, black triangular band, and
a black symbol.
In this manual this symbol is used only in connection with those warning
statements that the labels on the equipment refer to.

Caution. ISO 7000.
This symbol is identified by a white background, black triangular band, and
a black symbol.

Follow instructions for use. ISO 7010.
This symbol is identified by a blue background and a white symbol.

Consult operating instructions. / Operating instructions.

DANGER — Shock hazard. Dangerous voltage. To reduce the risk of electric
shock, do not remove cover. Refer servicing to qualified service personnel.
ISO 7010.
This symbol is identified by a yellow background, black triangular band, and
a black symbol.
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Symbol Explanation

Electrostatic sensitive device. Connections should not be made to this device
unless ESD precautionary procedures are followed.

Non-ionizing electromagnetic radiation. Interference may occur in the vicinity
of this device.

Type BF (IEC 60601-1) protection against electric shock. Isolated (floating)
applied part suitable for intentional external and internal application to the
patient, excluding direct cardiac application.

Type BF (IEC 60601-1) defibrillator-proof protection against electric shock.
Isolated (floating) applied part suitable for intentional external and internal
application to the patient, excluding direct cardiac application.

Type CF (IEC 60601-1) protection against electric shock. Isolated (floating)
applied part suitable for intentional external and internal application to the
patient, including direct cardiac application.

Type CF (IEC 60601-1) defibrillator-proof protection against electric shock.
Isolated (floating) applied part suitable for intentional external and internal
application to the patient including direct cardiac application.

Safety ground. Remove power cord from the mains source by grasping the
plug. Do not pull on the cable.

System safety
System safety messages apply to the entire system. Safety messages specific to parts
of the system are found in the relevant section.

System warning safety messages
The following warning safety messages apply to this monitoring system.

Accessories warnings
WARNING Single-use products are not designed to be reused. Reuse

may cause a risk of cross-contamination, affect the
measurement accuracy and/or system performance, and
cause a malfunction as a result of the product being physically
damaged due to cleaning, disinfection, re-sterilization and/or
reuse.
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WARNING Use only approved accessories, including mounts, and
defibrillator-proof cables and invasive pressure transducers.
For a list of approved accessories, see the supplemental
information provided. Other cables, transducers and
accessories may cause a safety hazard, damage the
equipment or system, result in increased emissions or
decreased immunity of the equipment or system, or interfere
with the measurement.

WARNING ELECTRIC SHOCK. Only use protected leadwires and patient
cables with this monitor. The use of unprotected leadwires
and patient cables creates the potential for making an
electrical connection to ground or to a high voltage power
source which can cause serious injury or death to the patient.

WARNING For detailed instructions and information regarding supplies
and accessories, always refer to their own instructions for use.

Cables warnings
WARNING CABLES. Route all cables away from patient’s throat to avoid

possible strangulation.

WARNING SITE REQUIREMENTS. Do not route cables or tubing in a way
that they may present a stumbling hazard.

WARNING SAFETY GROUND. Remove power cord from the mains source
by grasping the plug. Do not pull on the cable.

Defibrillation warnings
WARNING Do not touch the patient, table, bed, instruments, modules or

the monitor during defibrillation.

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires. Using other cables or leadwires may
result in damage to the equipment and compromise patient
and user safety.

Electrical warnings
WARNING POWER SUPPLY. Always connect the device power cable to a

properly installed power outlet with protective earth contacts
before connecting any other interface cables. If the integrity
of the protective earth conductor is in doubt, disconnect
the monitor from the power line (and use it with the battery
option (B650) if available). If the installation does not provide
for a protective earth conductor, disconnect the device power
cable from the power line after having disconnected all other
interface cables. All devices of a system must be connected
to the same power supply circuit. Devices which are not
connected to the same circuit must be electrically isolated
when operated.
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WARNING EXCESSIVE LEAKAGE CURRENT. Do not use a multiple socket
outlet or extension cord.

WARNING EXCESSIVE TOUCH CURRENT. To avoid excessive patient
leakage current, do not simultaneously touch the patient and
the electrical connectors located at the rear panel of the CPU
or monitor, or within the module housing, frames, or battery
slot.

WARNING INTERFACING OTHER EQUIPMENT. Connect only items that are
specified as part of the system and as compatible. For more
information, see the supplemental information manual.

WARNING EXCESSIVE LEAKAGE CURRENT. To avoid summation of leakage
currents when interfacing the device with other equipment,
the devices may only be interconnected with each other
or to parts of the system when it has been determined by
qualified biomedical personnel that there is no danger to the
patient, the operator, or the environment as a result. In those
instances where there is any element of doubt concerning
the safety of the connected devices, the user must contact
the manufacturers concerned (or other informed experts) for
proper use. In all cases, safe and proper operation should be
verified with the applicable manufacturer’s instructions for
use, and system standards IEC 60601-1 must be complied
with.

WARNING Do not under any circumstances remove the grounding
conductor from the power plug. Always check that power
cord and plug are intact and undamaged

WARNING During intracardiac application of a device, a defibrillator and
pacemaker whose proper functioning has been verified must
be kept at hand.

WARNING ELECTRIC SHOCK. If liquid has accidentally entered the system
or its parts, disconnect the power cord from the power
supply and have the equipment serviced by qualified service
personnel.

WARNING DISCONNECTION FROM MAINS. When disconnecting the
device from the power line, remove the plug from the wall
outlet first. Then you may disconnect the power cord from the
device. If you do not observe this sequence, there is a risk
of coming into contact with line voltage by inserting metal
objects, such as the pins of leadwires, into the sockets of the
power cord by mistake.
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WARNING INTRACARDIAC APPLICATION. When applying devices
intracardially, electrically conductive contact with parts
connected to the heart (pressure transducers, metal tube
connections and stopcocks, guide wires, etc.) must be avoided
in all cases. To prevent electrical contact, we recommend
the following:
● always wear isolating rubber gloves,
● keep parts that are conductively connected to the heart

isolated from ground,
● if possible, do not use tube fittings or stopcocks made of

metal.

Equipment warnings
WARNING EXPLOSION. Do not use this equipment in the presence of

flammable anesthetics, vapors or liquids.

WARNING If an error message appears during operation, it is the licensed
medical practitioner’s responsibility to decide whether the
unit is still suitable for patient monitoring. As a general rule,
monitoring should only continue in extremely urgent cases
and under the direct supervision of a licensed healthcare
practitioner. The unit must be repaired before being used
again on a patient. If an error message appears after
power-up, the unit must be repaired before being used on
a patient.

WARNING Ensure that modules are securely latched.

WARNING The parameter modules are not able to withstand unpacked
drops from a height of 1 m without damage. If a module is
dropped, please service it before taking it back into use.

WARNING If the frame or monitor is dropped, please service it before
taking it back into use.

Site requirement warnings
WARNING BEFORE INSTALLATION. Compatibility is critical to safe and

effective use of this device. Please contact your local sales or
service representative prior to installation to verify equipment
compatibility.

System caution safety messages
The following caution safety messages apply to this monitoring system.
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Loss of data
CAUTION LOSS OF DATA. Should themonitor at any time temporarily lose

patient data, the potential exists that active monitoring is not
being done. Close patient observation or alternate monitoring
devices should be used until monitor function is restored. If
the monitor does not automatically resume single-parameter
operation within 60 seconds or full monitoring in 90 seconds,
power cycle the monitor by turning it off and then on again. If
monitoring is not restored, disconnect the network cable from
the monitor’s Network IX/MC ports and keep the patient under
close observation. Once monitoring is restored, you should
verify correct monitoring state and alarm function.

Electrical caution
CAUTION POWER REQUIREMENTS. Before connecting the device to the

power line, check that the voltage and frequency ratings of
the power line are the same as those indicated on the device’s
label. If this is not the case, do not connect the system to the
power line until you adjust the device to match the power
source. In U.S.A., if the installation of this equipment will use
240V rather than 120V, the source must be a center-tapped,
240V, single-phase circuit. This equipment is suitable for
connection to public mains as defined in CISPR 11.

Site requirement cautions
CAUTION LOSS OF MONITORING. Leave space for circulation of air to

prevent the monitor from overheating. The manufacturer
is not responsible for damage to equipment caused by
improperly vented cabinets, improper or faulty power, or
insufficient wall strength to support equipment mounted on
such walls.

Notice safety messages
The following notice safety message applies to this monitoring system:

NOTICE The warranty does not cover damages resulting from the use
of accessories and consumables from other manufacturers.

Indications for use

B850 indications for use
The CARESCAPE Monitor B850 is a multi-parameter high acuity patient monitor
intended for use in multiple areas within a professional healthcare facility.

The CARESCAPE Monitor B850 is intended for use on adult, pediatric, and neonatal
patients and on one patient at a time.

The CARESCAPE Monitor B850 is indicated for monitoring of:

● hemodynamic (including ECG, ST segment, arrhythmia detection, ECG diagnostic
analysis and measurement, invasive pressure, non-invasive blood pressure, pulse
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oximetry, cardiac output (thermodilution and pulse contour), temperature, mixed
venous oxygen saturation, central venous oxygen saturation, and Surgical Pleth
Index),

● respiratory (impedance respiration, airway gases (CO2, O2, N2O, and anesthetic
agents), spirometry, gas exchange), and

● neurophysiological status (including electroencephalography, Entropy, Bispectral
Index (BIS), and neuromuscular transmission).

The CARESCAPE Monitor B850 also provides alarms, trends, snapshots and events,
and calculations, and can be connected to displays, printers and recording devices.

The CARESCAPE Monitor B850 can be a stand-alone monitor or interfaced to other
devices. It can also be connected to other monitors for remote viewing and to data
management software devices via a network.

The CARESCAPE Monitor B850 is intended for use under the direct supervision of
a licensed healthcare practitioner, or by personnel trained in proper use of the
equipment in a professional healthcare facility.

The CARESCAPE Monitor B850 is not intended for use during MRI.

B650 indications for use
The CARESCAPE Monitor B650 is a multi-parameter patient monitor intended for use in
multiple areas and intrahospital transport within a professional healthcare facility.

The CARESCAPE Monitor B650 is intended for use on adult, pediatric, and neonatal
patients and on one patient at a time.

The CARESCAPE Monitor B650 is indicated for monitoring of:

● hemodynamic (including ECG, ST segment, arrhythmia detection, ECG diagnostic
analysis and measurement, invasive pressure, non-invasive blood pressure, pulse
oximetry, cardiac output (thermodilution and pulse contour), temperature, mixed
venous oxygen saturation, central venous oxygen saturation, and Surgical Pleth
Index),

● respiratory (impedance respiration, airway gases (CO2, O2, N2O, and anesthetic
agents), spirometry, gas exchange), and

● neurophysiological status (including electroencephalography, Entropy, Bispectral
Index (BIS), and neuromuscular transmission).

The CARESCAPE Monitor B650 also provides alarms, trends, snapshots and events,
and calculations, and can be connected to displays, printers and recording devices.

The CARESCAPE Monitor B650 can be a stand-alone monitor or interfaced to other
devices. It can also be connected to other monitors for remote viewing and to data
management software devices via a network.

The CARESCAPE Monitor B650 is intended for use under the direct supervision of
a licensed healthcare practitioner, or by personnel trained in proper use of the
equipment in a professional healthcare facility.

The CARESCAPE Monitor B650 is not intended for use during MRI.

B450 indications for use
The CARESCAPE Monitor B450 is a multi-parameter patient monitor intended for use in
multiple areas and intrahospital transport within a professional healthcare facility.
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The CARESCAPE Monitor B450 is intended for use on adult, pediatric, and neonatal
patients and on one patient at a time.

The CARESCAPE Monitor B450 is indicated for monitoring of:

● hemodynamic (including ECG, ST segment, arrhythmia detection, ECG diagnostic
analysis and measurement, invasive pressure, non-invasive blood pressure, pulse
oximetry, cardiac output (thermodilution and pulse contour), temperature, mixed
venous oxygen saturation, central venous oxygen saturation, and Surgical Pleth
Index),

● respiratory (impedance respiration, airway gases (CO2, O2, N2O, and anesthetic
agents), spirometry), and

● neurophysiological status (including electroencephalography, Entropy, Bispectral
Index (BIS), and neuromuscular transmission).

The CARESCAPE Monitor B450 also provides alarms, trends, snapshots and events,
and calculations, and can be connected to displays, printers and recording devices.

The CARESCAPE Monitor B450 can be a stand-alone monitor or interfaced to other
devices. It can also be connected to other monitors for remote viewing and to data
management software devices via a network.

The CARESCAPE Monitor B450 is intended for use under the direct supervision of
a licensed healthcare practitioner, or by personnel trained in proper use of the
equipment in a professional healthcare facility.

The CARESCAPE Monitor B450 is not intended for use during MRI.

Indications for use safety precautions

Indications for use warnings
WARNING Read all the safety information before using the monitor for

the first time. This manual contains instructions necessary
to operate this device safely and in accordance with its
functions and intended use. This manual is intended for
clinical professionals. Clinical professionals are expected to
have a working knowledge of medical procedures, practices
and terminology, as required for the monitoring of all patients.

WARNING SINGLE PATIENT USE. This equipment is designed for use
on one patient at a time. Using this equipment to monitor
different parameters on different patients at the same time
compromises the accuracy of data acquired.

WARNING INSTRUCTIONS FOR USE. For continued safe use of this
equipment, it is necessary that the listed instructions are
followed. However, instructions listed in this manual in no way
supersede established medical practices concerning patient
care.

The following applies to B650 and B450 only:

WARNING INTRAHOSPITAL TRANSPORT. Vibrations during intrahospital
transport may disturb SpO2, ECG, impedance respiration, NIBP,
and IP measurements.
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Indications for use cautions
CAUTION U.S. Federal law restricts this device to sale by or on the order

of a physician.

CAUTION SUPERVISED USE. This equipment is intended for use under
the direct supervision of a licensed healthcare practitioner.

Training requirements
No product-specific training is required for the use of the CARESCAPE monitors.

Electromagnetic compatibility

EMC warnings
WARNING Other equipment may interfere with the system, even if that

other equipment complies with CISPR emission requirements.

WARNING Use only approved accessories, including mounts, and
defibrillator-proof cables and invasive pressure transducers.
For a list of approved accessories, see the supplemental
information provided. Other cables, transducers and
accessories may cause a safety hazard, damage the
equipment or system, result in increased emissions or
decreased immunity of the equipment or system, or interfere
with the measurement.

WARNING Pins of connectors identified with the ESD warning symbol
should not be touched. Connections should not be made
to these connectors unless electrostatic discharge (ESD)
precautions are used.

WARNING Do not use the monitor in high electromagnetic fields (for
example, during magnetic resonance imaging).

WARNING The device/system should not be used adjacent to, or stacked
with, other equipment. Consult qualified personnel regarding
device/system configuration.

WARNING EMC. Magnetic and electrical fields are capable of interfering
with the proper performance of the device. For this reason
make sure that all external devices operated in the vicinity of
the monitor comply with the relevant EMC requirements. X-ray
equipment or MRI devices are a possible source of interference
as they may emit higher levels of electromagnetic radiation.
Changes or modifications to this device/system not expressly
approved by GE may cause EMC issues with this or other
equipment. This device/system is designed and tested to
comply with applicable standards and regulations regarding
EMC and needs to be installed and put into service according
to the EMC information stated as follows: This device/system
is suitable for use in all establishments other than domestic
and those directly connected to the public low-voltage power
supply network that supplies buildings used for domestic
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purposes. Mains power should be that of a typical commercial
or hospital environment. Device is compliant to Class A.

EMC cautions
CAUTION Use of known RF sources, such as cell/portable phones,

or other radio frequency (RF) emitting equipment near the
system may cause unexpected or adverse operation of
this device/system. Consult qualified personnel regarding
device/system configuration.

ESD safety precautions
● To avoid electrostatic charges building up, it is recommended to store, maintain

and use the equipment at a relative humidity of 30% or greater.

● To prevent applying a possible electrostatic charge to the ESD sensitive parts of
the equipment, touch the metallic frame of the component or a large metal object
located close to the equipment. When working with the equipment and specifically
when the ESD sensitive parts of the equipment may be touched a grounded wrist
strap intended for use with ESD sensitive equipment should be worn. See the
documentation provided with the wrist straps for details of proper use. Floors
should be covered by ESD dissipative carpets or similar. Non-synthetic clothing
should be used when working with the component.
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System safety precautions

System warnings
WARNING Never install equipment above the patient.

WARNING Operation of the monitor outside the specified performance
range may cause inaccurate results.

WARNING EXCESSIVE LEAKAGE CURRENT. A secondary display or printer
that is a non-medical grade device and is used within the
patient environment, must always be powered from an
additional transformer providing at least basic isolation
(isolating or separating transformer). Using without an
isolating transformer could result in unacceptable enclosure
leakage currents.

WARNING EXCESSIVE LEAKAGE CURRENT. Laser printers are UL
60950/IEC 60950 certified equipment, which may not
meet the leakage current requirements of patient care
equipment. This equipment must not be located in the patient
environment unless the medical system standard IEC 60601-1
is followed. Do not connect a laser printer to a multiple socket
outlet supplying patient care equipment. The use of multiple
socket outlet for a system will result in an enclosure leakage
current equal to the sum of all the individual earth leakage
currents of the system if there is an interruption of the multiple
socket outlet protective earth conductor. Consult your local
service representative before installing a laser printer.

WARNING PHYSICAL INJURY. Take care when mounting devices to an IV
pole. If a device is mounted too high the IV pole may become
unbalanced and tip over.

WARNING Do not touch the electrical connector located within the
module frame.

WARNING ELECTRIC SHOCK. Always unplug the grounded cables when
not in use. Leaving them connected could result in an electric
shock from the ground contact in the other end.

WARNING To prevent liquids from entering the display casing, do not tilt
the display more than +/- 15 degrees.
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WARNING EXPLOSION OR FIRE. Using non-recommended batteries
could result in injury/burns to the patients or users. Only use
batteries recommended or manufactured by GE. The warranty
can be voided if non-recommended batteries are used.

WARNING EXPLOSION HAZARD. Do not incinerate a battery or store at
high temperatures. Serious injury or death could result.

WARNING Use only washable keyboard with at least IPX1 protection
against ingress of water.

WARNING Do not connect a monochrome display to the monitor. Visual
alarm indicators may not appear properly.

WARNING B650, B450: To prevent liquids from entering the monitor, do
not tilt the monitor more than +/-15 degrees. If the monitor
is used as a stationary bedside monitor with CARESCAPE
respiratory modules or PDM, do not tilt it at all.

WARNING The B450 must always be used with a battery inserted. This
will ensure the functioning of the monitor and prevent data
loss during possible supply mains interruptions.

The following warnings apply to the B650:

WARNING If there is a power failure (e.g., the supply mains is interrupted)
affecting a B650 without a battery option, the monitor gives a
continuous beeping alarm. This alarm remains active for as
long as there is some residual power left, or until it is silenced
with the Trim Knob or the standby button, or until the supply
mains is restored.

WARNING LOSS OF MONITORING. If the supply mains is interrupted and
there is no battery power available, the B650 may cease to
function. If the B650 is equipped with the optional battery,
always use the monitor with the battery inserted. This will
ensure the functioning of the monitor during possible supply
mains interruptions.

The following warnings apply to the B850:

WARNING B850: ELECTRIC SHOCK. Do not use the F7 Frame for
standalone use. Ventilation holes on the F7 E-module Frame
will be covered only if installed within an Aisys CS2, Avance
CS2, or Aespire anesthesia machine.

WARNING B850: Using other displays than B850 system specific ones
may result in loss of visual alarms and patient monitoring.

WARNING EQUIPMENT MALFUNCTION. Using the CPU or the module
frame in a wrong position may result in equipment
malfunction. The CPU must only be used in vertical or
horizontal position, and the frames only in horizontal position.
To avoid the risk of equipment malfunction, make sure that
these devices are not used in any other position.
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WARNING EQUIPMENT MALFUNCTION. When the CPU is used in vertical
position, it is not protected against harmful effects of dripping
water (IPX1). Therefore, we recommend using the CPU Flush
Mount Kit with environment shield to provide protection from
drips or splashes of liquids. Withouth the shield, liquids may
enter the equipment and lead to its malfunction.

System caution

B650 and B450 only.

CAUTION To comply with the FCC RF exposure requirements, the
monitor with the wireless network (WLAN) option must be
operated with a separation distance of 20 cm or more from
a person’s body.

Operation warnings
WARNING After transferring or reinstalling themonitor, always check that

it is properly connected and all parts are securely attached.

WARNING The device/system should not be used adjacent to, or stacked
with, other equipment. Consult qualified personnel regarding
device/system configuration.

WARNING When detaching modules, be careful not to drop them. Always
support with one hand while pulling out with the other.

WARNING ACCURACY. If the accuracy of any value displayed on
the monitor, central station, or printed on a graph strip is
questionable, determine the patient’s vital signs by alternative
means. Verify that all equipment is working correctly.

WARNING If you accidentally drop the monitor, modules or Frames, have
them checked by qualified service personnel prior to clinical
use.

WARNING To prevent liquids from entering the display casing, do not tilt
the display more than +/- 15 degrees.

The following warning applies to B650 and B450:

WARNING B650, B450: To prevent liquids from entering the monitor, do
not tilt the monitor more than +/-15 degrees. If the monitor
is used as a stationary bedside monitor with CARESCAPE
respiratory modules or PDM, do not tilt it at all.

The following warnings apply to the B850:
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WARNING EQUIPMENT MALFUNCTION. Using the CPU or the module
frame in a wrong position may result in equipment
malfunction. The CPU must only be used in vertical or
horizontal position, and the frames only in horizontal position.
To avoid the risk of equipment malfunction, make sure that
these devices are not used in any other position.

WARNING EQUIPMENT MALFUNCTION. When the CPU is used in vertical
position, it is not protected against harmful effects of dripping
water (IPX1). Therefore, we recommend using the CPU Flush
Mount Kit with environment shield to provide protection from
drips or splashes of liquids. Withouth the shield, liquids may
enter the equipment and lead to its malfunction.

WARNING B850 only: Do not use the monitor without manufacturer
approved mounting attached.

Monitor installation points to note
● To avoid electrostatic charges building up, it is recommended to store, maintain

and use the equipment at a relative humidity of 30% or greater. Floors should
be covered by ESD dissipative carpets or similar ESC dissipative products.
Non-synthetic clothing should be used when working with the component.

● Choose a location that affords an unobstructed view of the display and easy
access to the operating controls at the monitor or remotely via View on Alarm
or remote devices like central stations.

● Choose a location that allows for an easy access to disconnect the monitor from
the power line by unplugging the monitor.

● Set up the monitor in a location that affords sufficient ventilation. The ventilation
openings of the device must not be obstructed (by equipment, walls, or blankets,
for example).

● The environmental operating conditions specified in the technical specifications
must be ensured at all times.

● The monitor is designed to comply with the requirements of IEC 60601-1.
● Using the power cord supplied with the monitor, connect it to the power line. Use

only the original cord.
● For measurements in or near the heart, we recommend connecting the monitor to

the potential equalization system. Use the green and yellow potential equalization

cable and connect it to the pin labeled with the equipotential symbol:
● B850: To prevent any liquid from entering the modules, make sure that the Frame is

mounted horizontally so that the modules will be in a vertical position.

CAUTION PACKAGING DISPOSAL. Dispose of the packaging material,
observing the applicable waste control regulations.

Short description of the equipment
The CARESCAPE monitors B850, B650, and B450 are modular multi-parameter patient
monitors. The B850 and B650 are meant for high-acuity applications, and the portable
CARESCAPE Monitor B450 for low-acuity applications. These monitors can be used
with most patient populations within a professional healthcare facility, but acquisition
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modules may have limitations for use based on the patient’s age, weight, or clinical
condition, or on the type of the care unit (for example, OR or ICU only). There are
several types of acquisition modules to choose from based on care requirements
and patient needs.

The modular system design is inherent in electronics and algorithms: some processing
of the measurement signals is done by the acquisition modules and further processing
happens on the monitor.

Measurement values are displayed as graphic or numeric values, like waveforms and
numbers, and when applicable, also as alarm messages.

The CARESCAPE Monitor B850 supports three independent displays, and the screen
contents shown on each are user-configurable. The D19KT VER01 display has an
integrated alarm light. The CARESCAPE Monitor B650 incorporates a 15-inch display
and the CARESCAPE Monitor B450 a 12-inch display, both with an alarm light.
Both monitors also support additional displays: B650 a slave display, and B450 an
independent display. Screen contents are user-configurable.

The user interface of these monitors can be used as a touchscreen, or with a Trim
Knob or a mouse and a keyboard. The most important and commonly used functions
have main keys either on the main menu (soft keys) or on the monitor front panel
(hard keys). The menu structure design allows access to all functions needed by the
clinical user with just a few clicks.

The CARESCAPE monitors B850, B650, and B450 transfer the measurement data to
central stations and to the hospital patient data depositories. They communicate with
a variety of other bedside medical devices and monitoring systems, and the B650 and
B450 can also use a wireless network for interfacing.

For all physical and performance specifications, refer to the supplemental information
provided.

B850 system components
All components listed below can be used within the patient environment as long as
an additional transformer providing at least basic isolation is used with non-medical
grade secondary displays and printers.

Your system may not include all these components. Consult your local representative
for the available components.
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1. 19-inch display D19KT VER01: Touchscreen display that provides Trim Knob
control. If a non-medical grade display is used as a secondary display within the
patient environment it must always be powered from an additional transformer
providing at least basic isolation.

2. Processing unit: Provides a link between parameter acquisition and input and
output devices. The processing unit works with multi-parameter acquisition
devices.

3. Acquisition modules: Two types of acquisition modules can be used: PDM and
E-modules.

4. The F7 Frame has seven module slots, and the F5 Frame has five module slots
that support all E-module acquisition modules. It supports both PDM and PSM
modules with a slide mount.

5. Laser printer: This device may be connected to the monitor, network, or to
a central station on the network. The laser printer can print waveforms,
alarm waveforms, numeric trends, and reports. If it is used within the patient
environment it must always be powered from an additional transformer providing
at least basic isolation.

6. PRN 50-M+ recorder: This device may be connected directly to the monitor or
over the network to a remote monitor or central station. The recorder can print
waveforms, alarm waveforms, and numeric trends.

7. Mouse.
8. Unity Network Interface Device (ID): Used with the monitor to communicate with

other manufacturers’ peripheral bedside devices, such as ventilators and gas
delivery systems, to centralize patient data on one device.

9. Remote control: Used to provide all patient monitor controls on a portable
component with a Trim Knob control.

10. Barcode reader: Used to scan Patient Information Number from barcodes when
admitting patients.

11. Keyboard: Allows data entry without using the on-screen keyboard or a
touchscreen display.
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B850 processing unit front view
Four M-port connectors are located on the processing unit. The M-ports are used to
connect peripheral devices to the monitor.

1. Power indicator: Illuminates green when the power is turned on.

2. M-ports: Connect the remote control, PRN 50-M+ recorder, or a Unity Network
Interface Device (ID) to the monitor.

B850 processing unit back view

1. Power on/off switch.

2. Power inlet connector.

3. Equipotential connector. For measurements in or near the heart we recommend
connecting the monitor to the potential equalization system (IEC 60601–1) to
ensure equal potential levels between the devices in the system.

4. Four USB ports: For connecting the touchscreen display, remote control, keyboard,
mouse, and barcode reader.

5. Two Ethernet connectors: For connecting the MC and IX networks. The MC
Network establishes communication and allows patient data to be sent to an
optional CIC Pro Clinical Information Center or CARESCAPE Central Station. The
IX Network provides access for example to the MUSE server, Citrix server, and IX
printers.

6. Two ePort connectors: For connecting the PDM and the module frames.

7. Two serial RS232 connectors.

8. DVI-D 2 connector for one digital display.

9. DVI-3 (optional third video display connector) supports a digital display and a
cloned analog display (iPanel application only)

10. DVI-I 1 connector for a digital display and a cloned analog display.
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B850 module frames F7 and F5
WARNING Do not touch the electrical connector located within the

module frame.

WARNING B850: ELECTRIC SHOCK. Do not use the F7 Frame for
standalone use. Ventilation holes on the F7 E-module Frame
will be covered only if installed within an Aisys CS2, Avance
CS2, or Aespire anesthesia machine.

1. Defibrillator (ECG) and IABP synchronization (E-modules only)

F5 and F7 E-module Frames provide an interface between the monitor and E-modules.
Frames allow additional parameters to be monitored.

The F5 Frame has five module slots that support all E-module acquisition modules. It
supports both PDM and PSM with a slide mount.

The F7 Frame has seven module slots, but it does not have a slide mount for the PDM
or PSM. The PSM module may be interfaced to the F5 or F7 Frame with a cable when
the Module Bus Adapter or Interface Module for PSM is used.

B650 system components
All components listed below can be used within the patient environment as long as
an additional transformer providing at least basic isolation is used with non-medical
grade secondary displays and printers.

Your system may not include all these components. Consult your local representative
for the available components.
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1. CARESCAPE Monitor B650

2. 19-inch display D19KT VER01: Touchscreen display that provides Trim Knob
control. If a non-medical grade display is used as a secondary display within the
patient environment it must always be powered from an additional transformer
providing at least basic isolation.

3. Laser printer: This device may be connected to the monitor, network, or to
a central station on the network. The laser printer can print waveforms,
alarm waveforms, numeric trends, and reports. If it is used within the patient
environment it must always be powered from an additional transformer providing
at least basic isolation.

4. Acquisition modules: Two types of acquisition modules can be used: PDM and
E-modules.

5. Keyboard: Allows data entry without using the on-screen keyboard or a
touchscreen display.

6. Mouse: Allows on-screen user selections and data entry.

7. Barcode reader: Used to scan Patient Information Number from barcodes when
admitting patients.

8. Unity Network Interface Device (ID): Used with the monitor to communicate with
other manufacturers’ peripheral bedside devices, such as ventilators and gas
delivery systems, to centralize patient data on one device.

9. Remote control: Used to provide all patient monitor controls on a portable
component with a Trim Knob control.
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B650 monitor front panel

1. Alarm light

2. Trim Knob control

3. Abbreviated integrated keypad

4. Battery power/mains power indicators

5. On/standby

B650 monitor side views

1. Recorder *

2. Module slot * for one double-width
or two single-width modules

3. Release switch for the pivoting
module frame

4. Defibrillator (ECG) and IABP
synchronization (E-modules only)

* = optional

1. Battery cover *

2. Lock for battery cover
* = optional
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B650 monitor back panel

1. Pivoting module frame

2. Slide mount, connector for PDM

3. Slide mount, connector for PSM

4. Connector for secondary (clone) display

5. Connector for ePort (PDM cable) *

6. Connector for remote on/off *

7. Network connectors (one or four) *

8. USB ports (two or four)*

9. Panel options

10. Power and ground

11. Cable release switch

* = optional

B650 pivoting module frame
The pivoting module frame provides an interface between the monitor and acquisition
modules. There are two pivoting module frame options available:

● Frame with PSM, PDM, and E-module support

● Frame with PSM, PDM, E-module, and recorder support

Using the B650 pivoting module frame
WARNING Do not touch the electrical connector located within the

module frame.
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1. Press the pivoting module frame’s release switch and use the rail on top of the
frame to help you in moving the frame.

2. Keep the release switch pressed and turn the module frame to the position you
prefer (0, 45 or 90 degrees). The module frame clicks when locked in position.

45 degrees 90 degrees

3. To return the pivoting module frame to its original position (0 degrees), press the
release switch and turn the frame. Make sure that the frame locks in place and
that the red color in the upper part of the switch is no longer visible.

B450 system components
All components listed below can be used within the patient environment as long as
an additional transformer providing at least basic isolation is used with non-medical
grade secondary displays and printers.

Your system may not include all these components. Consult your local representative
for the available components.
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1. CARESCAPE Monitor B450

2. 19-inch display D19KT VER01: Touchscreen display that provides Trim Knob
control. If a non-medical grade display is used as a secondary display within the
patient environment it must always be powered from an additional transformer
providing at least basic isolation.

3. Laser printer: This device may be connected to the monitor, network, or to
a central station on the network. The laser printer can print waveforms,
alarm waveforms, numeric trends, and reports. If it is used within the patient
environment it must always be powered from an additional transformer providing
at least basic isolation.

4. Acquisition modules: Two types of acquisition modules can be used: PDM and
E-modules.

5. Keyboard: Allows data entry without using the on-screen keyboard or a
touchscreen display.

6. Mouse: Allows on-screen user selections and data entry.

7. Barcode reader: Used to scan Patient Information Number from barcodes when
admitting patients.

8. Remote control: Used to provide all patient monitor controls on a portable
component with a Trim Knob control.

9. Unity Network Interface Device (ID): Used with the monitor to communicate with
other manufacturers’ peripheral bedside devices, such as ventilators and gas
delivery systems, to centralize patient data on one device.
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B450 monitor front panel

1. Alarm light

2. Battery power/mains power indicators

3. On/standby

B450 monitor side views

1. Module slot for one single-width
module

2. Defibrillator (ECG) and IABP
synchronization (E-modules only)

3. Optional recorder

4. Release latch for recorder

1. Receptacle for power cord

2. Battery slot

3. Release latch for battery door
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B450 monitor back panel

1. Slide mount, connector for PDM

2. Slide mount, connector for PSM

3. Connector for MC Network. The MC Network establishes communication and
allows patient data to be sent to an optional CIC Pro Clinical Information Center
or CARESCAPE Central Station.

4. Connector for IX Network. The IX Network provides access for example to the
MUSE server, Citrix server, and IX printers.

5. Connector for Unity Network Interface Device (ID)

6. Connector for ePort (PDM cable)

7. Connector for secondary display

8. USB ports

9. Connector for remote on/off

10. Power and ground

Monitor battery

B650 and B450 only.

WARNING The B450 must always be used with a battery inserted. This
will ensure the functioning of the monitor and prevent data
loss during possible supply mains interruptions.
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WARNING EXPLOSION OR FIRE. Using non-recommended batteries
could result in injury/burns to the patients or users. Only use
batteries recommended or manufactured by GE. The warranty
can be voided if non-recommended batteries are used.

WARNING EXPLOSION HAZARD. Do not incinerate a battery or store at
high temperatures. Serious injury or death could result.

WARNING PHYSICAL INJURY. Make sure the battery is completely
inserted and the battery door is completely closed. Falling
batteries could seriously or fatally injure neonatal or other
vulnerable patients.

For information regarding the operation and charging time of the monitor battery, see
the supplemental information manual.

If your B650 monitor has the optional battery slot, you can insert a lithium-ion battery
and use the monitor on battery power.

With the B450, you can use one or two lithium-ion batteries. One will always have
to be inserted.

The LED indicators on the monitor front panel indicate whether the monitor is being
used on battery or mains power, and also whether the battery is charging, full or
missing:

Front panel
indicator

Meaning

Monitor is operated on mains power.

Monitor is operated on battery power.

Battery failure or no battery.

Battery is charging. The indicator goes off when the battery is fully
charged.

Inserting and removing the B650 monitor battery
1. Open the battery slot by turning the lock 90 degrees clockwise:

2. Insert the battery with the test indicator side up and the connector end first all
the way into the battery slot.

3. Push the cover back up and lock it in place by turning the lock 90 degrees
counter-clockwise.

4. To remove the battery, open the battery slot and pull the battery out from the cord.
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Inserting and removing the B450 monitor battery
1. Open the battery cover by pressing the battery cover release latch down and

pulling the battery door open:

The yellow warning symbol inside the battery slot door:

WARNING The B450 must always be used with a battery inserted. This will
ensure the functioning of the monitor and prevent data loss
during possible supply mains interruptions.

2. Insert the batteries, one at a time, with the test indicator facing front and the
connector end first all the way into the battery slot.

3. Close the battery door carefully.

4. To remove a battery, open the battery cover and pull the battery out from the cord.

Checking the battery charge with monitor software

B650 and B450 only.

You can check the monitor battery status using the monitor software:

1. Select the battery status area in the upper right corner of the screen, or select
Monitor Setup > Battery Status.

2. Check the Monitor battery status that appears.

If the B450 has two batteries inserted, there are two columns, A and B, that show
information for each battery.

3. If you wish to see more detailed battery information, select the Advanced tab.
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Monitor battery charge symbols on screen

B650 and B450 only.

You can check the battery charge level from the monitor battery symbol on the right
upper corner of the display.

Screen symbol Meaning

Monitor battery is full.

Monitor battery (green). The higher the charge, the bigger the green
bar within the symbol. Numbers indicate the remaining run time.

Monitor battery (yellow). This symbol and a message indicating low
battery charge appear when there is less than 20 minutes of run
time left.

Monitor battery (red). This symbol and a message indicating empty
battery appear when there is less than 5 minutes of run time left.

Monitor battery is charging. There is a white running bar inside the
symbol.

Battery test button
When the battery is not inserted into the monitor, you can check its status by using the
TEST button on the battery itself. Push the button and check the green charging level
indicators to see how much charge is left:

● Four LEDs illuminated: 75% to 100% of full-charge capacity.

● Three LEDs illuminated: 50% to 74.9% of full-charge capacity.

● Two LEDs illuminated: 25% to 49.9% of full-charge capacity.

● One LED illuminated: 10% to 24.9% of full-charge capacity.

● One LED flashing: < 10% of full-charge capacity.

Alarm light
The alarm light provides a visual alarm when an alarm condition is present. It
indicates the highest priority alarm. The alarm light also provides a visual indicator
when the audio alarms are paused or when they are off.
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1. Audio alarm paused/off area

2. Alarm light area (cyan = low priority; yellow = medium priority; red = high priority)

Acquisition modules
You can use different types of acquisition modules with the monitor. They provide
connection to the patient, process patient data signals, and send patient data signals
to the monitor. For a complete list of compatible devices, see the supplemental
information manual.

The module interface is disabled when the NICU software package is selected with
other E-modules than E-NSATX or E-MASIMO, or CARESCAPE respiratory modules
with the Respiratory Module License. Gas exchange measurement with CARESCAPE
respiratory modules is not available for neonatal patients.

Identical modules
WARNING Do not use identical measurement modules or modules that

map a measurement to the same channel or parameter
window. If such modules have been connected, remove the
module that has been most recently connected. You can also
remove both modules and reconnect the new module after
five seconds.

The following modules are considered identical and should not be used simultaneously
in the same monitoring system.

Module Simultaneous use

PDM
E-PSMP

Only one per system.

CARESCAPE respiratory modules
E-miniC

Only one per system.

E-COP
E-COPSv

Only one per system.

E-NSATX
E-MASIMO

Only one per system.

E-ENTROPY Only one per system.

E-NMT Only one per system.

E-BIS Only one per system.
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PSMP front view
1. NIBP Auto On/Off

2. NIBP Start/Cancel

3. Zero P2

4. Tab for removing the module

5. ECG (imp.resp).

6. SpO2

7. T1 to T2

8. P1 to P2

9. NIBP

10. Zero P1

PDM front view
The PDM module requires additional time to power up when used without the PDM
battery. Do not interrupt the startup sequence by unplugging the PDM module.

1. ECG (imp.resp).

2. T1 to T2/C.O.

3. P1/P3 and P2/P4

4. SpO2

5. NIBP

6. Communication indicator. Illuminates yellow during
boot-up and turns green after boot-up; flashes yellow
if communication fails; is not illuminated when no
power is applied to the PDM.

7. Power indicator: Illuminates yellow during boot-up
and turns green after boot-up;illuminates green when
the PDM module is powered by the monitor, or when
the PDM battery is installed and power is applied to
the PDM by pressing the Power On button; is not
illuminated when no power is applied to the PDM.

8. Dual function Power On and Zero All button

9. Defib/Sync

10. Tab for removing the module

WARNING PHYSICAL INJURY. Do not install the PDM above a patient.
Make sure the battery is completely inserted and the battery
door is completely closed. Falling batteries could seriously or
fatally injure neonatal or other vulnerable patients.
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WARNING PHYSICAL INJURY Do not install the PDM above a patient.
Leaks from the battery cells can occur under extreme
conditions. The liquid is caustic to the eyes and skin. If the
liquid comes in contact with eyes or skin, flush with clean
water and seek medical attention.

WARNING EXPLOSION OR FIRE. Using non-recommended batteries
could result in injury/burns to the patients or users. Only use
batteries recommended or manufactured by GE. The warranty
can be voided if non-recommended batteries are used.

Connecting a PDM or PSM to a frame
1. Connect the module by aligning it with the insertion guides of the docking station

on the outside of the frame. Make sure that the PDM is only used in vertical
position.

2. Push the module into the docking station until it clicks and stops.

NOTE The PDM module requires additional time to power up when used
without the PDM battery. Do not interrupt the startup sequence
by unplugging the PDM module.

Removing a PDM or PSM from a frame
1. Pull the pull tab out and slide the module out of the guides.

2. Hold onto the module to make sure it does not drop when it comes out.

Connecting other E-modules than the PSM to a frame
NOTE An E-module can occupy any slot in the frame, no specific

order is required.

1. With the module properly oriented (module release latch facing down), align the
insertion guide slot in the module with the insertion guide in the frame.

2. Push the module into the frame until it clicks.
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Removing other E-modules than PSM from a frame
1. Press the release latch at the bottom of the module.

2. While pressing the release latch, grasp the module firmly and pull out.

Connecting a PSM or PDM to the B650
1. Connect a module by aligning it with the insertion guides on the pivoting module

frame. Make sure that the PDM is only used in vertical position.

2. Push the module into the module frame until it clicks and stops.

NOTE The PDM module requires additional time to power up when used
without the PDM battery. Do not interrupt the startup sequence
by unplugging the PDM module.

Removing a PSM or PDM from the B650
1. Pull the release tab out and slide the module out of the guides.

2. Hold onto the module to make sure it does not drop when it comes out.

Connecting other E-modules than PSM to the B650
1. With the module properly oriented (module release latch facing down), align the

insertion guide slot in the module with the insertion guide in the module frame.

2. Push the module into the module frame until it clicks.
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Removing other E-modules than PSM from the B650
1. Press the release latch at the bottom of the module.

2. While pressing the release latch, grasp the module firmly and pull out.

Connecting a PDM or PSM to the B450
1. Connect a module by aligning it with the insertion guides of the docking station on

the back of the monitor. Make sure that the PDM is only used in vertical position.

2. Push the module into the docking station until it clicks and stops.

NOTE The PDM module requires additional time to power up when used
without the PDM battery. Do not interrupt the startup sequence
by unplugging the PDM module.

Removing a PDM or PSM from the B450
1. Pull the release tab out and slide the module out of the guides.

2. Hold onto the module to make sure it does not drop when it comes out.
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Connecting other E-modules than PSM to the B450
1. With the module properly oriented (module release latch facing down), align the

insertion guide slot in the module with the insertion guide in the module frame.

2. Push the module into the module frame until it clicks.

Removing other E-modules than PSM from the B450
1. Press the release latch at the bottom of the module.

2. While pressing the release latch, grasp the module firmly and pull out.

PSM and PDM parameters
Parameter E-PSMP PDM (Masimo)** PDM (Nellcor)**

ECG up to 12 leads up to 12 leads up to 12 leads

Imp.respiration x x x

Invasive pressures 2* 4* 4*

NIBP x x x

Temperature 2* 2*
(or C.O.)

2*
(or C.O.)

C.O. - x
(or 2 temp.)

x
(or 2 temp.)

SpO2 Masimo - x -

SpO2 Nellcor - - x

SpO2 GE x - -

* A dual adapter cable is required to monitor two invasive pressure or temperature measurements on a
single connector.

** Different SpO2 cables are required for each type of SpO2 processing. The cable connectors are not
interchangeable.
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E-COP and E-COPSv parameters
Parameter E-COP E-COPSv

Invasive pressures 1 1

SvO2 - x

C.O. x
(also REF)

x
(also REF)

E-PP and E-PT parameters
Parameter E-PP E-PT

Invasive pressures 2 1

Temperature - 2*

* A dual adapter cable is required to monitor two temperature measurements on a single connector.

E-module gas parameters
Module

CO2 N2O O2

Anesthetic
agents Agent ID

E-miniC x * - - -

E-sCO x * x - -

E-sCOV x * x - -

E-sCOVX x * x - -

E-sCAiO x x x x x

E-sCAiOE x x x x x

E-sCAiOV x x x x x

E-sCAiOVX x x x x x

E-sCAiOVE x x x x x

* The E-sCO, E-sCOV, and E-sCOVX modules automatically compensate for N2O in realtime although N2O
values are not displayed on screen. The E-miniC requires manual selection from the monitor menu to
compensate for N2O.

Module
Spirometry Gas exchange Aisys CS2 end-tidal control

E-miniC
- - -

E-sCO - - -

E-sCOV x - -

E-sCOVX x x -

E-sCAiO - - -

E-sCAiOE x - x

E-sCAiOV x - -

E-sCAiOVE x - x
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Module
Spirometry Gas exchange Aisys CS2 end-tidal control

E-sCAiOVX x x -

For more information on the use of end-tidal control, refer to the Aisys CS2 user documentation.

E-MASIMO and E-NSATX parameters
Parameter E-NSATX* E-MASIMO*

SpO2 Masimo - x

SpO2 Nellcor x -

* Different SpO2 cables are required for each type of SpO2 processing. The cable connectors are not
interchangeable.

Specialty E-module parameters
Parameter E-NMT E-ENTROPY E-BIS

Level of relaxation x - -

Nerve stimulation x - -

Entropy - x -

BIS - - x

Displays
WARNING To prevent liquids from entering the display casing, do not tilt

the display more than +/- 15 degrees.

WARNING ELECTRIC SHOCK. Always unplug the grounded cables when
not in use. Leaving them connected could result in an electric
shock from the ground contact in the other end.

WARNING B650, B450: Secondary displays will not sound the audible
alarms. Keep the patient under close surveillance.

WARNING If there is a power failure (for example, the supply mains is
interrupted or the USB cable is disconnected during an active
patient case), the CARESCAPE D19KT VER01 display gives a
continuous beeping alarm. This alarm remains active for as
long as there is some residual power left, or until it is silenced
with the Trim Knob or the standby button, or until the USB
cable is reconnected or the supply mains is restored. A power
failure alarm is also indicated by the alarm light flashing
yellow.

76 CARESCAPE Monitors B850, B650, B450 2105822-001



System introduction

1. Alarm light
2. Trim Knob control
3. Standby button

The standby button does not turn off the USB connectors on the back of the
display. To completely turn off the display, turn off the mains power switch on
the back of the display.

The CARESCAPE D19KT VER01 display provides a Trim Knob control and indicates a
power failure alarm by a continuous beep. The display integrates audible (B850 only)
and visual alarms, and provides USB connectivity.

The Bx50 monitors support a different number of displays:
● B850: The monitor supports up to three independent displays and two additional

clone displays. The third display is only for use with the iPanel software application.
● B650: The monitor supports one secondary (clone) display. The monitor itself has a

15” integrated display.
● B450: The monitor supports one secondary independent display. The monitor itself

has a 12” integrated display.

Other system components
For more information, refer to the devices’ own instructions.

Input devices Description

Barcode reader
The barcode reader can be used to scan Patient Information from
barcodes when admitting patients.
The barcode reader comes pre-configured and its configuration must
not be changed. If you change the barcode reader it will not operate
properly with the monitor.

Keyboard
A washable, antibacterial keyboard is specified for use with the monitor.
It may be connected to the monitor or display via one of the USB
connectors. The keyboard allows you to enter data without using the
on-screen keyboard or a touchscreen display.

WARNING Use only washable keyboard with at least IPX1
protection against ingress of water.
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Input devices Description

Mouse
A standard mouse may be connected to the monitor or display via one of
the USB connectors. The mouse allows you to select any on-screen items
without a Trim Knob control or a touchscreen display.

Remote control
The remote control provides all patient monitor controls on a portable
component with a Trim Knob control. The remote control is connected to
the patient monitor via one of the USB connectors.

Recorders and laser printers Description

PRN 50–M+ with the B850 only.
The monitor can print to a configured network laser printer, a PRN 50-M+
recorder (B850), an optional recorder (B650 and B450), or a remote
recorder in the network.
You need the IX Network for the network printer.

Central stations Description

CIC Pro Clinical Information Center
The MC Network establishes communication and allows patient data
to be sent to an optional CIC Pro Clinical Information Center (central
station). See the CIC Pro Clinical Information Center Operator’s Manual
for operating instructions.

CARESCAPE Central Station
The MC Network establishes communication and allows patient data to
be sent to an optional CARESCAPE Central Station. See the CARESCAPE
Central Station User’s Manual for operating instructions.

Other devices Description

Unity Network Interface Device (ID)
The monitor can interface with peripheral medical devices, such as
ventilators and gas delivery systems, to centralize patient data on one
device. A Unity Network Interface Device (ID) is used with the monitor to
communicate with peripheral devices.
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iPanel software application

B850 and B450 only.

The iPanel application, viewable from one of the monitor’s display screens, gives
access to desktops created by the hospital IT. These desktops provide patient
information from other systems that may be installed at the hospital [e.g.,
Centricity Clinical Information View (Centricity CIV), MUSE Web, and Picture Archiving
Communications System (PACS)]. Desktops can be created with customer defined
resolutions using the hospital-wide login and identification process. The iPanel
application is used through a Citrix thin client on the monitor so no additional
equipment is required at the bedside.

WARNING VIEWING WRONG PATIENT DATA. When viewing patient data
remotely with iPanel or some other Citrix application, pay
special attention to the patient identification and ensure that
you are viewing the correct patient. Otherwise there is a risk
of mistakenly viewing another patient’s data.

See the supplemental information manual for the iPanel application default settings.
See the monitor service manual for configuring the size, location, and behavior of
the iPanel application.

InSite with RSvP
InSite with RSvP provides a set of software applications to manage, diagnose, and
track system at customer sites by using the Internet for secure communications
between the customers’ and GE’s firewalls. InSite with RSvP consists of Enterprise
Server, which resides at GE’s support center, and Remote Service Agent that resides on
a system at the customer site (or on a PC controlling the system(s) at the customer site).

Equipment markings
The following markings appear on one or more of the devices.

Bell cancel. Audio off.

Audio pause. Temporary audio off.

General alarm.

Fuse. Replace with identical type and rating fuse.

Do not reuse.
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The following markings appear on one or more of the devices.

Battery (monitor): The flashing orange symbol indicates that
there is a battery failure/missing battery.

Battery (monitor): The solid orange symbol indicates that the
battery is being charged.

Battery (monitor). The solid green symbol indicates that the
monitor is being used on battery power.

Battery (monitor). Located on the battery slot cover.

Battery (monitor): The battery slot cover is open/closed.

Battery (monitor): Test button on the battery to check the battery
charge level.

Battery (PDM).

Communication.

Power indicator.

On/standby button.

Standby or power indicator.

USB connectors.

Ethernet connectors.

Serial interface.

ePort connector for PDM module and E-module frame.

DVI connector. Video output connector for digital or analog
source.
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The following markings appear on one or more of the devices.

Color video input. Video input connector for digital or analog
source.

Gas inlet.

Gas outlet.

Zero all.

Degree of ingress protection.
Degree of protection against harmful ingress of water:
Components not marked with an IPX n code are rated as
Ordinary (no protection against fluid ingress). All other IPXn rated
components have the degree of protection per the ‘n’ rating.
IPX1: This equipment is protected against harmful effects of
dripping water as per IEC 60529.

Latex-free.

Use by.

Add date.

Home. Return to the main display.

Alternating current.
Green symbol on the B650 and B450 monitor front panel:
the monitor is being used on mains power. Without mains
connection the B650 and B450 are internally powered medical
equipment.

Direct current.

Equipotentiality. Connect device to a potential equalization
conductor.

Protective earth ground. Connectors grounded to the AC power
source.
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The following markings appear on one or more of the devices.

Defibrillator synchronization connectors.

Stacking limit by number.

Date of manufacture. This symbol indicates the date of
manufacture of this device. The first four digits identify the year,
the following two digits identify the month, and the last two
digits identify the day.

Manufacturer date and address. The first four digits identify the
year, the following two digits identify the month, and the last two
digits identify the day.

Manufacturer name and address.

Batch or lot number.

Abbreviation for label part number.

Abbreviation of product number.

Identifies the device type.

Catalogue or orderable part number.

Device serial number.

Device model or type.

Every device has a unique marking for identification. The UDI
marking appears on the device label.

Mass of typical portable RGM (respiratory gas monitor)
configuration.
The indicated mass (12 kg in this example) varies per RGM
configuration.

Locked.
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The following markings appear on one or more of the devices.

Unlocked.

No heavy load.

Maximum total load

Atmospheric pressure limitations.

Temperature limitations.

Humidity limitations.

Keep dry. Protect from rain.

Fragile. Handle with care.

This way up.

This symbol indicates that the waste of electrical and electronic
equipment must not be disposed as unsorted municipal waste
and must be collected separately. Please contact an authorized
representative of the manufacturer for information concerning
the decommissioning of your equipment.

Recycled materials or may be recycled.

Recyclable Lithium-Ion.

European authorized representative.

2105822-001 CARESCAPE Monitors B850, B650, B450 83



System introduction

The following markings appear on one or more of the devices.

European Union Conformity Mark.

Indicates that the product is certified for both the U.S. and
Canadian markets.

FCC. USA only. Complies with applicable US government (Federal
Communications Commission) radio-frequency interference
regulations.

CAUTION U.S. Federal law restricts this device to
sale by or on the order of a physician.

Russia only. GOST-R mark.

Eurasian Economic Union countries only. Eurasian Conformity
mark. Conformity to applicable technical regulations of Customs
Union.

Brazil only. INMETRO certificate.

The following symbols (required by China law only) are
representative of what you may see on your equipment.

The number in the symbol indicates the EFUP period in years,
as explained below. Check the symbol on your equipment for
its EFUP period.
This symbol indicates the product contains hazardous materials
in excess of the limits established by the Chinese standard
GB/T 26572 Requirements for Concentration Limits for Certain
Hazardous Substances in Electronic Information Products. The
number in the symbol is the Environment-friendly Use Period
(EFUP), which indicates the period during which the hazardous
substances or elements contained in electronic information
products will not leak or mutate under normal operating
conditions so that the use of such electronic information
products will not result in any severe environmental pollution,
any bodily injury or damage to any assets. The unit of the period
is "Year".
In order to maintain the declared EFUP, the product shall
be operated normally according to the instructions and
environmental conditions as defined in the product manual,
and periodic maintenance schedules specified in Product
Maintenance Procedures shall be followed strictly.
Consumables or certain parts may have their own label with an
EFUP value less than the product. Periodic replacement of those
consumables or parts to maintain the declared EFUP shall be
done in accordance with the Product Maintenance Procedures.
This product must not be disposed of as unsorted municipal
waste, and must be collected separately and handled properly
after decommissioning.
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The following markings appear on one or more of the devices.

This symbol indicates that this electronic information product
does not contain any hazardous substance or elements above
the maximum concentration value established by the Chinese
standard GB/T 26572, and can be recycled after being discarded,
and should not be casually discarded.

Underwriters Laboratories product certification mark.

Canada only. Industry Canada certification number indicates
that this product meets the applicable Industry Canada technical
specifications.

China only. Chinese Compulsory Certification as required by
AQSIQ. Safety & EMC compliance.

China only. China Ministry of Industry and Information
Technology identification number for Radio Transmission
Equipment Type Approval.

Australia only. The product complies with the applicable
Australian standard and establishes a traceable link between
the equipment and the manufacturer, importer or their agent
responsible for compliance.

Japan only. The PSE mark (Product Safety Electric Appliance and
Materials) is a mandatory mark required on Electrical Appliances
in Japan as authorized by the Electrical Appliance and Material
Safety Law (DENAN). This mark signifies that a product complies
with the law according to a set of standards for electric devices.

Japan only. Approved under Japan TELEC requirements.

Brazil only. Approved under ANATEL (Agência Nacional de
Telecomunicações) requirements.

South Africa only. Approved under ICASA (Independent
Communications Authority of South Africa) requirements.

Korea only. Approved under KCC (Korea Communications
Commission) requirements.

Ukraine only. Mark of conformity with the Technical Regulations.
This productmeets the requirements of the Technical Regulations
on medical devices, approved by Resolution No. 753 of the
Cabinet of Ministers of Ukraine on October 2nd 2013
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Unique Device Identifier (UDI)
Unique Device Identifier. (UDI)
Every medical device has a unique marking for identification.
The UDI marking appears on the device labeling.
Note that this is only an example of a UDI marking. The
device may have a linear barcode as in this example, or a
DataMatrix code, or only alphanumeric identifiers with no
barcode. Also the identifiers vary per product.

The characters used in the UDI marking represent specific identifiers. In the example above:

Device identifier:

● (01) = GS1 global trade item number (GTIN) of the device.

● 1234567891234 = Global trade item number.
Production identifiers:

● (21) = GS1 application identifier for the serial number of the device.

● SJN14241237HA = Serial number.

● (11) = GS1 application identifier for the manufacturing date of the device.

● 150628= Manufacturing date: year-month-day (YYMMDD).
Note that for some product types the production identifier can have other elements instead of the ones
listed above:

● (10) = GS1 application identifier for the batch or lot number, followed by the batch or lot number.

● (17) = GS1 application identifier for the expiration date of the device, followed by the expiration date.
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Main screen layout
The main screen displays alarms, information, trends, snapshots, waveforms,
parameter windows, and the main menu in pre-defined areas.

When the information area of the screen is selected, it opens the Admit/Discharge
menu and provides access to settings related to patient and administrative
information, standby and profile selections, and similar. If the OR or PACU software
packages are used, the Case Setupmenu opens and the Standby tab is not available.

Alarm area Information area

Split screen area
(option). You may also
select Minitrend as an
option for this area.

Waveform area Upper parameter windows

Lower parameter windows (option)

Main menu area

In addition, the information area of the screen displays the following information:
● Patient name (if entered).
● Profile name that is being used for patient monitoring.
● PDM battery gauge icon if a PDM module is connected to the monitor. You can

access the Battery Statusmenu by clicking this icon.
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● B650, B450: Monitor battery gauge and battery status icons (if batteries are
inserted). You can access the Battery Statusmenu by clicking these icons.

● Bed name and care unit of the local monitor (if connected to the MC Network).

● Network symbol (if connected to the MC Network).

● B650, B450: WLAN signal strength symbol (if connected to the wireless network).

● Telemetry transmitter used in combination monitoring

● Current time of day.

Main keys
Various functions of the monitor can be accessed through the monitor’s main menu
keys. In addition, they can be accessed through:

● Remote control: optional for all Bx50 monitors

● Trim Knob control: used for selecting menus and menu options.

Key Function

Home. Close all menus/applications displayed on the
monitor.

Pause audio alarm. Pause active audio alarms or
pre-pause audio for incoming active alarms.

Alarm Setup Allows access to alarm limits and priorities,
arrhythmia alarm settings, and audible and visual
alarm indicators.

Monitor Setup Allows access to screen setup (also primary and
secondary screen with B850), colors, sound volumes,
parameter setup, printing, brightness settings (B650,
B450), battery status, touchscreen off setting, and IP
calibration. Also allows access to password protected
functions default setup, service calibrations, and
service.

Procedures Allows access to cardiac output, catheter insertion,
wedge, 12 lead analysis, ST trends, spirometry loops,
and timers (elapsed time, countdown timer).

Data & Pages Allows access to admit/discharge patient (ICU, ED,
NICU software packages) or start/end case (OR, PACU
software packages), drug calculator, laboratory data,
calculations for hemodynamic, oxygenation, and
ventilation measurement values, and other patients
in the network. It also allows selecting predefined
pages. B850 and B450: Access to iPanel.

Trends Allows access to graphic, numeric, snapshot,
ST-snashot, and Machine Gas Cons. trends, events,
and trend scales.

Print Waveforms or Stop Printing Print or stop printing the parameter waveforms.
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Key Function

Freeze/Snapshot or Unfreeze Freeze or unfreeze the scrolling waveforms. Freezing
will automatically end after 15 seconds, or you can
end it manually.
A snapshot is taken every time this button is pressed.

NIBP Auto Start or NIBP Auto Stop Start or stop automatic non-invasive blood pressure
measurements at timed intervals. After selection, the
button toggles to NIBP Auto Stop.
PDM: Mesurement does not start unless the cuff size
is defined.

NIBP Start or NIBP Cancel Start or stop a non-invasive blood pressure
measurement. After selection, the key toggles to
NIBP Cancel.
PDM: Mesurement does not start unless the cuff size
is defined.

NIBP Auto Start or stop automatic non-invasive blood pressure
measurements at timed intervals.

NIBP Start/Stop USB remote control only: Start or stop a non-invasive
blood pressure measurement.
PDM: Mesurement does not start unless the cuff size
is defined.

Parameters USB remote control only: Select and review parameter
settings.

Zero All Pressures Zero all invasive pressure channels.
This does not apply to ICP.

An example of a menu
The following is an example of a menu illustrating some of the components and how
they are referred to in this manual:
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1. Menu title (for example, ECG)

2. Submenu tabs (for example, ECG, ST, QT, Arrhythmia)

3. Tabs (for example, Setup, Alarms)

4. Selection lists: when selecting the arrow, a list of options appears

5. Check box for selecting/deselecting a feature

6. Arrow selector spinner for increasing/decreasing a value

7. Help text area

8. Radio button for selecting/deselecting a feature

9. Selection key. The field below shows the current selection/status.

10. Exit key (for example, Previous Menu, Close)

NOTE Not all menus have these same components.

Menu options
In this manual, the term select means using the mouse, Trim Knob control, or
touchscreen display to select an item on the screen.

Selecting menu options with a touchscreen
NOTE Do not use pencils, pens, or other sharp objects to activate

the touchscreen. The touchscreen will not function properly if
tape or paper is stuck to the display surface.

1. Touch the menu option with your finger.

2. The highlight on screen moves to this option.
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3. Lift your finger off the screen, and the selected function is performed (e.g., a list
opens).

Selecting menu options with the Trim Knob control
1. Rotate the Trim Knob control in either direction to move the highlighted cursor

from option to option on the display.

2. Press the Trim Knob control once to select the highlighted option.

Selecting menu options with a mouse
1. Move the mouse until the pointer (arrow) is on the menu option you wish to select.

2. Click the left mouse button once.

Data field entries
You can use the on-screen keyboard or a standard keyboard to type data into a data
field. Data fields are selected with a touchscreen, Trim Knob, or mouse.

Entering data
When data entry is required, the monitor automatically displays an on-screen
keyboard for you to use. If you prefer, you can use a standard keyboard instead.

1. Select the desired field.

The selected field changes color into yellow, indicating that you can begin entering
the text.

2. Enter data:

a. On-screen keyboard: Select the characters with the mouse, Trim Knob, or
touchscreen.

b. Standard keyboard: Type the desired text into the selected field.

About the user default settings
User default settings mean those settings (start-up mode, profile etc.) that the user
has saved into the monitor to replace the factory default settings. The monitor uses
these settings when it is turned on and after a power off situation that lasts more than
15 minutes. If there are no user default settings, factory default settings are used.

If you configure an alarm priority to a value that deviates from the recommendation
of international alarm safety standards, the monitor notifies you about the
non-compliance when you try to save your changes to profiles. In this case, you
have two options: save your chosen values anyway, or use the standard-compliant
values. If you use the standard-compliant values, the monitor saves the lowest
possible compliant value. For example, if you have chosen a Low priority level and
standard-compliant values are Medium and High, the monitor saves the Medium
priority level.

About profiles
When you start monitoring a patient, you can use the startup profile (set during
configuration) or select another profile. According to the configuration, your software
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may have up to eight profiles to choose from. Profiles control many settings, including
parameter defaults, alarm detection limits, and alarm functionality.

Profiles are set through Monitor Setup > Default Setup > Profile Settings, and they
are password protected.

For more information, see the supplemental information manual.

Selecting a profile
The monitor starts with the startup profile, but you can select another profile
according to your needs. You can also change the profile while monitoring a patient
without losing any patient data.

1. Select the patient information area on the screen.

2. Select the Patient tab.

3. Select a profile from the Profile list.

4. You can return to the previous profile by selecting Return to Previous Profile.

If you make changes to a profile while using it and need to return to its previous
settings, first select another profile and then re-select the one you were using.

Supply mains interruption
If the supply mains to the equipment is interrupted for less than 15 minutes (and the
B650 is used without the optional battery), the monitor keeps the trend data and the
latest user-made settings. If not, contact qualified service personnel. After 15 minutes,
all patient information and trend data is lost and the monitor returns to the user
default settings (start-up mode). For more information, see the service manual.

WARNING The B450 must always be used with a battery inserted. This
will ensure the functioning of the monitor and prevent data
loss during possible supply mains interruptions.

User interface indicators
The following indicators appear in the software user interface.

Alarm off indicator.
The symbol may not display at the central station or on a remote
bedside monitor.

Alarm priority indicator: High (red). Indicates a high priority
alarm.

Alarm priority indicator: Medium (yellow). Indicates a medium
priority alarm.

Alarm priority indicator: Low (cyan). Indicates a low priority
alarm.

Alarm volume icon. Adjust the minimum alarm tone volume.
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The following indicators appear in the software user interface.

Audio alarms off indicator.

Audio alarms paused indicator with countdown timer - Indicates
all audio alarms are paused and the amount of time remaining
for the alarm pause period displays as a countdown timer.

Pause audio alarms - Selectable from the monitor’s main menu.
Also an indicator of a temporarily paused active audio alarm

Low priority audio off alarm indicator.

General warning sign. Displays when the priority setting
deviates from the recommendation of international alarm safety
standards.

Reminder volume icon. Adjust the volume of the tone that
sounds every two minutes when audio alarms are turned off.

Touch volume icon. Adjust the volume of the tone that sounds
when a user touches a touchscreen display.

Home icon. Close all menus/applications displayed on the
monitor.

Locking setting indicator. Indicates this setting is locked and
cannot be adjusted.

Network connection indicator. Indicates themonitor is connected
to the Local Area Network (LAN).

Network connection indicator. Indicates themonitor is connected
to the Wireless Local Area Network (WLAN).

Network (WLAN) signal strength. The number of segments
corresponds to the signal strength: four segments indicate
strong signal, one segment weak signal.

Monitor battery is full.

Monitor battery (green). The higher the charge, the bigger the
green bar within the symbol. Numbers indicate the remaining
run time.

Monitor battery (yellow). This symbol and a message indicating
low battery charge appear when there is less than 20 minutes of
run time left.

Monitor battery (red). This symbol and a message indicating
empty battery appear when there is less than 5 minutes of run
time left.
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The following indicators appear in the software user interface.

Monitor battery is charging. There is a white running bar inside
the symbol.

Monitory battery failure indicator. Indicates a missing battery
or a battery failure.

PDM battery charging indicator. Indicates the battery is charging.

PDM battery gauge indicator. Indicates the charge level of the
battery.

PDM battery failure indicator. Indicates the battery is not
available for use.

Snapshot indicator. Indicates the event has an associated
snapshot.

Beat source indicator.

Respiration indicator. Indicates a breath is detected by the
impedance respiration algorithm.

BIS and Entropy sensor impedance check indicator (gray).
Displays for each sensor as the impedance check is in progress.

BIS and Entropy sensor impedance check error indicator (red).
Indicates the specified sensor failed the impedance check.

BIS and Entropy sensor impedance check passed indicator.
Indicates the specified sensor passed the impedance check.

Completed NIBP volume icon. Adjust the volume of the tone that
sounds when an NIBP measurement result is available.

Manual NIBP icon. Start a manual NIBP measurement.

Nellcor OxiMax SatSeconds indicator. Indicates the amount of
time the SpO2 saturation is outside the limits before alarms are
generated.

SpO2 signal strength indicator. Indicates the signal strength, with
three asterisks indicating the strongest signal.
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The following indicators appear in the software user interface.

NMT Stimulus beep volume icon. Adjust the volume of the tone
that sounds when a stimulus pulse is generated.

Progress bar. Indicates the amount of time remaining until the
next automatic measurement.
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5
Setting up the monitor before use

Normal screen and other pages
When monitoring begins, the main page appears automatically. This preconfigured
page is called the normal screen. Any changes you make to the screen setup during
monitoring are changes to this normal screen. These changes are not permanent
unless they are saved to a profile. They are valid until the case is reset/the patient
is discharged from the monitor. They are also kept in the monitor memory for 15
minutes after the power is turned off.

Pages are user-defined screen formats. The contents are preconfigured but can
be changed. Page configuration is password protected, but once the pages are
configured they can be selected to screen by all users. There may be pages designed,
for instance, for physicians, surgeons, or nurses. For more information on page
configuration, see the supplemental information manual.

In addition to the normal screen, each profile can have up to five additional pages and
some of these may be preconfigured. These additional pages are needed for instance
when all the measured parameters do not fit on the normal screen page. These pages
can also include information that is needed only during a specific phase of care. The
name of the page currently in use is always displayed in the upper part of the screen.

Selecting the normal screen (main page)
You can return to the normal screen (main page) any time during the monitoring.

You can either select the icon or key, or:

1. Select Data & Pages.

2. Select Normal Screen.

Selecting pages
You can select different pages to the screen during monitoring to view their
information.

1. Select Data & Pages.

2. Select the radio button of the page you want to see.

3. You can return to the normal screen by selecting the home icon or home key, or
through Data & Pages > Normal Screen.
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Adjusting sound volumes
You can adjust various sound volumes according to your care environment needs.
While you are adjusting the volume, you will hear a corresponding sound that will
guide you in determining a suitable level. All volumes other than Alarm Volume can be
set to 0 if required.

1. Select Monitor Setup.

2. Select Sound Volumes.

3. Adjust the different sound volumes:
● Beat Volume
● Completed NIBP Volume
● Stimulus Beep Volume
● Alarm Volume
● Touch Volume. This selection is not adjustable if it has been locked through

Default Setup > Locking Settings.

Brightness settings

B850 display brightness
For information on how to set the display brightness for B850 displays, refer to their
user manual.

Adjusting the display brightness automatically

B650 and B450 only.

With the automatic adjustment, the display brightness is automatically set according
to the ambient light. This same setting also turns on the B650 keyboard light
automatically.

1. Select Monitor Setup > Brightness.

2. Select the radio button for Automatic adjustment.

Adjusting the display brightness manually

B650 and B450 only.

With the manual adjustment, you can set the display brightness level according to
your needs.

1. Select Monitor Setup > Brightness.

2. Select the radio button for Manual adjustment.

3. Select Display % and adjust the display brightness in the range of 30% to 100%.

98 CARESCAPE Monitors B850, B650, B450 2105822-001



Setting up the monitor before use

Adjusting the alarm light brightness

B650 and B450 only.

1. Select Monitor Setup > Brightness.

2. Select the radio button for Manual adjustment.

3. Select Alarm Light % and adjust the brightness.

NOTE You can also adjust the alarm light brightness through Alarm
Setup > Audible & Visual > Alarm Light %. This selection is
available for the B850 also.

Setting the keyboard light to turn on automatically

B650 only.

With the automatic adjustment, the keyboard light comes on automatically when the
brightness level of the display stays below or above set default limits for more than 10
seconds. This same selection adjusts the display brightness level automatically.

1. Select Monitor Setup > Brightness.

2. Select the radio button for Automatic adjustment.

Turning the keyboard light on manually

B650 only.

You can select the keyboard light on or off manually when needed.

1. Select Monitor Setup > Brightness.

2. Select the radio button for Manual adjustment.

3. Select Keyboard and set the keyboard light On or Off.

Screen setup modifications

Parameter windows
The parameter windows show numeric or graphic presentation of the measurement
data. Each window can contain one or several parameters according to what you
have chosen.

The parameter windows can be of four different sizes according to the number of
selected and active parameters on screen. The sizes can be described as big (full
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width, full height), small (half width, half height), tall (half width, full height), and wide
(full width, half height):

SMALL WIDE
BIG TALL

You can configure parameters to the lower parameter area (horizontal, lower part of
the screen) and/or to the upper parameter area (vertical, on the right).

Upper parameter area
You can configure individual waveforms and parameter windows in the Upper
Parameter Area. One parameter window can show more than one parameter when
parameter combinations (such as SpO2 & SvO2) are used.

You can also combine invasive pressure waveforms. ECG or ST monitoring reduces the
number of upper parameter windows by one, and monitoring both of them reduces
the number by two.

Lower parameter area
Any numeric parameter window in the lower parameter area having an empty field
(=OFF) above or below it is automatically enlarged.

You can configure a maximum of eight lower parameter windows. When the lower
parameter windows are on, they reduce the space used for waveforms and upper
parameter windows: you can then choose up to six waveforms and 12 parameter
windows to display in the upper parameter area of the screen.

The contents of the available parameters’ list is set in the Care Unit Settings, and the
setting is password protected.

For more information, see the supplemental information manual.

Selecting parameters to the screen
Most parameters appear on screen automatically when their measurement starts.
However, if you cannot see the parameter you are measuring, select it to the screen:

1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with the Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select the parameter to the upper or lower parameter area:

a. Select Upper Parameter Area > Show Parameter.

If a parameter is still not visible in the upper parameter area after you have
selected it to the screen, raise its priority with the arrow keys in the Change
Order column. If you want to hide the waveform of a parameter, deselect
Show with Waveform.

b. Select Lower Parameter Area and activate it by selecting the radio button
Double Height or Single Height. Then select the parameter from the
dropdown lists. To hide the Lower Parameter Area from the screen, select Off.

Selecting Double Height allows eight different parameter combinations in the
selection lists in addition to the individual parameters, and selecting Single
Height allows four combinations.
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Waveform field safety precautions
WARNING Always make sure that the waveform size is sufficient for the

care environment.

CAUTION The waveform autoscaling feature automatically updates the
display from the best possible signal amplitude. Always make
sure that the waveform display scale is correctly understood
and does not lead to delayed patient treatment.

Selecting the display mode for IP waveforms
You can select the invasive pressure waveforms to be shown as individual waveforms,
or in a combined view.

1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with the Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select Upper Parameter Area.

4. Select an option from the Invasive Pressure Waveforms list:

● To view individual waveforms, select Individual.

● To combine the currently displayed adjacent waveforms (2 to 4), select
Combined. The new waveform field will use the combined height of the original
fields.

● To combine up to four waveforms in one field, select 4invP. The new waveform
field will use the height of two upper parameter windows.

Setting up a split screen
You can split the waveform area into two parts. The split screen option divides the
screen so that you can view graphic and/or numeric data of the chosen measurement
on the left while still having waveforms and parameter windows visible at the same
time.

1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with the Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select Split Screen.

4. Select the type of split screen you need from the dropdown list:

● None: no split screen

● ST shows current and reference QRS complexes and ST trends.

● CCO shows the CCO Graphical view contents.

● Spiro 1 is a basic view of spirometry data.

● Spiro 2 is an enhanced view of spirometry data.

● Minitrend shows minitrends beside waveforms.

● AoA can show SPI and Entropy values and minitrends, and the NMT parameter
window. The contents depend on the modules and selections in use.
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Locked alarm and parameter settings
Some care unit and profile settings can be locked. Clinicians cannot adjust the locked
settings for the admitted patient. These settings are indicated with a lock symbol: .

The alarm and parameter settings that can be locked vary by acquisition module. They
are set through Default Setup > Locking Settings and they are password protected.

For more information, see the supplemental information manual.

Color selections
You can select display colors for the timer and all parameters according to your needs.
However, note that these settings are not adjustable if the selection has been locked.

For more information, see the supplemental information manual.

Selecting colors for IP channels without labels
1. Select Monitor Setup > Colors.

2. Select the Invasive Pressures tab.

3. Select Channels.

4. Select the colors from the lists.

Selecting colors for IP channels with labels
1. Select Monitor Setup > Colors.

2. Select the Invasive Pressures tab.

3. Select Labels.

4. Select the colors from the lists.

Selecting colors for other parameters and timer
1. Select Monitor Setup > Colors.

2. Select the Other Parameters tab.

3. Select:

a. Common and the colors from the lists.

b. Specific and the colors from the lists.

c. Select the color for the timer through Specific > Timer.

Parameter configurations
Before monitoring a patient, always check the parameter setup settings and alarm
limit values. Parameter settings and alarm limit values can be configured by selecting
Monitor Setup > Parameter Setup, then selecting a parameter. You can also access
setup and alarm settings by selecting a parameter window of a parameter that has
already been configured to the screen.

Setting up printing options
You can check that the printing options for waveforms, reports and devices are set
according to your needs when you start monitoring a patient.
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1. Select Monitor Setup.

2. Select Printing.

3. Check the settings by going through the different options and change if necessary.

Checking the PDM battery status
1. Select the battery status area in the upper right corner of the screen, or select

Monitor Setup > Battery Status.

2. B650, B450 only: Select the PDM tab. With the B850 the PDM battery status view
opens automatically.

3. Check the battery status information.

Checking the monitor battery status

B650 and B450 only.

1. Select the battery status area in the upper right corner of the screen, or select
Monitor Setup > Battery Status.

2. Check the Monitor battery status information that appears.

If the B450 has two batteries inserted, there are two columns, A and B, that show
information for each battery.

3. If you wish to see more detailed battery information, select the Advanced tab.

B850 with several screens
You can define the screen settings for several screens with the B850. For instance, you
can select which applications they show, do they show menus and/or alarms etc.

For more information, see the supplemental information manual.

Other setup changes
All other setup changes, like care unit settings and profile settings, require a password.

For more information, see the supplemental information manual.
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Software packages and terminology
The terminology used in different software packages varies: in OR and PACU, you start
or reset a case, and in other software packages you admit or discharge a patient. In
addition, some other menu selections may also differ according to the licenses in use.
Read all instructions carefully.

Turning on the monitor
The monitor is preset at the factory for a specific AC voltage. Before applying power,
make sure that the power requirements match your power supply. Refer to the label
on the back of the processing unit (B850) or on the monitor back panel (B650, B450) for
voltage and current requirements.

1. Ensure all cables are properly connected.

2. Turn on the power:

a. B850: Press the power on/off switch located on the back of the processing unit
to the I (on) position, and turn on the power to the display screen.

b. B650, B450: Press the on/standby button located on the monitor front panel.

The welcoming screen will appear with a status bar indicating the progress of
the startup procedure.

Turning off the monitor
1. Ensure that the patient has been discharged/the case has been ended.

2. Turn off the power:

a. B850: Press the power on/off switch located on the back of the processing
unit. To completely turn off the display, turn off the mains power switch on
the back of the display.

b. B650, B450: Press the on/standby button located on the monitor front panel.
Complete the shutdown procedure by pressing the button a second time when
a message prompts you to do so.

The screen is turned off.

B650 and B450: The monitor battery keeps charging if the mains cable is
connected. You can leave the batteries in the monitor even if the mains cable
is connected.
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Invasive pressure labels and PDM
WARNING When connecting PDM, the loaded IP labels may affect the

channel labeling of other already connected channels, and
consequently also the alarm limits.

When monitoring is started, stored invasive pressure labels for zeroed channels will
be transferred from the PDM to the monitor. Labels for those channels that have not
been zeroed will be the ones selected at the monitor. Note that the currently stored
labels may differ from defaults.

The IP labels saved to PDM are mapped according to this table:

From the monitor to PDM

Art 1 to Art 8 ART

CVP CVP

Fem FEM

FemV SP

ICP 1 to ICP 8
(intracranial pressure)

ICP1 to ICP8

LAP LA

P1 to P8 SP

PA PA

RAP RA

RVP SP

UAC UAC

UVC UVC

The IP labels loaded from PDM are mapped according to this table:

From PDM to the monitor

ART Art 1 to Art 8: default

CVP CVP

FEM Fem

ICP1 to ICP8 ICP 1 to ICP 8

LA LAP

SP

FemV if the current site for this
channel is FemV

RVP if the current site for this channel is RVP
P1 to P8, depending on the channel

PA PA

RA RAP
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From PDM to the monitor

UAC UAC

UVC UVC

Starting monitoring
A case automatically starts/a patient is admitted when the monitor detects any of the
following vital signs: ECG, impedance respiration, Art, Fem, UAC, NIBP, SpO2, CO2, BIS,
or Entropy. Each vital sign has activation criteria that must be met before the vital
sign is considered active. When a case is started/a patient is admitted at the bedside
monitor and the monitor is connected to the network, patient data will display at
the central station.

A case manually starts/a patient is admitted when any patient data is entered
or loaded. Patient data can be entered locally using the monitor, loaded from an
Admit-Discharge-Transfer (ADT) server over the CARESCAPE Network, or entered
remotely using a central station.No trend data can be loaded from the CARESCAPE
Network.

Always observe the monitor and the patient carefully during start-up periods and
when inserting acquisition modules.

CAUTION Discharge to clear patient data. When admitting a new
patient/starting a new case, you must clear all previous
patient data from the system. To accomplish this, be sure
the acquisition module is securely mounted, disconnect the
patient cables, then discharge the previous patient/end the
case.

The following are generic instructions listing the basic steps for starting monitoring.
Parameter-specific instructions are more detailed and should always be followed as
well.

1. Connect the patient to the monitor according to the measurement setup
requirements. The alarms and parameter settings become active.

2. If the startup profile is not suitable, select another profile.

3. Enter patient demographics, or load/combine the data.

4. Start the measurement.

5. Zero invasive pressure lines.

6. If required, change the parameters on screen.

7. Check alarm limits and adjust if necessary.

Pre-monitoring checklist
Before you start monitoring a patient check the following:
● Acquisition modules are firmly in place.
● Accessories are intact and properly connected.
● Monitor is displaying the monitoring screen.
● No messages indicate the monitor or acquisition module is not functioning.
● Desired parameters are selected to view on the screen.
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● Alarm signals are working and can be seen and heard in your care environment.

● Required parameter calibrations are completed.

Performance check
After turning on the monitor, and during operation, the monitor runs automatic
self-tests. If a malfunction is detected, the monitor displays a message or an alarm,
depending on the severity of the malfunction.

Entering patient data

Entering patient data with the monitor
1. Select the patient information area on the screen, or select Data & Pages >

Admit/Discharge or Start / Reset Case.

2. Select the Patient tab.

3. Edit or enter patient data:

a. Select Edit Name & MRN, select the field to be edited and enter the data.

Entering the Second Id in addition to the Medical Record Number allows a
flexible use of local patient identification methods, like the use of BSN in the
Netherlands. The Second Id has no network support, so only the Medical
Record Number can be used for searching and retrieving patient data from
the network. Both Medical Record Number and Second Id will appear in the
printouts.

b. Select Edit All Demographics and select values for different types of data.

If 12SL ECG with ACI-TIPI or 12RLTM 12 lead ECG is licensed, also the Ethnicity
selection is available.

You can edit Height andWeight also from the lists on the Patient tab.

c. If the combination monitoring mode Monitor or Telemetry has been enabled
in the configuration, the ECG Source selection is available. You can select
the ECG Source from a list containing the monitor and available telemetry
transmitter(s). When you confirm the source selection with Confirm, the
connection between the selected transmitter and monitor will be established
(telemetry transmitter selected), or the patient is discharged from the telemetry
transmitter (monitor selected).

Entering patient data with a barcode reader
You can scan patient data from barcodes if this function has been enabled during
configuration. For more information, see the monitor’s service manual.

1. Select the patient information area on the screen, or select Data & Pages >
Admit/Discharge or Start / Reset Case.

2. Select the Patient tab.

3. Select Scan from Barcode.

Any information, including empty fields, scanned from the barcodes replaces the
corresponding information previously entered from the monitor.

108 CARESCAPE Monitors B850, B650, B450 2105822-001



Starting and ending monitoring

4. You can cancel the scanning by selecting Cancel Scan.

Loading patient information from the CARESCAPE
Network (ADT server)

In the CARESCAPE Network, patient information can be loaded from the ADT server.
You cannot merge data between the monitor and the ADT server.

1. Select the patient information area on the screen.

2. Select the Load Patient tab.

3. Select Find Patients.

4. Select the Medical Record Number and/or Last Name field and enter the
information you have available. If Visit Number Query Setting has been enabled
during configuration, you can also use the Visit Number for the search. This field
is not visible if the feature is not enabled.

You can also add the First Name information but the search does not function
with this information only.

5. Select Find.

6. When the patient list appears, select the patient.

7. Select Load Patient Information to load the data from the ADT server.

Entering administrative information
Administrative information can be transferred from the monitor to the PDM only.

1. Select the patient information area on screen.

2. Select the Administr. Information tab.

3. Select Edit.

4. Select the field to be edited and enter the data as required:

● Visit Number

● Primary Physician

● Referring Physician

About case reset/patient discharge
Resetting a case/discharging a patient deletes all patient information from an
attached PDM. If this is not desired, disconnect the PDM from the monitor before
resetting a case/discharging the patient.

The monitor may be configured with an automatic case reset/patient discharge
timer. If this is configured and vital signs are no longer detected, monitoring will end
automatically after the configured time has elapsed.

The patient can be discharged remotely using a central station provided that this
option has been enabled. This option is not available in OR and PACU software
packages. However, if there is a pending automatic software or settings update that
will take place after the patient discharge, remote discharge is not possible. The
discharge option will then be disabled at the central station.

2105822-001 CARESCAPE Monitors B850, B650, B450 109



Starting and ending monitoring

Pending software or setting activation
If there is a pending software or setting activation, it is indicated with the messages
Software activation after next discharge / Software activation after next case end,
or Setting activation after next discharge / Setting activation after next case end.
When you reset a case/discharge a patient, this activation will automatically take
place. Follow the instructional texts that appear on screen.

NOTE If the pending activation cannot be allowed to take place
and must be canceled for some reason, contact authorized
service personnel.

Residual physiological data
To ensure that no physiological data remains in the acquisition module or in the
bedside monitor after resetting a case/discharging the patient, do the following:

● PDM: Do not disconnect the acquisition module from the bedside monitor before
ending a case or discharging a patient. You must also disconnect all the patient
cables from the patient. The PDM can continue to measure patient data with
battery power even when the module is not connected to the patient monitor.

● Bedside monitor: Remove the acquisition modules from the monitor or disconnect
all the patient cables from the patient.

Resetting a case/discharging a patient
1. Disconnect patient cables.

2. Print necessary data and wait until the printing is completed.

3. Select the patient information field on the screen.

4. Select the Patient tab.

5. Select Reset Case or Discharge Patient.

Monitor settings, including alarm limits, return to their default settings. All patient data
and trend data is removed from both the monitor and a connected PDM.

Resetting a case/discharging a patient in combination
monitoring mode

NOTE Not available with the NICU software package.

1. Disconnect patient cables.

2. Print necessary data and wait until the printing is completed.

3. Select the patient information field.

4. Select the Patient tab.
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5. Select Reset Case or Discharge Patient and one of the following:

● No: No discharge actions take place.

● Telemetry: The patient is discharged from the telemetry transmitter but not
from the monitor.

● Monitor: The patient is discharged from the monitor but not from the telemetry
transmitter.

● Both: The patient is discharged from the monitor and the telemetry transmitter.

About continuing monitoring
Patient information and data is stored in the PDM. The Connecting Measurement
message appears on the monitor when the PDM is first connected. Vital sign
monitoring is not available during this initialization time. At the conclusion of the
initialization, the stored patient information and data can be transferred to the
monitor from the acquisition module. While patient information and data is being
transferred, the Loading from PDM message appears on the monitor. The type of
patient information and data that can be transferred includes the following:

● Patient demographic data

● Patient trends and alarm histories; alarm histories are converted to snapshots
during the transfer

● All zeroed invasive pressure site labels

● All invasive pressure transducer zero values for channels 1 to 4

● Latest values and timestamps for C.O., PCWP, and NIBP measurements

● NIBP cuff size

● NIBP auto cycle on/off information

● NIBP cycle time information if the NIBP auto cycle is on

The actions taken by the monitor and the menus that appear depend on whether the
monitor has an active patient case/admitted patient or not.

How to continue monitoring when a case is not
active/patient is discharged

When you connect a PDM that is actively measuring vital signs from ECG, invasive
pressures or SpO2, the patient information and data is automatically loaded from the
PDM to the monitor and a case is automatically started/patient is admitted.

When you connect a PDM that is not actively measuring vital signs from ECG, invasive
pressure or SpO2 but contains patient information, the Continuemenu appears. The
Continue menu has two informative fields on the top: the Patient in the monitor
and the Patient in the PDM. These fields show the text No patient identification
data available if there is no active case/admitted patient. Select one of the following
to continue monitoring:

● Load PDMData: This selection loads patient information and data from themodule.

● Erase PDM Data: This selection erases the patient information and data from
the module.
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How to continue monitoring when a case is active/patient
is admitted

When you connect a PDM that contains a Medical Record Number, MRN, that matches
the MRN entered on the monitor, the patient information and data is automatically
loaded from the PDM to the monitor and a case is automatically started/patient is
admitted.

When you connect a PDM that contains patient information but the MRN does not
match the MRN entered on the monitor, the Continuemenu appears.

NOTE When data is combined either automatically or manually, only
the data after the last module disconnection is loaded. To
load all trends, discharge the patient from the monitor and
make sure that the PDM is not connected to the monitor. Then
reconnect the module.

The Continuemenu has two informative fields on the top: the Patient in the monitor
and the Patient in the PDM. These fields show the MRN and Name of the Patient
information if there is an active case/admitted patient. Select one of the following
to continue monitoring:

● Load PDM Data: This selection erases the patient data from the monitor and loads
the data from the module.

● Continue Current: Monitoring will continue with the patient data from the monitor.
Invasive pressure labels of all zeroed channels are loaded from the module to
the monitor. All stored data is erased from the module and its settings are set to
their defaults as defined on the monitor

● Erase PDM Data: This selection erases the patient data from the module.

● Combine Data: This selection combines the patient data from the module with
that of the monitor even if the patient identification is different or it has not been
entered. Use this selection if no MRN has been entered or you know for certain that
you will continue monitoring the same patient. This selection may also be useful
if there has been a typing mistake or some other minor error when entering the
patient identification. Any information available in one device and not in the other
will overwrite the missing information. Be careful when using this selection. If you
are not absolutely certain that it is the same patient on the monitor and module, do
not combine the data.

● Discharge: This selection deletes the patient data from the module and from the
monitor.

If you connect a PDM module and there is no patient information or data in the
module or in the monitor, the monitoring does not start and the Continuemenu does
not appear.

When you select to erase data or discharge a patient in the Continue menu, the
patient’s vital signs cannot be observed during the erase/discharge cycle time.

If the Continue menu is open when a request for time adjustment is received, the
adjustment will be delayed until the menu is closed and data has been loaded.

If a PDM is connected to the monitor when the time is adjusted, the monitor sends the
new time to the module.
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About standby
When you remove the patient temporarily from the monitor, you can use the standby
option. Standby locations are defined during configuration through Monitor Setup
> Default Setup > Care Unit Settings > Standby Sites. These settings are password
protected.

For more information, see the supplemental information manual.

Starting standby
1. Select the patient information area on the screen.

2. Select the Standby tab.

3. Select the radio button for an appropriate standby location.

The factory default locations are the following but they can be changed during
configuration:
● Operating Room
● MRI
● CT Scan
● Physiotherapy
● Dialysis
● Radiology

4. Select Prepare for Standby.

If patient cables are still connected and the monitor receives vital signs, a text
indicating that audio alarms have been paused appears.

5. Remove the acquisition device or disconnect patient cables to start the standby.

If you do not disconnect the cables and vitals signs are still present after the audio
pause time expires, the standby is canceled.

6. Check that the NIBP Auto is turned off.

The screen goes blank and the GE logo with a text like Patient temporarily in MRI
(location according to your selection) appears.

End of standby
The monitor ends the standby automatically when any of the following conditions
occur:
● Vitals signs are still present after Prepare for Standby has been selected and the

audio pause time expires.
● Any vital signs are detected as active.
● User input is received: a keyboard key is pressed, Trim Knob is pressed or rotated,

primary mouse button is pressed, touchscreen is pressed.
● A PDM is connected.

About the combination monitoring mode
The combination monitoring is a licensed feature. In combination monitoring mode
ECG is acquired from a telemetry receiver system. This ECG data acquisition capability
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enhances basic telemetry monitoring by providing access to all of the available
parameters from bedside monitors, while acquiring the ECG data from telemetry. In
this monitoring mode, all data — local and telemetry — is viewed at the central station
and the bedside monitor. However, any historical data stored at the central station will
be unavailable. Any new alarm history samples created on the telemetry transmitter
cannot be viewed on the monitor if they are created after the combination monitoring
has been started. Only the snapshots created on the monitor and the samples of
the telemetry transmitter created prior to starting the combination monitoring can
be viewed.

During the combination mode the primary arrhythmia detection takes place at the
telemetry server and arrhythmias are reported to the monitor and central station.
The monitor performs a supplementary asystole detection unless the telemetry
server reports V Fib. Note that because of this supplementary asystole detection,
the alarm history may not always match that of the telemetry server. This may lead
to mismatching event history in network devices. If this supplementary asystole
detection is not desired, it can be disabled through Monitor Setup > Default Setup >
Care Unit Settings > Telemetry > Enhanced ASY detection.

The combination monitoring mode can be enabled through Monitor Setup > Default
Setup > Care Unit Settings > Telemetry > Monitor or Telemetry, and the setting is
password protected. The monitor needs to be configured to the CARESCAPE Network.
This option cannot be used in the NICU software package.

In case the telemetry patient has been admitted when the device is connected to the
monitor, the arrhythmia alarm priorities and limit alarm priorities (except in case the
monitor alarm is set to escalating) and the following ECG settings of the telemetry
will be used:

● HR, ST, and PVC alarm limits

● PVC alarm status (on/off)

● Pacemaker detection

● Lead analysis

● Va lead position

● Primary lead

● ECG waveform size

● Arrhythmia detection level

● ST analysis status (on/off)

When combination monitoring is started with a non-admitted telemetry patient, these
same settings from the monitor will be sent to telemetry. Additionally, the Telemetry
Waveforms printing location is sent to telemetry.

If the telemetry alarm priority is such that it is not supported by the monitor, it will be
mapped to the next higher priority available.

NOTE Patient’s age affects the alarm limits and alarm priorities
and also the configuration of the ECG algorithm including
arrhythmia alarms in the combination monitoring mode.
For more information, see the ApexPro Telemetry System
Operator’s Manual.

When combination monitoring is started with a non-admitted telemetry patient, the
printout type selection will be sent to the telemetry transmitter.
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CAUTION Users should be aware that all waveforms may be delayed
up to 2 seconds in the combination monitoring mode. If the
delay needs to be avoided, the combination monitoring mode
should be discontinued and all waveforms should be acquired
via the hard-wired bedside monitor.

CAUTION Users should be aware of a possible time discrepancy
between the waveforms from the telemetry device and the
waveforms from a device hard-wired to the monitor. Users
should not consider these waveforms to be synchronous. If
absolute synchronicity is desired, the combination monitoring
mode should be discontinued and the ECG waveforms should
be acquired via the hard-wired bedside monitor.

About the roving functionality
Roving functionality allows you to move, or rove, the monitor to fit the patient’s acuity
needs, rather than moving the patient to a monitored room. When you move the
monitor to a new location in the CARESCAPE Network, you can update the unit and/or
bed names from drop-down lists, or add new names manually. Available selections
depend on what has been allowed in configuration.

This functionality is also available in the combination monitoring mode for roving
between beds. In other words, you can move the monitor or a patient wearing a
telemetry transmitter from one location to another and update the information
accordingly.

These settings are configured through Monitor Setup > Default Setup > Care Unit
Settings > Roving and they are password protected.

Roving between units
If roving between units is allowed, you can update the unit name when moving the
monitor to a new location.

1. Select the patient information area on screen.

2. Select the Care Unit & Bed tab.

3. Select the Care Unit Name from the dropdown list.

Changing the Care Unit Name will also update the contents of the Bed Name list.

You can also change the name manually through New Unit & Bed. This selection is
available in the Care Unit & Bedmenu if it has been allowed in the Roving settings.

Entering the Location ID for 12SL
If roving between units is allowed and the 12SL ECG with ACI TIPI is enabled, you can
enter the Location ID that will be used in the 12SL reports.

1. Select the patient information area on screen.

2. Select the Care Unit & Bed tab.

3. Select the Location ID field and enter the ID with the on-screen numeric keypad.
You can enter any number from 0 to 599.

Roving between beds
If roving between beds is allowed, you can update the bed name when needed.
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1. Select the patient information area.

2. Select the Care Unit & Bed tab.

3. Select the Bed Name from the dropdown list.

The new name appears in the upper right corner of the display. The unit name is given
first, then a dash and the bed name (for instance, UNIT1–BED1).

You can also change the name manually through New Unit & Bed, or through New
Bed. These selections are available in the Care Unit & Bedmenu according to what
has been allowed in the Roving settings.

Adding new units and beds (manual roving)
If manual roving between beds and/or units is allowed, you can also enter their
names manually.

1. Select the patient information area.

2. Select the Care Unit & Bed tab.

3. Select New Unit & Bed.

If the Roving settings do not allow roving between units, the New Unit & Bed is
not available. In this case, select New Bed to enter a new bed name.

4. Select the Care Unit Name or the Bed Name field and type the new name with
the on-screen keyboard.

The maximum number of characters for the Care Unit Name is seven, and for
the Bed Name it is five.

5. Select Confirm to ensure that the names you entered are valid.
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Alarm warnings
WARNING When the alarms are off or while alarm audio is paused either

temporarily or indefinitely, observe the patient frequently.

WARNING MISSED ALARMS. Always make sure that the audio alarm
volume level is adequate in your care environment to avoid
missing alarms or not recognizing them due to too low a
volume. Audio levels that are less than ambient levels may
lead to unrecognized or missed alarms.

WARNING Always make sure that the alarm light brightness is adequate
in your care environment.

WARNING Always make sure that necessary alarm limits are active and
set according to the patient's clinical condition when you start
monitoring a patient.

WARNING Verify alarm processing is active and check the patient to
ensure no arrhythmias occurred during a power interruption.

WARNING Always check the alarm status after a prolonged power
interruption.

WARNING Alarms do not sound, alarm histories are not stored, alarm
graphs do not print, and alarms are not sent to the network
when the alarms are turned off.

WARNING Alarms do not sound and alarms are not sent to the
CARESCAPE Network during Audio Pause.

WARNING The audible alarm signal may be paused temporarily from a
central station or remote monitor.

WARNING To avoid missed detection of critical alarms, always inform
personnel dependent on the CARESCAPE monitor alarms of
remote alarm silencing or pausing interactions.

WARNING The peripheral device’s alarms must not be turned off or the
volume reduced in any way to diminish the importance of the
peripheral device as the primary alarm source for parameters
monitored by the peripheral device.
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WARNING There are no alarm indications until parameter-specific alarm
prerequisites have been met.

WARNING MISSED ALARMS. Do not use automatic view on alarm (AVOA)
as a replacement for a primary alarm source or as a central
station as this may lead to missed alarms.A maximum of four
beds can be displayed in the alarm area at one time, five
beds when no local alarms are present. To avoid missing
any alarms and to ensure alarm delivery between AVOA and
bed-to-bed monitors, configure the monitors to send and
receive alarms to and from each other.

WARNING Only the most recent, highest priority alarm is sent to remote
devices on the CARESCAPE Network. Therefore, less recent
alarms of equal or lower priority may not be displayed or may
not be indicated with their associated priority remotely.

WARNING Alarm messages may not be visible on the alarm display area
when three higher priority alarms are active.

WARNING Alarm messages may not be visible on the alarm display area
when one higher priority local alarm and four remote alarms
are active.

WARNING Latched alarms are not retained through a monitor reset if the
alarm condition has been removed.

WARNING The secondary alarm system shall not be relied upon for
receipt of alarm signals.

WARNING Equipment malfunctions, network disconnection, nurse call
disconnection (B850), and alarm volume settings may result
in missed alarms. Always keep the patient under close
surveillance.

WARNING MIXED ENVIRONMENT. A hazard can exist when the same
type of monitors in the same care area are using different
monitoring profiles and default configuration settings.

WARNING MISSED ALARM. Do not rely on receipt of certain alarm
conditions at a central station, remote bedside, or alarm
notification device when connected to the CARESCAPE
Network. Notification of any of these alarms will only be
given when it is the most recent, highest priority active alarm
coming from the bedside monitor. This applies to those limit
alarms and technical alarms that are defined as broadcast
only alarms in this manual.
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WARNING MISSING CRITICAL EVENTS. Reducing the physiological alarms’
priority levels lower than the default level can lead to missed
detection of critical events and therefore to adverse patient
outcome. Keep the patient under close surveillance if you
adjust the priority levels lower than the default value for the
following physiological alarms:
● V Tach, Tachy, Brady
● HR high/low, PR high/low
● ST (individual or group) high/low
● QT, QTc
● SpO2 low
● RR(Impedance) high/low, RR(CO2) high/low
● Apnea (Impedance), Apnea (CO2)
● NIBP high/low
● IP, CPP high/low
● Temperature high/low
● CO2 high/low
● FiAA high/low

WARNING MISSING CRITICAL EVENTS. NICU software package only:
Selecting the Off alarm priority for V Tach results in the system
no longer monitoring ventricular tachycardia from ECG. If you
select this option, keep the patient under close surveillance to
avoid missing any critical events.

WARNING PATIENT SAFETY. The default alarm priority for V Tach alarm
is high, but you may also select another priority level. If you
adjust the alarm priority level lower than the default value,
keep the patient under close surveillance. V Tach high alarm
priority escalation rules only apply when the alarm is active.

WARNING Reducing the technical alarms’ priority levels lower than the
default level can lead to missed detection of critical events
and therefore to adverse patient outcome. If you adjust the
priority levels for ECG lead off, ECG Leads off, Noisy ECG,
Arrhythmia paused, Telemetry battery low, or SpO2 probe off
alarms lower than the default value, keep the patient under
close surveillance.

WARNING If Alarm Setup > Audible & Visual > Pause All Audio for 5 min
or the 2 minute audio pause is selected before an alarm is
triggered, only the alarms for hypoxic gas mixture (FiO2 low,
EtO2 low, FiN2O high), and the alarm for dangerously high
airway pressure (Ppeak high: measured Ppeak exceeds the
set high alarm limit by 10 cmH2O) will break through. The
pause audio behavior is configured in the Care Unit Settings
and the setting is password protected.

WARNING When connecting PDM, the loaded IP labels may affect the
channel labeling of other already connected channels, and
consequently also the alarm limits.
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WARNING B850: Using other displays than the B850 system specific ones
may result in loss of visual alarms and patient monitoring.

WARNING Do not connect a monochrome display to the monitor. Visual
alarm indicators may not appear properly.

Alarm cautions
CAUTION Reducing the physiological alarms’ priority levels lower than

the default level can lead to missed detection of serious
events and therefore to adverse patient outcome. If you
adjust the priority levels for non-lethal arrhythmias, FiCO2
and/or EtCO2 alarms lower than the default value, keep the
patient under close surveillance.

Alarm overview

Alarm types
The monitor provides two types of alarm settings, system and patient-specific. System
alarm settings are set globally across an entire care environment. They are configured
at the time of installation and are password protected. Examples of configurable
system alarm settings are:

● Minimum alarm volume allowed

● Audio and alarm light off allowed

● Absolute limit setting

Patient-specific alarm settings are individualized, based on a patient’s current
condition. Examples of bedside alarm settings are:

● Parameter alarm limits

● Arrhythmia alarm priority settings

Alarm conditions
● Physiological alarm conditions are triggered by a patient measurement being

outside the parameter limits, by apnea, or by an arrhythmia condition.

● Technical alarm conditions are triggered by an electrical, mechanical, or other
failure of the equipment, or by failure of a sensor or component. Technical alarm
conditions may also be caused when an algorithm cannot classify or interpret the
available data. The visual manifestation of a technical alarm is active as long as
the reason for that alarm exists.

￭ Certain technical alarms can be deactivated with the pause audio key. The
Alarm Deactivation setting is configured in the Care Unit Settings and it is
password protected. For more information, see the supplemental information
manual.

Broadcast only alarms
Alarms are sent to the CARESCAPE Network and displayed on the central station or
remote monitor according to the following mapping. When the following alarms are
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broadcasted, the only indications on the CARESCAPE Network are the messages listed
below. All other alarms also broadcast the parameter alarms.

Feature Message on the bedside monitor Message sent to the CARESCAPE
Network and displayed on the central
station/remote monitor

ECG HR(ECG) high HR ECG HI xxx
(where xxx = realtime numerics)

ECG HR(ECG) low HR ECG LO xxx
(where xxx = realtime numerics)

ECG ST Ant high ST ANT HIGH

ECG ST Ant low ST ANT LOW

ECG ST Inf high ST INF HIGH

ECG ST Inf low ST INF LOW

ECG ST Lat high ST LAT HIGH

ECG ST Lat low ST LAT LOW

ECG QT high QT HIGH

ECG QTc high QTC HIGH

ECG Remove one ECG module REMOVE 1 ECG

ECG ECG measurements removed ECG REMOVED

ECG PDM module removed PDM REMOVED

ECG PSM/PRESTN module removed PSM REMOVED

NIBP NIBP measurement removed NIBP REMOVED

NIBP Check NIBP
NIBP over range
NIBP under range

CHECK NIBP

NIBP NIBP auto stopped
NIBP STAT stopped

NIBP STOPPED

SpO2 Identical SpO2 modules SPO2 IDENT

SpO2 SpO2 measurement removed SPO2 REMOVED

Spirometry PEEPtot high PEEPTOT HIGH

Spirometry PEEPtot low PEEPTOT LOW

Spirometry PEEPe high PEEPE HIGH

Spirometry PEEPe low PEEPE LOW

Spirometry PEEPi high PEEPI HIGH

Spirometry PEEPi low PEEPI LOW

Spirometry MVexp high MVEXP HIGH

IP No Px transducer NO PX TRANSD

IP Pressure measurement removed IP REMOVED

IP Identical IP1 modules IDENTICAL IP
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Feature Message on the bedside monitor Message sent to the CARESCAPE
Network and displayed on the central
station/remote monitor

C.O. CO measurement removed CO REMOVED

C.O. Identical C.O. modules IDENTICAL CO

Temperature Tblood-T1 high TBL-T1 HIGH

Temperature Tblood-T3 high TBL-T3 HIGH

Temperature Identical temperature modules TEMP MOD ERR

Temperature Temp measurement removed TEMP REMOVED

SvO2 SvO2 cable off SVO2 CABL OFF

SvO2 SvO2 measurement removed SVO2 REMOVED

Gases Gas measurements removed GAS REMOVED

Gases Identical gas modules MODULE ERROR

Entropy Entropy RE high RE HIGH

Entropy Entropy RE low RE LOW

Entropy Entropy SE high SE HIGH

Entropy Entropy SE low SE LOW

Entropy Identical Entropy modules ENTROPY IDENT

Monitor battery Monitor battery empty! BATTERY EMPTY

Monitor battery Monitor powering down! POWERING DOWN

Service Service Monitor - and specific error
code

SERVICE HOST

Service Power management failure POWER FAILURE

Service Service the PDM and specific error code SERVICE PDM

Service Speaker failure SPEAKER FAIL

Service Module voltage low MODULE V LOW

Service Service gas module - and specific error
code

SERVICE SGAS

Broadcasted limit alarms
Only the following limit alarms are broadcasted with realtime parameter numerics.

Feature Alarm message on the monitor Broadcasted message

ECG, IP, SpO2 HR high HR HIGH xxx

ECG Tachy TACHY xxx

ECG, IP, SpO2 HR low HR LOW xxx

ECG Brady BRADY xxx

ECG HR(ECG) high HR ECG HI xxx

ECG HR(ECG) low HR ECG LO xxx
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Feature Alarm message on the monitor Broadcasted message

Impedance
respiration

Resp high
Resp low

RR IMP HI xxx
RR IMP LO xxx

SpO2 SpO2 high, SpO2 low
SpO2(2) high, SpO2(2) low

SPO2 HIGH xxx, SPO2 LOW xxx

Arrhythmia alarm mapping
Certain arrhythmias are only annunciated locally. Since the CARESCAPE Network
and CARESCAPE Central Station are unfamiliar with some of these new arrhythmias,
they are mapped to corresponding known arrhythmias in the Event directory of the
CARESCAPE Central Station. Consult the following table for more details:

Measurement on
the monitor

Alarm message on
the monitor

Alarm message on
the central station
ADU

Event directory on
the central station

Alarm level control
on the central
station

HR high/low HR/PR high
(telemetry) or
Tachy/PR high
(PDM, PSM)
HR/PR low
(telemetry) or
Brady/PR low (PDM,
PSM)

TACHY/BRADY Tachy/Brady Parameter: HR
high/low

PVC count Frequent PVCs Frequent PVCs PVC Parameter: PVC

Multifocal PVCs Multifocal PVCs Multifocal PVCs PVC Arrhythmia: PVC

Missing beat Missing beat Missing beat PAUSE N/A

Pause Pause Pause PAUSE Arrhythmia: PAUSE

SVC count Frequent SVCs Frequent SVCs IRREGULAR N/A

SV tachy SV Tachy SV Tachy TACHY Arrhythmia: TACHY

Checking alarm function
1. Set a parameter alarm limit outside of the current measured patient values.

For example, connect the SpO2 sensor and adjust the SpO2 high limit under the
measured SpO2 values.

2. Confirm that the following alarm notification events occur:

● The audible alarm sounds the correct tone.

● The alarm light illuminates.

● The SpO2 numeric value flashes in the parameter window with the correct color.

● An alarm printout (if enabled).

3. Audio pause the alarms and confirm that the alarms are paused and that the left
side of the alarm indicator light is a solid blue color.

4. Return the parameter alarm limit to the original value.
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Visual alarm indications

Alarm icons on the screen

Alarm priority indicator. High (red). Indicates a high priority alarm.

Alarm priority indicator. Medium (yellow). Indicates a medium priority alarm.

Alarm priority indicator. Low (cyan). Indicates a low priority alarm.

Alarm off indicator.
The symbol may not display at the central station or on a remote bedside
monitor.

Alarm volume indicator. Adjust the minimum alarm tone volume.

Audio alarms off indicator.

Audio alarms paused indicator with countdown timer. Indicates all audio
alarms are paused and the amount of time remaining for the alarm pause
period as a countdown timer.

Pause audio alarms. Selectable from the monitor’s main menu. Also an
indicator of a temporarily paused active audio alarm.

Low priority audio off alarm indicator.

General warning sign. Displays when the priority setting deviates from the
recommendation of international alarm safety standards.

Description of alarm and information messages
Alarm and information messages can be displayed in three areas:

● The parameter window

● The waveform field

● Alarm area (upper part of the screen)

In the alarm area, up to five alarm or information messages may be displayed from
left to right, from the newest highest priority alarm to the oldest lowest priority alarm.
Up to four newest highest priority remote alarm messages display first, followed by
the newest highest priority local alarm messages.
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Alarm and information messages are stored in the clinical logs. Access to the
clinical logs is a service-level function and it is password protected. The alarm and
information messages stored in the clinical logs include:

● Time of occurrence

● Alarm or information message text

● Current value and the associated alarm limit if a limit alarm (local only)

Visual alarm signals and priority levels
Alarm signals indicate that an alarm condition is present. The alarm priority levels are
also indicated. The alarm signals assume that the patient monitor and the operator
are within the patient environment (1 meter / 3.3 feet).

The following table lists visual alarm signals for different alarm priority levels:

Priority level
Visual signals

High Medium Low Informational

Parameter window
physiological data values

Black text flashes
inside a red box.

Black text flashes
inside a yellow box.

Black text inside
a cyan (blue) box.

Not applicable.

Alarm area White text inside a
red box.

Black text inside a
yellow box.

White text inside
a cyan (blue) box.

Black text inside
a gray box.

Waveform field
messages

Text Text Text Text

Alarm light indicator1 Flashes red Flashes yellow Solid blue No effect

1When the audible alarms are turned off or are paused, the alarm audio pause/off area of the alarm light is
a solid blue color.

Setting the alarm light brightness
1. Select Alarm Setup from the monitor’s main menu.

2. Select the Audible & Visual tab.

3. Select an Alarm Light % value.

The greater the value, the brighter the light.

Audible alarm indications

Audible alarm signals
When more than one alarm occurs at the same time, the monitor will sound an
alarm tone for the highest priority alarm. Any lower priority audible alarm tones are
suppressed by the higher priority alarm tone.

The most recent of the alarms that has the highest priority level at this moment is the
alarm that is broadcast on the network. For example, if there is one medium-priority
alarm and a low-priority alarm appears, the medium-priority alarm is broadcast, not
the most recent (low-priority) alarm. If there is one medium-priority alarm and another
medium-priority alarm appears, the latest alarm that appeared is broadcast.
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Alarm tones
The alarm tones may be configured to sound in one of two different tone patterns:
Legacy or IEC. IEC tones are 60601-1-8 compliant. Legacy alarm tones match the
tones used on some previous GE monitoring devices.

For more information, see the supplemental information manual.

AVOA alarm tones may differ from the local monitor alarm tones. Both the highest
priority local alarm tone and the highest AVOA alarm tone will sound, but in a
sequence containing one local alarm tone pattern and one AVOA alarm tone pattern.
If the same tones have been selected for AVOA and local alarms, then only the highest
priority tone will sound.

Adjusting the alarm volume
The selections in the Alarms Setupmenu vary according to what has been configured
in the Care Unit Settings > Alarms (password protected).

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Audible & Visual tab.

3. Adjust the volume according to what is available in the menu:

● Adjust the Alarm Volume value. This is the volume for all alarms.

● Adjust the Alarm Volume for: separately for High & Medium Priority and Low
Priority.

The lower the number, the quieter the alarm volume. Note that the minimum allowed
alarm volume levels are set in the Care Unit Settings.

Audible alarm signals and priority levels
Alarm signals indicate that an alarm condition is present. The alarm priority levels are
also indicated. The alarm signals assume that the patient monitor and the operator
are within the patient environment (1 meter / 3.3 feet).

The following table lists alarm signals for different alarm priority levels:

Priority level
Audible signals

High Medium Low Informational

Audible tone pattern1 (IEC
60601-1-8)

Repeats a pattern of
5-beep tones played
two times

Repeats pattern of
3-beep tones

1-beep tone once
or repeatedly
at 25 ±0.5
second interval
(user-selectable)

None

Audible tone pattern
(legacy)

Repeats pattern of
3-beep tones (crisis)

Repeats pattern
of 2-beep tones
(warning)

1-beep tone
(advisory) once
or repeatedly
at 5.5 ±0.5
second interval
(user-selectable)

None

Automatic view on alarm
audible tone pattern

User configurable2 User configurable2 User configurable2 None
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Priority level
Audible signals

High Medium Low Informational
1 The IEC audible tone pattern is the factory default setting.
2The AVOA audible alarm tone pattern may be configured to match the local monitor’s audible tone pattern, repeat a
pattern of two beep tones, beep twice upon activation by an alarm condition, or be turned off. For configuring the AVOA
audible alarm tone pattern, see the supplemental information provided.

Auditory information signals
The monitor performs a self-diagnostic procedure at start-up and generates an
auditory test signal. There are also other auditory information signals indicating the
status of some parameter measurements.

For more information, see the supplemental information manual.

Parameter alarms

Alarm locks
Alarm locks prevent parameter alarm limits from being turned off. When an alarm
is locked, a lock icon appears next to the Alarm On/Alarm Off setting. Parameter
alarm locks are set through Default Setup > Locking Settings and they are password
protected.

For more information, see the supplemental information manual.

Absolute alarm limits
Absolute alarm limits prevent parameter alarm limits from being adjusted above (high)
or below (low) these values. When an alarm has an absolute limit, there is a gray
limit indicator in the alarm adjustment dialog. Absolute alarm limits are set through
Default Setup > Profile Settings and they are password protected.

For more information, see the supplemental information manual.

Setting parameter alarm limits
Parameter alarm limits may be set in the Alarms Setupmenu, or in the parameter
menus’ own Alarms tab. Alarm limits should not be set beyond reasonable
physiological boundaries in order to maintain patient safety. Setting outside of
reasonable boundaries would cause the alarms to be ineffective.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Alarm Limits tab.

3. Select a parameter label.

If you are unable to find a specific parameter, select the right arrow to display
additional labels. If the parameter limit has been turned off, the alarm limit will
be greyed out.

Selecting a parameter label takes you to that parameter menu’s Alarms tab
where you can select alarms on or off, and set their limits.
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About critical alarms
You can configure two different levels of alarms for HR and SpO2/SpO2(2) alarms: basic
and critical. This enables an alarm to start with the basic alarm level and priority
indication, and then change to high alarm indication once the selected critical alarm
level is reached. The critical alarm is always indicated as high, but you can select the
priority for the basic alarm. Always check that you are configuring the right alarm.

Basic and critical alarm settings are available as follows:

● ECG: basic alarm HR Tachy/Brady, critical alarm HR Critical Tachy/Brady

● SpO2, SpO2(2): basic alarm SpO2, critical alarm SpO2 Critical

You must always set the critical alarm level limits so that they are outside the basic
alarm limits. If you try to set them inside the basic alarm limits, the basic alarm limits
will also change at the same time.

Setting alarm limits automatically
When selected, the Auto Limits feature automatically sets new high limit and low limit
values, based upon the current physiological value. The Auto Limits should only be
used for patients whose currently measured values are considered safe.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Alarm Limits tab.

3. Select Auto Limits.

If you need to undo these changes and return to the previous alarm limit settings,
select Undo Settings before closing the menu.

Default auto alarm limits
Parameter High limit Low limit

NIBP S/D/M: NIBP*1.25+10 S/D/M: NIBP*0.75-10

All HR/PR parameters
(ECG, SpO2, UAC, Art,
Fem)

All HR*1.25 of the current HR value
(averaged over last 10 s)

All HR*0.75 of the current HR value
(averaged over last 10 s)

Critical HR All HR*1.4375 of the current HR value
(averaged over last 10 s)

All HR*0.5625 of the current HR value
(averaged over last 10 s)

ST group Greatest value in group: +1 if group is
enabled, otherwise limit is +2

Smallest value in group: -1 if group
enabled, otherwise limit is -2

ST individual ST+1 if enabled, otherwise limit is +2 ST-1 if enabled, otherwise limit is -2

PVC PVC+10 Not applicable

EtCO2 EtCO2 +5% EtCO2 -5%

SpO2 SpO2 +5% SpO2 -5%

Art, Fem, P1 Sys/Dia/Mean:
Value*1.25+10mmHg
Value*1.25+1.3kPa

Sys/Dia/Mean:
Value*0.75-10mmHg
Value*0.75-1.3kPa

FemV, CVP, PA, RAP,
RVP, LAP, ICP, CPP,
P2-8

Sys/Dia/Mean:
Value*1.25+5mmHg
Value*1.25+0.67kPa

Sys/Dia/Mean:
Value*0.75-5mmHg
Value*0.75-0.67kPa
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Parameter High limit Low limit

UAC/UVC Sys/Dia/Mean:
Value*1.25+5mmHg
Value*1.25+0.67kPa

Sys/Dia/Mean:
Value*0.75-5mmHg
Value*0.75-0.67kPa

Critical SpO2 SpO2 + 15% SpO2 –15%

SvO2 SvO2 +5% SvO2 -5%

Temperature, TBlood Tx+1°C
Tx+1.8°F

Tx-1°C
Tx-1.8°F

Tx-Ty (e.g., T2-T1) Tx-Ty+1°C
Tx-Ty+1.8°F

Tx-Ty-1°C
Tx-Ty-1.8°F

Ppeak Ppeak+10 cmH2O Ppeak-10cmH2O

PEEPtot PEEPtot+5cmH2O PEEPtot-5cmH2O

PEEPe PEEPe+5cmH2O PEEPe-5cmH2O

MVexp MVexp+2 MVexp-2

RR RR*1.25+2 RR*0.75-2

Returning the default alarm limits
1. Select Alarm Setup from the monitor’s main menu.

2. Select the Alarm Limits tab.

3. Select Default Limits.

If you need to undo these changes, select Undo Settings before closing the menu.

Configurable alarm delays
You can configure alarm delays for the following alarms: PR (SpO2/IP) high/low, SpO2
high, SpO2 low, RR (Imped) high, RR (Imped) low. These delays are set through Default
Setup > Profile Settings > Alarm Delays and they are password protected.

For more information, see the supplemental information manual.

Alarm priorities and escalation

Alarm priority levels
Physiological and technical alarms are categorized by priority level:

● High priority alarms require an immediate response.

● Medium priority alarms require a prompt response.

● Low priority alarms require you to be aware of this condition.

● Informational priority messages provide information you should know.

NOTE Informational messages are not sent to the network, and
they are never latched.
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Alarm priority escalation
An escalating alarm starts at a designated priority level (low or medium) and will
escalate to the next higher priority level of alarm (after a set number of seconds) if the
alarm condition has not been resolved. It is important to note that these escalate up
to the next level but will not reset until the condition has been resolved.

NOTE Alarm priority escalation affects the currently ongoing alarm
condition, not any future alarms of the same type. Any new
alarms will alarm at their designated priority level, not at the
escalated level.

For more information, see the supplemental information manual.

Selecting parameter alarm priority levels
Escalating an alarm priority increases the priority of the alarm condition or increases
the sense of urgency of an alarm signal. The alarm priority is based on clinical
considerations.

The allowed priorities for different alarm groups are defined in the Care Unit Settings
and they are password protected.

For more information, see the supplemental information manual.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Alarm Priorities tab.

3. Select the alarm group: ECG, Invasive Pressures, or Other Parameters.

4. Select the alarm and its priority from the list.

Selectable alarms are:

ECG Invasive pressures Other parameters

HR/PR high (telemetry) or
Tachy/PR high (PSM, PDM)

Art high/low SpO2 high

HR/PR low (telemetry) or
Brady/PR low (PSM, PDM)

Fem high/low SpO2 low

ST Segment high/low CVP high/low SpO2 probe off

Frequent PVCs FemV high/low NIBP high/low

Frequent SVCs PA high/low CO2 high/low

QT/QTc RAP high/low FiAA high/low

ECG lead off RVP high/low Apnea (CO2)

ECG leads off LAP high/low Apnea (Impedance)

Noisy ECG ICP high/low RR (CO2) high/low

Arrhythmia paused CPP high/low RR (Impedance) high/low

Change telemetry battery P1 high/low to P8 high/low TcCO2 high/low

V Tach TcO2 high/low
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ECG Invasive pressures Other parameters

Temp high/low

CCO high/low

CCI high/low

Ventilator disconnected

You can select alarm priorities for V Tach through Alarm Setup > Arrhythmia > Lethal.
Although the low and medium priority settings are allowed for V Tach, the alarm will
always be high priority if the V Tach duration is more than 30 seconds, the HR is higher
than the set HR high limit, and the HR exceeds 150 beats/min. In the NICU software
package the high priority is enforced at 180 beats/min.

According to what has been allowed in the Care Unit Settings, the selectable priorities
are:

● Escalating, High, Medium, Low, Informational, or

● Escalating, High, Medium, Low, or

● Escalating, High, Medium, or

● Escalating, High, or

● Escalating, Informational, or

● Low, Informational, or

● High, Medium, or

● High, Medium, Low, Informational.

The possible selections in the Care Unit Settings vary per parameter, so not all
priorities are available for all of the alarms. The general warning sign displays when
the selected alarm priority setting deviates from the recommendation of international
safety standards.

Setting arrhythmia alarms
You can set the arrhythmia alarms in the Alarms Setupmenu, or in the ECGmenu.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Arrhythmia tab.

3. Select Lethal Alarms.

You can now select the Alarm Priority, Create Snapshot, and Print on Alarm
options per arrhythmia. In addition, you can select V Tach Criteria > Minimum
HR/min, Event Duration, and whether both of these criteria (AND) , or only one of
them (OR), is applied. Note that V Tach Criteria is not configurable in combination
monitoring of patients younger than 14 years.
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4. If Full Arrhythmia license is enabled, you can also select options for the Atrial
Alarms and Ventricular Alarms.

● Ventricular Alarms: You can select the Alarm Priority, Create Snapshot, and
Print on Alarm options.

● Atrial Alarms: You can select the Alarm Priority, Create Snapshot, and Print
on Alarm options. In addition, you can set the detection criteria for SV Tachy:
SVT Length, HR for SVT /min, and Pause Interval.

Pausing and silencing alarms

Audible alarms off behavior
Depending on the Audio Alarm default settings configured during installation, you
can turn on or turn off audible alarms.

For more information, see the supplemental information manual.

When audible alarms are turned off:

● All audible alarms are turned off except for any high priority alarms configured
to break through the audio off setting.

● The audio off bell icon displays in the upper left corner of the display screen.

● The alarm audio pause/off area of the alarm light is solid blue when audible alarms
are paused or when audio off is selected for an alarm group.

Turning audible alarms on/off
You can turn on/off the audible physiological alarm tones for an alarm group or for
all alarms.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Audible & Visual tab.

3. Select an alarm group. Choices are:

● None: No audible alarms are turned off.

● Apnea Audio Off: Turns off audible alarms for apnea, EtCO2, FiCO2, respiration
rate, Ppeak low, PEEPe, PEEPtot, PEEPi, and MVexp limit alarms.

● ECG Audio Off: Turns off audible alarms for all HR and PR source limit and
arrhythmia alarms.

● Apnea & ECG Audio Off: Turns off audio alarms for all HR and PR source limit,
arrhythmia, apnea, EtCO2, FiCO2, respiration rate, Ppeak low, PEEPe, PEEPtot,
PEEPi, and MVexp limit alarms.

● All Alarms Audio Off: Turns off all audible alarms except some high priority
alarms defined as breakthrough alarms.

4. To turn on all audible alarms again, select Activate All Audible Alarms, or select
None as instructed above.

NOTE If alarms are turned off for any of the defined alarm groups
and an alarm occurs within the alarm group, a beep tone will
sound every 2 minutes as a reminder that alarms are turned
off.
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NOTE France only: A reminder beep tone sounds every 2 minutes
when the Audible & Visual > None setting is not selected.

Pause audio behaviors
Selecting the pause audio key results in different alarm behaviors depending on
whether the alarms are active and/or latched or not. Acknowledging or pausing audio
alarms does not affect other alarm indicators. They will still continue indicating alarms.

When the monitor is on the network, alarms can also be paused and acknowledged at
the central station.

Active and/or latched alarms

Selection Result

Select once ● Pauses all active audio alarms for 2 minutes.

● Removes all latched alarms.

● Deactivates some technical alarms.

Second selection of during
the 2 minute pause

● Starts a 2 or 5 minute audio pause period for all alarms except the
specified breakthrough alarms. The 2 or 5 minute duration is a care unit
setting and password protected.

● Removes all new latched alarms.
Some technical alarms may also be deactivated with this selection.

Select once during audio
pause

● Ends the audio pause period.

● Restores all acknowledged and silenced alarms if the alarm condition
still exists.

No active or latched alarms

Selection Result

Select once ● Starts a 2 or 5 minute audio pause period for all alarms except the
specified breakthrough alarms.

Select once during audio
pause

● Ends the audio pause period.

● Restores all acknowledged and silenced alarms if the alarm condition
still exists.

Pausing alarms for 5 minutes
You can pause audible alarms with the pause audio key for 2 or 5 minutes according
to the care unit settings. You can also pause all alarms for 5 minutes through the
Alarms Setup menu.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Audible & Visual tab.

3. Select Pause All Audio for 5 min. This will pause all alarms, including the
breakthrough alarms, except FiO2 low, EtO2 low<18%, FiN2O low>82%, and
Ppeak high. It also removes latched alarms.
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Activating all audible alarms
If necessary, you can activate all paused audible alarms before the 2 or 5 minute
pause expires.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Audible & Visual tab.

3. Select Activate All Audible Alarms.

Technical alarms’ deactivation with the pause audio key
Certain technical alarms can be deactivated with the pause audio key. The Alarm
Deactivation setting is configured in the Care Unit Settings and it is password
protected.

For more information, see the supplemental information manual.

Technical alarms for which the deactivation with the pause audio key can be allowed
are:

● ECG Leads Off

● Art disconnect

● Fem disconnect

● UAC disconnect

● SpO2 Probe Off

Apnea alarms’ deactivation with the pause audio key
Apnea alarms can be deactivated with the pause audio key if the Allow alarm
deactivation with the Audio Pause key for: setting Apnea (CO2/Imped) is enabled in
the Care Unit Settings. This setting is password protected.

NOTE The following parameters are not trended while apnea alarm
is deactivated: EtCO2, FiCO2, EtO2, FiO2, EtN2O, FiN2O, EtAA,
FiAA, MAC, MACage, EtBal, and ambient pressure.

For more information, see the supplemental information manual.

Pause audio with combination monitoring
When using combination monitoring, the pause audio behavior is the following:

● If the telemetry transmitter is in pause audio state, also the monitor will be in the
same state. You can cancel the pause audio at the bedside monitor by selecting
the pause audio key. This will not affect the telemetry device.

● If the monitor’s own pause audio state ends before the telemetry transmitter’s
audio pause, the monitor will re-enter pause audio.

● The pause audio started by the telemetry transmitter will end also at the monitor
when the transmitter’s pause audio ends.

Breakthrough alarms
The breakthrough alarms feature allows pre-defined and user-selectable alarms to
“break through” (interrupt) an All Alarms Audio Off or a 2 or 5 minute audible alarm
pause condition.
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The FiO2 low, EtO2 low, FiN2O high, and Ppeak high alarms will always break through
when escalated to or activated at high priority alarm condition regardless of the All
Alarms Audio Off selection or any alarm pausing.

The following alarms will break through when activated at high priority alarm
condition regardless of the 2 to 5 minute audible alarm pause: Asystole, V Fib/V Tach,
V Tach, Brady (in the NICU software package only), Critical SpO2 high/low, Critical
SpO2(2) high/low, and Critical HR high/low.

WARNING If Alarm Setup > Audible & Visual > Pause All Audio for 5 min
or the 2 minute audio pause is selected before an alarm is
triggered, only the alarms for hypoxic gas mixture (FiO2 low,
EtO2 low, FiN2O high), and the alarm for dangerously high
airway pressure (Ppeak high: measured Ppeak exceeds the
set high alarm limit by 10 cmH2O) will break through. The
pause audio behavior is configured in the Care Unit Settings
and the setting is password protected.

Latched alarms
When alarms are latched, the audible alarm and visual message remains after the
alarm condition no longer exists. The audible alarm can be paused with the pause
audio key, and this also clears the alarm message from the screen. Alarms can be
configured to latch for high priority alarms only, all alarm priorities, or none. The
Latching Alarms setting is configured in the Care Unit Settings and it is password
protected.

For more information, see the supplemental information manual.

Turning off all local alarm indicators (sleepmode)
NOTE This feature is not available with OR and PACU software

packages.
If the feature has been enabled in the Care Unit Settings (password protected), you
can turn off the monitor’s display and turn off all audible, visual, and alarm light alarm
indicators until you turn them back on again. Patient monitoring is occurring; however,
the monitor is not displaying patient data or indicating patient alarms locally. Local
printing is also inactive. Alarms are logged and trended. If the monitor is connected to
the network, alarms and alarm printouts, and parameter data will continue to be sent
over the network during sleep mode. For more information on enabling or disabling
the Audio & Display > Off Allowed feature, see the supplemental information manual.

1. Select Alarm Setup from the monitor’s main menu.

2. Select the Pause Monitoring tab.

3. Select Audio & Display > Off.

A screen saver with GE logo and the text Audio&Display off replaces the display
of patient data. This reminder changes its position on screen once a minute. Any
user input (touchscreen, button, Trim Knob, keyboard key, mouse click) reactivates
the alarms and the monitoring screen.

Remote management of alarms
The remote alarm settings are defined in the Care Unit Settings and they are
password protected. The following settings are available:
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● Allowing remote audio pause from this monitor for a remote bed.

● Allowing audio pause for this monitor from a central station or remote monitor. Not
available with the OR software package.

● Allowing remote pausing of different alarm priorities.

● Showing the remote patient name.

● Turning the remote monitor’s alarm light on or off.

● Selecting the remote alarm notification tone.

For more information, see the supplemental information manual.

Alarm settings after a power loss
If the monitor loses power, the amount of time without power affects whether or
not you need to reset the alarm settings.

Power loss
duration

Alarm setting status after a power loss

Up to 15 minutes The alarm settings that are in effect before the power loss are restored
automatically.

Greater than 15
minutes

The alarm settings revert back to the user default settings (start-up
mode). You must reconfigure any patient-specific alarm settings.

Alarm data stored in Clinical logs
Access to the Clinical logs is a service-level function and it is password protected.

The monitor stores a record of patient-related local and remote alarms and
information messages as well as any adjustments to the alarm limits in the Clinical
logs.

Stored alarm data during a power cycle or power
loss

If the monitor goes through a power cycle or a loss of power, the stored alarm data
is not affected. The alarm data remains stored in the Clinical log until the monitor
automatically clears the oldest stored data to allow new data to be stored.
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ECG compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

ECG safety precautions

ECG warnings
WARNING Make sure that the leadwire set clips or snaps do not touch

any electrically conductive material including earth.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.

WARNING This device is intended to record electrocardiograms from
surface ECG electrodes. It is not meant for positioning
(floating) temporary pacemaker leadwires, performing
pericardiocentesis, or other internal applications.

WARNING The Maximum filter may alter the displayed ECG morphology.
Do not makemeasurements from the displayed or printed ECG
when this filter is selected. Displayed ST values are calculated
before applying the Maximum filtering and may differ from
values measured from the displayed or printed ECG.

WARNING This device uses a computerized 12 lead ECG analysis
program, which can be used as a tool in generating ECG
records that provide ECG measurements and interpretative
statements from the ECG recordings. The interpretive
statements are only significant when used in conjunction
with clinical findings. All ECG records should be overread by
a qualified physician. To ensure accuracy, use only the ECG
records for physician interpretation.
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WARNING To assure accurate 12 lead analysis when using a 10-leadwire
patient cable, youmust verify that the correct leadwire block is
plugged into the appropriate side of the cable. The V2 through
V6 leadwire block is color-coded brown (AHA) or white (IEC).

WARNING When transitioning from a 10-lead cable to a 5-lead cable,
select the Update Lead Set option to clear the Lead off
message from the display.

WARNING Disconnected electrodes or loose electrode connections can
lead to missed critical severity ECG alarms. If the monitor
reports Leads off after selecting Update Lead Set option,
always check the electrode connections to the patient.

WARNING CONDUCTIVE CONNECTIONS. Extreme care must be exercised
when applying medical electrical equipment. Many parts
of the human/machine circuit are conductive, such as
the patient, connectors, electrodes, transducers. It is
very important that these conductive parts do not come
into contact with other grounded, conductive parts when
connected to the isolated patient input of the device. Such
contact would bridge the patient’s isolation and cancel the
protection provided by the isolated input.

WARNING DELAYED ASYSTOLE ALARM. The pulsatile heart rate may have
a slower response time than the electrical heart rate where
there is a low perfusion patient condition. When using the
IntelliRate feature in this situation, the monitor may delay
calling an ASYSTOLE patient alarm. The user may elect to turn
the IntelliRate feature off for patients at risk of these events,
otherwise patient treatment may be delayed. Such patients
should always be kept under close observation.

WARNING NOISY ECG alarm. The Noisy ECG alarm indicates that the
system is no longer monitoring ECG and there may be no HR
high, HR low, Tachy or Brady alarms. If you adjust the alarm
priority level lower than the default value, keep the patient
under close surveillance.

WARNING PATIENT SAFETY. The default alarm priority for V Tach alarm
is high, but you may also select another priority level. If you
adjust the alarm priority level lower than the default value,
keep the patient under close surveillance. V Tach high alarm
priority escalation rules only apply when the alarm is active.

WARNING INACCURATE HEART RATE INDICATION, PDM.The electrical and
pulsatile heart rate values provided by the various monitored
parameters (ECG, SpO2, blood pressures) may differ markedly.
These differences may be due to underlying physiologic
conditions (e.g., electromechanical dissociation, pulseless
electrical activity, non-perfusing rhythms) or to inaccuracies in
the heart rate values caused by artifact, poor signal quality, or
arrhythmias. The user may elect to turn the IntelliRate feature
off for patients at risk of these events, otherwise patient
treatment may be delayed. Such patients should always be
kept under close observation.
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WARNING ELECTRODES. Whenever patient defibrillation is a possibility,
use non-polarizing (silver/silver chloride construction)
electrodes for ECG monitoring. Polarizing electrodes (stainless
steel or silver constructed) may cause the electrodes to retain
a residual charge after defibrillation. A residual charge will
block acquisition of the ECG signal.

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires.

WARNING HEART RATE ALARM INTERFERENCE. Poor cable positioning
or improper electrode preparation may cause line isolation
monitor transients to resemble actual cardiac waveforms and
thus inhibit heart rate alarms. To minimize this problem, follow
proper electrode placement and cable positioning guidelines
provided with this product.

ECG cautions
CAUTION The patient's skin may become irritated after prolonged

contact with electrode gel or adhesive.

ECG measurement limitations
● E-modules used for this measurement are not suitable for use with neonatal

patients.
● The monitor will display a Leads off message in an input overload condition, or

upon disconnection of electrode leadwires.

ECG points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.
● For information on materials used in accessories and their biocompatibility, refer

to the instructions for use in the accessory package.
● Pre-gelled ECG electrodes are recommended. Check the expiration date.
● Make sure the electrode gel is moist.
● Make sure the electrodes have good skin contact.
● Replace all electrodes at least every 24 to 48 hours.
● Use the Multi-Link electrosurgical unit (ESU) ECG patient cable when using the

monitor in the presence of an electrosurgical unit. This cable, with a built-in ESU
filter, helps reduce electrosurgical noise detected on the ECG signal.

● E-modules: Whenever a cable, electrode or V-lead is changed, the monitor
automatically relearns.

● Depending on the ECG module used, not all ECG measurements and settings are
available to view or change.

● Select the Deactivate ECG Leads Off option to remove a Leads offmessage from
the display when a cable is off.
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ECG measurement setup

ECG equipment to patient connection

1. Module with ECG measurement capability

2. AAMI/AHA or IEC Multi-Link 3/5-lead, 6-lead, or 12-lead ECG cable

3. AAMI/AHA or IEC 3-leadwire, 5-leadwire, or 6-leadwire set

4. AAMI/AHA or IEC precordial leads leadwire set

NOTE For measuring ECG with telemetry system, connect the
leadwire set to the telemetry transmitter.

Preparing the patient’s electrode sites
Excessive body hair or skin oil reduces electrode contact with the skin and decreases
the quality of electrode signal. When preparing the electrode sites, avoid bones close
to skin, obvious layers of fat and major muscles.

1. Shave any hair from the electrode site.

2. Gently rub the surface of the skin to increase capillary blood flow.

3. Clean the skin with alcohol or a mild soap and water solution to remove skin oil
and dead or abraded skin cells.

4. Dry the skin completely before applying the electrodes.

Applying the electrodes to the patient
1. Place the electrodes on the prepared sites.

2. Stabilize the electrode and leadwire with a leadwire stress loop near the electrode.
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3. Tape the stress loop to the patient (excluding neonates).

A secured stress loop prevents leadwire rotation about the electrode snap,
leadwire tugging at the electrode, and ECG artifact.

3– lead or 5–lead ECG electrode placement
For a 3-leadwire electrode placement, the R/RA, L/LA, and F/LL electrodes should
be used.

IEC AAMI/AHA Electrode placement

R (red) RA (white) Just below the right clavicle.

L (yellow) LA (black) Just below the left clavicle.

User defined User defined For the 5-lead placement, place the
precordial electrode according to the
physician's preference.

N (black) RL (green) Lower right edge of the rib cage.

F (green) LL (red) Lower left edge of the rib cage.

6–lead ECG electrode placement
NOTE PDM and PSM only.

NOTE For 12RLTM monitoring, a 12RL 12 lead ECG license is required.
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NOTE A 6- or 10-leadwire cable may be used. However, when using
a 10-leadwire cable, do not prepare or connect precordial
leads 2, 3, 4, or 6. Position the Ca/Va electrode in the C1/V1
position and place the Cb/Vb electrode in the C5/V5 position.
The leadwire label for the Ca/Va and Cb/Vb leads are white
(IEC) or brown (AAMI/AHA).

If you are using the 6–leadwire cables for a 12 lead ECG connection, note that the
12RL can be used for adult patients only.

IEC AAMI/AHA Electrode placement

R (red) RA (white) Just below the right clavicle.

L (yellow) LA (black) Just below the left clavicle.

Ca/C1 (white) Va/V1 (brown) 4th intercostal space, right sternal border.

Cb/C5 (white) Vb/V5 (brown) Left anterior axillary line at C4/V4 level.

N (black) RL (green) Lower right edge of the rib cage.

F (green) LL (red) Lower left edge of the rib cage.

10–lead ECG electrode placement for cardiac monitoring
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IEC AAMI/AHA Electrode placement

R (red) RA (white) Just below the right clavicle.

L (yellow) LA (black) Just below the left clavicle.

N (black) RL (green) Lower right edge of the rib cage.

F (green) LL (red) Lower left edge of the rib cage.

C/C1 (white) V/V1 (brown) 4th intercostal space, right sternal border.

C2 (white/yellow) V2 (brown/yellow) 4th intercostal space, left sternal border.

C3 (white/green) V3 (brown/green) Midway between C2/V2 and C4/V4.

C4 (white/brown) V4 (brown/blue) 5th intercostal space, mid-clavicular line.

C5 (white/black) V5 (brown/orange) Left anterior axillary line at C4/V4 level.

C6 (white/purple) V6 (brown/purple) Mid-axillary line at C4/V4 and C5/V5 levels.

Standard resting 10–lead ECG electrode placement
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IEC AAMI/AHA Electrode placement

R (red) RA (white) Right deltoid or wrist.

L (yellow) LA (black) Left deltoid or wrist.

N (black) RL (green) Right thigh or ankle.

F (green) LL (red) Left thigh or ankle.

C/C1 (white) V/V1 (brown) 4th intercostal space, right border of the
sternum.

C2 (white/yellow) V2 (brown/yellow) 4th intercostal space, left border of the
sternum.

C3 (white/green) V3 (brown/green) Midway between C2/V2 and C4/V4.

C4 (white/brown) V4 (brown/blue) 5th intercostal space, mid-clavicular line.

C5 (white/black) V5 (brown/orange) Left anterior axillary line at C4/V4 level.

C6 (white/purple) V6 (brown/purple) Mid-axillary line at C4/V4 and C5/V5 levels.

Checking the ECG measurement
1. Check that the waveforms and parameter values are displayed when the cable is

connected to the patient.

About the ECG analog output signal
Maximum delay of the ECG analog output signal is 30 ms with the PDM and 15 ms
with E-modules. Pacemaker pulse indication is included when appropriate and it is
summed in to the ECG waveform.

ECG synchronization pulse delay from the R-wave peak is <35 ms for the PDM and
E-modules, with the exception of wide QRS (120 ms/0.5 mV).

For more information and detailed specifications, refer to the supplemental
information manual.
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ECG module Analog output signal

E-modules ECG 1 Lead (top waveform position).
If ECG 1 Lead is any of the derived leads related to the 12RLTM 12 lead, then the
analog output will use lead II.

PDM ECG 1 Lead (top waveform position).

About the combination monitoring mode
The combination monitoring is a licensed feature. In combination monitoring mode
ECG is acquired from a telemetry receiver system. This ECG data acquisition capability
enhances basic telemetry monitoring by providing access to all of the available
parameters from bedside monitors, while acquiring the ECG data from telemetry. In
this monitoring mode, all data — local and telemetry — is viewed at the central station
and the bedside monitor. However, any historical data stored at the central station will
be unavailable. Any new alarm history samples created on the telemetry transmitter
cannot be viewed on the monitor if they are created after the combination monitoring
has been started. Only the snapshots created on the monitor and the samples of
the telemetry transmitter created prior to starting the combination monitoring can
be viewed.

During the combination mode the primary arrhythmia detection takes place at the
telemetry server and arrhythmias are reported to the monitor and central station.
The monitor performs a supplementary asystole detection unless the telemetry
server reports V Fib. Note that because of this supplementary asystole detection,
the alarm history may not always match that of the telemetry server. This may lead
to mismatching event history in network devices. If this supplementary asystole
detection is not desired, it can be disabled through Monitor Setup > Default Setup >
Care Unit Settings > Telemetry > Enhanced ASY detection.

The combination monitoring mode can be enabled through Monitor Setup > Default
Setup > Care Unit Settings > Telemetry > Monitor or Telemetry, and the setting is
password protected. The monitor needs to be configured to the CARESCAPE Network.
This option cannot be used in the NICU software package.

In case the telemetry patient has been admitted when the device is connected to the
monitor, the arrhythmia alarm priorities and limit alarm priorities (except in case the
monitor alarm is set to escalating) and the following ECG settings of the telemetry
will be used:

● HR, ST, and PVC alarm limits
● PVC alarm status (on/off)
● Pacemaker detection
● Lead analysis
● Va lead position
● Primary lead
● ECG waveform size
● Arrhythmia detection level
● ST analysis status (on/off)

When combination monitoring is started with a non-admitted telemetry patient, these
same settings from the monitor will be sent to telemetry. Additionally, the Telemetry
Waveforms printing location is sent to telemetry.
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If the telemetry alarm priority is such that it is not supported by the monitor, it will be
mapped to the next higher priority available.

NOTE Patient’s age affects the alarm limits and alarm priorities
and also the configuration of the ECG algorithm including
arrhythmia alarms in the combination monitoring mode.
For more information, see the ApexPro Telemetry System
Operator’s Manual.

When combination monitoring is started with a non-admitted telemetry patient, the
printout type selection will be sent to the telemetry transmitter.

CAUTION Users should be aware that all waveforms may be delayed
up to 2 seconds in the combination monitoring mode. If the
delay needs to be avoided, the combination monitoring mode
should be discontinued and all waveforms should be acquired
via the hard-wired bedside monitor.

CAUTION Users should be aware of a possible time discrepancy
between the waveforms from the telemetry device and the
waveforms from a device hard-wired to the monitor. Users
should not consider these waveforms to be synchronous. If
absolute synchronicity is desired, the combination monitoring
mode should be discontinued and the ECG waveforms should
be acquired via the hard-wired bedside monitor.

About V Tach criteria and combination monitoring
If V Tach Event Duration Criteria has been allowed during configuration through
Monitor Setup > Default Setup > Profile Settings > Alarm Delays, you can set V
Tach Criteria to individualize the V Tach alarm to a specific patient condition. This
adjustable criteria setting is not transferred to the telemetry server. The alarm history
at the bedside monitor may not match that of the central station when V Tach Criteria
have been adjusted to other than the default setting (Minimum HR/min > 100, Event
Duration Off). Switching between the combination monitoring and normal monitoring
may affect the alarm history of the bedside monitor, which will show the latest alarm
history from the telemetry server. You can always check the complete patient history
from the central station full disclosure. You can check the current values through ECG
> Arrhythmia > Lethal Alarms > V Tach Criteria.

Due to age-dependent arrhythmia algorithm and HR criteria for V Tach in Apex Pro,
you cannot adjust the V Tach Criteria in combination monitoring for patients aged
14 or younger.

About enhanced Asystole detection and combination
monitoring

The bedside monitor can enhance an Asystole call from the telemetry server in
combination monitoring. The Asystole alarm detected by the enhanced Asystole
detection in the monitor is not transferred to the telemetry server alarm history.

The alarm history at the bedside monitor may not match that of the central station
when using the Enhanced ASY detection feature. Switching between the combination
monitoring and normal monitoring may affect the alarm history of the bedside
monitor, which will show the latest alarm history from the telemetry server. You can
always check the complete patient history from the central station full disclosure.
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You can disable this supplementary Asystole detection through Monitor Setup >
Default Setup > Care Unit Settings > Telemetry > Enhanced ASY detection. This
setting is password protected.

Selecting the ECG source
NOTE Not available with the NICU software package.

This setting is available if the telemetry license is enabled and the combination
monitoring mode Monitor or Telemetry has been enabled during configuration. The
monitor needs to be in the CARESCAPE Network.

1. Select the HR parameter window.

2. Select a source from the ECG Source list.

This list contains the monitor and available telemetry transmitter(s). When you
confirm the source selection with Confirm, the connection between the selected
transmitter and monitor will be established (telemetry transmitter selected), or the
patient is discharged from the telemetry transmitter (monitor selected).

Using the ECG measurement

The first three displayed ECG leads
You can choose the order of the ECG waveforms displayed in the ECG waveform area.

Lead selection depends on the type of ECG cable used.

The ECG 1 Lead, ECG 2 Lead, and ECG 3 Lead settings affect arrhythmia detection.

When ECG 1 Lead, ECG 2 Lead, or ECG 3 Lead are changed manually and the lead
becomes inactive due to a disconnection, the monitor looks to the ECG lead saved in
the patient profile. If ECG 1 Lead is not available, the monitor looks for lead II, then
lead I, and lastly lead III. Later, if the manually selected lead becomes available again,
the monitor will change back to this lead.

Selecting the first displayed ECG lead
The ECG 1 Lead is the first ECG lead displayed in the ECG waveform area. The monitor
uses the ECG 1 Lead for single-lead analysis if it is I, II, III, or V1. If it is anything else,
then the following mapping is used: V2 to V6 = V1, aVR = II, aVL = I, aVF = III.

1. Select the HR parameter window.

2. Select a lead from the ECG 1 Lead list.

Selecting the second displayed ECG lead
The ECG 2 Lead is the ECG lead displayed after the ECG 1 Lead in the ECG waveform
area.

1. Select the HR parameter window.

2. Select a lead from the ECG 2 Lead list.

If your selection is Cascade, the displayed ECG 1 Lead waveform continues into
the ECG 2 Lead waveform area.
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Selecting the third displayed ECG lead
The ECG 3 Lead is the ECG lead displayed after the ECG 2 Lead in the ECG waveform
area.

1. Select the HR parameter window.

2. Select a lead from the ECG 3 Lead list.

If your selection is Cascade, the displayed ECG 2 Lead waveform continues into
the ECG 3 Lead waveform area.

Selecting the Va ECG lead
NOTE 12RL monitoring - The Va lead is the first V-lead label used

with a 6-leadwire ECG cable for 12RLTM monitoring. 12RL is
possible only if the Va is set to V1.

The Va Lead Position selection affects the ST numeric trends.

When using a 6-leadwire ECG cable, the factory default for the Va lead is V1, however
you may choose a different lead.

The Va lead is the only V-lead used with a 5-leadwire ECG cable.

The Va lead is the V-lead data that is sent to all remote devices like the central station.

1. Select the HR parameter window.

2. Select a lead from the Va Lead Position list.

Selecting the Vb ECG lead
NOTE PDM and E-modules only.

NOTE 12RL monitoring - The Vb lead is the second V-lead label used
with a 6-leadwire ECG cable for 12RLTM monitoring and must
be set to V5.

This selection is not available with combination monitoring.

When using a 6-leadwire ECG cable, the factory default for the Vb lead is V5, however
you may choose a different lead.

1. Select the HR parameter window.

2. Select a lead from the Vb Lead Position list.

Changing to an ECG cable with fewer leadwires
This selection will update the measurement mode between 3–, 5–, 6–, 12RLTM
and 10–lead mode when changing to a smaller amount of leadwires with PDM
and E-modules. Transition from the 12RL mode to the 6–lead mode is detected
automatically.

This selection is not available with combination monitoring.

1. Select the HR parameter window.

2. Select Update Lead Set.
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Deactivating the ECG leads off alarm
The selection is available when there are not enough leads connected for arrhythmia
detection. This selection will acknowledge the ECG Leads Off alarm, but it will not
change the measurement mode to fewer leads.

This selection is not available with combination monitoring.

1. Select the HR parameter window.

2. Select Deactivate ECG Leads Off.

Selecting the beat source
Not all sources (like telemetry ECG, IP) provide the necessary status information for this.

1. Select the HR parameter window.

2. Select the beat source from the Beat Source list:

● Primary HR

● ECG

● Art

● Fem

● UAC

● Pleth

The beat source indicator will appear beside the chosen beat source on the screen,
and the beat sound will reflect the beat of that source.

Setting the beat volume
1. Select the HR parameter window.

2. Set the beat tone volume with the Beat Volume arrows.

The range is 0 (volume off) to 10. The louder the volume, the more bars in the
indicator.

Setting the beep tone during bradycardia and HR low
alarms

NOTE PDM only. NICU software package only.

This selection is not available with combination monitoring.

This selection is available if the Beat Volume for QRS is set to 0 (off).

If the alarm for bradycardia has been set to off or silenced, or the ECG alarms are
silenced permanently, then the QRS tone does not sound, either.

1. Select the HR parameter window.
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2. Set the beep tone: Beat Tone on Brady Only > On or Off.

When the beep tone is selected On, the QRS tones will sound only with Brady
alarm conditions.

● If the alarm volume has been set to below 8, the QRS tones will sound at the
selected alarm volume level +2.

● If the alarm volume has been set to 8 or more, the QRS tones will sound at
alarm volume level 10.

Variable beat tone
You can configure a variable beat tone throughMonitor Setup > Default Setup > Care
Unit Settings > Parameters > Variable Beat Tone. This setting is password protected.

If it set to All beat sources, the SpO2 saturation affects all beep sounds including ECG
and IP when the SpO2 measurement is available: beep frequency changes according
to increasing and decreasing SpO2 values. If the setting is set to Only SpO2, other beep
sounds are not affected by the changing SpO2 values.

For more information, see the supplemental information manual.

Aspect ratio and different display sizes
ECG aspect ratio is the ratio of the vertical sensitivity (ECG size) to the horizontal
sensitivity (sweep speed).

The B450 aspect ratio is optimized for the 12” integrated display, and the B650 aspect
ratio is optimized for the 15” integrated display. If larger external displays are used,
the waveform size and sweep speed may change.

The B850 aspect ratio is optimized for a 19” display. If a display of a different size is
used, the waveform size and sweep speed may change.

For more information, see the supplemental information manual.

Selecting the ECG waveform size
This selection adjusts the size of the displayed ECG waveform.

1. Select the HR parameter window.

2. Select a value from the ECG Size list.

The selections are 0.5x, 1x, 2x, 4x. The smaller the value, the smaller the waveform.

NOTE The ECG Size setting affects arrhythmia detection and heart
rate calculation sensitivity. Normal waveform size/QRS
detection sensitivity is 1x. Size 2x and greater increases
the QRS detection sensitivity. This may be helpful for low
amplitude QRS waveforms. Use with caution since baseline
artifact may be detected as a QRS complex.

Selecting the hemodynamic waveform sweep speed
NOTE This setting adjusts the waveform speed for all of the

hemodynamic parameters.

1. Select the HR parameter window.

150 CARESCAPE Monitors B850, B650, B450 2105822-001



ECG

2. Select a numeric value from the Hemodynamic Sweep Speed list.

The smaller the value, the slower the sweep speed.

Printing all ECG waveforms
NOTE Pressing Graph in the telemetry transmitter will start the

telemetry waveform printing.

1. Select the HR parameter window.

2. Select All ECG Waveforms.

3. Select Print Page.

4. You can stop printing by selecting Stop Printing or Cancel Printing.

Selecting the ECG waveform filter
You can select how the waveform appears on the display and on the printout.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select a filter from theWaveform Filter list. Choices are:

● Diagnostic:

￭ E-modules and PDM: 0.05 Hz to 150 Hz.

● Monitoring:

￭ PDM, E-modules: 0.05 Hz to 32 Hz (with 50 Hz powerline frequency).

￭ PDM, E-modules: 0.05 Hz to 40 Hz (with 60 Hz powerline frequency).

￭ Telemetry transmitters: 0.05 Hz to 40 Hz. The waveform filter is
automatically set to Monitoring and cannot be changed.

● Moderate:

￭ PDM, E-modules: 0.5 Hz to 22 Hz.

● Maximum:

￭ PDM, E-modules: 5 Hz to 25 Hz.

When the Maximum filter is selected, the prompt textWarning: Maximum
filter alters the displayed ECG morphology is displayed.

Setting the QRS width
NOTE This setting affects the arrhythmia detection sensitivity.

This selection is not available with combination monitoring.

If the QRS Width is locked in the Care Unit Settings, the option is not selectable.

1. Select the HR parameter window.

2. Select the Advanced tab.
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3. Select a setting from the QRS Width list. Choices are:
● Narrow: Intended for use with all neonates and the pediatric patient with a

QRS complex width of 100 ms or less. This is the default setting for the Infant
and Pediatric profiles.

● Normal: Intended for ECG rhythms that have QRS complex widths of
approximately 70 ms or wider (for example, almost all adult patients and any
patient with electronic ventricular pacing).

Selecting the leads for ECG analysis
You can choose whether the monitor performs an ECG analysis using single lead ECG
data or data from multiple ECG leads. Multiple ECG leads will typically reduce false
alarms and improve the detection sensitivity. However, if most leads are noisy or low
amplitude, the Single leadmode using the best available ECG lead will help.

In multi-lead mode the ECG algorithm uses leads I, II, III, and Va for arrhythmia
detection. As a default Va is set to V1. Sometimes the V1 may have low amplitude QRS
along with other leads used for arrhythmia detection. In this case, select the Va to the
lead (V1-V6) that is best for monitoring ECG with better QRS amplitude.

With a 3-leadwire cable the setting is Single lead and cannot be changed. If the
measurement mode is changed from the 3–leadwire mode to 5–, 6–, 10–lead or
12RLTM mode, the setting changes to Multi lead.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select an option from the Lead Analysis list. The choices are:
● Single lead: EkPro algorithm uses one of the leads I, II, III, or V1 for the analysis.

ECG 1 Lead is used for the analysis if it is I, II, III, or V1. If it is anything else, then
the following mapping is used: V2 to V6 = V1, aVR = II, aVL = I, aVF = III. Also
note that the ST values are only calculated for the single lead.

● Multi lead: EkPro algorithm uses the following leads:
￭ 3–lead mode: the only measured lead (I, II, or III)
￭ 5–lead and 6–lead mode: any lead assigned to Va.
￭ 12RL mode: I, II, III, and V1.
￭ 12–lead mode: I, II, III, and Va.

Relearning the patient’s QRS pattern
During ECG monitoring, you may need to use the Relearn QRS feature when a
dramatic change in the patient’s ECG pattern has occurred. Allowing the monitor to
learn the new ECG pattern corrects false arrhythmia alarms and heart rate values,
and restores the ST measurements. Relearning takes typically 30 seconds or less. The
message Relearning... displays while the monitor relearns the QRS pattern. During this
time, arrhythmia detection may not be available. If the monitor is not able to relearn
due to a low amplitude QRS, for example, the Arrhythmia paused alarm is triggered.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select Relearn QRS.

Automatic relearning takes place when:
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● The measurement mode changes between the 3–lead mode and any other lead
mode.

● The ECG 1 Lead selection is changed in the 3–lead mode.
● The Va lead selection is changed in the 5–lead, 6–lead, 12RLTM, and 12–lead modes.
● The ECG cable is connected (PSM, PDM).
● The Lead Analysis setting is changed from Multi lead to Single lead.

Setting the primary HR source
The primary heart rate can be calculated from the ECG leads, SpO2 measurement,
or invasive pressure waveform.

NOTE This setting adjusts the primary heart rate source for all of the
hemodynamic parameters.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select a parameter from the Primary HR Source list. The selection list will only
show active measurements and AUTO or IntelliRate. Choices are:
● PDM with single HR: IntelliRate, ECG, Art 1 to Art 8, Fem, UAC, Pleth.
● PDM with multiple HR: IntelliRate, ECG.
● E-modules, telemetry transmitters with single HR: AUTO, ECG, Art 1 to Art 8,

Fem, UAC, Pleth.
● E-modules, telemetry transmitters with multiple HR: AUTO, ECG.

Showing a second HR value in the HR parameter window
You can display a second heart rate source in the HR parameter window.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select the Show 2nd HR Source check box to display the second HR source.

● If the primary HR source for E-modules is ECG or AUTO (ECG), the secondary HR
source is displayed in this order: Art 1 to Art 8, Fem, SpO2.

● If the primary HR source for PDM is ECG or IntelliRate (ECG), the secondary HR
source displayed in this order: UAC, Art 1 to Art 8, Fem, SpO2.

● If the primary HR source is anything else than mentioned above, the secondary HR
source is always ECG.

Showing ST in the HR parameter window
This option is available with the Multi-lead ST Analysis license only.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select the Show ST check box to display ST in the HR parameter window.

Showing PVC in the HR parameter window
This option is enabled with the full arrhythmia license and the Full detection level only.
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1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select the Show PVC check box to display PVC in the HR parameter window.

Showing QT in the HR parameter window
This option is available with the Multi-lead QT/QTc Analysis license only.

This selection is not available with combination monitoring.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select the Show QT check box to display QT in the HR parameter window.

Displaying the ECG grid
You can have a reference grid in the ECG1, ECG2, and ECG3 waveform areas. The grid
points will be at 200 ms horizontally and 0.5 mV vertically.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select the ECG Grid check box to display the grid.

ECG alarm limits
The HR Alarms can be set to Single or Multiple through Monitor Setup > Default
Setup > Care Unit Settings > Parameters > ECG. This setting is password protected.

The Single heart rate setting allows you to set one common HR limit for multiple
sources (e.g., ECG, SpO2, Art) from the Alarms tab and the PVC and SVC alarm limits for
ECG from the PVC/SVC Alarms tab. With this setting activated, turning off the SpO2 HR
alarm limits also turns off the primary HR alarm and adjusting the SpO2 HR limit values
also adjusts the primary HR limit value.

The Multiple heart rate setting allows you to set a primary heart rate/pulse rate
source and up to six individual heart rate/pulse rate alarms and limits from the HR/PR
Alarms tab. It also allows you to set PVC and SVC alarm limits for ECG from the
PVC/SVC Alarms tab. (The tab is called PVC Alarms with telemetry transmitters).
With the Multiple heart rate setting activated, turning off the SpO2 HR alarm limits
does not turn off the primary HR alarm.

You also have the option to select HR Critical Tachy/Brady alarm. This enables
different alarm limit configurations for basic alarms and critical alarms.

Setting HR alarm limits for a single HR source
You also have the option to select HR Critical Tachy/Brady alarm. This enables
different alarm limit configurations for basic alarms and critical alarms.

1. Select the HR parameter window.

2. Select ECG tab.

3. Select the Alarms or the PVC/SVC Alarms tab to set the alarms.
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4. Adjust the alarm limits with the arrows.

Always check that you are configuring the right alarm. Note that the HR Critical
Tachy/Brady alarm limits must always be set outside the basic alarm limits.

Setting HR/PR alarm limits for multiple HR sources
You also have the option to select HR Critical Tachy/Brady alarm. This enables
different alarm limit configurations for basic alarms and critical alarms.

1. Select the HR parameter window.

2. Select the HR/PR Alarms tab.

3. Select the Alarm On check box for those alarms you wish to set: HR Tachy/Brady,
HR Critical Tachy/Brady, and PR alarms for SpO2 .

If a feature is not active, the alarm limits are greyed out and the Alarm On check
box is not selected.

4. Adjust the alarm limits with the arrows.

Always check that you are configuring the right alarm. Note that the HR Critical
Tachy/Brady alarm limits must always be set outside the basic alarm limits.

Setting PVC alarm limits
Available with the full arrhythmia license only.

1. Select the HR parameter window.

2. Select the PVC/SVC Alarms or PVC Alarms (telemetry transmitters) tab.

3. Check that the PVC alarm is turned on.

If a feature is not active, the alarm limits are greyed out.

4. Select Alarm On to set the alarms.

5. Adjust the alarm limits with the arrows.

Setting SVC alarm limits
Available with the full arrhythmia license only. Not available with combination
monitoring.

1. Select the HR parameter window.

2. Select the PVC/SVC Alarms tab.

3. Check that the SVC alarm is turned on.

If a feature is not active, the alarm limits are greyed out.

4. Select Alarm On to set the alarms.

5. Adjust the alarm limits with the arrows.

Selecting the HR alarm range
With the Single heart rate setting only.

1. Select the HR parameter window.
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2. Select the heart rate alarm range from the HR Alarm Range list:

● 30–240 (set and disabled if the Primary HR Source is IntelliRate, AUTO, or
SpO2).

● 20–300

NOTE France only: Available selections are 30–230 and 20–230.
Selection 30–230 is set and disabled if the Primary HR
Source is IntelliRate, AUTO, or SpO2.

Configurable PR alarm delays
Alarm delays for PR (SpO2/IP) high and PR (SpO2/IP) low are configurable from 0 to 20
seconds in increments of 5 seconds. These delays are set through Default Setup >
Profile Settings > Alarm Delays and they are password protected.

You can check the delays through ECG > HR/PR Alarms > Priorities & Delays Info.

For more information, see the supplemental information manual.

ECG alarm priorities
You can set the alarm priorities for various ECG alarms through Alarm Setup > Alarm
Priorities > ECG.

Note the following regarding CARESCAPE Central Station v2.0 or earlier and alarm
priorities for HR/PR high, Tachy/PR high, HR/PR low and Brady/PR low:

● If you have selected different priorities on the monitor for high and low alarms,
the alarm level control at the CARESCAPE Central Station will be inactivated.
This situation is also indicated as an empty cell in the central station’s table of
parameter limits and alarm levels.

● If the HR high/low alarm level control is active at the central station and it is
selected, the selection applies to HR/PR high, Tachy/PR high, HR/PR low, and
Brady/PR low provided that you have selected the same alarm priority for high and
low alarms on the monitor. Otherwise the monitor will discard the central station
selection, resulting in an empty cell in the central station’s table of parameter
limits and alarm levels.

The allowed priorities are defined in the Care Unit Settings, and they are password
protected.

Checking alarm delays and priorities information
You can check which alarms have priority settings that deviate from the
recommendation of international safety standards, and also the delays selected for
each alarm.

1. Select the ECG parameter window.

2. Select the HR/PR Alarms tab.

3. Select Delays & Priorities Info (or Delays Info if there are no alarms deviating
from standards).

4. Check the priorities and delays.
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ECG measurement practicalities

Alternate pulse rate source
The alternate pulse rate source allows clinicians to acquire a pulse rate from a source
other than ECG (Art, Fem, UAC, or SpO2). The following circumstances may warrant
the use of an alternate pulse rate source:
● Excessive artifact due to an electrical interference from equipment (for example,

electrosurgical device).
● Excessive patient movement causing significant artifact (for example, seizure

activity).
● Inability to use standard lead placement (for example, burns).

PDM IntelliRate algorithm
The PDM uses the IntelliRate algorithm. IntelliRate extracts information from multiple
physiological signals (ECG, SpO2, Art) and applies rule-based logic to determine which
heart rate source has the highest likelihood of being accurate. By reporting the most
accurate rate, the trended pulse rate is more accurate, and occurrences of false pulse
rate limit violation alarms are greatly reduced. The alternate pulse rate source value
replaces the standard heart rate value in the HR parameter window.

E-modules, and telemetry transmitters Auto algorithm
E-modules, and telemetry transmitters use the AUTO algorithm. AUTO selects the first
available heart rate source based on a pre-defined parameter priority:
1. ECG
2. Art
3. Fem
4. SpO2

ECG troubleshooting
Problem Solution

ECG signal is noisy or no QRS is detected ● Ensure that the patient is not shivering.

● Select the correct filter by selecting the HR
parameter window > Advanced > Waveform
Filter.

● Check the electrode quality and positioning. Do
not place electrodes on body hair, bones close to
skin, layers of fat and major muscles. Pre-gelled
electrodes are recommended.

● Change the lead in ECG1 to the best available
signal and consider using the Single leadmode.

● Consider using ECG Size > 2x.

● Try an alternative location for the Va lead to
improve signal quality. In some cases, like if the
patient has a significant heart failure, changing for
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Problem Solution
example from V5 to V1 can result in a considerable
difference in the signal amplitude.

● Check all cable connectors.

12 lead analysis

Intended use of 12RLTM Interpolated 12 lead ECG analysis
The GE 12RL program generates a 12 lead ECG report from a subset of the electrodes
used to acquire a standard 12 lead ECG. Four of the precordial channels of the 12 lead
ECG (V2, V3, V4, V6) are not acquired from the patient; rather, they are reconstructed
from information that is directly recorded in the other channels of the 12 lead ECG.

The four signals generated by the GE 12RL program are similar but not identical to
the standard 12 lead ECG. All ECG data generated via 12RL are clearly identified as to
which channels have been synthesized.

The GE 12RL program is intended for use in a monitoring environment. Computerized
measurements may be generated from these data; however, a computerized
interpretation will not.

The product is intended for use in the general adult population ranging from healthy
subjects to patients with cardiac and/or non-cardiac abnormalities.

The product is to be used in conjunction with the patient's clinical history, symptoms,
and other diagnostic tests for final clinical judgment.

Intended use of 12SL ECG analysis
The 12SL Analysis Program assists the physician in measuring and interpreting resting
12 lead ECGs for rhythm and contour information by providing an initial automated
interpretation. Interpretation by the product is then confirmed, edited, or deleted by the
physician. The analysis program is intended for use in the general population, ranging
from healthy subjects to patients with cardiac and/or non-cardiac abnormalities. The
analysis is intended for use in hospitals, outpatient clinics, emergency departments,
and out-of hospital sites such as ambulances and patients’ homes.

ACS Tool option is intended for adult patient population who are suspected clinically to
have acute coronary syndrome.

NOTE Although the 12SL analysis program can be used
out-of-hospital, CARESCAPE monitors are intended for
in-hospital use only.

The 12SL analysis program is also referred to as the 12 lead ECG analysis program.

Intended use of ACI-TIPI
The Acute Cardiac Ischemia–Time Insensitive Predictive Instrument (ACI-TIPI) is
intended to be used in a hospital or clinic environment by competent health
professionals. TIPI utilizes recorded ECG data along with patient demographic and
chest pain status to produce a numerical score which is the predicted probability of
acute cardiac ischemia. Like any computer-assisted ECG interpretation program, the
GE Marquette ACI-TIPI evaluation and probability score is intended to supplement,
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not substitute for the physician’s decision process. It should be used in conjunction
with knowledge of the patient’s history, the results of a physical examination, the
ECG tracing, and other clinical findings.

ACI-TIPI is intended for adult patient populations.

About 12SL analysis
For a 12 lead ECG analysis, a 12SL ECG with ACI-TIPI license, 10-leadwire cable, and
10–lead lead electrode placement are required.

For more information regarding the 12SL analysis, refer to the Marquette 12SL ECG
Analysis Program Physician’s Guide.

During monitoring the ECG leads are typically placed on the patient’s torso. For more
information on the impact of electrode positioning on the 12SL analysis, refer to the
Marquette 12SL ECG Analysis Program Physician’s Guide.

12 lead ECG analysis points to note
● To obtain the most accurate 12 lead ECG analysis, you should enter accurate

patient demographics. This is especially important when storing and comparing
12 lead reports in the MUSE database.

● For a 12 lead ECG analysis with the 12RLTM feature, a 12RL 12 lead ECG license
and a 6–leadwire cable (or a 10-leadwire cable with the C2/V2, C3/V3, C4/V4, and
C6/V6 leads disconnected) is required.

● For a 12 lead ECG analysis with the 12RL feature, confirm that the Va and Vb lead
positions are set correctly for a 12RL measurement.

● For the most accurate serial comparisons, use the same electrode configuration as
used on the prior analysis for the patient.

● A clinician must always confirm the 12 lead ECG analysis.

Entering data for a 12 lead ECG analysis
When the Tech ID Required is set to mandatory in the Care Unit Settings, you must
enter the Technician ID before you can confirm the 12 lead settings. All Care Unit
Settings are password protected.

For more information, see the supplemental information manual.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Settings.

4. Enter the Technician ID if required.

5. Enter the Order Number.

6. Select an option from the Reasons for 12 Lead list.

You can also add your own password protected list of pre-defined reasons for
recording a 12 lead ECG through the Care Unit Settings.

7. Select Cancel or Confirm.
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Entering data for an ACI-TIPI 12 lead ECG analysis
NOTE The patient must be at least 16 years old for an ACI-TIPI 12

lead ECG analysis.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Settings.

4. Select Diagnostic Tool > ACI-TIPI.

5. Select the patient’s gender from the Gender list.

This selection will also be updated to the patient demographics.

6. If the patient’s age has not been entered previously, select it now from the Age list.

7. Select the symptoms present from the Chest or Left Arm Pain list.

8. Select Cancel or Confirm.

Selecting Confirm is required before you can complete an ACI-TIPI 12 lead ECG
analysis.

Enabling and disabling the 12SL ACS
WARNING Acute Coronary Syndrome (ACS) feature must be used only

with patients to whom this measurement is suitable.

12SL-ACS is an optional higher-sensitivity analysis for the detection of acute ischemia
and acute infarction designed for a higher risk population with a higher prior
probability of having these conditions. When this setting is enabled, you will get
ACS-specific statements in addition to the diagnostic statements.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Settings > Diagnostic Tool.

4. Select ACS or Off.

5. Select Cancel or Confirm.

Entering the Location ID for 12SL
If roving between units is allowed and the 12SL ECG with ACI TIPI is enabled, you can
enter the Location ID that will be used in the 12SL reports.

1. Select the patient information area on screen.

2. Select the Care Unit & Bed tab.

3. Select the Location ID field and enter the ID with the on-screen numeric keypad.
You can enter any number from 0 to 599.

Setting automatic 12 lead ECG analysis measurements
1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Settings.
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4. Select a time interval from the Auto Interval list.

5. Select Cancel or Confirm.

Setting the 12 lead ECG analysis display format
This setting will change the 12 lead ECG waveform display format and the printed 12
lead ECG report waveform format. The 25 mm/s or 50 mm/s 12 Lead Print Speed is
selected during configuration through Care Unit Settings > Parameters > 12 Lead
ECG. The setting is password protected and it affects the sweep speed for 12SL
printouts and the available display formats for the 12 lead analysis.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Settings.

4. Select a format from the Display Format list:

● 4 x 2.5 - 1 Rhythm (with print speed 25 mm/s only)

● 4 x 2.5 - 3 Rhythms (with print speed 25 mm/s only)

● 12 Rhythms

● 2 x 6 Rhythms 50 mm/s

● Cabrera

5. Select Cancel or Confirm.

Selecting the 12 lead waveform filter
You can select the waveform filter to best suit your needs. Filter selection will affect
the waveform view and the printouts of the selected report.

Select the upper limit for the filter band:

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Filter.

4. Select a filter from the Low-pass list:

● 20 Hz

● 40 Hz

● 100 Hz

● 150 Hz.

Selecting the 12SL baseline stabilization
You can filter out waveform wander from 12SL by selecting baseline stabilization. The
selection is available if it has been allowed during configuration through Care Unit
Settings > Parameters > 12 Lead ECG > Allow Baseline Stabilization. The setting
is password protected.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select the Stabilize Baseline check box.
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Including or excluding 12SL statements in printed reports
You can select whether you want the 12SL diagnostic statements to be included in
printed reports or not.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Settings.

4. Select or deselect the checkbox Print Interpretations.

5. Select Cancel or Confirm.

Generating a 12 lead ECG analysis report during an ST
alarm condition

You can have a 12 lead ECG report automatically generated when an ST alarm
condition occurs. Automatically generated reports are viewable through 12 Lead
Analysis > Saved Reports.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Settings.

4. Select On from the 12 Lead on ST Alarm list.

5. Select Cancel or Confirm.

Performing a 12 lead ECG analysis
1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select 12 Lead Now.

All the waveforms in the 12 Lead Analysis view freeze during the analysis except for
the ECG I waveform. Analysis takes less than one second to complete. At that time, the
monitor generates a 12 lead report, saves the report locally, and displays the report
on the screen. The monitor can store up to fifteen 12 lead reports locally.

A 12 lead report and the MUSE database
After the monitor generates the 12 lead report, you can send it to the optional MUSE
database for further analysis or storage, print the report, or delete the report.

The Send to MUSE or MUSE + Print are not selectable when:
● The MUSE database is not available or when the local report has already been sent

to the MUSE database.
● A temporary medical record number is used and Care Unit Settings > Transmit

with temp MRN has not been enabled.
● The 12RLTM feature was used. The MUSE database does not support a 12 lead

report with the 12RL feature.

Sending a 12 lead ECG report to the MUSE database
1. Select the HR parameter window.
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2. Select 12 Lead Analysis.

3. Select Send to MUSE.

The local 12 lead ECG report is now sent to the MUSE database.

4. Select Print to print the 12 lead report.

You can also selectMUSE + Print instead of the two separate steps 3 and 4 above.

5. Select Delete to delete the report and return to the real-time view.

6. To generate a new 12 lead ECG analysis report, select Real-time View and repeat
the procedure for performing a 12 lead ECG analysis.

Viewing or printing saved 12 lead ECG reports
You can view and print 12 lead reports that are stored at the monitor (local), or if
available, stored at a MUSE database. The newest reports are displayed first.

To open a report that is stored at the MUSE database, a connection to the CARESCAPE
Network is required.

1. Select the HR parameter window.

2. Select 12 Lead Analysis.

3. Select Saved Reports.

4. Select the desired 12 lead report from the list.

5. To view this report, select View.

A report that is stored locally at the monitor opens and displays in the 12 Lead
Analysis view. A report that is stored at the MUSE database opens and displays in
the MUSE Report view.

6. To send a locally saved 12 lead ECG report to the MUSE database, select Send
to MUSE.

You can only send the report to the MUSE database once.

7. To resize a report displayed in the MUSE Report view, select a value from the
Zoom list.

If you zoom in closer on the report, use the vertical scroll bar to view all parts
of the report.

8. To print a report displayed in the MUSE Report view, select Print.

9. To stop printing, select Stop Printing or Cancel Printing.

About the 12 lead ECG analysis program
The 12 lead ECG analysis program assists the physician in interpreting and measuring
the resting ten seconds of ECG data. This program generates a diagnostic textual
report on patient’s cardiovascular condition. This report can be routed to the MUSE
Cardiology Information System via the CARESCAPE Network. The following figure
shows a typical 12 lead ECG report.
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1. Patient information, including patient Name:, MRN:, Date: and Time: the report
was generated.

2. Available values including Ventricular Rate, PR Interval, QRS Duration, QT/QTc,
and P-R-T Axis.

3. Diagnostic statements and/or error messages.

4. Waveform area.

Up to 15 reports can be stored on the monitor until the patient is discharged. Also a
PDF report generated by the MUSE can be viewed via the monitor.

The 12 lead ECG analysis program includes the Gender Specific Criteria and the
Acute Cardiac Ischemia-Time Insensitive Predictive Instrument (ACI-TIPI). ACI-TIPI uses
recorded ECG data to produce a numerical score which is the predicted probability of
acute cardiac ischemia. In addition, the gender specific criteria improves the detection
of acute myocardial infarctions (AMI) for adult women under the age of 60. ACI-TIPI
can be enabled or disabled for the admitted patient.

Complete analysis requires a 10-leadwire cable.

About the 12RLTM ECG analysis program
NOTE 12RL is not available with the NICU software package.

NOTE Reconstructed (interpolated) leads cannot be selected for
pacemaker detection or impedance respiration monitoring.

NOTE Interpretive statements are not available when a 12 lead ECG
analysis is generated using the 12RL analysis program.

The 12RL analysis program generates a 12 lead ECG report from a subset of the
electrodes used to acquire a standard 12 lead ECG. The 12 lead report includes the
statement LEADS V2, V3, V4, AND V6 ARE INTERPOLATED to identify that the ECG
measurements were analyzed using reconstructed (interpolated) leads. If the software
version of the MUSE does not support this message, the message STATEMENT NOT
FOUND is displayed instead. Reconstructed leads are identified on the monitor and in
printouts (graphs) by the letter d (for derived) before the lead name (e.g., dV2) to ensure
the clinician can identify the reconstructed waveform tracings.
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12RL uses a standard 6-leadwire electrode placement to acquire leads I, II, III, AVR, AVF,
V1 and V5. The four precordial leads (V2, V3, V4, V6) are not acquired from the patient.
This reconstruction assumes accurate electrode placement and typical anatomy.

For 12RL monitoring, a 6- or 10-leadwire cable may be used. However, when using a
10-leadwire cable, do not prepare or connect precordial leads 2, 3, 4, or 6.

12 lead ECG analysis troubleshooting
Problem Solution

Transmitting a 12 lead report to a MUSE database
fails.

There are communications problems with the
network or the MUSE database.

● Contact qualified service personnel.

Printing a 12 lead analysis report fails. There is a printer error or communication problems
with the network.

● Check the printer. If you cannot resolve the
problem, contact authorized service personnel.

Pacemaker detection

Pacemaker detection warnings
WARNING RATE METERS. Keep pacemaker patients under close

observation. Rate meters may continue to count the
pacemaker rate during cardiac arrest and some arrhythmias.
Therefore, do not rely entirely on rate meter alarms. See
the supplemental information manual for disclosure of the
pacemaker pulse rejection capability of this device.

WARNING FALSE CALLS. False low heart rate indicators or false
Asystole calls may result with certain pacemakers because
of pacemaker artifact such as electrical overshoot of the
pacemaker overlapping the true QRS complexes.

WARNING MONITORING PACEMAKER PATIENTS. PDM and telemetry: the
monitoring of pacemaker patients can only occur with the
pace program activated.

WARNING PACEMAKER INDICATION. Pacemaker activity is indicated
on the electrocardiogram through the display of a different
colored pacemaker marker pulse. All pacemaker marker
pulses appear upright and uniform and should not be used
for diagnostic interpretation.

WARNING PATIENT HAZARD. A pacemaker pulse can be counted as a
QRS during Asystole. Keep pacemaker patients under close
observation.

WARNING PATIENT HAZARD. Asystole may not be detected if the patient
has a pacemaker that produces high-amplitude pacer spikes,
the pacemaker detection is on, and a PDM is used. Keep
pacemaker patients under close observation.
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Pacemaker detection points to note
● PDM, combination monitoring: Pacemaker detection must be turned on at the

monitor. It must be used whenever the monitored patient has a pacemaker.
● PSMP: Pacemaker detection is always on.
● PSMP: If the patient has an atrial pacemaker, ST calculations can be performed if

the pacer spike does not coincide with the ISO point’s adjustment range.
● PSMP: Leads R, L, F, and V are used for pacemaker detection.
● PDM: The following leads are used for pacemaker detection:

￭ 5–lead mode: Leads R, L, F, and V
￭ 10–lead mode: Leads R, F, V1, and V5

Selecting the pacemaker detection
With E-modules the pacemaker detection is always enabled.

With PDM and combinationmonitoring it must be turned on. However, youmay disable
pacemaker event processing by turning off pacemaker detection. When pacemaker
detection is turned off, the monitoring device ignores pacemaker pulse detections
which may adversely affect the heart rate accuracy of the monitoring device.

1. Select the HR parameter window.

2. Select the Advanced tab.

3. Select a value from the Pacemaker Detection list.

List options are acquisition module dependent:
● E-modules:

￭ Show: Displays pacemaker spikes on the ECG waveform.
￭ Hide: Hides the pacemaker spikes on the ECG waveform.
￭ Sensitive: Increases pacemaker detection sensitivity and displays the

pacemaker spikes on the ECG waveform. By selecting this option you can
improve the detection of small amplitude pacemakers. However, this mode is
also more sensitive to false pacemaker detections.

● PDM:
￭ Sensitive: Includes pacemaker marker pulses in the waveform with a more

sensitive lower threshold on the pace pulse amplitude.
￭ Normal: Detects and draws pacemaker marker pulses in the waveform.

The detection is less sensitive to electromagnetic interference. This option is
recommended when the interference level is high, for example due to an LVAD
device or infusion pumps.

￭ Off: Pacemaker pulses are not detected or marked with pacemaker marker
bars. Pacemaker pulses are shown as they appear in the waveform signal.

● Combination monitoring:
￭ Off: Turns off pacemaker detection.
￭ Pace 2: Minimizes the possibility of counting pacemaker artifact as QRS

complexes during asystole.
￭ Pace 1: Does not minimize the possibility of counting artifact as a QRS complex

during asystole. If the monitor resets or is discharged, or the profile is changed,
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and the monitor is set to Pace 1, the monitor automatically changes to the
Pace 2 setting.

Pacemaker detection troubleshooting
Problem Solution

How does activating pacemaker detection impact
monitoring?

● Beats that would otherwise be classified as
ventricular are instead classified as V-paced if a
ventricular pacemaker event is detected.

● Residual pacemaker energy that might otherwise
appear in the ECG is removed, and a pacemaker
enhanced spike is placed in the ECG.

● On the ECG waveform, pacemaker detection
is indicated by uniform, upright pacemaker
enhancement spikes in the ECG data, both
displayed and graphed.

How can pacemaker detection be improved? ● Possible problems include:

￭ Heart rate double counting.

￭ Inaccurate alarms for low heart rate or asystole.

￭ Pacemaker spikes not recognized by the
software.

￭ False PVC detections and arrhythmia alarms.

● Possible solutions include:

￭ Relearn arrhythmia.

￭ Re-prepare the patient skin, replace the
electrodes, and adjust the electrode placement.

￭ Try an alternate electrode placement.

￭ Try single-lead analysis, if available.

￭ E-modules, combination monitoring: Switch to
another pacemaker detection mode.

Why is the monitor double-counting the heart rate,
alarming for a low heart rate, or not detecting
pacemaker spikes?

The monitor is not detecting pacemaker activity.
Causes may include:

● PDM, combination monitoring: The pacemaker
detection program is turned off. Turn it on, reprep
the skin and reposition the electrodes if necessary.
Relearn ECG.

● The pacemaker signal is too weak for the monitor
to detect.

● The ECG signal is too weak for the monitor to
detect.

● The monitor is detecting atrial pacemaker artifact
or non-QRS features as beats.

If the monitor is alarming for low heart rate or
asystole, assess the QRS amplitude:

● View all ECG leads to assess the amplitude of the
QRS complexes. To ensure correct HR readings,
a 0.5 mV QRS amplitude is recommended for a
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Problem Solution
normal ECG signal. If the QRS amplitude drops
below 0.5 mV or an abnormal QRS width occurs
(more than 120 ms), QRS detection may be
reduced, leading to false asystole alarms.

● If necessary, reprep the skin and reposition the
electrodes.

● Relearn ECG.

Arrhythmia monitoring

Arrhythmia monitoring warnings
WARNING V Fib/V Tach should not be considered a substitute for the V

Tach arrhythmia alarm. Efforts to lower the V Tach alarm level
can result in missed ventricular tachycardia alarms.

WARNING LOSS OR DETERIORATION OF ARRHYTHMIA DETECTION.
Automated arrhythmia analysis programs may incorrectly
identify the presence or absence of an arrhythmia. A
physician must therefore interpret the arrhythmia information
in conjunction with other clinical findings. Please take special
note of the following ECG waveform conditions:
● Noisy waveforms. Noisy portions of ECG waveforms are

typically excluded from analysis. The exclusions are
necessary to reduce the occurrence of inaccurate beat
interpretations and/or rhythm alarms. If the excluded noisy
portions of the ECG waveform contain true arrhythmia
events, those events may remain undetected by the
system.

● Beat amplitude and duration. Accurate detection and
interpretation of beats becomes increasingly difficult as
the amplitude and/or duration of those beats approach
the design limits of the analysis program. Thus, as beats
become extremely wide or narrow, or especially as beats
become small, arrhythmia interpretation performance may
degrade.

● Other morphology considerations. Automated arrhythmia
detection algorithms are designed fundamentally to detect
significant changes in QRS morphology. If an arrhythmia
event is present and does not exhibit a significant change
from the patient’s predominant morphology, it is possible
for those events to remain undetected by the system.

WARNING PAUSED ANALYSIS. Certain conditions pause arrhythmia
analysis. When paused, arrhythmia conditions are not
detected and alarms associated with arrhythmias do not
occur. Conditions causing paused arrhythmia analysis include
arrhythmia off, arrhythmia paused, leads fail, alarm pause, all
alarms off, and discharged patient.
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WARNING FAILURE TO DETECT LETHAL ARRHYTHMIA. Always monitor
ECG for arrhythmia detection purposes. HR calculated from
pulsatile SpO2 waveform may differ significantly from ECG HR
measured values. Users should be aware that the SpO2 probe
off and No SpO2 pulse technical alarms escalate no higher
than a Medium priority.

WARNING FAILURE TO DETECT LETHAL ARRHYTHMIA.The SpO2 parameter
pulsatile heart rate measurement is based on the optical
detection of a peripheral flow pulse and therefore may not
detect certain arrhythmias. The pulse oximetry parameter
should not be used as a replacement or substitute for ECG
based arrhythmia analysis.

WARNING ARRHYTHMIA PAUSED alarm. The Arrhythmia paused alarm
indicates that the system is no longer monitoring arrhythmia
or heart rate from ECG. If you adjust the alarm priority level
lower than the default value, keep the patient under close
surveillance.

Arrhythmia measurement limitations
● Since the arrhythmia detection algorithm sensitivity and specificity is less than

100%, sometimes there may be some false arrhythmias detected and also some
true arrhythmia events may not be detected. This is especially true when the signal
is noisy.

● The ECG size and QRS width settings affect arrhythmia detection and heart rate
calculation sensitivity.

● If QRS amplitude is low, the monitor might not be able to calculate HR and false
Asystole may occur.

● If learning phase takes place while arrhythmia is already occurring, it may affect
the subsequent arrhythmia detection.

● During the learning phase of the algorithm, arrhythmia detection may not be
available. As a result, the patient condition should be closely monitored during
the learning phase and for several minutes after the learning phase to allow the
algorithm to reach optimal detection performance.

Arrhythmia alarm mapping
Certain arrhythmias are only annunciated locally. Since the CARESCAPE Network
and CARESCAPE Central Station are unfamiliar with some of these new arrhythmias,
they are mapped to corresponding known arrhythmias in the Event directory of the
CARESCAPE Central Station. Consult the following table for more details:

2105822-001 CARESCAPE Monitors B850, B650, B450 169



ECG

Measurement on
the monitor

Alarm message on
the monitor

Alarm message on
the central station
ADU

Event directory on
the central station

Alarm level control
on the central
station

HR high/low HR/PR high
(telemetry) or
Tachy/PR high
(PDM, PSM)
HR/PR low
(telemetry) or
Brady/PR low (PDM,
PSM)

TACHY/BRADY Tachy/Brady Parameter: HR
high/low

PVC count Frequent PVCs Frequent PVCs PVC Parameter: PVC

Multifocal PVCs Multifocal PVCs Multifocal PVCs PVC Arrhythmia: PVC

Missing beat Missing beat Missing beat PAUSE N/A

Pause Pause Pause PAUSE Arrhythmia: PAUSE

SVC count Frequent SVCs Frequent SVCs IRREGULAR N/A

SV tachy SV Tachy SV Tachy TACHY Arrhythmia: TACHY

Setting the arrhythmia category to alarm
Depending on what has been allowed in the Care Unit Settings > Parameters > ECG >
Allowed Arrh. Levels, you can select different arrhythmia categories to alarm.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Lethal Alarms.

4. Select the arrhythmia category you want to alarm:

● Full: All arrhythmias alarm.

● Lethal: Only lethal arrhythmias alarm.

● Off: No arrhythmia alarms are generated.

Setting arrhythmia alarms
While monitoring ECG, you can adjust the settings for arrhythmia alarm conditions.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Lethal Alarms, Ventricular Alarms, or Atrial Alarms.

Ventricular Alarms and Atrial Alarms are only adjustable with the full arrhythmia
license.

4. Select an arrhythmia from the list.

5. Select the arrhythmia alarm’s Alarm Priority with the arrows.

6. Select the check box for Create Snapshot if you wish to activate an arrhythmia
snapshot creation.
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7. Select the check box for Print on Alarm if you wish to activate printing during
arrhythmia alarm.

For arrhythmia alarm waveform printing, the printing will continue until 20
seconds has passed from the clearance of the last active arrhythmia alarm (e.g.,
10 seconds saved data, arrhythmia alarm duration + 20 seconds data).

Setting the alarm pause interval
With combination monitoring this setting is always 3 seconds and cannot be edited.

You can set the time interval between the two adjacent beats before the pause alarm
condition is annunciated.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Atrial Alarms.

4. Select a value from the Pause Interval list.

Selecting V Tach criteria
This setting determines how the time and HR criteria are applied to determine the V
Tach alarm. The selection is shown only if the V Tach Event Duration Criteria has
been allowed during configuration through Monitor Setup > Default Setup > Profile
Settings > Alarm Delays. This setting is password protected. For more information,
see the supplemental information manual.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Lethal Alarms.

4. Select V Tach Criteria.

5. Select a value for V Tach Criteria: Minimum HR/min AND Event Duration, or
Minimum HR/min OR Event Duration.

About V Tach criteria and combination monitoring
If V Tach Event Duration Criteria has been allowed during configuration through
Monitor Setup > Default Setup > Profile Settings > Alarm Delays, you can set V
Tach Criteria to individualize the V Tach alarm to a specific patient condition. This
adjustable criteria setting is not transferred to the telemetry server. The alarm history
at the bedside monitor may not match that of the central station when V Tach Criteria
have been adjusted to other than the default setting (Minimum HR/min > 100, Event
Duration Off). Switching between the combination monitoring and normal monitoring
may affect the alarm history of the bedside monitor, which will show the latest alarm
history from the telemetry server. You can always check the complete patient history
from the central station full disclosure. You can check the current values through ECG
> Arrhythmia > Lethal Alarms > V Tach Criteria.

Due to age-dependent arrhythmia algorithm and HR criteria for V Tach in Apex Pro,
you cannot adjust the V Tach Criteria in combination monitoring for patients aged
14 or younger.
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Setting minimum HR for V Tach
This setting determines the minimum heart rate to trigger the V Tach alarm.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Lethal Alarms.

4. Select V Tach Criteria.

5. Set a value for Minimum HR/min.

You can set the value to > 100, or from 110 to 300 in steps of 10.

Setting V Tach event duration
This setting determines how long a time the algorithm needs to trigger the V Tach
alarm. The selection is shown only if the V Tach Event Duration Criteria has been
allowed during configuration through Monitor Setup > Default Setup > Profile
Settings > Alarm Delays . This setting is password protected. For more information,
see the supplemental information manual.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Lethal Alarms.

4. Select V Tach Criteria.

5. Set a value in seconds for Event Duration.

Setting the SVT length
E-modules and PDM only.

This setting determines how many consecutive SVCs are needed to trigger the SV
Tachy alarm.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Atrial Alarms.

4. Select a value from the SVT Length list.

Setting HR for SVT
E-modules and PDM only.

This setting determines the minimum value for the HR to trigger the SV Tachy alarm.

1. Select the HR parameter window.

2. Select the Arrhythmia tab.

3. Select Atrial Alarms.

4. Select a value from the HR for SVT /min list.
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Arrhythmia alarm messages
NOTE A clinician must analyze the arrhythmia information in

conjunction with the other clinical findings.

Alarm message Arrhythmia analysis Alarm priority default Arrhythmia detection
criteria

A Fib Full (All other software
packages except NICU)

According to priority
setting

Absence of P-waves and
irregular RR-interval.

Accel. Ventric. Full According to priority
setting

Accelerated ventricular
rhythm - Run of PVCs
with a run length of at
least six beats and the
rate requirements have
not met for V Tach or V
Brady.

Asystole Lethal High HR decreased to zero.

Bigeminy Full According to priority
setting

Every other beat is PVC
(N-V-N-V-N-V ).

Brady Lethal with NICU
software package
and in combination
monitoring with all
software packages if age
is 0–2 or 3–10.
Full with all other
software packages
Combination monitoring
only

According to priority
setting

Displayed 8-beat average
ECG heart rate falls
below the user-selected
common HR low limit or
ECG HR low limit.

Couplet Full According to priority
setting

Two consecutive PVCs
are detected between
normal beats, N-V-V-N.
The coupling interval
between the PVCs must
be less than 600 ms.

Irregular Full
PDM in NICU software
package only

According to priority
setting

Six consecutive normal
RR intervals vary by 100
ms or more.

Missing beat Full
E-modules with all
software packages;
PDM with other software
packages except NICU

According to priority
setting

Actual RR interval more
than 1.8 times the
average RR interval.

Multifocal PVCs Full
E-modules, PDM

According to priority
setting

Over the last 15 beats
two or more PVCs with
different morphologies
are detected.
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Alarm message Arrhythmia analysis Alarm priority default Arrhythmia detection
criteria

Pause Full According to priority
setting

Coupling interval
between two beats
exceeds:

● 3 seconds with
combination
monitoring

● 1 to 5 seconds
(configurable) with
E-modules and PDM

R on T Full According to priority
setting

Isolated PVC is detected
within 100 ms of the
peak of the T-wave of the
patient’s predominant
normal beat.

Single PVC Full
Combination monitoring
only.

According to priority
setting

Isolated PVC is detected.

SV Tachy Full
E-modules and PDM only

According to priority
setting

A run of SVCs is detected
with a run length of at
least the set SVT Length
and the heart rate is at
least the set HR for SVT
/min.

Tachy Full
Combination monitoring
only.

According to priority
setting

Occurs when four
consecutive RR intervals
or the displayed 8-beat
average ECG heart
rate exceeds the
user-selected common
HR high limit or ECG HR
high limit.

Trigeminy Full According to priority
setting

Every third beat is PVC (N,
N, V, N, N, V, N, N, V).

V Brady Full According to priority
setting

Run of PVCs are detected
with a run length of at
least three beats. In
addition, at least two
consecutive RR intervals
in the run must have an
effective heart rate less
than 50 bpm (OR, PACU,
ICU, ED) or 60 bpm (NICU).

V Fib/V Tach Lethal High ECG waveform indicates
a chaotic ventricular
rhythm.
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Alarm message Arrhythmia analysis Alarm priority default Arrhythmia detection
criteria

V Tach Lethal According to priority
setting.
Always High if V Tach
duration >30 seconds,
and HR >180 bpm in
NICU or >150 bpm in
other software packages,
and HR is over the user
adjusted HR high limit.

A run of PVCs is detected
with a run length of six
beats or more and the
effective HR and V Tach
duration meets the user
defined criteria.

VT>2 Full According to priority
setting

A run of PVCs is detected
with a run length of more
than two beats but less
than the six beats. In
addition at least two
consecutive RR intervals
in the run must have an
effective HR that exceeds
100 bpm.

About the arrhythmia detection
When an ECG signal is detected at the start of monitoring, the arrhythmia detection
algorithm begins acquiring and analyzing QRS complexes in the leads used for
arrhythmia detection. This phase is known as learning. Once learning is complete, the
dominant QRS complex is stored as a reference template. Reference template is used
as a normal morphology of that patient and it is compared with incoming beats to
identify possible arrhythmias.

The EK-Pro arrhythmia detection algorithm is used. EK-Pro simultaneously analyzes
leads I, II, III, and V. Once learning is complete, the dominant QRS complex becomes
the template. When a PDM with an ongoing ECG measurement is connected, the
system shall provide the EK-Pro V11 arrhythmia detection from the PDM until the
monitor’s EK-Pro13 algorithm has learned the ECG rhythm and starts to provide the
arrhythmia detection.

The algorithm uses continuous correlation, incremental template updating and
contextual analysis. Continuous correlation attempts to find the best match between
each incoming complex and the set of stored (learned) templates. If no match is
found with the existing template, a new template is stored for the identified new
QRS shape. Incremental template updating allows information from each beat, that
correlates over time, to be reflected in the associated template. Contextual analysis
uses information from neighboring QRS complexes along with existing template
measurements to make the best possible decision regarding the beat’s origin (e.g.,
early, wide).
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Arrhythmia troubleshooting
Problem Solution

Why is themonitor alarming for asystole, bradycardia,
pause, or inaccurate heart rate when a visible QRS
waveform is present?

The monitor may not be detecting sufficient QRS
amplitude in all analyzed leads. Multiple leads are
used for arrhythmia processing.

1. Assess the patient.

2. Check the ECG signal acquired from the patient.

3. View all ECG leads to assess the amplitude of the
QRS complexes. To ensure correct HR readings,
a 0.5 mV QRS amplitude is recommended for a
normal ECG signal. If the QRS amplitude drops
below 0.5 mV or an abnormal QRS width occurs
(more than 120 ms), QRS detection may be
reduced, leading to false Asystole alarms.

4. Relearn arrhythmia. It is important to relearn
the patient’s ECG pattern any time the electrode
configuration is adjusted.

5. The ECG size settings affect the arrhythmia
detection and heart rate calculation. Increase the
ECG size by selecting a value from the ECG Size list.

If the problem continues, switch to the ECG lead
with the greatest amplitude, display that lead, then
switch to single lead analysis so all arrhythmia
interpretations are based on this single ECG lead.

How does the IntelliRate algorithm impact an
Asystole alarm with a QRS waveform?

Intellirate will report Asystole when the following
conditions are met:

● The ECG HR has been valid and has changed by
1/min or less during the previous 30 seconds.

● The invasive pressure pulse rate has been valid for
the previous 60 seconds, and it has been 0/min
during the previous 30 seconds.

● The mean arterial blood pressure of the invasive
pressure pulse rate source is below the user-
selected limit.

● The SpO2 parameter if available does not indicate
beat detections in the previous 30 seconds.

Why is the monitor calling V Tach when the patient is
not in V Tach?

The monitoring system may be detecting a wider
QRS complex or artifact in some of the analyzed ECG
waveforms. In addition, the V leads may be exhibiting
polarity changes, which may occasionally cause an
inaccurate call.

1. Assess the patient.

2. Check the ECG signal acquired from the patient.

● View all ECG leads to assess the width of the
QRS complexes in the analyzed leads.

● If artifact exists in any of the analyzed leads,
reprep the patient’s skin, replace electrodes,
and adjust the electrode placement.
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Problem Solution

● It may be beneficial to move V lead electrodes
(chest lead) to alternate precordial electrode
placements to improve detection.

3. Relearn arrhythmia. It is important to relearn
the patient’s ECG pattern any time the electrode
configuration is adjusted.

If the problem continues, determine the lead with
the narrowest QRS complex, display that lead, then
switch to single lead analysis so all arrhythmia
interpretations are based on this single ECG lead.

ST detection

About the ST analysis
NOTE Multi-lead ST Analysis license only.

If enabled, ST analysis starts automatically after the ECG leads have been connected
and QRS detection has started. The message Learning displays within each QRS
complex window. Once the program has completed the learning phase, ST values are
updated every 10 seconds, QRS complexes every 40 seconds.

ST detection with PDM and E-modules
During the learning period, the algorithm uses the isoelectric reference and the J+
reference points to calculate the ST values. The algorithm automatically searches for
the J and ISO points. These settings can be adjusted for the current patient.

ST detection measurement limitations
● ST values may be affected by such factors as some drugs or metabolic and

conduction disturbances.

● Since ST is often calculated with a fixed delay from the J point, changes in heart
rate may affect ST.

● The ST algorithm has been tested for accuracy of the ST segment data. The
significance of the ST segment changes needs to be determined by a physician.

ST detection points to note
ST segment deviations are not displayed for patients with ventricular pacemakers or
if the rhythm is considered as from ventricular origin.

Starting the ST detection
1. Select the ST parameter window or select the HR parameter window and the ST

tab.

2. Select Setup.

3. Select On from the ST Analysis list.
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Selecting leads to the ST window
1. Select the ST parameter window.

2. Select Setup.

3. Select the leads for display from the ST Window list.

Choices are:

● ST Leads: Displays the first three ST leads. The ST lead with the greatest
deviation is also displayed in the parameter window to the right of the ST leads.

● All Leads: Displays anterior, inferior, and lateral lead groups.

● Off: No ST parameter window is displayed. Instead, two ECG waveforms are
displayed beside the HR field (if ECG2 has been selected to the screen).

Changing the displayed ST leads
You can select the display order of the first, second, and third displayed ST lead.

1. Select the ST parameter window.

2. Select Setup.

3. Select a lead from the ST Leads list.

Adjusting the ST point manually
This selection is not available with combination monitoring.

● E-modules and PDM automatically set the ST point according to the heart rate.
Manual adjustments may be required if the following automatic settings are not
adequate for example when QT time is short:

￭ If the heart rate is greater than or equal to 120 bpm, then the ST point is set
to J + 60 ms.

￭ If the heart rate is less than 120 bpm, then the ST point is set to J + 80 ms.

Manually adjusting the ST Point, ISO Point, or J Point overrides the automatic
detection of the ST point. As a result, you are responsible for monitoring the patient
ST levels with new adjustments and required to make further setting adjustments as
necessary according to changes in the patient’s rhythm.

1. Select the ST parameter window.

2. Select Setup.

3. Select a value from the ST Point list.

Adjusting the isoelectric measurement (ISO) point
E-modules and PDM automatically set the isoelectric point. Manual adjustments may
be required if, for example, a P-wave is attached to the QRS-wave.

1. Select the ST parameter window.

2. Select Setup.

3. Adjust the ISO Point with the arrows.

When the ISO Point is adjusted, also the ST point changes accordingly and its
automatic setting is stopped.
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Adjusting the J point
This selection is not available with combination monitoring.

1. Select the ST parameter window.

2. Select Setup.

3. Adjust the J Point with the arrows.

When the J Point is adjusted, also the ST point changes accordingly.

About the realtime QRS/ST complexes
This feature is not available with combination monitoring.

The initial reference QRS is stored and used as a comparison against the incoming
QRS complexes. The current complex is superimposed over the reference complex in
order to visually assess the change in each QRS complex. QRS complexes are updated
every 40 seconds with PDM and every 10 seconds with E-modules. Current ST values
in millimeters shall be displayed in each QRS window. Numeric values are updated
every 10 seconds.

About the reference QRS
PDM and E-modules save the initial reference QRS up to three minutes after the ECG
measurement is started. With PDM or E-modules up to six additional reference QRS
complexes can be stored manually.

Each QRS reference is identified with the date and timestamp.

If a new reference QRS complex is saved and there is no room for another reference
complex, then the oldest manual or automatic reference complex is erased.

Saving a reference QRS manually
This selection is not available with combination monitoring.

You cannot save a reference QRS manually until an initial reference QRS complex has
been saved, or if ST Analysis is disabled.

1. Select the ST parameter window.

2. Select Realtime View.

3. Select Save Reference.

The current QRS becomes the new reference QRS.

Automatic saving of reference QRS complexes
The QRS reference is not saved during an ST alarm condition, only the ST snapshot
is saved.

If a new reference QRS complex is saved and there is no room for another complex,
then the oldest manual or automatic complex is erased. You may want to manually
erase QRS complexes to avoid automated erasing.

A reference QRS complex is saved automatically whenever you do one of the following:

● Change the Va or Vb lead.

● Change the ST point manually.
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Selecting a saved reference QRS complex for display
This selection is not available with combination monitoring.

You can select and display a saved reference QRS for ST analysis.

1. Select the ST parameter window.

2. Select Realtime View.

3. Select a saved reference from the Reference QRS list.

Erasing a reference QRS
This selection is not available with combination monitoring.

You cannot erase the initial reference QRS.

1. Select the ST parameter window.

2. Select Realtime View.

3. Select a reference QRS from the Erase Reference list.

If you delete the reference QRS currently displayed, then the next, newer reference
QRS is displayed as the reference QRS.

Printing a realtime QRS/ST report

This selection is not available with combination monitoring.

The QRS/ST report displays the current ST leads and the trends at 10 minute intervals.

1. Select the ST parameter window.

2. Select Realtime View.

3. Select Print QRS/ST.

4. To stop printing, select Cancel Printing.

Viewing QRS and ST in a split screen
In the split screen window, you can view the reference QRS complex, current QRS
complexes, and ST trends.

1. Select Monitor Setup from the monitor’s main menu.

2. Select Screen Setup.

3. Select Split Screen

4. Select ST to view an ST/QRS split screen.

Selecting the ST time scale
This selection is not available with combination monitoring.

This setting also determines the length of the ST trend report, and you can select it
from the Realtime View or the Trend View.

1. Select the ST parameter window.

2. Select Realtime View or Trend View.
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3. Select a value from the Trend Scales list.

ST trend display
This feature is not available with combination monitoring.

Each QRS window displays the current QRS complex and ST value. The QRS complexes
and current measurement point lines are updated at least every 40 seconds. Each
QRS window has a corresponding trend window displaying the ST trend along with
the trend scale and current time interval. The primary HR trend window is displayed
below the last ST trend window. The ST trends for the available leads are updated
every 10 seconds.

Displaying QRS complexes and ST trends for other leads
This selection is not available with combination monitoring.

1. Select the ST parameter window.

2. Select Trend View.

3. Select a lead group from the Leads list. Choices are:

● ST: The leads displayed in the ST window.

● Anterior: The leads belonging to this lead group.

● Inferior: The leads belonging to this lead group.

● Lateral: The leads belonging to this lead group.

● Display: The leads associated with the waveforms selected for display.

Reviewing ST trends
This selection is not available with combination monitoring.

You can review ST trend values and compare ST trend related QRS complexes with
realtime QRS complexes by using the yellow-colored cursor. The current time of the
cursor is displayed above the cursor. Each yellow-colored trend value is displayed next
to the cursor and ST trend related QRS complexes are drawn in the QRS windows
with the color gray.

1. Select the ST parameter window.

2. Select Trend View.

3. Select the right or left arrow above the QRS view to move the ST cursor.

Printing an ST trend report
This selection is not available with combination monitoring.

The length of the ST trend report is the same as the Trend Scales setting for ST trends.

1. Select the ST parameter window.

2. Select Trend View.

3. Select Print Page.

4. To stop printing, select Cancel Printing.
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Ischemic burden
This feature is not available with combination monitoring.

Ischemic burden provides additional information about the degree of ST changes
during a certain time period. It is a visualization of ischemia. In ST Trend View, the area
between the ST trend and the ischemic burden limit is colored yellow:

Myocardial ischemia appears in the ECG as an ST segment deviation from the
isoelectric line (ISO point). The ST segment generally rises above the isoelectric line in
the presence of transmural ischemia and is below the isoelectric line in the presence of
subendocardial ischemia. The ST measurements are displayed as a numeric value: a
negative (-) number indicates ST depression; a positive number indicates ST elevation.

ST depression ST elevation

Enabling ischemic burden
This selection is not available with combination monitoring.

1. Select the ST parameter window.

2. Select Trend View.

3. Select Ischemic Burden.

4. Select the check box for Ischemic Burden.

Setting the ischemic burden limits
This selection is not available with combination monitoring.

You can set the lower and upper threshold values.

1. Select the ST parameter window.

2. Select Trend View.

3. Select Ischemic Burden.

4. Set the lower threshold value with the Depression Limit (mm) arrows.

5. Set the upper threshold value with the Elevation Limit (mm) arrows.

ST alarm limits
Depending on what has been selected in the Care Unit Settings for ST alarms, you
may set the ST alarm limits for a lead group, for individual leads, or for all leads relative
to the patient’s current measurements.

The leads associated with each lead group are as follows:
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● Anterior: V1, V2/dV2, V3/dV3, V4/dV4.
● Inferior: II, III, aVF.
● Lateral: V5, V6/dV6, I, aVL.
The d in dV2, dV3, dV4, and dV6 above represents the derived lead value.

Setting alarm limits for lead groups
1. Select the ST parameter window.

2. Select Alarms.

3. Select Alarm On for an ECG lead group: Anterior, Inferior, or Lateral.

If the alarm is locked, there is a lock symbol beside the selection and the selection
is not available.

4. Set upper and lower alarm limits with the arrows.

Setting alarm limits for individual leads
1. Select the ST parameter window.

2. Select Alarms.

3. Select Alarm On for an ECG lead to adjust its alarm limits.

If the alarm is locked, there is a lock symbol beside the check box and the
selection is not available.

4. Set High and Low alarm limits with the arrows.

Setting relative alarm limits
You can adjust the high/low alarm limits set around the current ST value for all of the
individual ST leads or for the leads in a selected lead group. For example, when you
select a Relative Auto Limits value of 2 mm, the high limit is set at the current ST value
+2 mm, and the low limit is set at the current ST value -2mm.

1. Select the ST parameter window.

2. Select Alarms.

3. Select Relative Auto Limits.

4. Set the relative limits as needed:
● Set All Limits with the arrows and select Update All.
● Set limits for Anterior leads with the arrows and select Update Anterior.
● Set limits for Inferior leads with the arrows and select Update Inferior.
● Set limits for Lateral leads with the arrows and select Update Lateral.

QT detection
This selection is not available with combination monitoring.

With Multi-lead QT/QTc Analysis license only.

The administration of some drug types can prolong the QT segment. Monitoring QT
segment changes can help identify how these drugs are affecting the QT segment.

QT/QTc measurement limitations
● Not available with combination monitoring.
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● At least one measured V-lead must be available in order for the algorithm to
process QT.

● QT/QTc values are calculated with 5-leadwire, 6-leadwire, or 10-leadwire ECG
cables.

Starting the QT/QTc measurement
This selection is not available with combination monitoring.

1. Select the HR parameter window.

2. Select the QT tab.

3. Select On from the QT Analysis list.

Setting QT/QTc alarms
This selection is not available with combination monitoring.

1. Select the HR parameter window.

2. Select the QT tab.

3. Select Alarms.

4. Select Alarm On.

5. Adjust the alarm limits with the arrows.

Selecting QT or QTc for analysis
This selection is not available with combination monitoring.

1. Select the HR parameter window.

2. Select the QT tab.

3. Select QT or QTc from the Show list.
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Impedance respiration

Impedance respiration compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

Respiration safety precautions

Respiration warnings
WARNING Make sure that the leadwire set clips or snaps do not touch

any electrically conductive material including earth.

WARNING The impedance respiration measurement is inherently
very sensitive as it measures very small physiological
signals (changes of impedance of the patient’s chest
area). Electromagnetic interference may cause erroneous
measurements at various frequencies, for example
interference with the signal/ waveform, leading to respiration
rate readings inconsistent with the patient's true respiration
rate. If you notice this, use another form of respiration
monitoring, for instance end-tidal CO2.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.

WARNING APNEA EVENTS. The monitor may not detect all episodes of
inadequate breathing, nor does it distinguish between central,
obstructive, and mixed apnea events.

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires.
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WARNING ELECTRODE CONFIGURATION. Impedance respiration
monitoring is not reliable when ECG electrodes are placed
anywhere but on the chest.

WARNING ELECTRODES. Whenever patient defibrillation is a possibility,
use non-polarizing (silver/silver chloride construction)
electrodes for ECG monitoring. Polarizing electrodes (stainless
steel or silver constructed) may cause the electrodes to retain
a residual charge after defibrillation. A residual charge will
block acquisition of the ECG signal.

WARNING PDM. If the Cardiac Artifact Alarm is turned off, apnea events
may not be detected.

Respiration cautions
CAUTION The impedance respiration measurement may cause rate

changes in Minute Ventilation Rate Responsive Pacemakers.
Set the pacemaker rate responsive mode off (PDM only) or turn
off the impedance respiration measurement on the monitor.

Respiration measurement limitations
● PSM: Impedance respiration is intended for patients over three years old.

● Electrical devices, such as electrosurgery units and infrared heaters, that emit
electromagnetic disturbance, may cause artifacts or disable the respiration
measurement completely.

● Movement artifacts, shivering, and interference from the heart may interfere with
the respiration measurement.

Respiration points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● Connect only one impedance respiration module to the monitor simultaneously.

● Do not place electrodes on obvious layers of fat, or major muscles.

● Make sure the electrode gel is moist.

● Make sure electrodes have good skin contact.

● Depending on the respiration module used, not all respiration measurements and
settings are available to view or change.

● Since respiration monitoring is so closely linked with ECG monitoring, patient
preparation and electrode placement are important.

● Intermittent mechanical ventilation: During spontaneous breathing the ventilator
may at times support the patient’s ventilation with an extra inspiration. If these
ventilator inspirations are substantially larger than the spontaneous breaths, the
respiration calculation may mistakenly count only the inspirations and expirations
produced by the ventilator.

186 CARESCAPE Monitors B850, B650, B450 2105822-001



Impedance respiration

Respiration measurement setup

Respiration equipment to patient connection

1. Module with ECG measurement capability

2. AAMI/AHA or IEC Multi-Link 3/5-lead, 6-lead, or 12SL ECG cable

3. AAMI/AHA or IEC 3-leadwire, 5-leadwire, or 6-leadwire set

4. AAMI/AHA or IEC precordial leads leadwire set

Preparing the patient’s respiration electrode sites
Excessive body hair or skin oil reduces electrode contact with the skin and decreases
the quality of electrode signal.
When preparing the electrode sites, avoid obvious layers of fat and major muscles.

1. Shave any hair from the electrode site.

2. Gently rub the surface of the skin to increase capillary blood flow.

3. Clean the skin with alcohol or a mild soap and water solution to remove skin oil
and dead or abraded skin cells.

4. Dry the skin completely before applying the electrodes.

Respiration lead and breath detection
Respiration leads identify the ECG leads used for respiration measurement. Each
respiration lead is suited for specific breath detection conditions:
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Lead Description Available with modules

Lead I Best for detecting thoracic
breathing, but is more
susceptible to cardiogenic
artifact.

PDM, PSM

Lead II Equally good at detecting
thoracic or abdominal
breathing, but is more
susceptible to cardiogenic
and motion (head, neck, or
arm) artifact.

PDM, PSM
PSM uses the ECG lead selection if the
measurement mode is 3-lead and Lead
II if the measurement mode is 5-, 6-,
or 10-leadwire set. If any electrode is
disconnected, the remaining lead (I, II or
III) is used, if possible.

Lead RL-LL Best at detecting abdominal
breathing and is not as
susceptible to cardiogenic or
motion artifact.
The RL-LL respiration lead is
available with PDM only.

PDM
Not available for 3-lead measurement.

If you are monitoring with a fixed-lead, 3-lead cable, respiration can only be obtained
from the lead for which the cable is manufactured. For example, if the cable is a
fixed lead II cable, as indicated by a label on the cable itself, respiration can only
be obtained from lead II.

PDM: Even though the same electrodes are used for ECG and respiration monitoring,
it is possible to get a lead fail message for respiration without one for ECG. The
impedance may be too high for respiration detection, but the electrode is still good
for ECG.

Respiration lead I electrode placement

ECG lead I for upper chest breather

IEC AAMI/AHA Electrode placement

R (red) RA (white) Just below the right clavicle.

L (yellow) LA (black) Just below the left clavicle.
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Respiration lead II electrode placement

ECG lead II for chest or upper abdominal breather

IEC AAMI/AHA Electrode placement

R (red) RA (white) Just below the right clavicle.

F (green) LL (red) Lower left edge of the rib
cage.

Respiration lead RL-LL electrode placement
NOTE The RL-LL respiration lead is available with PDM only.

When monitoring respiration through the RL-LL vector, use a standard 5- or 6-leadwire
electrode placement, except place the RL electrode on the fifth intercostal space on
the right side of the chest. Impedance respiration lead between V5R and LL provides
maximum respiration signal strength, minimum noise/artifact content, and minimum
cardiogenic artifact.

RL-LL vector for abdominal breather

IEC AAMI/AHA Electrode placement

N (black) RL (green) Fifth intercostal space on the
right.

F (green) LL (red) Lower left edge of the rib
cage.
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Respiration measurement checks
1. Check that the waveform and parameter value are displayed when the cable is

connected to the patient.

NOTE There may also be a respiration rate value displayed in the
CO2 parameter window. Only the value in the respiration
parameter window is measured from the impedance
respiration source.

Respiration measurement on the monitor screen
● The spikes in the waveform indicate detected inspiration and expiration.

● PDM: A text similar to APN 15 s indicates the value to which the apnea alarm delay
is set. In this example, the value is set to 15 seconds. It means that the apnea
alarm will activate after 15 seconds from the last detected breath.

Using the respiration measurement

Turning on the respiration measurement
The respiration measurement does not start automatically, so you must select it on.

1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select Respiration Measurement > On.

Selecting the respiration lead
NOTE PDM only. In addition, the RL-LL respiration lead is available

with PDM only.

1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select lead I, II, or RL-LL from the selection list on the right. Lead selections are
presented as graphical icons.

Selecting the respiration waveform size manually
1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select a value from the Size list.

The greater the value, the larger the waveform size.

Selecting the respiration waveform size automatically
NOTE PDM only.

You can automatically size the waveform to fit the available space.

1. Select the impedance respiration parameter window.
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2. Select the Setup tab.

3. Select Autosize Waveform.

Selecting the waveform speed
1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select a value from the Resp Sweep Speed list.

The lower the value, the slower the sweep speed.

Selecting the waveform sensitivity
Breath detection accuracy may be enhanced by increasing or decreasing the
waveform sensitivity.

1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select a value from the Sensitivity list.

The lower the value, the greater the sensitivity.

Enabling respiration smoothing
NOTE PDM only.

When respiration smoothing is enabled, 10 seconds of respiration rate values are
averaged. You can use this feature to smooth out rapid changes in the respiration
rate values.

1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select the Imped. Resp Smoothing check box to enable smoothing. Deselect it
to disable smoothing.

Relearning the respiration pattern
NOTE PDM only.
If the patient’s breathing pattern changes after the initial learning process has taken
place, it may be necessary to relearn. There is no respiration rate displayed during the
relearning process. When relearning is complete, the Relearn Respirationmessage
will clear and the respiration rate will be displayed. The detection threshold and the
waveform size update after the new respiration pattern is learned.

1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select Relearn Respiration.

The detection threshold (sensitivity) and the waveform size update after the new
respiration pattern is learned.
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Turning on or off the respiration rate alarm
1. Select the impedance respiration parameter window.

2. Select the Alarms tab.

3. Select Alarm On or Alarm Off for the Resp Rate (Impedance).

If you select Alarm Off, you cannot adjust the alarm limits. If informational priority
level has been selected for the alarm, the menu selections are Message On and
Message Off.

Setting the respiration alarm limits
1. Select the impedance respiration parameter window.

2. Select the Alarms tab.

3. Set the Respiration Rate limits with the arrow selectors.

Setting the apnea alarm delay
NOTE PDM only. The delay for the PSM is always 20 seconds.

You can select the apnea alarm delay by defining seconds in the Apnea Limit Seconds
setting (3 - 30 seconds). If anything else than the default (20 seconds) is selected, the
selected seconds are displayed in the parameter window.

1. Select the impedance respiration parameter window.

2. Select the Alarms tab.

3. Set the Apnea Limit Seconds with the arrow selectors.

Configurable respiration alarm delays
Alarm delays for RR (Imped) high and RR (Imped) Low are configurable from 0 to 30
seconds in increments of 5 seconds. These delays are set through Default Setup >
Profile Settings > Alarm Delays and they are password protected.

You can check the delays through Impedance Respiration > Alarms > Priorities &
Delays Info.

For more information, see the supplemental information manual.

Enabling the respiration cardiac artifact alarm
NOTE PDM only.

The cardiac artifact alarm can be enabled to display the Cardiac artifactmessage
when the respiration rate is within 5% of the ECG heart rate. It takes about 30 breaths
before the module detects a cardiac artifact alarm condition.

1. Select the impedance respiration parameter window.

2. Select the Alarms tab.

3. Select Cardiac Artifact > Alarm On.
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Respiration alarm priorities
You can select priorities for the Apnea (Impedance) and RR (Impedance) high/low
alarms through Alarm Setup > Alarm Priorities > Other Parameters. The available
choices depend on what has been allowed in the Care Unit Settings (password
protected setting). If all priorities have been allowed, you can select one of the
following:
● Escalating
● High
● Medium
● Low
● Informational.

NOTE If the RR (Impedance) high/low alarm delay has been enabled
in the Care Unit Settings (password protected) and you select
priorities High, Medium, Low, or Informational, a prompt
text will appear on screen indicating that alarm delay has
been selected.

Checking alarm delays and priorities information
You can check which alarms have priority settings that deviate from the
recommendation of international safety standards, and also the delays selected for
each alarm.

1. Select the impedance respiration parameter window.

2. Select the Alarms tab.

3. Select Priorities & Delays Info.

4. Check the priorities and delays.

Turning off the respiration measurement
1. Select the impedance respiration parameter window.

2. Select the Setup tab.

3. Select Respiration Measurement > Off.

Respiration measurement description
When starting respiration monitoring, the system “learns” the patient’s respiration
pattern. The respiration rate is calculated from impedance changes and a respiration
waveform is displayed.

Respiration measurement with PSM
With impedance respiration Sensitivity set to AUTO, two breaths are averaged and
the average amplitude of the respiration waveform is found. Detection sensitivity
is automatically set at one half of the average amplitude. Sensitivity dotted lines
displayed on the waveform show the minimum detection range which is 25%. The
percentage is the ratio to the reference bar on the left in the waveform display, which
corresponds to 100%.The user can manually set the impedance respiration Sensitivity
to 20%, 40%, 60%, 80%, or 100% and the sensitivity dotted lines displayed on the
waveform will show the selected detection range. The percentage is shown with a
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reference bar that corresponds to 100%, meaning that the 100% selection uses the
whole drawing area. The bar is on the left in the waveform display.

Respiration measurement with PDM
Eight breaths are averaged and the average amplitude of the respiration waveform
is found. Detection sensitivity is automatically set at 40% of the average amplitude.
Sensitivity dotted lines displayed on the waveform show this 40% detection range.
Once learning is complete, the user can adjust the detection sensitivity to 10, 20,
30, 40, 50, 60, 70, 80, or 90%.

How to interpret the respiration values
The following is an example of a regular and even respiratory waveform, with the
inspiration and expiration markers identified (1 = inspiration marker, 2 = expiration
marker).

Respiration troubleshooting
Problem Solution

What can I do if the respiration measurement fails? ● Check electrode quality and positioning.

● Adjust the breath detection sensitivity. During
ventilator-supported breathing, the respiration
calculation may count only ventilator-produced
inspirations and expirations.

● Other electrical devices may interfere with the
measurement.

Why does the waveform have a combination of
shallow and deep breaths, but the monitor is not
detecting the shallow breaths?

If the detection sensitivity threshold is set too high,
shallow breaths will not be detected, as shown in the
following example of incorrect detection (1 = breath).

● Decrease the detection sensitivity percentage until
the markers correctly identify each inspiration and
expiration or set to AUTO (PSM). If the detection
mode is AUTO, the grid lines represent the
minimum limits. The limits in use may be a larger
range. The following is an example of correct
detection.

Respiration detection is not dependent on the size of
the waveform. Size is for visual purposes only.

Why is the monitor detecting cardiac artifact as
breaths?

The breath detection threshold is too low (1 = breath,
2 = artifact). The following is an example of incorrect
detection.
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Problem Solution

● Increase the detection sensitivity percentage until
the markers correctly identify each inspiration and
expiration. The following is an example of correct
detection.
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Pulse oximetry

SpO2 compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

SpO₂ safety precautions

SpO2 warnings
WARNING The operator is responsible for checking the compatibility of

the pulse oximetry monitor, sensor, and patient cable prior
to use. Incompatible components can result in degraded
performance and/or device malfunction.

WARNING If the accuracy of any measurement does not seem
reasonable, first check the patient’s vital signs, then check for
conditions that may cause inaccurate SpO2 readings. If the
problem is still not resolved, check the monitor and the SpO2
module, cable, or sensor for proper functioning.

WARNING A pulse oximeter should not be used as an apnea monitor. A
pulse oximeter should be considered an early warning device.
As a trend toward patient deoxygenation is indicated, blood
samples should be analyzed by a laboratory CO-oximeter to
completely understand the patient's condition.

WARNING Check that the pulse oximetry waveform is physiological
in shape to ensure waveform quality and minimize noise
spikes caused by motion conditions. (Not applicable when
monitoring SpO2 with Masimo SET technology.)

WARNING To prevent erroneous readings, do not use physically
damaged sensors, cables or modules. Discard a damaged
sensor or cable immediately. Never repair a damaged sensor
or cable; never use a sensor or cable repaired by others.

WARNING Pulse rate measurement is based on the optical detection of
a peripheral flow pulse and therefore may not detect certain
arrhythmias. The pulse oximeter should not be used as a
replacement or substitute for ECG-based arrhythmia analysis.
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WARNING Cable/sensor after care:
● Do not reuse sensors intended for single patient use.
● Do not sterilize sensors or patient cables by irradiation,

steam, or ethylene oxide.
● Clean the surface of the probe before and after each

patient use.
● Allow sensor and cable to dry completely after cleaning.

Moisture and dirt on the connector can affect the
measurement accuracy.

● If a probe is damaged in any way, discontinue use
immediately.

● Inaccurate SpO2 data can result if a sensor is past its useful
life. Therefore, re-evaluate the measurement periodically
by performing additional assessment of the patient and
equipment, including consideration of use of alternate
monitoring methods such as direct measurement of
arterial oxyhemoglobin saturation (SaO2).

● A damaged sensor may cause burns during electrosurgery.

WARNING Oximetry performance may be impaired when patient
perfusion is low or signal attenuation is high.

WARNING NEONATAL. The display of inaccurate pulse oximetry (SpO2)
values has been linked to the presence of poor signal strength
or artifact due to patient motion during signal analysis. This
condition is most likely to be encountered when the monitor is
used on neonates or infants. These same conditions in adults
do not impact the SpO2 values to the same extent.
We recommend the application of the following criteria when
using the pulse oximetry function on neonates and infants:
● The peripheral pulse rate (PPR) as determined by the SpO2

function must be within 10% of the heart rate, and
● The SpO2 signal strength should be adequate. This is

indicated by the display of two or three asterisks or the
absence of the Low signal qualitymessage.

Procedures or devices previously applied in your facility for
SpO2 monitoring should be used in the event the SpO2 value
from the monitor cannot be validated by the above criteria.

WARNING Many factors may cause inaccurate readings and alarms,
decreased perfusion, and or low signal strength:
● Interfering substances:

￭ Carboxyhemoglobin may erroneously increase SpO2
reading.

￭ Methemoglobin (MetHb) usually represents less than 1%
of the total Hb, but in the case of methemoglobinemia
that can be congenital or induced by some IV dyes,
antibiotics (such as sulphas,) inhaled gases etc. this
level increases sharply and thus can cause inaccuracies
in the SpO2 reading.

￭ Intravascular dyes (such as indocyanine green,
methylene blue, etc.)
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● Physiological characteristics:
￭ Cardiac arrest
￭ Hypotension
￭ Shock
￭ Severe vasoconstriction
￭ Severe anemia
￭ Hypothermia
￭ Venous pulsations
￭ Darkly pigmented skin
￭ Ventricular septal defects (VSDs)

● Environmental conditions:
￭ Excessive ambient light
￭ Electrical interference
￭ Electrosurgery
￭ Defibrillation - May cause inaccurate reading for a short

amount of time.
￭ Excessive patient/sensor motion. Artifact can simulate

an SpO2 reading, so that the monitor fails to sound an
alarm. In order to ensure reliable patient monitoring, the
proper application of the probe and the signal quality
must be checked at regular intervals.

￭ Improper connection to the monitor or interconnect
cable

￭ Contaminants on the sensor in the optical path
● Sensor placement:

￭ Incorrect sensor placement - prolonged monitoring or
incorrect sensor application can cause skin irritation or
impaired circulation. It is recommended that you check
the probe site every four hours (more frequently for poor
perfusion or for neonates). Refer to the instructions
supplied with the sensor.

￭ Sensor placement on the same extremity as a blood
pressure cuff, arterial catheter or intravascular line; or
arterial occlusion proximal to the sensor.

￭ Poor sensor fit.
￭ Do not allow tape to block the sensor light emitter and

detector.

WARNING FAILURE TO DETECT LETHAL ARRHYTHMIA. Always monitor
ECG for arrhythmia detection purposes. HR calculated from
pulsatile SpO2 waveform may differ significantly from ECG HR
measured values. Users should be aware that the SpO2 probe
off and No SpO2 pulse technical alarms escalate no higher
than a Medium priority.
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WARNING FAILURE TO DETECT LETHAL ARRHYTHMIA.The SpO2 parameter
pulsatile heart rate measurement is based on the optical
detection of a peripheral flow pulse and therefore may not
detect certain arrhythmias. The pulse oximetry parameter
should not be used as a replacement or substitute for ECG
based arrhythmia analysis.

WARNING Using the Maximum sensitivity setting delays the SpO2 probe
off detection alarm.

WARNING With deactivated SpO2 probe off alarm, keep the patient
under close surveillance.

WARNING MISSED ALARM. Check the SpO2measurement when switching
the SpO2 measurement sources to avoid missed SpO2 alarms.

The yellow warning triangle on the E-PSMP and PDM refers to the following warning:

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires. Using other cables or leadwires may
result in damage to the equipment and compromise patient
and user safety.

SpO2 cautions
CAUTION A damaged sensor or a sensor soaked in liquid may cause

burns during electrosurgery.

CAUTION Prolonged monitoring or incorrect sensor application can
cause skin irritation or impaired circulation. It is recommended
that you check the probe site every four hours (more
frequently in case of poor perfusion or neonatal patients).
Refer to the instructions supplied with the sensor.

SpO2 measurement limitations
● Other E-modules than E-MASIMO and E-NSATX used for this measurement are not

suitable for use with neonatal patients.

● The pulse oximeter cannot distinguish between oxyhemoglobin and
dyshemoglobins.

● Poor perfusion may affect the accuracy of measurement, especially when using
an ear sensor.

● To avoid erroneous measurements, do not use a blood pressure cuff on the same
limb as the SpO2 sensor.

SpO2 points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.
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● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● For more detailed information regarding sensor accuracies, refer to the
supplemental analysis graphs provided.

● Use dry and clean sensors only.

● Do not use damaged sensors.

● Check that you are not re-using a disposable sensor or other disposable
accessories.

● The recommended maximum application times for different sensor types: refer to
the sensor instructions for use

● Primary and secondary SpO2 sites may be measured.

● Always check the patient and the sensor site if the accuracy of the SpO2 values is
questionable.

● Depending on the SpO2 module used, not all SpO2 measurements and settings
are available to view or change.

● With Nellcor Oximax and Masimo SET technologies, the pulse oximetry waveform is
a normalized waveform. It is not normalized with GE Ohmeda technology.

● SpO2 signal strength indicators are displayed for all modules except Unity Network
Interface Device (ID).

● There are three supported pulse oximetry technologies:

￭ Masimo SET: PDM and E-MASIMO.

￭ Nellcor OxiMax: PDM and E-NSATX.

￭ GE Ohmeda: E-PSMP.

Masimo safety precautions
The pulse oximetry device is to be operated by, or under direct supervision of,
qualified personnel only. The manual, accessories, directions for use, all precautionary
information, and specifications should be read before use.

Masimo warnings
WARNING As with all medical equipment, carefully route patient

cabling to reduce the possibility of patient entanglement or
strangulation

WARNING Do not place the pulse oximetry device or accessories in any
position that might cause it to fall on the patient.

WARNING Do not start or operate the pulse oximetry device unless the
setup was verified to be correct.

WARNING Do not use the pulse oximetry device during magnetic
resonance imaging (MRI) or in an MRI environment.

WARNING Do not use the pulse oximetry device if it appears or is
suspected to be damaged.
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WARNING Explosion hazard: Do not use the pulse oximetry device in
the presence of flammable anesthetics or other flammable
substance in combination with air, oxygen-enriched
environments, or nitrous oxide.

WARNING To ensure safety, avoid stacking multiple devices or placing
anything on the instrument during operation.

WARNING To protect agains injury, follow the directions below:
● Avoid placing the device on surfaces with visible liquid spill.
● Do not soak or immerse the device in liquids.
● Do not attempt to sterilize the device.
● Use cleaning solutions only as instructed in this user’s

manual
● Do not attempt to clean the device while monitoring a

patient.

WARNING To protect from electric shock, always remove the sensor
and completely disconnect the pulse oximetry device before
bathing the patient.

WARNING If any measurement seems questionable, first check the
patient’s vital signs by alternate means and then check the
pulse oximetry device for proper functioning.

WARNING Inaccurate SpO2 readings may be caused by:
● Improper sensor application and placement
● Elevated levels of COHb or MetHb: High levels of COHb

or MetHb may occur with a seemingly normal SpO2.
When elevated levels of COHb or MetHb are suspected,
laboratory analysis (CO-Oximetry) of a blood sample should
be performed.

● Elevated levels of bilirubin
● Elevated levels of dyshemoglobin
● Vasospastic disease, such as Raynaud’s, and peripheral

vascular disease
● Hemoglobinopathies and synthesis disorders such as

thalassemias, Hb s, Hb c, sickle cell, etc.
● Hypocapnic or hypercapnic conditions
● Severa anemia
● Very low arterial perfusion
● Extreme motion artifact
● Abnormal venous pulsation or venous constriction
● Severe vasoconstriction or hypothermia
● Arterial catheters and intra-aortic balloon
● Intravascular dyes, such as indocyanine green or

methylene blue
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● Externally applied coloring and texture, such as nail polish,
acrylic nails, glitter, etc.

● Birthmark(s), tattoos, skin discolorations, moisture on skin,
deformed or abnormal fingers, etc.

● Skin color disorders

WARNING Interfering Substances: Dyes or any substance containing
dyes that change usual blood pigmentation may cause
erroneous readings.

WARNING The pulse oximetry device should not be used as the sole
basis for medical decisions. It must be used in conjunction
with clinical signs and symptoms.

WARNING The pulse oximetry device is not an apnea monitor.

WARNING The pulse oximetry device may be used during defibrillation,
but this may affect the accuracy or availability of the
parameters and measurements.

WARNING The pulse oximetry device may be used during electrocautery,
but this may affect the accuracy or availability of the
parameters and measurements.

WARNING The pulse oximetry device should not be used for arrhythmia
analysis.

WARNING SpO2 is empirically calibrated in healthy adult volunteers
with normal levels of carboxyhemoglobin (COHb) and
methemoglobin (MetHb).

WARNING Do not adjust, repair, open, disassemble, or modify the
pulse oximetry device or accessories. Injury to personnel or
equipment damage could occur. Return the pulse oximetry
device for servicing if necessary.

Masimo cautions
CAUTION Do not place the pulse oximetry device where the controls can

be changed by the patient.

CAUTION Electrical shock and flammability hazard: Before cleaning,
always turn off the device and disconnect from any power
source.

CAUTION When patients are undergoing photodynamic therapy they
may be sensitive to light sources. Pulse oximetry may be used
only under careful clinical supervision for short time periods
to minimize interference with photodynamic therapy.

CAUTION Do not place the pulse oximetry device on electrical
equipment that may affect the instrument, preventing it from
working properly.
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CAUTION If the SpO2 values indicate hypoxemia, a laboratory blood
sample should be taken to confirm the patient’s condition.

CAUTION If the Low Perfusion message is frequently displayed, find a
better perfused monitoring site. In the interim, assess the
patient and, if indicated, verify oxygenation status through
other means.

CAUTION Change the application site or replace the sensor and/or
patient cable when a Replace sensor and/or Replace patient
cable, or a persistent poor signal quality message (such as
Low SIQ) is displayed on the host monitor. These messages
may indicate that patient monitoring time is exhausted on the
patient cable or sensor

CAUTION If using pulse oximetry during full body irradiation, keep the
sensor out of the radiation field. If the sensor is exposed to the
radiation, the reading might be inaccurate or the instrument
might read zero for the duration of the active irradiation
period.

CAUTION To ensure that alarm limits are appropriate for the patient
beingmonitored, check the limits each time the pulse oximetry
device is used.

CAUTION Variation in measurements may be profound and may be
affected by sampling technique as well as the patient’s
physiological conditions. Any results exhibiting inconsistency
with the patient’s clinical status should be repeated and/or
supplemented with additional test data. Blood samples
should be analyzed by laboratory instruments prior to clinical
decision making to completely understand the patient’s
condition.

CAUTION Do not submerge the pulse oximetry device in any cleaning
solution or attempt to sterilize by autoclave, irradiation, steam,
gas, ethylene oxide or any other method. This will seriously
damage the pulse oximetry device.

CAUTION Electrical Shock Hazard: Carry out periodic tests to verify that
leakage currents of patient-applied circuits and the system
are within acceptable limits as specified by the applicable
safety standards. The summation of leakage currents
must be checked and in compliance with IEC 60601-1 and
UL60601-1. The system leakage current must be checked
when connecting external equipment to the system. When an
event such as a component drop of approximately 1 meter or
greater or a spillage of blood or other liquids occurs, retest
before further use. Injury to personnel could occur.

CAUTION Disposal of product: Comply with local laws in the disposal of
the instrument and/or its accessories.

CAUTION To minimize radio interference, other electrical equipment
that emits radio frequency transmissions should not be in
close proximity to the pulse oximetry device.
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CAUTION Replace the cable or sensor when a replace sensor or when a
low SIQ message is consistently displayed while monitoring
consecutive patients after completing troubleshooting steps
listed in this manual.

Masimo points to note
● A functional tester cannot be used to assess the accuracy of the pulse oximetry

device.

● High-intensity extreme lights (such as pulsating strobe lights) directed on the
sensor, may not allow the pulse oximetry device to obtain vital sign readings.

● When using the Maximum Sensitivity setting, performance of the Sensor Off
detection may be compromised. If the instrument is in this setting and the sensor
becomes dislodged from the patient, the potential for false readings may occur
due to environmental noise such as light, vibration, and excessive air movement.

● Do not loop the patient cabling into a tight coil or wrap around the device, as this
can damage the patient cabling.

● Additional information specific to the Masimo sensors compatible with the pulse
oximeter, including information about parameter/measurement performance
during motion and low perfusion, may be found in the sensor's directions for use
(DFU).

● Cables and sensors are provided with X-CalTM technology to minimize the risk of
inaccurate readings and unanticipated loss of patient monitoring. Refer to the
Cable or Sensor DFU for the specified duration of the patient monitoring time.

SpO₂ measurement guidelines

GE Ohmeda technology and sensor measurement
guidelines

The following measurement guidelines apply to GE Ohmeda technology:

● The time period for acquiring a measurement average is adjustable.

● The SpO2 waveform corresponds to (but is not proportional to) the arterial pressure
waveform.

● Only TruSignal sensors are supported.

● Use the following guidelines when using TruSignal sensors and cables:

￭ Read the sensor instructions for use of the SpO2 sensor before using it.

￭ Periodically inspect extension cables and sensors for damage.

￭ Do not use damaged sensors.

￭ Refer to the cleaning instructions in the instructions for use of reusable TruSignal
sensors.

￭ Do not use NIBP or constricting instruments on the same appendage as the
SpO2 sensor.
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Masimo SET technology and sensor measurement
guidelines

With motion, the plethysmographic waveform (or SpO2 waveform) is often
distorted and may be obscured by the artifact. With Masimo SET technology, the
plethysmographic waveform is not an indication of signal quality or validity. Even with
a waveform obscured by artifact, Masimo SET technology is able to read through the
noise and locate the arterial pulsation.

Although Masimo SET technology processes SpO2 measurements differently than
other SpO2 technologies, the function and appearance is essentially the same as other
technologies. The following measurement guidelines apply to Masimo SET technology
only:
● The time period for acquiring a measurement average is adjustable.
● Refer to the supplemental information manual for compatible Masimo sensors.

These sensors non-invasively measure pulse rate and the amount of oxygenated
hemoglobin. Use the following guidelines when using Masimo SET sensors:
￭ Read the sensor directions before use.
￭ Only use sensors with Masimo SET technology.
￭ Do not use damaged sensors.
￭ Do not use a sensor with exposed optical components.
￭ Refer to the cleaning instructions in the directions for use for reusable Masimo

SET sensors.

Additional information for MASIMO technology
NO IMPLIED LICENSE: Possession or purchase of this device does not convey any
express or implied license to use the device with unauthorized replacement parts
which would, alone, or in combination with this device, fall within the scope of one
or more of the patents relating to this device. Sensors that are designated for single
use are licensed for use on a single patient only, and are not sold. There is no license,
implied or otherwise, that would allow use of single use Masimo Sensors beyond their
intended single use. After use of single use Masimo Sensors, the license is exhausted,
there is no further license granted by MASIMO, and they must be discarded.

This device is covered under one or more patents as set forth at
http://www.masimo.com/patents.htm.

We recommend the use of Masimo SET sensors for use with Masimo technology.

Nellcor OxiMax technology and sensor measurement
guidelines

The following measurement guidelines apply to Nellcor OxiMax:
● The SpO2 waveform corresponds to (but is not proportional to) the arterial pressure

waveform.
● Only Nellcor OxiMax sensors are supported. Use the following guidelines when

using OxiMax SpO2 accessories and sensors:
￭ Periodically inspect extension cables and sensors for damage and discontinue

use if damage is found.
￭ Do not immerse sensors.

206 CARESCAPE Monitors B850, B650, B450 2105822-001

http://www.masimo.com/patents.htm


Pulse oximetry

￭ Do not use NIBP or constricting instruments on the same appendage as the
SpO2 sensor.

Additional information for Nellcor OxiMax technology
NOTICE: Purchase of this instrument confers no express or implied license under any
Covidien patent to use this instrument with any oximetry, level of consciousness,
regional oxygen saturation and respiration rate, as applicable Sensor that is not
manufactured or licensed by Covidien.

For patients with SpO2 levels in the 60% to 80% range, the LoSat accuracy feature is
available. For more information, see the supplemental information manual.

SpO₂ measurement setup

SpO2 equipment to patient connection

1. Acquisition module with SpO2 measurement capability

2. Interconnect cable

3. Reusable sensors

4. Disposable sensors

Preparing the SpO2 connection
1. Connect the SpO2 module(s) to the monitor.

2. Connect the adapter cable(s) to the SpO2 module connector(s).

3. Clean the surface of reusable sensors.

4. Prepare the application site(s).

5. Remove nail polish and earrings.

6. Follow the sensor manufacturer's instructions to position the sensor(s).

7. Attach the sensor(s) to the patient.
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8. Stabilize the sensor cable(s) to minimize sensor movement.

Checking the SpO2 measurement
1. Check that the red light is lit in the sensor.

2. Check that the waveforms and parameter values are displayed when the sensor is
connected to the patient.

SpO2 functional testers
You can verify the functionality of pulse oximeter sensor and monitor with a functional
SpO2 tester, but you cannot evaluate their accuracy with such a device. For more
information, refer to standard ISO 80601-2-61 Annex FF (Simulators, calibrators and
functional testers for pulse oximeter equipment).

Using the SpO₂ measurement

Primary and secondary SpO2measurement sources
It is possible to measure SpO2 from two different measurement sources
simultaneously. The primary SpO2 source is labeled SpO2 and the secondary SpO2
source is labeled SpO2(2).

The following table shows the acquisition modules that may be used as primary and
secondary SpO2 measurement sources.

Primary SpO2 source Compatible secondary SpO2 source(s)

PDM, PSM

● E-NSATX

● E-MASIMO

● Unity Network ID connectivity device

E-NSATX, E-MASIMO ● Unity Network ID connectivity device

Unity Network ID connectivity
device

● E-NSATX

● E-MASIMO
E-NSATX and E-MASIMO modules require a PDM with no
SpO2 sensor connected in order to work as a secondary
SpO2 source when the Unity Network ID connectivity device
is the primary SpO2 source.

Changing the SpO2 waveform size
NOTE All other modules except PSM.

1. Select the SpO2 parameter window.

2. Select the SpO2 or SpO2(2) tab.

3. Choose the size from the Size list: 1x, 2x, 4x, or 8x.

Changing the SpO2 waveform scale
NOTE PSM only.

1. Select the SpO2 parameter window.
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2. Select the SpO2 or SpO2(2) tab.

3. Select the scale from the Scale list:

● AUTO: The scale is automatically selected according to the IrMod % (infrared
modulation percentage) received from the measurement source.

● Other scale options are 2, 5, 10, 20, or 50.

Selecting the SpO2 hemodynamic sweep speed
NOTE This setting adjusts the waveform speed for all of the

hemodynamic parameters.

1. Select the SpO2 parameter window.

2. Select the SpO2 or SpO2(2) tab.

3. Select a numeric value from the Hemodynamic Sweep Speed list.

The smaller the value, the slower the sweep speed.

Selecting the SpO2 as the primary heart rate source
The primary heart rate can be calculated from the ECG leads, SpO2 measurement,
or invasive pressure waveform.

NOTE This setting adjusts the primary heart rate source for all of the
hemodynamic parameters.

NOTE HR Alarmsmust be configured as Single to enable the SpO2
as the primary heart rate source.

NOTE Primary SpO2 measurement only.

SpO2 can be the Primary HR Source for all modules.

1. Select the SpO2 parameter window.

2. Select the SpO2 tab.

3. Select the heart rate source from the Primary HR Source list.

Showing the SpO2 pulse rate
1. Select the SpO2 parameter window.

2. Select the SpO2 or SpO2(2) tab.

3. Select Show Pulse Rate.

Adjusting the SpO2 pulse beep tone volume
A variable pitch beep tone rises in pitch with increasing oxygen saturation or falls in
pitch with decreasing oxygen saturation.

1. Select the SpO2 parameter window.

2. Select the SpO2 tab.

3. Adjust the volume with the Beat Volume arrows.
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Variable beat tone
You can configure a variable beat tone throughMonitor Setup > Default Setup > Care
Unit Settings > Parameters > Variable Beat Tone. This setting is password protected.

If it set to All beat sources, the SpO2 saturation affects all beep sounds including ECG
and IP when the SpO2 measurement is available: beep frequency changes according
to increasing and decreasing SpO2 values. If the setting is set to Only SpO2, other beep
sounds are not affected by the changing SpO2 values.

For more information, see the supplemental information manual.

Masimo SET data averaging and updating
For Masimo SET technology, when using the default averaging time of 8 seconds,
there is a maximum data-averaging signal processing time of 10 seconds from real
time plus an additional delay of 2 seconds to update the displayed waveform. Audible
alarms are delayed until an alarm limit violation occurs for at least 5 seconds.

Selecting the SpO2 averaging time
NOTE PSM, E-MASIMO, and PDM with Masimo technology and

Masimo sensors only. The primary SpO2 measurement only.

You can have an average of the SpO2 measurement on screen instead of the beat to
beat values, and you can select how many seconds are used for this averaging: 2 s,
4 s, 8 s, 10 s, 12 s, 14 s, or 16 s.

1. Select the SpO2 parameter window.

2. Select the SpO2 tab.

3. Select the number of seconds from the Averaging list.

Selecting the Masimo SpO2 sensor sensitivity level
NOTE SpO2 modules with Masimo technology and Masimo sensors

only.

1. Select the SpO2 parameter window.

2. Select the SpO2 tab.

3. Select the appropriate Sensitivity radio button:

● Use the Normal sensitivity setting for normal patient monitoring purposes.

● Use theMaximum sensitivity setting for improved poor perfusion performance.

Using theMaximum sensitivity setting delays the SpO2 probe off detection alarm.
It is recommended to use this setting in care areas where the application site
is inspected frequently.

Nellcor OxiMax data averaging and updating
The Nellcor OxiMax algorithm automatically extends the amount of data required for
measuring SpO2 and pulse rate depending on the measurement conditions. During
normal measurement conditions in the normal response mode, the averaging time
is 6 to 7 seconds.
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During difficult measurement conditions, which can be caused by low perfusion,
motion, ambient light, electrocautery, other interference, or a combination of these
factors, the OxiMax algorithm automatically extends the dynamic averaging time
required beyond 7 seconds.

As the measurement conditions become even more difficult, the amount of data
required continues to expand. If dynamic averaging time reaches 40 seconds, the
pulse timeout condition will be set and the module will report a zero saturation
indicating a loss-of-pulse condition. If the time reaches 30 seconds, the message
Check probe appears on screen.

Selecting the SpO2 response time
NOTE PDM Nellcor only.
You can select the response (averaging) time. Normal (default) is the recommended
setting.

1. Select the SpO2 parameter window.

2. Select the SpO2(2) or SpO2(2) tab.

3. Select the radio button for the response time: Normal or Fast.

Nellcor OxiMax Saturation Seconds alarm management
NOTE PDM with primary SpO2 measurement and the Nellcor option

only.

Nellcor OxiMax technology uses the Saturation Seconds to decrease the likelihood of
false SpO2 saturation alarms caused by motion artifact. It does not apply to pulse rate.

With traditional pulse oximetry alarm management, upper and lower alarm limits are
set. During monitoring, as soon as a limit is violated, an alarm is generated. With
Saturation Seconds alarm management, upper and lower alarm limits are set in the
same way as traditional alarm management. If the alarm priority is Escalating, the
alarm priority limit automatically changes to Medium.

A Saturation Seconds limit is also set. This allows monitoring of SpO2 saturation
outside the set limits for a period of time (count value) before an alarm sounds. The
method of calculation is as follows: The number of percentage points that the SpO2
saturation falls outside the alarm limit is multiplied by the number of seconds that it
remains outside the limit. This can be stated as the equation “points x seconds =
Saturation Seconds,” where points equals SpO2 percentage points at or outside the
limit, and seconds equals the number of seconds SpO2 remains at that point outside
the limit.

The following table demonstrates the alarm response time with a Saturation Seconds
limit set at 30 and a low limit of 80%. The SpO2 level drops to 79% (2 points) and
remains there for two seconds. Then it drops to 76% (5 points) for three seconds, and
then to 75% (6 points) for two seconds. The resulting Saturation Seconds are:

SpO2 saturation change Clock seconds Saturation Seconds

2x 2 = 4

5x 3 = 15

6x 2 = 12

Total Saturation Seconds 31
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After approximately seven seconds, the alarm would sound because 30 Saturation
Seconds would have been exceeded (arrow in the following figure).

SpO2 saturation %

Seconds

The Saturation Seconds feature has a “safety net” designed for patients whose
saturation is frequently outside the limits but does not remain outside the limits long
enough for the Saturation Seconds limit to be reached. When three or more limit
violations occur within 60 seconds, an alarm sounds even if the Saturation Seconds
limit has not been reached.

Saturation Seconds alarm response example
Saturation levels may fluctuate above and below an alarm limit, re-entering the
acceptable range (non-alarm range) several times. During such fluctuation, the
monitor integrates the number of SpO2 saturation points, both positive and negative,
until either the Saturation Seconds limit is reached or the saturation level returns to
within the normal range and remains there.

When an SpO2 saturation value exceeds an alarm limit, a pie chart (circular graph) in
the SpO2 parameter menu begins to fill in a clockwise direction. As seconds pass and
the value is compared against the alarm limits and the Saturation Seconds setting, the
chart fills proportionately. When the pie chart is completely filled, indicating that the
Saturation Seconds limit has been reached, an alarm sounds. When the SpO2 value is
within the set limits, the Saturation Seconds pie chart empties in a counterclockwise
direction.

Showing the Saturation Seconds in the SpO2 parameter window
NOTE PDM with primary SpO2 measurement and the Nellcor option

only.

1. Select the SpO2 parameter window.

2. Select the SpO2 tab.

3. Select Show Sat. Seconds.

Setting the Saturation Seconds threshold
1. Select the SpO2 parameter window.

2. Select the SpO2 tab.
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3. Set the threshold with the Saturation Seconds arrows.

Setting the SpO2 alarms and alarm limits
You can set the alarms and alarm limits for primary and secondary SpO2
measurements separately.

You also have the option to select SpO2 Critical alarm. This enables different alarm
limit configurations for basic alarms and critical alarms.

1. Select the SpO2 parameter window.

2. Select the SpO2 or SpO2(2) tab.

3. Select:

a. HR Alarms set to Single: Select the Alarms tab to set alarm limits for SpO2 and
SpO2 Critical, and select the HR Alarms tab to set alarm limits for HR(ECG)
and HR Critical Tachy/Brady.

b. HR alarms set to Multiple: Select the Alarms tab to set the alarm limits for
SpO2, SpO2 Critical, or PR(SpO2).

If a feature is not active, alarm limits are greyed out. Select Alarm On to
set the alarm limits. PR(SpO2) setting is not available for the secondary SpO2
measurement.

Always check that you are configuring the right alarm. Note that the SpO2 Critical
alarm limits must always be set outside the basic alarm limits

Deactivating the SpO2 probe off alarm
This feature is meant to be used when ending SpO2 monitoring. It should not be used
during active SpO2 monitoring. This setting can be enabled during configuration. If it
has been enabled, there will be a button on the SpO2 and SpO2(2) tabs that allows you
to deactivate the alarm:

1. Select the SpO2 parameter window.

2. Select the SpO2 or SpO2(2) tab.

3. Select Deactivate SpO2 Probe Off.

When the alarm is deactivated, there will be no audible or visual SpO2 probe off alarm
indications. The alarm is automatically reactivated if SpO2 vitals signs are detected
and alarm condition is met again.

WARNING With deactivated SpO2 probe off alarm, keep the patient
under close surveillance.

Configurable SpO2 alarm delays
Alarm delays for SpO2 high and SpO2 low are configurable from 0 to 15 seconds
in increments of 5 seconds. These delays are set through Default Setup > Profile
Settings > Alarm Delays and they are password protected.

For more information, see the supplemental information manual.

You can check the delays through SpO2 or SpO2 (2) > Alarms > Priorities & Delays Info.
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Configurable PR alarm delays
Alarm delays for PR (SpO2/IP) high and PR (SpO2/IP) low are configurable from 0 to 20
seconds in increments of 5 seconds. These delays are set through Default Setup >
Profile Settings > Alarm Delays and they are password protected.

You can check the delays through ECG > HR/PR Alarms > Priorities & Delays Info.

For more information, see the supplemental information manual.

SpO2 alarm priorities
You can set the alarm priorities for various SpO2 alarms through Alarm Setup > Alarm
Priorities > Other Parameters.

Note the following regarding CARESCAPE Central Station v2.0 or earlier and alarm
priorities for SpO2 high, SpO2 low, SpO2(2) high, and SpO2(2) low:

● If you have selected different priorities on the monitor for high and low alarms,
the alarm level control at the CARESCAPE Central Station will be inactivated.
This situation is also indicated as an empty cell in the central station’s table of
parameter limits and alarm levels.

● If the SpO2 high/low alarm level control is active at the central station and it is
selected, the selection applies to SpO2 high, SpO2 low, SpO2(2) high, and SpO2(2)
low provided that you have selected the same alarm priority for high and low
alarms on the monitor. Otherwise the monitor will discard the central station
selection, resulting in an empty cell in the central station’s table of parameter
limits and alarm levels.

The allowed priorities are defined in the Care Unit Settings, and they are password
protected.

Checking alarm delays and priorities information
You can check which alarms have priority settings that deviate from the
recommendation of international safety standards, and also the delays selected for
each alarm.

1. Select the SpO2 parameter window.

2. Select the SpO2 or SpO2(2) tab.

3. Select the Alarms tab.

4. Select Priorities & Delays Info.

5. Check the priorities and delays.

Stopping the SpO2 measurement
1. Remove the SpO2 sensor from the patient.

2. Disconnect the sensor from the sensor cable.

3. Disconnect the sensor cable from the module.

4. Select to acknowledge the SpO2 probe off alarm.
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5. Discard single-use sensors.

● Always disconnect the RD SET, LNOP, or LNCS sensor from the cable before
repositioning the sensor. Reconnect the RD SET, LNOP, or LNCS sensor after it
has been repositioned.

● Use only sensors and cables listed in the supplemental information manual.

How to interpret the SpO₂ values

SpO2 signal strength
Signal strength is indicated with asterisks in the parameter window. The signal
strength indicator refers to the amplitude of the plethysmographic waveform, not the
quality of the waveform.

For PSM with GE Ohmeda technology, the signal strength indicator is also displayed as
the infrared modulation percentage in the waveform.

Unity Network Interface Device (ID) does not display signal strength indicators. Signal
strength may be determined by the amplitude of the SpO2 waveform.

SpO2 waveform quality
NOTE Not for Masimo SET technology.

Under normal conditions, the SpO2 waveform corresponds to (but is not proportional
to) the arterial pressure waveform. The typical SpO2 waveform can help the user find a
sensor location with the fewest noise spikes.

Normal waveform

If noise (artifact) is seen on the waveform because of poor sensor placement, the
photodetector may not be flush with the tissue. Check that the sensor is secured and
the tissue sample is not too thick. Pulse rate is determined from the SpO2 waveform,
which can be disrupted by hemodynamic pressure disturbances. Motion at the sensor
site is indicated by noise spikes in the normal waveform.

Abnormal waveform

SpO2 waveform stability
The stability of the displayed SpO2 values can also be used as an indication of signal
validity. To aid you in successful SpO2 monitoring, messages are provided in the SpO2
parameter window.

SpO2 wavelengths and optical output power
GE Ohmeda, Masimo SET and Nellcor OxiMax pulse oximetry are calibrated to display
functional saturation.
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This information may be useful to clinicians such as those performing photodynamic
therapy:

● Nellcor OxiMax pulse oximetry sensors contain LEDs that emit red light at a
wavelength of approximately 660 nm and infrared light at a wavelength of
approximately 900 nm. The total optical output power of the sensor LEDs is less
than 15 mW.

● Masimo SET pulse oximetry sensors contain LEDs that emit red light at a
wavelength of approximately 653 nm to 660 nm and infrared light at a wavelength
of approximately 880 nm to 905 nm. The total optical output power of the LEDs is
less than or equal to 15 mW.

● GE Ohmeda SpO2 for use with TruSignal sensors only: GE pulse oximetry sensors
contain LEDs that emit red light at a wavelength of approximately 663 nm and
infrared light at a wavelength of approximately 890 or 940 nm. The maximum
optical output power for each LED is less than 15mW.

SpO2measurement and interference
These types of interference can influence the function of SpO2:
● Incorrect sensor application, e.g., sensor placement on an extremity with a blood

pressure cuff, arterial catheter, or intravascular line, sensor applied too tightly.
● Intravascular dyes, such as idocyanine or methylene blue.
● Externally applied coloring agents with opaque materials in high ambient light

conditions, e.g., conditions created from one or more of the following sources:
￭ Surgical lights, especially xenon light sources
￭ Bilirubin lamps
￭ Fluorescent lights
￭ Infrared heating lamps
￭ Direct sunlight

● Excessive patient activity
● Venous pulsation
● Dysfunctional hemoglobin
● Poor (low) peripheral perfusion
● Arterial occlusion proximal to the sensor
● Loss of pulse (cardiac arrest)
● Electromagnetic interference (EMI)
● Ventilator-induced pressure change

SpO2 troubleshooting
Problem Solution

SpO2 signal is poor

● Check the sensor and sensor position.

● Make sure the patient is not shivering, moving, or does not have tremors.

● The patient’s pulse may be too low to measure.

Unable to adjust alarm
limits

The alarm limits are not adjustable when the measurement source is from an
external device connected to the Unity Network ID connectivity device.
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Problem Solution

Deactivated SpO2 probe
off alarm keeps alarming
when the sensor is
disconnected from the
patient.

● Ensure that the sensor is protected from ambient light.

Why does the pulse
oximeter sometimes read
differently than a blood
gas analyzer?

Blood gas analyzers calculate the O2 saturation based on normal values for pH,
PaCO2, Hb, temperature, etc. (i.e., a normal oxyhemoglobin dissociation curve).
Depending on the patient’s physiologic and metabolic status, this curve and all
values may be shifted away from normal. Thus the oximeter, which measures O2
saturation, may not agree with the blood gas.

What effect can ambient
light have on pulse
oximetry monitoring?

Light sources such as surgical lamps, bilirubin lamps, fluorescent lights, infrared
heating lamps, and sunlight can cause poor waveform quality and inaccurate
readings. Error messages are possible. Shielding the sensor with opaque tape, the
posey wrap, or other dark or opaque material can increase oximetry accuracy,
verified by good waveform and signal strength.

What does
electrosurgical
interference look like and
how can it be minimized?

Electrosurgical interference is most obvious on the displayed waveform. It is a very
spiky, erratic looking waveform caused by the electrosurgical unit’s overwhelming
interference. It can result in grossly inaccurate pulse oximeter results.
Electrosurgical interference can be minimized by:

● Making sure the pulse oximeter sensor is as far away from the return pad
and operating site as possible.

● Making sure the sensor is not between the return pad and operating site.

● Keeping the power cord and sensor cable away from the power cord of the
electrosurgical unit.

● Plugging the electrosurgery unit into a separate set of outlets from the monitor.

What does motion
artifact look like, what
problems can it cause,
and how can it be
corrected?

For modules using Nellcor OxiMax technology, the main problem motion artifact
can cause is erroneous SpO2 readings.
Motion artifact occurs with excessive motion of the sensor, the cable leading to
the sensor, or the cable/sensor junction. In other words, anything that causes any
of these things to move, like the patient moving his hands, or the cable lying
across the ventilator tubing and being moved with every cycle, can cause motion
artifact. A non-arterial, often erratic looking waveform and a pulse rate that does
not coincide with the heart rate on the ECG will result.
Motion artifact can be reduced, if not eliminated, by selecting a “quieter” site on
the patient. An ear sensor if the hands do not remain still, an adhesive sensor
on the toe, or an adhesive sensor on the little finger for an adult or on the sole of
the foot in a newborn can help greatly.
Cable movement can be reduced by applying the sensor with the cable leading
toward the patient, then taping the cable to the side of the hand or foot. The
cable and sensor can also be stabilized with a stress loop near the sensor. Tape
the stress loop to the patient (excluding children). In the case of the butterfly
sensor, the tape was designed to secure the cable to the finger.
It has been noted that letting the patient view the SpO2 waveform enables the
patient to assist in reducing motion artifact.

Why is the parameter
window not displayed
on the monitor after
connecting the SpO2

No SpO2 data is displayed due to two secondary SpO2 modules in place at the
same time, hardware failure or an unrecognized or defective sensor.

● Make sure the accessories are compatible with the module.

● Make sure the sensor is attached to the interface cable and the cable is
connected to the module.
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Problem Solution

interface cable and
sensor?

● Make sure there is only one secondary SpO2 module connected to the monitor.

● Change the sensor.

● Change the cable.
If the problem persists, contact qualified service personnel.
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NIBP compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

NIBP safety precautions

NIBP warnings
WARNING The NIBP parameter will not measure blood pressure

effectively on patients who are experiencing seizures or
tremors.

WARNING Arrhythmias will increase the time required by the NIBP
parameter to determine a blood pressure and may extend the
time beyond the capabilities of the parameter.

WARNING Do not apply external pressure against the cuff while
monitoring. Doing so may cause inaccurate blood pressure
values. Use care when placing the cuff on an extremity used
to monitor other patient parameters.

WARNING NIBP cuff inflation/deflation may lead to inaccurate values
from other monitored patient parameters that are measured
distally from the NIBP measurement site at the same
extremity.

WARNING PATIENT SAFETY. Ensure that the connection tubing is not
kinked. Kinked tubing may cause continuous cuff pressure,
which can interfere with the blood flow and cause injury to
the patient.

WARNING PATIENT SAFETY. Do not place the cuff on the arm on the side
of a mastectomy as this may lead to injury or swelling of the
arm due to cuff pressurization. To avoid this risk, use another
limb if possible.

WARNING Do not place the cuff over a wound as this may cause further
injury.
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WARNING PATIENT SAFETY. To prevent injury to the patient, do not place
the cuff on a limb being used for A-V fistulas, intravenous
infusion or on any area where circulation is compromised or
has the potential to be compromised. To avoid this risk, use
another limb if possible.

WARNING GE NIBP devices are designed for use with dual-hose cuffs
and tubing. The use of single-hose cuffs with dual-hose tubing
can result in unreliable and inaccurate NIBP data.

WARNING Accuracy of NIBP measurement depends on using a cuff of
the proper size. It is essential to measure the circumference of
the limb and choose the proper size cuff.

WARNING NIBP READINGS MAY TIME OUT WHEN USING IABP. An
IABP creates non-physiological arterial waveforms. These
waveforms create an oscillometric signal that may not be
interpreted by the NIBP algorithm, causing NIBP to time out.
The patient blood pressure can be monitored from the balloon
pump device.

WARNING The NIBP cuff size for PDM or the inflation limits for PSM (with
undetected cuff hoses) must be correctly selected in the NIBP
Setup window to obtain reliable NIBP data and to prevent
excessive cuff pressure during infant or child use.

WARNING If a patient’s beat-to-beat pulse amplitude varies significantly
(e.g., because of pulsus alternans, atrial fibrillation, or the
use of a rapid-cycling artificial ventilator), blood pressure
and pulse rate readings can be erratic, and an alternate
measuring method should be used for confirmation.

The following warning applies to the PSM only:

WARNING PSM. Non-invasive blood pressure measurement is intended
for patients weighing over 5 kg (11 lb).

The following warnings apply to the PDM only:

WARNING NIBP AUTO DISCONTINUED. The NIBP Auto setting reverts
to OFF when the PDM is removed from one monitor and
is connected to another monitor if the PDM battery is not
installed. If the PDM is used for bedside and transport
monitoring, its battery should be installed when in use. In
the event that the PDM battery is not installed, the settings
for NIBP Auto can be reset after connecting the PDM to the
monitor.

WARNING PATIENT SAFETY. Always ensure that you are using NIBP infant
settings when monitoring neonatal patients. Using other
settings may lead to risks to the patient due to wrong alarm
limits or cuff pressure, for example.
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WARNING PDM For SuperSTAT NIBP (Adult/Child) only. It takes one to
three minutes for the NIBP parameter to identify an irregular
rhythm after ECG is connected. For patients with irregular
rhythms, wait three minutes after ECG has been connected
and ECG heart rate is present on the monitor screen before
performing an NIBP determination.

NIBP cautions
CAUTION The acquisition module sets the inflation pressure

automatically according to the previous measurement. Reset
the case or discharge the patient to reset the inflation limits
before measuring NIBP on a new patient.

CAUTION Devices that exert pressure on tissue have been associated
with purpura, skin avulsion, compartmental syndrome,
ischemia, and/or neuropathy. To minimize these potential
problems, especially when monitoring at frequent intervals
or over extended periods of time, make sure the cuff is
applied appropriately and examine the cuff site and the limb
distal to the cuff regularly for signs of impeded blood flow.
Periodically check patient limb circulation distal to the cuff.
Check frequently when using auto NIBP in 1 and 2 minute
intervals. The 1 and 2 minute intervals are not recommended
for extended periods of time.

NIBP measurement limitations
● A patient's vital signs may vary dramatically during the use of cardiovascular

agents such as those that raise or lower blood pressure or those that increase
or decrease heart rate.

● Although automated NIBP is generally safe and accurate, it has some limitations. It
may be difficult to obtain reliable readings under the following circumstances:

￭ Shock accompanied by low blood pressure and pulse.

￭ Variations in blood pressure and pulse rate.

￭ In patients with anatomic abnormalities, such as calcified (hardened) arteries
or subclavian compression.

￭ Compression of the cuff caused by shivering, seizures, arm movement, or
bumping against the cuff.

● Proper sizing and position of the cuff are essential to obtaining reliable readings:

￭ Too large a cuff is better than too small a cuff, which may yield falsely high
readings.

￭ The cuff should also fit properly over the brachial artery (or whatever artery is
being used) so that the cuff is sufficiently sensitive to vibrations in the artery.

NIBP points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.
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● The measurement has been validated with patient populations requiring
clinical investigations according to ISO 81060-2:2013 apart from pregnant and
pre-eclamptic women.

● Use the appropriate size NIBP cuff for the patient (adult, child, or infant).

● The NIBP Infant software settings apply to the following patient populations:

￭ PDM: neonates from birth to 29 days of age, infants from 1 month to 3 years of
age

￭ PSM: patients weighing more than 5 kg, from 1 month to 3 years of age.

● Operator position: Make sure you do not lean on the cuff or hoses, and do
not disturb the patient in any way during the measurement. Position yourself
accordingly.

● The measurement site, patient’s position (standing, sitting, lying down), exercise, or
physiologic condition can affect the NIBP readings.

● With mobile patients and when taking routine resting blood pressure, ensure that:

￭ The patient is comfortably seated, with their legs uncrossed and feet flat on
the floor.

￭ The patient’s arms and back are supported.

￭ The middle of the cuff is at the level of the right atrium of the patient’s heart.

● Also consider the following recommendations:

￭ Allow 5 minutes to pass before taking the first measurement.

￭ Ensure that the patient is relaxed and does not talk during the measurement.

● NIBP can be measured by multiple acquisition modules. Connect one NIBP cable
only.

● Depending on the NIBP module used, not all NIBP measurements and settings
are available to view or change.

NIBP measurement setup

NIBP equipment to patient connection

1. Module with NIBP measurement capability

2. Cuff hose

3. Cuff of correct size

4. Brachial artery arrow (printed on cuff)

5. Cuff index line (printed on cuff)
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NIBP module keys
There are two NIBP related keys on the PSM:

Auto On/Off Starts and stops automatic measurements at timed
intervals.

Start Cancel Starts a single measurement, and cancels any
measurement in progress.

NOTE You can also select NIBP Start/NIBP Cancel or NIBP Auto
Start/NIBP Auto Stop from the monitor’s main menu.

Preparing the NIBP patient connection
1. Select an appropriate NIBP cuff size for the patient.

2. Connect the NIBP cuff hose to the module's NIBP connector.

3. Position the NIBP cuff on the patient:

● Place the cuff arrow over the brachial artery (or whatever artery is being used).

● Make sure that the cuff index line falls within the range markings on the cuff.

● Wrap the cuff around the limb.

4. Make sure that the NIBP cuff tubes are not kinked, compressed, or stretched.

5. Verify or select the correct Init. Pressure or Cuff Size from the NIBP Setupmenu.

Checking the NIBP measurement
1. Check that the pressure values are displayed.

2. PSM: For children and when using hoses without identification, the inflation limit
must be set manually.

3. PDM: Always select the NIBP cuff size before starting a measurement. If you are
trying to start the measurement without selecting the cuff size first, the NIBP
menu opens automatically with the Cuff Size list open.

4. PSM: Check that the cuff hose was detected (if cuff detection is supported).

5. PSM: Start the Venous Stasis mode and check that the pump is not restarting
during the measurement. If it does, the cuff may be leaking.

NIBP measurement on screen
You can have a time progress bar in the NIBP parameter window with NIBP Auto,
STAT or Venous Stasis modes:

With NIBP Automode this may be replaced by a count down indicator. The selection
of either the Graphical progress bar or the Numerical indicator is a care unit setting
and it is password protected.

● NIBP Auto: The number of green segments indicates the proportion of the cycling
time since the last measurement while the distance between the end of the bar
and the last lit segment indicates the time remaining until the next measurement.
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● During clock synchronization, the number of the green segments indicates
the difference between the cycling time and time remaining until the next
measurement.

● STAT or Venous Stasis: The bar indicates the time that the mode will continue. STAT
holds multiple measurements for 5 minutes, and Venous Stasis continues without
measurements for 1 minute with infants and 2 minutes with children and adults.

Manual NIBP measurements

Starting or stopping a single NIBP measurement from the
main menu

1. Start the measurement by selecting NIBP Start.

2. Stop the measurement by selecting NIBP Cancel.

Starting or stopping a single NIBP measurement from the
NIBP Setup menu

1. Select the NIBP parameter window.

2. Start the measurement by selecting Start Manual NIBP.

3. Stop the measurement by selecting Cancel NIBP.

Starting or stopping a single NIBP measurement with the
PSM module key

1. Start the measurement by pressing the Start Cancel key.

2. Stop the measurement by pressing the Start Cancel key again.

Automatic NIBP measurements

NIBP Auto mode
The NIBP Automode initiates repeated measurements for the selected Cycle Time.
There will be at least a 30 second delay between two consecutive NIBP measurements
during auto cycling.

Starting or stopping the NIBP Auto from the monitor’s main menu
1. Select NIBP Auto Start.

2. Stop the measurement by selecting NIBP Auto Stop.

Starting or stopping the NIBP Auto from the NIBP Setup menu
1. Select the NIBP parameter window.

2. Select Start Cycling for NIBP Auto.

3. Stop the measurement by selecting NIBP Auto > Stop Cycling.
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Starting or stopping the NIBP Auto with the PSM module key
1. Press the Auto On/Off key.

2. Stop the measurement by pressing the Auto On/Off key again.

Setting the cycle time between NIBP measurements
To automatically measure NIBP at set time intervals, you must first set the cycle time.

1. Select the NIBP parameter window.

2. Select the cycle time from the Cycle Time list.

Automatic NIBP measurements and monitor clock
synchronization

Clock synchronization timing (cycling sync) automatically synchronizes your automatic
NIBP measurement time intervals with the monitor clock. For example, if automatic
measurements are initiated for five minute intervals at 4:02, the first measurement is
taken immediately at 4:02. The next measurement will be taken at 4:05 (interval and
clock are now synchronized). All measurements will continue at five minute intervals
(that is, 4:10, 4:15, and so on)

There will always be at least a 30 second delay between two consecutive NIBP
measurements during auto cycling. If an automatic measurement completes with
less than 30 seconds to the next scheduled measurement, the monitor will delay the
scheduled measurement until 30 seconds have passed. The cycling synchronization
is not done during these 30 seconds but it will be done after the delayed auto
measurement starts.

Examples with a 5 minute cycling time:

Completion with less than 30 seconds to
the next scheduled measurement

Completion after the next scheduled
measurement should have started

● First auto measurement starts: 4:59:00

● First auto measurement completes:
4:59:40

● Second auto measurement starts: 5:00:20
(not clock synchronized)

● Third auto measurement starts: 5:05:00
(clock synchronized)

● First auto measurement starts: 4:59:00

● First auto measurement completes:
5:00:10

● Second auto measurement starts: 5:05:00

STAT mode
NOTE Not available in the NICU software package.

The STATmode initiates a continuous cycle of measurements for five minutes. The
message STAT displays in the NIBP parameter window when STAT is started. A new
NIBP measurement starts after the previous measurement completes. The amount of
time between measurements varies. It is at least four seconds for adult and child and
at least eight seconds for infant. The early systolic value is measured and displayed
until the final result is available, but it is never produced for the first measurement in
a series of STATmode measurements. After five minutes, the monitor automatically
returns to the previously selected cycling interval or manual mode.
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Starting or stopping a Stat NIBP measurement
You can set the NIBP measurement to continue for five consecutive minutes.

1. Select the NIBP parameter window.

2. Select Start Stat.

3. Stop the measurement by selecting Stop Stat.

Venous stasis
NOTE PSM only.

The venous stasis mode initiates inflation and holds a constant pressure in the cuff
to help venous cannulation. The message Stasis displays in the NIBP parameter
window when venous stasis mode is started. During the last 10 seconds, the Stasis
message begins to flash to indicate the monitor is about to return to the previously
selected cycling interval or manual mode. Stasis measurement pressure is controlled
by the PSM internally.

Venous stasis allows you to apply continuous NIBP cuff pressure for a short period of
time. The cuff inflation pressure and duration are dependent on the detected cuff or
selected inflation limits.

Cuff Pressure Duration

Adult 80 ± 5 mmHg (10.7 ± 0.7 kPa) 2 minutes

Child 60 ± 5 mmHg (8.0 ± 0.7 kPa) 2 minutes

Infant 40 ± 5 mmHg (5.3 ± 0.7 kPa) 1 minute

Venous stasis pressure may be lower than the values above if the patient has low
blood pressure. The venous stasis pressure adapts to the measured mean pressure
being approximately the same as the mean pressure but always at least the following:

● Adult: 40 ± 5 mmHg (5.3 ± 0.7 kPa)

● Child: 30 ± 5 mmHg (4.0 ± 0.7 kPa)

● Infant: 20 ± 5 mmHg (2.7 ± 0.7 kPa)

Starting or stopping the venous stasis
NOTE PSM only.

1. Select the NIBP parameter window.

2. Select Start Venous Stasis.

3. Stop the venous stasis by selecting Stop Venous Stasis.

NIBP cuffs

NIBP cuff selection and placement
Always choose the appropriate blood pressure measurement site. In adult and
child patients, the upper arm is preferred for convenience and because normative
values are generally based on this site. When factors prohibit use of the upper arm,
the clinician must plan patient care accordingly, taking into account the patient’s
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cardiovascular status and the effect of an alternative site on blood pressure values,
proper cuff size, and comfort.

Adult and child Infant

Always measure patient’s limb and select appropriately sized cuff according to
size marked on cuff or cuff packaging. When cuff sizes overlap for a specified
circumference, choose the larger size cuff.

If patient is standing, sitting, or inclined, ensure that cuffed limb is supported to
maintain the cuff at level of patient’s heart. If the cuff is not at heart level, the
difference in the measured pressure values due to hydrostatic effect must be
considered.

Selecting NIBP cuff size
NOTE PDM only.

NOTE In the NICU software package, infant ranges are equal to
neonatal ranges

You must first select the NIBP cuff size before starting a NIBP measurement.

1. Select the NIBP parameter window.

2. Select Adult, Child, or Infant from the Cuff Size list.

Initial NIBP cuff inflation pressure
Cuff size PDM PSM

Adult 135 mmHg (18 kPa) 170 mmHg (22.7 kPa)

Child 125 mmHg (16.7 kPa) 150 mmHg (20.0 kPa)

Infant 100 mmHg (13.3 kPa) 120 mmHg (16.0 kPa)

NOTE PDM: When the Auto Initial Inflate setting is enabled, the
initial cuff inflation pressures are dependent on the NIBP
module used and selected cuff size. The initial target pressure
preset can be adjusted if you desire a lower or higher initial
target pressure.

Selecting the initial NIBP cuff inflation pressure
NOTE PDM only.

You can determine the cuff inflation pressure automatically based on the cuff size.

1. Select the NIBP parameter window.

2. Select Auto Initial Inflate.
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Setting the target NIBP inflation pressure
NOTE PDM only.

You can manually change the target inflation pressure for the first NIBP measurement.

1. Select the NIBP parameter window.

2. Check that Auto Initial Inflate is not selected.

3. Select a value from the Init. Pressure list.

Selecting the cuff inflation limits
NOTE PSM only.
Black-colored Adult/Child cuff hoses and blue-colored Infant cuff hoses are
automatically detected by the monitor and inflation limits are set accordingly.
However, if the cuff hoses cannot be detected automatically, you must set the inflation
limits manually. You can also select the inflation limits when the automatic detection
is working.

1. Select the NIBP parameter window.

2. Select the Setup tab.

3. Select Infant, Child, or Adult from the Inflation Limits list.

NIBP volume and display settings

Adjusting the NIBP measurement completion tone volume
1. Select the NIBP parameter window.

2. Set the Completed NIBP Volume.

The lower the value, the softer the tone.

Setting the NIBP display format
1. Select the NIBP parameter window.

2. Select the format from the Display Format list:

● Sys/Dia (Mean): All values are shown, but the sys/dia values are shown in a
bigger font.

● (Mean) Sys/Dia: All values are shown, but the mean value is shown in a bigger
font.

NIBP alarms

Setting NIBP alarms
1. Select the NIBP parameter window.

2. Select the Alarms tab.
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3. Select Systolic (SYS), Mean (M), or Diastolic (DIA) pressure.

If the feature is not active, the alarm limits are greyed out. Select Alarm On to
set the alarms. If informational priority level has been selected for the alarm, the
menu selection is Message On.

4. Set the alarm limits.

Silenced NIBP alarms
The silence alarm behavior is different for NIBP than for any other parameter. Unlike
the continuously monitored parameters, NIBP is measured periodically. As a result,
silencing a physiological NIBP alarm will clear that active alarm until the next NIBP
measurement is taken. If the new measurement is outside the alarm limits, the alarm
is activated again.

NIBP recheck after alarm violation (control measurement)
If the NIBP value exceeds the alarm limits and the NIBP alarm priority selection is
Escalating, a new measurement takes place automatically. If the NIBP measurement
is taken manually, the recheck measurement is taken 4 seconds (Adult, Child cuff) or 8
seconds (Infant cuff) after the first measurement. When the NIBP measurement is
taken automatically, the recheck measurement is delayed by 30 seconds before the
second measurement is taken.

NIBP measurement description
The acquisition modules use oscillometric technology to acquire NIBP. Oscillometry
is the most commonly used means of indirect blood pressure measurement in
automated devices. It is based on the principle that pulsatile blood flow through an
artery creates oscillations of the arterial wall.

Oscillometric devices use a blood pressure cuff to sense these oscillations that appear
as tiny pulsations in cuff pressure. By measuring and analyzing at various cuff
pressures, the amplitude (which changes based on the pressure within the cuff) and
the frequency of these pulsations (which is dependent on the patient’s heart rate),
oscillometric devices can non-invasively determine blood pressure.

● x = Time(s)
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● y = Pressures
1. Systolic
2. Mean
3. Diastolic
4. Extracted pulse wave
5. Cuff pressure

NIBP measurement technologies
The DINAMAP Classic technology measures the mean arterial pressure, then
determines the systolic and diastolic values. The technology examines pulses from the
cuff and waits for two sequential pulses equal in both frequency and amplitude. It will
not deflate the cuff until it has good data. Artifact and false pulses are rejected.

The first determination initially pumps up to a target cuff pressure of:
● PDM: 135 mmHg for adult, 125 mmHg for child, or 100 mmHg for infant. The initial

target pressure preset can be adjusted to a lower (or higher) initial target pressure.
● PSM: 170 mmHg for adult, 150 mmHg for child or 120 mmHg for infant.

PDM uses the DINAMAP Step Deflation technology. During the deflation process, the
monitor measures two consecutive pulsations in cuff pressure. If their amplitude
differs by an acceptably small amount and the time interval between the pulsations
matches the previous time intervals, the pulsations are averaged and stored along
with the corresponding cuff pressure. The cuff is then deflated to the next step (in
steps of 5-10 mmHg). As the deflation occurs, oscillation waves are assessed for
strength and amplitude until the maximum oscillation amplitude or MAP is obtained.

If either of the above criteria is not met, the cuff pressure is maintained until two
consecutive pulsations are detected that meet the criteria. Eventually, if the cuff is
maintained at one pressure step for longer than one minute or the determination time
exceeds two minutes, the monitor will time out and display an error.

● x = Cuff pulsation waveform
● y = Cuff pressure
1. Cuff deflation
2. Systolic pressure (ratio of maximum amplitude)

230 CARESCAPE Monitors B850, B650, B450 2105822-001



Non-invasive blood pressure

3. Mean arterial pressure (maximum pulsation amplitude)

4. Diastolic pressure (ratio of maximum amplitude)

5. Cuff pulsations (each pulsation represents one heart beat)

6. Amplitude (changes based on cuff pressure)

7. Resulting waveform

Systolic and diastolic determinations are based on a mathematical calculation within
the algorithm. The deflation mode is heart rate dependent, it is typically longer with
heart rates that are slow and/or irregular.

This patented process of finding two matched pulsations of relatively equal amplitude
and frequency at each step rejects artifact due to patient movement or other
deviations from ideal conditions (e.g., cuff disturbances) and greatly enhances the
overall accuracy of the monitor.

NOTE NIBP values are based on the oscillometric method of
non-invasive blood pressure measurement taken with a cuff
on the arm of adult and child patients, and a cuff on the
calf of infants. The values correspond to comparisons with
intra-arterial values (a mean difference of ± 5 mmHg, and a
standard deviation of < 8 mmHg).

PDM modules’ NIBP technology
The PDM DINAMAP SuperSTAT technology estimates the systolic, mean arterial,
and diastolic values by evaluating all cuff pressure data gathered during an NIBP
determination.

For adults and children, when ECG is being monitored it provides and confirms
more detailed timing information for the SuperSTAT algorithm. At the beginning of a
SuperSTAT NIBP determination, the coefficient of variation from the previous 120 ECG
RR intervals is used to determine if an irregular rhythm is present.

The first determination initially pumps up to a default target cuff pressure of about
135 mmHg for adults, 125 mmHg for child, or 100 mmHg for infant. The initial target
pressure preset can be adjusted if you desire a lower (or higher) initial target pressure.
To allow for rapid setting of cuff pressure, the monitor will momentarily inflate to a
higher pressure, then immediately deflate to the target pressure.

As a determination is taken, the pattern of the patient's oscillation size is stored as a
function of pressure. In any subsequent determination, as few as four pressure steps
may be necessary to complete the process. When employing fewer pressure steps, the
system uses the stored information from the previous blood pressure determination to
decide the best pressure steps to take. The consistency of pulse sizes are measured to
tell if the oscillations taken at a step are good and if more steps are needed.

If the current blood pressure reading is similar to the previous reading, some
information from the previous blood pressure may be used in the current
determination. The data is constantly evaluated during a measurement to try to
perform a blood pressure determination in the shortest possible time, providing
greater comfort to the patient.

If it has been 16 minutes or less since the last determination and the current blood
pressure is similar to the previous reading, the monitor will try to make an accelerated
determination of blood pressure.

2105822-001 CARESCAPE Monitors B850, B650, B450 231



Non-invasive blood pressure

During irregular rhythms, only pulses from the current determination are used in
calculating the blood pressure values. In order to ensure adequate artifact rejection
capability and optimal SuperSTAT NIBP performance, several criteria used to
match and qualify the oscillometric pulses at each pressure step are relaxed while
supplementing the criteria with additional information from ECG.

PSM modules’ NIBP technology
PSM use a technology similar to DINAMAP Classic, with the exception of cuff deflation.
In this algorithm the cuff pressure is deflated continuously (linear bleed), as opposed
to step deflation.

1. Cuff deflation

2. Systolic pressure (ratio of maximum amplitude)

3. Mean arterial pressure (maximum pulsation amplitude)

4. Diastolic pressure (ratio of maximum amplitude)

5. Cuff pulsations (each pulsation represents one heart beat)

6. Amplitude (changes based on cuff pressure)

7. Resulting waveform

When the measurement signal detects artifacts, the deflation is stopped until a good
signal can be measured again. The cuff pressure remains at one pressure level until it
gets two similar pulses before continuing to the next pressure level. It compares two
sequential pulses and uses information and statistics from previous pulses.

The performance in disturbance or artifact cases is comparable to DINAMAP Classic.

The measurements do not use ECG information. The initial inflation pressure cannot
be adjusted, it is determined by the patient type (adult, child or infant). The first
determination initially pumps up to a target cuff pressure of 170 mmHg for adult, 150
mmHg for child or 120 mmHg for infant. After the first measurement, the inflation
pressure is adjusted according to measured systolic pressure.

NIBP calibration
NIBP calibration procedure is explained in the Module Frames and Modules Service
Manual. The calibration procedure is password protected.

232 CARESCAPE Monitors B850, B650, B450 2105822-001



Non-invasive blood pressure

NIBP troubleshooting
Problem Solution

NIBP measurement does not work or
the values seem unstable.

● Check that the cuff tubing is not bent, stretched, compressed,
or loose.

● Check the cuff position and cuff tube connection.

● Prevent motion artifact.

● Use NIBP cuffs of correct size.

Why is the monitor re-inflating the cuff
automatically?

The cuff target pressure must be higher than the patient’s systolic
pressure to obtain an accurate systolic and diastolic measurement.
If a systolic blood pressure cannot be found, the monitor searches
for a systolic reading by re-inflating the cuff at a higher pressure.
This systolic search may occur once per NIBP determination cycle.
During a systolic search, the maximum cuff inflation pressure
will not exceed the normal pressure range of the cuff. For more
information, refer to the technical specifications.
A control measurement may be taking place. If the measured NIBP
value exceeds the alarm limits, a single low priority alarm sounds
and a new measurement is automatically taken. If the new value
(the control measurement) also exceeds the alarm limits the alarm
priority escalates to medium. In Manual mode and STAT mode
there are at least four seconds between the first measurement and
the control measurement for Adult and Child cuffs, eight seconds
for Infant cuffs. In Auto mode there are at least 30 seconds
between the first measurement and the control measurement.
For PSM, ifWeak pulsation or Artifacts is detected, the module
repeats the measurement up to three times. Assess the patient
and perform a visual inspection of the equipment to ensure system
integrity.
For PSM, if cuff occlusion is detected during inflation the module
might repeat the measurement. Perform a visual inspection of the
equipment to ensure system integrity.

NIBP measurement does not start. Ensure that the cuff size has been selected (PDM).
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Invasive pressures compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

Invasive pressure safety precautions

Invasive pressure warnings

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires. Using other cables or leadwires may
result in damage to the equipment and compromise patient
and user safety.

WARNING All invasive procedures involve risks to the patient. Use aseptic
technique. Incorrect use of the catheter can lead to vessel
perforation. Follow catheter manufacturer's instructions.

WARNING Make sure that no part of the patient connections touches
any electrically conductive material including earth.

WARNING Mechanical shock to an invasive blood pressure transducer
may cause severe shifts in the zero balance and calibration,
and cause erroneous readings.

WARNING Repositioning the patient after a completed zeroing procedure
may cause incorrect measurement values.

WARNING When connecting PDM, the loaded IP labels may affect the
channel labeling of other already connected channels, and
consequently also the alarm limits.

Invasive pressure measurement limitations
● E-modules used for this measurement are not suitable for use with neonatal

patients.

2105822-001 CARESCAPE Monitors B850, B650, B450 235



Invasive pressures

Invasive pressure points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● Defibrillator discharge may affect the invasive pressure measurement. Refer to
the supplemental information manual for details regarding the recovery time from
defibrillator discharge.

● Depending on the invasive pressure module used, not all invasive pressure
measurements and settings are available to view or change.

● Do not turn on the IABP algorithm unless a balloon pump is in use.

● If two pressure measurement modules that map to the same pressure channel
are connected, the first detected pressure measurement module is assigned to
the indicated pressure channel.

● A pressure channel is activated when a pressure transducer interface cable
is connected to the PDM or E-COP module, or when a pressure transducer is
connected to the E-COPSv, E-PSMP, E-PP, or E-PT module.

● A pressure channel is deactivated when the pressure transducer interface cable is
disconnected from the PDM or E-COP module, or when the pressure transducer is
disconnected from the or E-COPSv, E-PSMP, E-PP, or E-PT module.

● E-modules: A deactivated pressure channel does not release the assigned pressure
channel. To release an assigned pressure channel, remove the module from the
system.

● PCWP: Follow your care unit’s policy and procedures for obtaining PCWP
measurements, including balloon inflation duration.

● SPV and PPV: Measurement is reliable only when the patient is mechanically
ventilated.
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Invasive pressure measurement setup

Invasive pressure equipment to patient connection

1. Module with invasive pressure measurement capability

2. Fluid bag with pressure infusor

3. Transducer setup

4. Invasive blood pressure adapter cable; single or dual cable (optional)

Invasive pressure module keys
There are invasive pressure keys on the following modules:

Module Key Functionality

E-modules Zero P1 to P8 Zeros the reference for each pressure transducer
individually.

PDM Zeros the reference for all pressure transducers
connected to the PDM.

Connecting the invasive pressure transducer and cable
1. Prepare the transducer kit according to the manufacturer’s instructions.

2. Connect the pressure transducer to the transducer cable.

3. Remove entrapped air from within the transducer setup according to the
transducer kit manufacturer’s instructions.

4. Connect the transducer cable to the acquisition module’s invasive pressure
connector.

5. Connect the transducer to the patient line.
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Checking the invasive pressure measurement
1. Check that the monitor recognizes cable connections (activates the display) for all

the pressure channels used and the pressure values and appropriate waveforms
are displayed.

2. Make sure that all the transducers are zeroed correctly.

Invasive pressure measurement on the monitor screen
The invasive pressure channel labels are as follows:

Label Description

Art 1 to Art 8 Arterial pressure

Fem Femoral arterial pressure

FemV Femoral venous pressure

PA Pulmonary arterial pressure

CVP Central venous pressure

LAP Left atrial pressure

RAP Right atrial pressure

ICP 1 to ICP 8 Intracranial pressure

RVP Right ventricular pressure

UAC Umibilical arterial pressure

UVC Umbilical venous pressure

P1 to P8 Non-specific pressure channel labels

Selecting the display mode for IP waveforms
You can select the invasive pressure waveforms to be shown as individual waveforms,
or in a combined view.

1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with the Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select Upper Parameter Area.

4. Select an option from the Invasive Pressure Waveforms list:

● To view individual waveforms, select Individual.

● To combine the currently displayed adjacent waveforms (2 to 4), select
Combined. The new waveform field will use the combined height of the original
fields.

● To combine up to four waveforms in one field, select 4invP. The new waveform
field will use the height of two upper parameter windows.
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Using the invasive pressure measurement

Invasive pressure measurement mapping
Invasive pressure measurements are mapped to one of eight (B850), seven (B650), or
six (B450) invasive pressure channels as follows:

Pressure channel Pressure measurement source

P1 PDM, E-PSMP

P2 PDM, E-PSMP

P3 PDM

P4 PDM

P5 E-PP

P6 E-PP

P7 E-PT

P8 E-COP
or
E-COPSv

Invasive pressure analog output
Invasive pressure module Analog output signal

E-modules P1 channel

PDM Sets the first available arterial channel (Art 1 to Art 8, Fem, UAC)
for invasive pressure analog output.

● If there are no arterial channels available, the first zeroed
channel will be used.

● If there are no zeroed channels available, a flat line will be
the output of the IP Analog output channel.

About zeroing the invasive pressure transducers
● Prior to monitoring, zero transducers at the patient’s phlebostatic axis. Zeroing the

pressure transducers is very important for accurate pressure measurements. To
avoid inaccurate measurements, you must zero the pressure transducers:
￭ Before measuring invasive pressures.
￭ Before initiating treatment changes reliant upon pressures data.
￭ When using a new transducer or tubing.
￭ After reconnecting the transducer cable to the acquisition device.
￭ Whenever the patient’s position is changed.
￭ Whenever the pressure reading is questionable.

● Pressures can be zeroed individually by selecting Zero on the pressure menu or
by pressing the zero key on the modules. You can zero all pressures except ICP by
selecting Zero All Pressures on the main menu.
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● You can zero all active transducers on the E-modules by pressing each Zero P1 to
P8 keys.

● You can zero all active transducers on the PDM module by pressing the zero all
key.

NOTE E-modules record a time stamp of the last successful zeroing
for each invasive blood pressure channel.

Zeroing the invasive pressure transducers
1. Level the transducer following your care unit’s policy (usually level of the

phlebostatic axis).

2. Close the transducer stopcock to the patient and open the venting stopcock to air.

3. If the pressure line you are trying to zero does not have the transducer open to air,
the message Pressure Sensed displays.

4. You can zero all connected pressure transducers simultaneously by selecting Zero
All Pressures from the monitor’s main menu or from the remote control, or you
can zero a single active pressure transducer by selecting the invasive pressure
parameter window > Setup > Zero.

NOTE Zero All Pressures does not zero a connected ICP channel.
The ICP channel must be zeroed separately. When the
Zero ICP separately message displays, you can zero
the ICP channel by pressing the Zero P1 to P8 or zero
all module key or by selecting Zero from the ICP Setup
window.

5. Check that a zero reference has been established. Watch the pressure parameter
window for messages.

6. Close the venting stopcock to air and open the transducer stopcock to the patient.

7. Check that pressure numerics display on screen.

Selecting an invasive pressure channel label
One channel label can only be mapped to one channel at a time. If you select a
channel label that is already mapped to another channel, the other channel’s label
will change to the default value.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select a channel label from the Label list.

Selecting the size of the invasive pressure waveform
1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Set the waveform scale with the Scale arrows.

The larger the scale value, the smaller the waveform size.
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Optimizing the invasive pressure waveform scale
You can select an automatic calculation for an optimized waveform size. This size
will then be used for the local waveform, minitrend, and waveform printouts. Other
instances (e.g., information sent to the network), will use the scale selection that is as
close as possible to the upper limit of the optimized scale.

The algorithm uses the last four seconds of the waveform data to calculate the scale.
If you notice a considerable change in the waveform during that time, wait for the
waveform to stabilize and perform the operation again.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select Optimize Scale.

The Scale selection will now show the automatic limit range.

NOTE The Optimize Scale selection will not automatically change
to match the waveform, you will always have to select it
manually every time.

Selecting the hemodynamic waveform sweep speed
NOTE This setting adjusts the waveform speed for all of the

hemodynamic parameters.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select a numeric value from the Hemodynamic Sweep Speed list.

The smaller the value, the slower the sweep speed.

Selecting the invasive pressure noise reduction filter
NOTE If arterial pressure is used to trigger the intra-aortic balloon

pump, use the 40 Hz pressure filter.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select a numeric value from the Filter Hz list.

The smaller the filter value, the greater the degree of filtering that occurs.

Selecting the displayed invasive pressure format
You can choose to display systolic, diastolic or mean pressure values in different
formats.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.
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3. Select the format from the Parameter Format list:

● Mean only: Only the mean value is shown.
● Sys/Dia (Mean): All values are shown, but the sys/dia values are shown in a

bigger font.
● (Mean) Sys/Dia: All values are shown, but the mean value is shown in a bigger

font.
● Sys/Dia/Mean: All values are shown in an equally big font.

Selecting invasive pressure as the primary heart rate source
The primary heart rate can be calculated from the ECG leads, SpO2 measurement,
or invasive pressure waveform.

NOTE This setting adjusts the primary heart rate source for all of the
hemodynamic parameters.

NOTE This setting is available for Art 1 to Art 8, Fem, or UAC invasive
pressure channels only.

NOTE HR Alarmsmust be configured as Single to enable invasive
pressure as the primary heart rate source.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select the heart rate source from the Primary HR Source list.

Variable beat tone
You can configure a variable beat tone throughMonitor Setup > Default Setup > Care
Unit Settings > Parameters > Variable Beat Tone. This setting is password protected.

If it set to All beat sources, the SpO2 saturation affects all beep sounds including ECG
and IP when the SpO2 measurement is available: beep frequency changes according
to increasing and decreasing SpO2 values. If the setting is set to Only SpO2, other beep
sounds are not affected by the changing SpO2 values.

For more information, see the supplemental information manual.

Selecting the ventilation mode
NOTE E-modules only.

This setting affects the respiration filter.

1. Select the invasive pressure parameter window.

2. Select the label (P2, P5, P6, P7, P8, CVP, FemV, PA, RAP, RVP, LAP).

3. Select Ventilation Mode > Spontaneous or Controlled.

Showing the pulse rate in the invasive pressure parameter
window

NOTE This setting is available for Art 1 to Art 8, Fem, or UAC invasive
pressure channels only.
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1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select Show Pulse Rate.

Showing the CPP value in the ICP parameter window
A valid mean arterial pressure is required to compute the cerebral perfusion pressure
(CPP) value.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select Show CPP.

Selecting Smart BP
NOTE PDM only. Art 1 to Art 8 and Fem invasive pressure channels

only.

Smart BP is an algorithm that temporarily deactivates the arterial and femoral alarms
when it detects the zeroing of a transducer, fast flushing of the system, or blood
draws. The message Artifact displays during the alarm deactivation. When pulsatile
pressure returns and 15-20 beats are detected, numerics are displayed and alarms
are reactivated.

1. Select the invasive pressure parameter window.

2. Select the Advanced tab.

3. Select Smart BP.

Compensating for intra-aortic balloon pump (IABP)
waveform irregularities

WARNING INCORRECT PULSE RATE. Be sure to turn off the IABP setting
when the cardiac assist device is no longer used. Failure to do
so could result in incorrect pulse rate readings.

CAUTION PATIENT HAZARD. If you choose to trigger the balloon pump
from the monitor, contact the balloon pump manufacturer
directly for interface requirements, as they vary among
manufacturers. Some trigger modes on certain balloon pump
devices may not be compatible with the GE analog output
signal, and use may contribute to patient injury or sub-optimal
pumping results.

NOTE PDM only. Art 1 to Art 8 and Fem invasive pressure channels
only.

1. Select the invasive pressure parameter window.

2. Select the Advanced tab.

3. Select IABP On.

IABP now displays in the invasive pressure channel parameter window.

2105822-001 CARESCAPE Monitors B850, B650, B450 243



Invasive pressures

Selecting the invasive pressure response time
NOTE E-modules only.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select Response list > Normal or B-to-B (beat-to-beat).

Using the IP channel standby
If you wish to prepare and zero a channel beforehand, you can use the channel
standby.

1. Select the invasive pressure parameter window.

2. Select the Setup tab.

3. Select Standby P1 to Standby P8 (text changes according to the channel).

Channel alarms and measurement are disabled until Activate P1 to Activate P8 is
selected.

Using the invasive pressure waveform cursor
You can display an invasive pressure waveform cursor for the selected invasive
pressure channel. The cursor is selectable when a pressure waveform channel is
active and using the selected pressure channel.

Up to ten pressure points can be saved and displayed. The oldest value, displayed at
the top of the list, is discarded in order to save the newest value.

1. Select the invasive pressure parameter window.

2. Select the Setup tab > Cursor.

3. Select Show Cursor.

4. You can move the cursor to specific points with the arrows.

5. To save the pressure value at the cursor point, select Save.

6. To stop showing the cursor, deselect Show Cursor.

Setting an arterial invasive pressure
disconnection alarm

You can set an additional alarm to activate if the mean pressure falls below 10 mmHg
(1.33 kPa). The arterial disconnection alarm also applies to channels Fem and UAC.

1. Select the invasive pressure parameter window.

2. Select the Advanced tab.

3. Select Arterial Disconnect.

Setting invasive pressure alarm limits
1. Select the invasive pressure parameter window.
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2. Select the desired alarms setting:
● x Alarms (e.g., Art 1 Alarms): Settings for the selected invasive pressure

channel.
● HR Alarms: Settings when the heart rate alarms are from a single source.
● PR(x) Alarms (e.g., PR(Art 1) Alarms): Settings when the heart rate alarms are

calculated from multiple sources.

NOTE If a feature is not active, the alarm limits are greyed
out. You can set them on by selecting Alarm On. If
informational priority level has been selected for the
alarm, the menu selections areMessage On andMessage
Off.

3. Set the alarm limits.

Configurable PR alarm delays
Alarm delays for PR (SpO2/IP) high and PR (SpO2/IP) low are configurable from 0 to 20
seconds in increments of 5 seconds. These delays are set through Default Setup >
Profile Settings > Alarm Delays and they are password protected.

You can check the delays through ECG > HR/PR Alarms > Priorities & Delays Info.

For more information, see the supplemental information manual.

Invasive pressures alarm priorities
You can set the alarm priorities for various invasive pressure alarms through Alarm
Setup > Alarm Priorities > Invasive Pressures. The allowed priorities are defined in
the Care Unit Settings, and they are password protected.

Checking alarm delays and priorities information
You can check which alarms have priority settings that deviate from the
recommendation of international safety standards, and also the delays selected for
each alarm.

1. Select the invasive pressure parameter window.

2. Select the Alarms tab.

3. Select P1 Art > PR(Art 1) Alarms, P3 Fem > PR(Fem) Alarms, or P7 Art 7 > PR(Art 7)
Alarms.

4. Select Priorities & Delays Info.

5. Check the priorities and delays.

Systolic pressure variation and pulse pressure
variation

Systolic pressure variation (SPV) and pulse pressure variation (PPV) can provide useful
information for example when assessing the effects of fluid therapy on the cardiac
output of a patient. A parameter window with both SPV and PPV values appears on
the display provided that SPV has been selected to the screen and the arterial site
selected as the SPV source is active.
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The SPV and PPV measurement is automatic, and SPV can also be taken manually.

With the NICU software package, no automatic SPV or PPV are available , only the
manual SPV can be used.

NOTE The SPV and PPV measurements are reliable for mechanically
ventilated patients with no arrhythmias, and when the arterial
site selected as the SPV source is providing reliable readings.

Changing the SPV source
1. Select the invasive pressure parameter window.

2. Select Art 1 to Art 8, Fem or UAC.

3. Select the Setup tab.

4. Select SPV Source > Art 1 to Art 8, Fem, or UAC. You can also turn off the
measurement by selecting Off (default).

Measuring SPV manually
The SPV can also be measured manually. In addition to ECG1 and the selected SPV
source, one of the following parameters is displayed in this order: Paw, CO2, Resp. You
can set the SPV cursors to define the difference between the minimum and maximum
systolic peak pressures.

1. Select the SPV and PPV parameter window.

2. Select Freeze Waveforms.

3. Adjust the cursors with the arrow selectors.

NOTE You must always adjust the cursors in the NICU software
package. The monitor does not suggest any cursor
positions as there is no automatic SPV measurement in
this software package.

4. You can save these cursors by selecting Save.

This will restart the waveforms. If you do not want to save the cursors, select
Restart Waveforms.

NOTE You can also set the scale for manual SVP measurement
through invasive pressure Setupmenu > Optimize Scale.

PA catheter insertion
The catheter insertion mode optimizes and enlarges the PA waveform field during
SWAN-GANZ thermodilution catheter insertion. Waveforms display at a rate of 12.5
mm/s and appear in the following display order: ECG1, Art 1 to Art 8, CVP, PA.

The arterial priority order is: Art 1 to Art 8, Fem, or UAC.

Selecting the PA catheter insertion mode
1. Select the PA invasive pressure parameter window.

2. Select Zero to zero the invasive pressure channel.
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3. Select Catheter Insertion.

The pressure scale settings follow the scale settings in the Setupmenu.

4. Select the procedure:

● To start an SvO2 procedure, select SvO2.

● To start a pulmonary capillary wedge pressure procedure, selectWedge.

● To start a cardiac output procedure, select C.O.

In the Catheter Insertionmenu, you can also freeze or restart the waveforms, and
print them:

● To freeze the moving waveforms, select Freeze Waveforms. At any time, select
Restart Waveforms to restart the waveforms.

● To print the catheter insertion waveforms, select Print Waveforms. At any time,
select Stop Printing or Cancel Printing to stop printing the waveforms.

Pulmonary capillary wedge pressure (PCWP)
measurement

You can obtain a PA wedge measurement (PCWP) manually or with the automated
wedge program. The manual measurement mode allows you to manually determine
the PCWP value. The automated wedge program displays on-screen messages to
inflate or deflate the catheter balloon. In either mode, the wedge algorithm then
determines the PCWP value. You can confirm this value or adjust the measurement
with the provided cursor.

NOTE E-modules always use the automated wedge program to
determine the PCWP value.

NOTE PDM may use either the automated wedge program or a
manual measurement to determine the PCWP value. The
PA wedge algorithm requires a 30% change in waveform
size between the PA and Wedge waveform in order to
initiate the automated program. If the algorithm fails to
distinguish between the waveforms, you should use the
manual measurement mode.

Showing the PCWP value in the PA window
1. Select the PA invasive pressure parameter window.

2. Select the Setup tab.

3. Select Show PCWP.

Taking a manual PA wedge measurement
NOTE PDM only.

1. Select the PA invasive pressure parameter window.

2. Select the Setup tab.

3. SelectWedge.

4. Select Mode: Manual.
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5. To record a realtime PA wedge waveform during analysis, select Print PA
Waveform. To stop printing, select Stop Printing or Cancel Printing.

6. Inflate the catheter balloon when the Manually "Freeze / Adjust" when ready
message displays.

7. Select Freeze/Adjust once the PCWP waveform is displayed. The Wedge
Complete message displays.

8. Deflate the balloon.

9. To adjust the PA wedge value, move the cursor up or down with the PCWP
/ Cursor arrows.

10. To save the PCWP value, select Confirm Wedge.

The saved PA wedge value displays in the parameter window and is stored in
trends and hemodynamic calculations.

11. To print a PCWP report, select Print PA Report. To stop printing, select Stop
Printing or Cancel Printing.

The PA wedge report contains 20 seconds of waveform data displayed at a
waveform speed of 12.5 mm/s.

Taking an automated PA wedge measurement
1. Select the PA invasive pressure parameter window.

2. Select the Setup tab.

3. SelectWedge.

4. Select Mode: Auto.

5. To record a realtime PA wedge waveform during analysis, select Print PA
Waveform. To stop printing, select Stop Printing or Cancel Printing.

6. Inflate the catheter balloon when the Inflate the Balloonmessage displays.

NOTE PDM only: Once the PCWP waveform is detected, the
Wedge processingmessage displays.

After 10 seconds, the automated wedge program displays the Deflate the
balloon, followed by theWedge Completemessage.

7. To adjust the PA wedge value, move the cursor up or down with the PCWP
/ Cursor arrows.

8. To save the PCWP value, select Confirm Wedge.

The saved PA wedge value displays in the parameter window and is stored in
trends and the hemodynamic calculations.

9. To print a PCWP report, select Print PA Report. To stop printing, select Print
Waveforms or Cancel Printing.

The PA wedge report contains 20 seconds of waveform data displayed at a
waveform speed of 12.5 mm/s.

Starting a new PA wedge measurement
You can clear the current wedge measurement and start a new one:
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1. Select PA invasive pressure parameter window.

2. Select Setup.

3. SelectWedge.

4. Select Restart Wedge.

Other selections in theWedgemenu
There are also two other selections in theWedgemenu:
● C.O.: This selection will open the C.O. Setup menu.
● Calculations: This selection will open the Hemo calculations menu.

Calibrating the invasive pressure measurement
with PDM

1. Connect all invasive pressure transducers being tested to the module.

2. Select Monitor Setup > IP Calibration.

3. Select the pressure site to test.

4. Increase or decrease the pressure to adjust the displayed pressure to a known
calibration factor and select Confirm.

5. Repeat for each pressure site as needed.

6. Select Previous Menu > Close.

Invasive pressure calibration with E-modules
The invasive pressure calibration with E-modules requires specific tools and setup. For
detailed instructions, see the Module Frames and Modules Service Manual.

Invasive pressure practicalities

Invasive pressure parameters
The measured invasive pressure parameters are systolic, diastolic, and mean. Pulse
rate can be monitored with any arterial site. PCWP can also be measured for a PA
site. CPP is a calculated value that requires a valid ICP value and a valid arterial site
value. In addition, also SPV and PPV can be measured.

With the B850 you can monitor up to eight pressures, with the B650 you can monitor
up to seven pressures, and with the B450 you can monitor up to six pressures.

The following table lists the available site names and displayed values:

Site Site name PDM, displayed values E-modules, displayed
values

General site name for the
specific invasive pressure
channels 1 to 8

P1 to P8 Mean Systolic, diastolic, mean

Arterial Art 1 to Art 8 Pulse rate, systolic,
diastolic, mean

Pulse rate, systolic,
diastolic, mean
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Site Site name PDM, displayed values E-modules, displayed
values

Central venous CVP Mean Systolic, diastolic, mean

Femoral arterial Fem Pulse rate, systolic,
diastolic, mean

Pulse rate, systolic,
diastolic, mean

Femoral venous FemV Mean Systolic, diastolic, mean

Intracranial ICP 1 to ICP 8 Mean Systolic, diastolic, mean

Left atrial LAP Mean Systolic, diastolic, mean

Pulmonary artery PA Systolic, diastolic, mean Systolic, diastolic, mean

Right atrial RAP Mean Systolic, diastolic, mean

Right ventricular RVP Mean Systolic, diastolic, mean

Umbilical artery catheter UAC Pulse rate, systolic,
diastolic, mean

Not supported.

Umbilical venous
catheter

UVC Mean Not supported.

Intra-aortic balloon pump
NOTE PDM only. Not available in the NICU software package.

GE recommends that the signal source used to trigger an IABP should be the
intra-aortic balloon pump itself. This ensures that the trigger signal is compatible with
all modes of the IABP. An extra set of ECG electrodes or an additional connection
from the arterial line can be connected to the monitor to produce waveforms on the
monitor’s display for consolidated viewing.

When using the monitor for triggering, the IABP triggers off the PDM module’s
Defib Sync ports and uses the first zeroed arterial invasive pressure channel. If the
intra-aortic balloon pump triggers off arterial pressure, the analog output defaults to
the numerically first zeroed arterial pressure:Art 1 to Art 8, Fem, or UAC. If no arterial
pressure is available, the numerically first zeroed pressure is used.

Triggering intra-aortic balloon pumps
NOTE If you choose to use the monitor for triggering, use the

following instructions. Failure to follow these instructions may
result in an incompatible analog output signal, which may
contribute to patient injury.

1. Contact the balloon pump manufacturer for interface requirements. See the
technical specifications for the ECG analog output delay specification for the
acquisition device.

2. Connect a compatible analog output cable to the monitor through the PDM
module’s Defib Sync connector.

3. Adjust the invasive pressure filter. If arterial pressure is used to trigger the balloon
pump, use the 40 Hz pressure filter.

4. Primary displayed ECG lead: If the balloon pump triggers off the R wave of the
ECG, review the patient’s ECG leads and place the one with the greatest amplitude
in the top (primary) position on the monitor display.
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5. Pacemaker detection: If the patient has a pacemaker, be sure the pacemaker
detection is turned on. Failure to turn pacemaker detection on may cause poor
beat detection, which may result in inadequate triggering of the balloon pump.

Effects of IABP on displayed values
Displayed pressure values are affected by the intra-aortic balloon pump. The IABP
program displays three values, for example 150/45 (98). The first value is the systolic
value, the second is the diastolic value, and the third is the mean value. The displayed
numeric values are indicating a rapidly varying waveform generated during IABP
treatment and do not always reflect a true arterial blood pressure.

For accuracy and reliability, always combine two or more of the recommended
methods for reading arterial and/or femoral blood pressure:

● The IABP waveform displayed on the screen (use scales for evaluation),

● A printed copy of the waveform (use scales for evaluation),

● The display on the balloon pump device, if available.

Since there are a number of points along the IABP waveform that could be the
displayed value, it is important to know which points the program uses. The values
displayed will differ depending on the timing of the pump.

1:1 or 1:2 timing
Diastolic numerics: The displayed diastole always equals the balloon end diastole.

Systolic numerics:

● When the augmented diastole is greater than the patient systole, the displayed
systole equals the augmented diastole.

Art 134/63

● When the patient systole is greater than the augmented diastole, the displayed
systole equals the patient systole.
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Art 160/45

1:3 or more timing
Diastolic numerics: The displayed diastole switches between the balloon end diastole
and the patient end diastole.

Systolic numerics: The displayed systolic numerics switch between the augmented
diastole and patient systole.

Displayed values will switch between: Art 123/51 ( ) and Art 100/60 ( )

Invasive pressure troubleshooting
Problem Solution

Artifact detected and the Smart BP option is turned
on.

● Check the patient status.

● Reposition the catheter.

● Zero the transducer.

● If problem persists, turn off the Smart BPoption.

● If the Smart BP option is turned off, use the audio
pause feature before drawing blood and before
zeroing to reduce nuisance alarms.

Invasive pressure readings seem unstable. ● Make sure there are no air bubbles in the
transducer systems.
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Problem Solution

● Flush and zero.

● Place the transducer on the patient’s phlebostatic
axis.

---/--- (80) Systolic and diastolic pressure values do
not display.

This may be due to the Smart BP option detecting
artifact. When artifacts are detected, only Mean
values are displayed.
● Check the patient.

● Turn off the Smart BP if required.

Numeric values are replaced by --- and the Module
voltage low alarm is active.

Measurement may not be working properly due to a
technical fault in the monitor.

● Check the patient status.

● If the problem persists, contact qualified service
personnel.

Invasive pressure waveform is displayed but no
numeric values are displayed.

● Zero the channel. Invasive pressure numeric
values are displayed only for successfully zeroed
channels.

Zeroing of invasive pressure channel(s) fails. ● Ensure that the channels are open to air.

The channel standby is not selectable, or it is
terminated without the user giving the activation
request.

If the pressures remain between 10 mmHg and
250 mmHg for 10 seconds or more, the selection is
disabled or the standby is terminated.

The measurement values in the SPV and PPV
parameter window are not displayed.

● Ensure that there are no arrhythmias present.

● Check that the correct arterial site has been
selected as the SPV source.

● If you are using the SPV measurement in the NICU
software package, only manual measurement is
shown.

● The algorithm requires at least three pulse beats
per each respiration cycle and when this is not
true, the values are not shown. Try using manual
measurement.

Why are displayed pressure values different than
expected?

● Check the patient. Values could be valid, the
patient could be lying on the tubing, or the tubing
could be kinked.

● Check tubing for bubbles.

● Remove excess tubing.

● Check phlebostatic axis placement of transducer.

● Rezero pressure.

● If patient is on IABP, verify that the monitor’s IABP
program is turned on. If necessary, turn it on.
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Problem Solution

Why are the arterial, non-invasive (oscillometric),
and auscultated blood pressure readings indicating
different values?

The three measurement methods use different
technologies. Auscultation and oscillometric are
both indirect methods of measuring blood pressure.
In auscultation, changes in arterial sounds during
cuff deflation are related to systolic and diastolic
pressure. With oscillometric measurement, changes
in measured pressure oscillations during cuff
deflation are related to systolic, mean and diastolic
pressures. Changes in the vascular tone of the
arterial system can cause these two indirect methods
to differ from one another and from direct arterial
pressure measurements.
Invasive arterial blood pressure is a direct method
of measuring blood pressure. Differences between
direct and indirect blood pressure measurements are
expected. These differences occur because direct
methods measure pressure and indirect methods
measure flow. In addition, differences occur because
the measurement location is not the same (e.g.,
brachial artery for NIBP vs. radial artery for invasive
arterial pressure monitoring).

Why is the monitor alarming arterial disconnect? ● Check the patient immediately in the event the
catheter has been dislodged.

● If the arterial disconnect alarm is turned on and
the mean pressure falls below 10 mmHg, the
monitor alarms. When zeroing a pressure line,
start the zeroing process within 8 seconds. After
that time the disconnect alarm is activated.

● If zeroing, close the stopcock. Once the monitor
detects the return of waveform and numeric data,
the alarm will reset.

Why can't the monitor detect PA wedge? Themonitor must detect a 30% decrease in waveform
amplitude to initiate a wedge.

● Use the manual method for PA wedge
measurement.

Why is the monitor displaying a message indicating
that it is processing the wedge when the balloon has
not been inflated?

● Begin wedge processing again. If a wedge is
again detected due to respiratory artifact on the
PA waveform, use the manual method for wedge
measurement.

Why is monitor displaying the Deflate the balloon
message after the balloon was inflated?

Themonitor must detect a 30% decrease in waveform
amplitude to initiate a wedge. If the waveform does
not change accordingly, the message will continue
to be displayed.

● Use the manual method for PA wedge
measurement.
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Problem Solution

Why is the displayed wedge measurement different
than expected?

● Repeat the wedge measurement, allowing a
minimum of three respiratory cycles of data.

● Verify end-expiration using the respiratory
waveform on the display and observing the
patient’s breathing pattern. Vertical cursors help
to identify the end-expiration and align it with the
PA pressure waveform.

● Adjust the PA wedge cursor to the end-expiratory
wedge value if necessary.

Why is there a flashing heart icon displayed next
to the PR value in the corresponding parameter
window?

The selection is ECG or SpO2menu > Beat Source >
Art 1 to Art 8, Fem, or UAC. No action is required.
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Temperature

Temperature compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

Temperature safety precautions

Temperature warnings

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires. Using other cables or leadwires may
result in damage to the equipment and compromise patient
and user safety.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.

WARNING When using a dual temperature cable, make sure to turn the
cable’s selection switch to the correct position (400).

Temperature measurement limitations
E-modules are not suitable for use with neonatal patients.
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Temperature points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.
● For information on materials used in accessories and their biocompatibility, refer

to the instructions for use in the accessory package.
● Use only GE approved temperature accessories.
● For more detailed information regarding the temperature probes, refer to their

own instructions for use.
● Depending on the temperature module used, not all temperature measurements

and settings are available to view or change.
● The temperature measurement uses direct mode. Displayed temperature values

represent the probe temperature of the measurement site on the patient.
● If two temperature measurement modules that map to the same temperature

channel are connected, the first detected temperature measurement module is
assigned to the indicated temperature channel. When this occurs, a technical
alarm indicating identical modules is generated.

● A temperature channel is activated when the module detects a temperature cable
(PDM) and temperature probe (E-modules).

● A temperature channel is deactivated when a temperature cable (PDM) or probe
(E-modules) is detached from the module.

● A deactivated temperature channel does not release the assigned temperature
channel. To release an assigned temperature channel, remove the module from
the system.

Temperature measurement setup

Temperature equipment to patient connection

1. Module with temperature measurement capability
2. Dual temperature cable
3. Single temperature cable
4. Temperature interconnect cable for disposable temperature probes
5. Reusable temperature probe (example)
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6. Disposable temperature probe (example)

Preparing the patient for temperature measurement
1. Follow the manufacturer's instructions for probe application.

2. Connect the temperature cable to the acquisition module connector.

Checking the temperature measurement
1. Check that the temperature value is displayed when the probe is connected to

a temperature cable.

Temperature measurement on screen
Up to four temperature measuring sites can be simultaneously measured and
monitored (five sites when monitoring Tblood). Temperature monitoring provides
numerics only. No waveform is generated or displayed.

NOTE A maximum of six user-defined measuring site label names
can be configured. See the supplemental information manual
for details.

The default temperature measuring site labels are as follows:

T1, T2 = general label Skin = skin

T3, T4 = general label AirW = airway

Eso = esophageal Room = room

Naso = nasal Myo = myocardial

Tymp = tympanic Core = core

Rect = rectal Surf = surface

Axil = axillary Blad = bladder

Using the temperature measurement

Temperature mappings
Temperature measurements are mapped to one of five temperature channels as
follows:

Temperature channel Measurement source, B850 Measurement source, B650
or B450

T1 PDM, PSM PDM, PSM

T2 PDM, PSM PDM, PSM

T3 E-PT E-PT

T4 E-PT E-PT

Tblood PDM, E-COP, E-COPSv
, or Unity ID.

PDM, E-COP, E-COPSv
, or Unity ID.
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Starting the temperature measurement
Connect the temperature probe to start the measurement. If the parameter window
displays Off in the value field:

1. Select the temperature parameter window.

2. Confirm that Measurement > On is selected.

Changing the temperature site label
1. Select the temperature parameter window.

2. Choose a site label from the Label list.

NOTE In addition to the default channel labels, you can configure up
to six user-defined channel labels in the care unit settings. See
the supplemental information manual for details.

Displaying the delta value between two temperature
channels

NOTE This selection is available when two temperatures are
displayed in the same temperature parameter window.

1. Select the temperature parameter window.

2. Select Show Tx-Ty (for example,T2-T1).

Setting temperature alarms
1. Select the temperature parameter window.

2. Select Alarms.

3. Choose a temperature channel or temperature delta.

If the feature is not active, the alarm limits are greyed out. Activate the alarm
by selecting Alarm On to set the alarms. If informational priority level has been
selected for the alarm, the menu selection is Message On.

4. Set the alarm limits.

If the setting of an alarm limit has been disabled during configuration, the setting is
marked with a lock symbol .

The high limit alarm setting for delta values is also adjustable.

Stopping the temperature measurement
1. Select the temperature parameter window.

2. Select Measurement > Off.

Temperature practicalities
● Each temperature label can be changed to reflect the temperature measurement

site.

● Individual temperature sites can be turned off.
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● Tblood is obtained from a pulmonary artery catheter.

● The difference between two temperature sites can be calculated and displayed.

● The dual temperature cable allows a two-channel measurement.

● The signal input is a high-insulation port to ensure patient safety and to protect the
device during defibrillation and electrosurgery.

● The monitor automatically calibrates the temperature measurements at startup
and then every 10 minutes for PSM and E-PT, and at least once a minute for PDM.

Temperature troubleshooting
Problem Solution

Temperature measurement fails ● Check that the probe adapter is properly
connected to the acquisition module.

● Check that the probe is properly connected to the
temperature cable or interconnect cable.

● Check that you are using the correct probe for the
anatomical location being monitored.

● Use a probe that is compatible with your system.

● Try using a known good probe in case the sensor
is damaged.

● Check that the acquisition module is properly
connected to the monitor.

● Check the patient connection.

● Check that there are not two identical
measurement modules in the system.

● If the problem persists, contact qualified service
personnel.
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Cardiac output

Cardiac output compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

C.O. safety precautions

C.O. warnings

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires. Using other cables or leadwires may
result in damage to the equipment and compromise patient
and user safety.

WARNING All invasive procedures involve risks to the patient. Use aseptic
technique. Incorrect use of the catheter can lead to vessel
perforation. Follow catheter manufacturer's instructions.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.

WARNING The cardiac output measurement results may be erroneous
during electrosurgery.

WARNING During atrial fibrillation the C.O./CCO readings may be
erroneous.
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C.O. cautions
CAUTION The C.O. time stamp indicates the time at which the C.O. value

was received by the monitor from the connected device.
In cases when the C.O. device is disconnected and then
reconnected to the Unity Network Interface Device (ID), the
time stamp may not indicate the actual time of the reading.

C.O. measurement limitations
● E-modules used for this measurement are not suitable for use with neonatal

patients.

C.O. points to note
● Cardiac output measurements from the PDM requires a C.O. license.

● This equipment is suitable for use in the presence of electrosurgery, as tested
according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● The C.O. connector cables are module-specific and can only be used with the
appropriate C.O. module.
For more information, see the supplemental information manual.

● The patient's height and weight values are required for determining Cardiac Index
(C.I.).

● E-modules only: Predefined catheters are already configured for a right ventricular
ejection fraction (REF) measurement, but user-defined catheters must be
configured to support it. Catheters that show up in the selection list can be added
or deleted through Care Unit Settings > Parameters > Catheters, and these
settings are password protected.

● Blood temperature measurement, Tblood, is provided from any supported
acquisition module that provides C.O. measurements. The Unity Network Interface
Device (ID) can only be used if no other acquisition module provides C.O.

● Depending on the module used, not all cardiac output measurements and settings
are available to view or change.

C.O. measurement setup

C.O. equipment to patient connection with an in-line probe
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1. Module with C.O. measurement capability

2. Cardiac output cable

3. In-line injectate probe

4. Injectate syringe

5. Injectate solution

6. CVP line to IP transducer or fluid infuser

7. Proximal injectate port

8. PA distal port

9. Optical module connector (used for SvO2 measurement)

10. Swan-Ganz thermodilution catheter

11. Thermistor connector

12. Balloon

13. Balloon inflation valve
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C.O. equipment to patient connection with a bath probe

1. Module with C.O. measurement capability

2. Cardiac output cable

3. Thermistor connector

4. Injectate temperature bath probe

5. Injectate fluid

6. Injectate syringe

7. Proximal injectate port

8. PA distal port

9. Balloon inflation valve

10. Swan-Ganz thermodilution catheter

11. Balloon

C.O. module key
There is one C.O. module key on the E-COP and E-COPSv modules:

Start C.O. Starts and stops the cardiac output measurement.

Preparing the C.O. measurement
1. Connect the C.O. cable to the acquisition module, thermistor, and injectate

temperature port.

2. Follow your care unit’s policy and procedures for positioning the patient for the
C.O. measurement.

3. Follow the catheter manufacturer's instructions to set up the in-line or bath
probe patient cables.
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4. For an in-line setup, make sure the in-line sensor is securely connected to the
tubing.

5. For the bath probe setup, make sure the bath probe is correctly sensing the
injectate temperature.

Checking the C.O. measurement
1. Check that the monitor recognizes cable connections (activates the display) and

all C.O. menu selections are available.

2. Remember that in order to get Cardiac Index (C.I.) you must first enter the patient
demographics.

3. For E-modules, check that the message Press Start C.O. or Press Start C.O. Serial
appears on the screen.

Using the C.O. measurement

Entering patient data for the C.I. value
The patient's height and weight values are required for determining cardiac index (C.I.).

1. Select the cardiac output parameter window.

2. Select the Measurement tab.

3. Select Demographics.

4. Set the patient’s height and weight with the arrows.

The BSA value is calculated automatically once the height and weight have been
selected.

5. You can return to the Cardiac Outputmenu by selecting Previous Menu.

C.O. measurement modes
C.O. measurements can be taken using the automatic or manual measurement
modes. Both measurement modes allow you to use up to six C.O. measurements
for calculating a C.O. average.

You can confirm the C.O. measurements within 30 minutes from the start of the first
thermodilution measurement, so even if you leave the menu the measurements will
not disappear during this time.

Taking an automatic C.O. measurement
PDM: When measuring C.O. using the automatic mode, the monitor averages
approximately 8.5 seconds of the patient’s blood temperature before establishing a
stable baseline and displaying the Inject When Readymessage.

E-modules: When measuring C.O. using the automatic mode, new measurements can
be taken when the Press Start C.O. Serialmessage displays.

Holding the injectate syringe by the plunger, not the barrel, improves measurement
accuracy.

1. Select the cardiac output parameter window.

2. Select the Setup tab.
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3. Select the radio button for Automaticmeasurement type.

4. Verify that the catheter settings are correct.

5. Select the Measurement tab.

6. Complete the following:

a. PDM: Get ready to inject the injectate solution when the message Inject When
Ready appears.

b. E-modules: When the message Press Start C.O. Serial appears, select Start
C.O. Serial.

7. Inject the injectate solution smoothly within 4 to 5 seconds.

8. The message Measuring displays, followed by the message Please wait until
the calculation is completed.

9. Observe the thermodilution curve displayed on the screen. The message C.O.
Complete displays after the C.O. determination has been made, followed shortly
by the message Please wait.

The curve disappears from the screen when the next measurement cycle can
start.

10. To take another C.O. measurement, wait for this message to display before
injecting the injectate:

● PDM: Inject When Ready

● E-modules: Inject now!

Taking a manual C.O. measurement
Measuring C.O. using the manual mode allows you to determine when to begin the
injection procedure. This mode may be preferred for patients with extreme blood
temperature fluctuations, or when the automatic mode is unable to establish a stable
baseline.

Holding the injectate syringe by the plunger, not the barrel, improves measurement
accuracy.

1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select the radio button for Manualmeasurement type.

4. Verify that the catheter settings are correct.

5. Select the Measurement tab.

6. Select Start C.O.

With E-modules, you can also use the Start C.O.module key.

7. When the Inject now! message appears, inject the injectate solution smoothly
within 4 to 5 seconds.

8. The message Measuring displays, followed by the message Please wait until
the calculation is completed.
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9. Observe the thermodilution curve displayed on the screen. The message C.O.
Complete displays after the C.O. determination has been made, followed shortly
by the message Please wait.

The curve remains on the screen.

10. Allow 1 to 1.5 minutes between injections to stabilize the catheter baseline
temperature.

The colder the injectate, the longer the time needed

11. To perform another C.O. measurement: wait for the Press Start C.O.message >
select Start C.O.

C.O. trial measurements
A real-time thermodilution curve and numeric value are displayed with each cardiac
output trial. Up to six measurements are retained. After each measured C.O. the
program automatically averages the C.O. value. It is recommended to use three to five
measurements with less than 10% variation between them for average C.O. When
saved, the averaged value is entered into the hemodynamic calculations. The saved
average C.O. value is displayed in the parameter window with a timestamp.

Printing a report of C.O. trials
The C.O. report must be initiated before confirming the C.O. measurements.

1. Select the cardiac output parameter window.

2. Select the Measurement tab.

3. Select Print.

The selection is available only if you have not confirmed the C.O. measurements.

Editing the C.O. average
1. Select the cardiac output parameter window.

2. Select the Measurement tab.

3. Select Edit Average.

4. Check the selection boxes for those trials you wish to include in the C.O. average.
If you do not wish to include a trial, ensure its selection box is not checked.

5. Select Confirm C.O. to store the calculated C.O. average and display it in the
cardiac output parameter window.

If you wish to print a C.O. report, you must start printing before confirming the C.O.

Canceling a C.O. measurement
When a C.O. measurement has just completed, you can remove this C.O. measurement
trial without entering the Edit Average window.

1. Select Measurement tab > Cancel/Reject Injection.

E-modules: In addition to removing the previous measurement, you can also
cancel an in-process measurement.
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C.O. catheter selections
You can select a cardiac output catheter from a list of default catheters and
preconfigured catheters, or enter a catheter for temporary use. Pre-configured
catheters which show up in the list can be added or deleted through Care Unit
Settings > Parameters > Catheters. These settings are password protected.

For more information, see the supplemental information manual.

Selecting a C.O. catheter from the list
1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select a catheter name from the Manufacturer list.

4. Select a catheter model from the Model list.

Entering a user-defined C.O. catheter
All user-defined catheter settings are erased when the monitor is discharged.

1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select Manufacturer > User Defined.

4. Set the Injectate Volume to match the value listed on the catheter packaging.

5. Set the Computation Constant to match the value listed on the catheter
packaging.

Selecting the C.O. injectate probe type
NOTE PDM only. E-modules detect the type of injectate probe

automatically.

1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select the correct Probe Type: Bath or In-Line.

Setting a C.O. right ventricular ejection fraction (REF)
measurement

NOTE E-COP and E-COPSv modules and catheters that support right
ventricular ejection fraction measurement only. PDM does not
provide a REF measurement.

A valid heart rate is required to take a REF measurement. ECG from a telemetry
transmitter cannot be used.

1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select the check box for REF Measurement.
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Selecting the C.O. scale
This selection sets the upper limit of the waveform scale for the thermodilution
waveform fields.

1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select a value from the Scale list.

Selecting what to show with C.O.
This setting affects the contents of the cardiac output parameter window.

1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select a value from the Show with C.O./C.I. list: None, PCWP, Tblood. With E-COP
and E-COPsv you can also select REF.

If you have an interfaced device measuring CCO, the list is called Show with
CCO/CCI.

Setting the Tblood alarm
1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select Tblood Alarm.

If the feature is not active, the alarm limits are greyed out. Select Alarm On to
set the alarms.

4. Set the Tblood alarm limits as required.

5. You can return to the cardiac output menu by selecting Previous Menu.

Adjusting the SvO2 from the cardiac output menu
NOTE E-modules and catheters supporting the SvO2 measurement

only.

1. Select the cardiac output parameter window.

2. Select the Setup tab.

3. Select SvO2.

4. Adjust the SvO2 settings as required.

5. You can return to the cardiac output menu by selecting Previous Menu.

Editing calculations
When a C.O. measurement has been confirmed, you can access the calculations
menu and adjust the hemodynamic, oxygenation, or ventilation calculation values as
needed.

1. Select the cardiac output parameter window.

2. Select the Measurement tab.
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3. Select Calculations.

4. Make necessary changes by selecting the Hemo, Oxy, or Vent tab > Edit Input.

5. You can return to the Cardiac Outputmenu by selecting Previous Menu.

Adjusting the wedge from the cardiac output menu
TheWedge selection is available only when there is a confirmed C.O. measurement
and an invasive pressure channel has been labeled as PA.

1. Select the cardiac output parameter window.

2. Select the Measurement tab.

3. SelectWedge.

4. Adjust the wedge settings as required.

5. You can return to the cardiac output menu by selecting Previous Menu.

C.O. practicalities

Cardiac output thermodilution curve
The thermodilution curve, which displays after a C.O. injection, shows the drop in blood
temperature as the injectate mixes with the blood. The peak of the curve indicates the
maximum difference in the patient’s baseline blood temperature and the temperature
of the injectate solution. As the mixture passes through the catheter and then out the
pulmonary artery, the temperature difference decreases as indicated by the curve
returning to the baseline. A spike is displayed at the onset of the curve, again at
70% of the maximum temperature difference, and again at 35% of the maximum
temperature difference. Spikes are also visible during an ongoing C.O. measurement.

1. Onset spike

2. 70% spike

3. 35% spike

Cardiac output is inversely proportional to the area under the thermodilution curve.
Cardiac output varies with body size. To more accurately assess cardiac performance
for individual patients, the cardiac index is often used.

How to improve the C.O. accuracy
The following influencing factors can influence the cardiac output accuracy:

● The technique used in performing a cardiac output.

● Temperature of the injectate solution.

● Volume of the injectate solution.
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● Patient’s baseline blood temperature.

● Patient’s inspiratory/expiratory cycle.

● Placement of catheter with relation to proximity of lung field.

● The pulmonary artery catheter itself.

● The patient’s rhythm and hemodynamic status.

● Any other rapid IV solutions which are infused while the cardiac output is being
performed.

The following are suggestions about technique that can help obtain accurate cardiac
output:

● Always hold the syringe by the plunger, not the barrel.

● Inject solution rapidly and smoothly.

● Inject within four to five seconds.

● Inject at end expiration.

● When not using an automatic program, wait one minute between injections to
allow baseline to stabilize.

● The temperature of the injectate should always be colder than blood temperature.
Keep the handling and waiting time with a filled syringe before injection as short as
possible. Warm injectate may lead to erroneous C.O. values.

● The probe can be a bath probe continuously measuring the cooling bath
temperature or the infusion bag temperature. Alternatively, a flow-through probe is
used for a closed injectate delivery. With an in-line system, the displayed injectate
temperature is the lowest temperature measured during injection.

C.O. troubleshooting
Problem Solution

C.O. measurement fails? The amount of injectate is too small or the injectate
is too warm.

● Inject smoothly and within 4 to 5 seconds.

What if the C.O. value is lower than expected? Cardiac output must be computed within 20
seconds. Decreasing the volume and increasing
the temperature will give you a smaller differential
change and should increase the chance of computing
a cardiac output within the 20-second period.

● Decrease the volume injected.

● Increase the temperature of the injectate.

What if the C.O. value is higher than expected? Cardiac output must be computed within 20
seconds. Increasing the volume and decreasing
the temperature will give you a greater differential
change.

● Increase the volume injected.

● Decrease the temperature of the injectate.
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Problem Solution

What if a stable baseline temperature cannot be
detected?

A message indicating a failure is displayed.

● Check the patient and the C.O. setup (both the
settings and the cables).

● Check for a significant amount of respiratory
variation and for rapid IV solution infusion, either
of which may influence the baseline temperature.
It may be necessary to stop or slow the solution
infusion during C.O. measurement, however, use
caution if the solution includes drugs/medication.

● Check the injectate temperature (IT). There should
be a minimum temperature difference of 10° C (18°
F) between the patient blood temperature and the
injectate solution temperature. Cool the injectate
solution if needed to increase the difference.

● Replace the injectate temperature cable.

● The pulmonary artery catheter may be damaged.
Replace it.

What if the cardiac output values are inaccurate? When in-line is being used along with iced injectate,
the initial temperature displayed will be the room
temperature. However, when the solution is injected,
the temperature displayed will decrease.

● Technique. It is important to understand the
technique used in performing a cardiac output
since it is a major influencing factor in obtaining
accurate cardiac output values.

￭ If room temperature solution is used, be sure
the bag is not exposed to a supplemental
heat source or touching other solutions or
equipment. This is important so the solution
temperature will be the same as the room air
temperature sensed through the bath or in-line
probe. Any difference in temperature could give
an inaccurate reading.

￭ When injecting, always hold the syringe by the
plunger and not by the barrel. The temperature
of the solution increases at a slower rate if the
barrel is not held, and therefore reduces the
potential for error in a cardiac output value.

￭ It is recommended that you inject rapidly
and smoothly into the proximal port of the
pulmonary artery catheter, within 4 to 5
seconds.

￭ Allow the baseline to stabilize between
injections. If automatic program is not being
used, allow one minute between injections. If
automatic program is being used, follow the
monitor prompts to inject.

￭ It is also recommended that you inject at the
patient’s end expiration. This helps reduce any
respiratory noise and therefore lessens error.
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Problem Solution

￭ A minimum difference of 10° C (18° F)
between the patient blood temperature
and solution/injectate temperature is
recommended.

● Respiration. The patient’s inspiratory/expiratory
cycle and placement of the catheter affects the
cardiac output value. Whenever the patient
inhales and exhales, the temperature in the lung
changes. During inspiration, the patient’s blood
temperature decreases and during expiration it
increases. Therefore, placement of the catheter
in relation to proximity of the lung fields affects
the baseline. If there is a significant amount of
respiratory noise on the patient’s baseline, cardiac
output may be calculated even if no injection was
performed. There is no differentiation between
temperature change caused by breaths versus
injections. It simply looks for a change in baseline
temperature.

● Baseline blood temperature. As little as a half
a degree Celsius change in blood temperature
due to respiratory noise may cause a C.O. value
to be displayed when an injection has not been
performed. Using auto mode looks for a stable
baseline before allowing an injection.

● Pulmonary artery catheter. The catheter itself may
be damaged (e.g., defective thermistor or defective
tubing).

● Hemodynamics. The patient’s rhythm can affect
the cardiac output value. If cardiac output trials
are being done at a time when the patient has
arrhythmias, you may notice a discrepancy in the
cardiac output values.

● Rapid IV solutions. Any rapid IV solution that is
infusing at the time when the solution is injected
can alter the cardiac output value. Maintain a
constant rate, or if possible, stop the solution 30
seconds before the C.O. injection and then restart
the infusion after the cardiac output is calculated.

● Injectate temperature fluctuation. If the injectate
temperature is fluctuating, check the injectate
temperature cable connection.

What if cardiac output is being calculated even
though solution has not been injected?.

There may be a change in the patient’s blood
temperature consistent with an injection.

● Check the patient and the C.O. setup (both the
settings and the cables).

● Check for a significant amount of respiratory
variation and for rapid IV solution infusion, either
of which may influence the baseline temperature.
It may be necessary to use the manual cardiac
mode rather than the automatic mode.
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Venous oxygenation (SvO₂)

SvO2 compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

SvO₂ safety precautions

SvO2 warnings

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires. Using other cables or leadwires may
result in damage to the equipment and compromise patient
and user safety.

WARNING All invasive procedures involve risks to the patient. Use aseptic
technique. Incorrect use of the catheter can lead to vessel
perforation. Follow catheter manufacturer's instructions.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.

WARNING The use of such dyes that usually change the patient
blood pigmentation may lead to faulty oxygen saturation
measurement values.

SvO2 measurement limitations
The SvO2 measurement is not intended for neonatal patients.
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SvO2 points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● Follow the catheter manufacturer's instructions for inserting the catheter.

● Follow your care unit’s policy and procedures for obtaining the SvO2measurements
and performing the calibration.

● Correct SvO2 measurements depend on the Hb values. Therefore, re-calibration
should be performed regularly in such clinical circumstances where the Hb values
change rapidly (for example, due to bleeding).

● For reliable saturation values from an external device, the signal strength indicator
should be higher than one asterisk.

● Depending on the module used, not all SvO2 measurements and settings are
available to view or change.

SvO₂ measurement setup

SvO2 equipment to patient connection

1. Module E-COPSv

2. Optical module

3. Optical connector

4. Swan-Ganz thermodilution catheter

Checking the SvO2 measurement
1. Check that the SvO2 value is displayed when the catheter is inserted in the patient

(always perform in vitro calibration first), the measurement has been started, and
theWarming up message has disappeared.

2. Check the position of the catheter regularly.

3. Calibrate in vivo and update the Hb value at least every 24 hours.
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SvO2 measurement on screen
Signal quality indicator from the catheter (only present when the SvO2 is measured
from an external device):

Indicator Explanation

no asterisk No signal

* Poor signal

** Fair signal

*** Good signal

Using the SvO₂ measurement

SvO2 calibration in vitro

1. Module E-COPSv
2. Optical module
3. Optical connector
4. Swan-Ganz thermodilution catheter

Calibrating a new SvO2 catheter in vitro
NOTE Do not perform in vitro calibration if the catheter has been

flushed. Using a wet catheter and calibration cup results in an
inaccurate calibration.

Always perform in vitro calibration with a new catheter before removing it from its
package. Follow the Advice to User information displayed in the Calibration window
to guide you through the calibration steps.

1. Connect the optical module to the acquisition module and let it warm up for 20
minutes.

2. Aseptically expose the catheter's optical connector.

3. Connect the catheter to the optical module.

4. Select the SvO2 parameter window.

5. Select the Calibration tab.
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6. If replacing an existing catheter, select New Catheter.

7. Select In Vitro Calibration > Calibrate to perform in vitro calibration.

8. Select Start SvO2 to complete the in vitro calibration.

9. Insert the catheter into the patient.

Recalling a previous in vitro calibration
After completing a successful initial calibration, you can recall the previous in vitro
calibration measurement when:

● The optical module is connected to the acquisition module and has not been
calibrated since being connected.

● An in vitro calibration was completed with this optical module using the same
catheter within the last 24 hours.

1. Select the SvO2 parameter window.

2. Select the Calibration tab.

3. Select Recall Calibration.

Calibrating SvO2 in vivo
NOTE For optimal accuracy, perform in vivo calibration at least

every 24 hours.
Follow the Advice to User information displayed in the Calibration window to guide
you through the calibration steps.

1. Select the SvO2 parameter window.

2. Select the Calibration tab.

3. Select In Vivo Calibration > Calibrate to perform in vivo calibration using the
SvO2 and Hb values measured from the blood sample.

4. Select Draw Blood Sample and slowly draw a blood sample.

5. Enter the laboratory results:

a. Select a value for Lab SvO2.

b. Select a value for Lab Hb.

6. Select Save Lab Values to complete calibration.

Updating the Hb value for SvO2measurement
The patient’s Hb value should be updated at least every 24 hours as it affects the
venous oxygenation measurement. The Update Hb selection is active after in vivo
calibration has been completed with the Save Lab Values.

1. Select the SvO2 parameter window.

2. Select the Calibration tab.

3. Select Update Hb and set the value.

Setting the SvO2 alarms
1. Select the SvO2 parameter window.

280 CARESCAPE Monitors B850, B650, B450 2105822-001



Venous oxygenation (SvO₂)

2. Select the Alarms tab.

If alarms have been set to Alarm Off, the alarm limits are greyed out. Select
Alarm On to set the alarms.

3. Set the alarm limits.

Stopping the SvO2 measurement
1. Remove the catheter from the patient.

2. Disconnect the catheter from the optical module.

3. Disconnect the optical module from the acquisition module.

4. Discard the catheter.

SvO2 measurement description
The SvO2 value is measured continuously by spectrophotometry. The algorithm
consists of five different parts:

● Initialization: When connected, a number of start-up procedures are performed
prior to normal operation. These procedures include transfer of calibration factors
and initialization of LED currents.

● Calibration

● Signal processing and SvO2 calculation: Light of various wavelengths (red 660 nm
and infrared 810 nm) is transmitted to the blood through a single plastic optical
fiber in the oximetry catheter, and reflected back through a separate optical fiber
to a photodetector. The light is electrically transmitted and analyzed. From the
amount of reflected light it is possible to measure the amount of light absorbed
by hemoglobin and oxyhemoglobin, resulting in the SvO2 value. The SvO2 value
is displayed as a percentage.

● Automatic gain control: The intensity of the red and infrared signals can be
amplified by four different gains. The gain is selected automatically to achieve
optimal signal levels.

● Signal quality

SvO2 troubleshooting
Problem Solution

SvO2 levels are too high ● Position the catheter correctly.

● Calibrate in vivo.

In vivo calibration fails ● Check the connections.

● Check that the optical cables have no sharp bends.

● If the in vivo calibration fails again, replace the catheter and/or the
optical module, and repeat the procedure.
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Airway gases

Airway gases compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

Airway gases safety precautions

Airway gases warnings
WARNING Always inspect the airway adapter for a tight connection and

proper operation before attaching it to the patient.

WARNING Leaks in the gas sampling circuit (water trap and sampling
line) may cause inaccurate readings.

WARNING Remove the airway sampling line from the patient’s airway
while nebulized medications are being delivered.

WARNING Handle the water trap and its contents as you would any body
fluid. Infectious hazard may be present.

WARNING Since sample gas may contain anesthetic agents, make sure
that it is not released in the room. Connect exhaust to a
scavenging system to prevent exposure to anesthetic agents.

WARNING Strong scavenging suction may cause excessive sample gas
flow and inaccurate gas readings.

WARNING Route all tubing away from the patient’s throat to avoid
strangulation.

WARNING To avoid the spread of infectious disease, do not allow the
exhaust to discharge in the direction of the patient or user.

WARNING EtCO2 values may differ from blood gas readings.

WARNING A failure in zeroing or calibrating airway gases may cause
inaccurate readings.
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WARNING INACCURATE READINGS. To ensure the accuracy of gas
measurement, perform regular calibration checks according
to the instructions provided. Failing to do so may result in
inaccurate readings and compromised patient safety. To
avoid this risk, always adhere to the recommended calibration
intervals.

WARNING Since calibration gas contains anesthetic agents, always
ensure sufficient ventilation of the room during calibration.

WARNING Always ensure the correct size and fit of accessories according
to patient type and application, especially when monitoring
pediatric and neonatal patients. The size and fit of accessories
may impact the measured gas concentration values at low
tidal volumes. It is recommended to have the gas sampling
port close to the proximal end of the endotracheal tube.
Excessive dead space in the circuit, including the accessories,
may cause re-breathing of gases. Very low accessory dead
space between the breathing circuit Y-piece and the gas
sampling site may impact the measured gas concentration
due to dilution of the sampled exhaled gas with fresh gas from
the ventilator. To confirm accurate correlation with measured
gases and blood, check arterial blood gas values to confirm a
suitable setup is used.

WARNING Do not wash, disinfect or open the water trap cartridge.
Do not touch the water trap membrane. The hydrophobic
membrane is damaged if any cleaning is attempted, and this
may result in the contamination of the gas sensors.

The following statements apply to the CARESCAPE respiratory modules:

WARNING Do not use a CO2 module at the same time as a CARESCAPE
respiratory module.

WARNING When using the CARESCAPE respiratory modules with volume
controlled ventilation at low tidal volumes, the specified gas
withdrawal rate may significantly reduce the amount of gas
delivered to the patient.

WARNING CARESCAPE respiratory modules: Make sure to compensate
for the possible reduction of tidal volume caused by the 120
ml/min gas sample flow.

WARNING Ensure that the CARESCAPE respiratory modules are in vertical
position when used. Tilting them may result in erroneous
readings.

WARNING PATIENT CROSS-INFECTION. Returning the sampled gas to the
patient circuit causes a risk of patient cross-infection.

WARNING PATIENT CROSS-INFECTION. Sampled gas may be returned to
the patient circuit only when using a bacterial breathing filter
system proximal to the patient. In addition, the anesthesia
machine must have a bacterial filter between the module gas
output and patient circuit. Otherwise, there is a risk of patient
cross-infection.
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The following statements apply to the E-miniC:

WARNING E-miniC modules: Do not use this module on patients that
cannot tolerate the removal of 150 ml/min from their total
minute ventilation.

WARNING E-miniC: O2, N2O and anesthetic agent gases may interfere
with EtCO2 readings.

WARNING To avoid the risk of patient cross-infection, do not return the
sampled gas to the breathing system.

Airway gases cautions
CAUTION Never connect the loose end of the gas sampling line to the

spirometry connector as this may break the spirometry unit.
The spirometry connector is meant for the spirometry tube
only.

CAUTION Do not apply pressurized air or gas to any outlet or tubing
connected to the monitor. Pressure may destroy sensitive
elements.

Airway gases measurement limitations
● CARESCAPE respiratory modules can be used with the NICU software package if

the Respiratory Module License is in use.
● E-miniC is not suitable for use with patients weighing less than 5 kg (11 lbs).

Airway gases points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.
● For information on materials used in accessories and their biocompatibility, refer

to the instructions for use in the accessory package.
● If anesthetic agents are present, use GE anesthesia sampling lines (PE/PVC).

Otherwise, you can use GE CO2 sampling line (PVC).
● CARESCAPE respiratory modules: Anesthetic agent identification, MAC or MACage,

N2O and EtBal are available with the anesthetic agent measurement license only.
This license is available for OR, PACU, NICU, and ICU software packages.
For more information, see the supplemental information manual.

● Make sure that you are using a water trap that is compatible with the module:
￭ CARESCAPE respiratory modules: D-fend Pro or D-fend Pro+
￭ E-miniC: Mini D-fend

● Empty the water trap container as soon as it is more than half full. With a
sample gas temperature of 37°C, a room temperature of 23°C, and sample gas
relative humidity of 100 %RH, the water trap should be emptied every 24 hours
(applies when the sample gas flow is within 120 ± 20 ml/min with the CARESCAPE
respiratory modules and within 150 ± 25 ml/min with the E-miniC).

● Place the airway adapter between the HME and Y-piece.
● Place the airway adapter with all sampling ports upwards.
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● D-lite(+) and Pedi-lite(+): Place the airway adapter in 45° tilt and all ports upwards
to prevent condensed water from entering the adapter interior and the tubing.

● Always check the tightness of all connections.

● Make sure that the gas sampling line is properly connected to the water trap and
the water trap is properly connected to the airway gas module. Gas leaks in these
connections may dilute the gas sample from the patient circuit, thus resulting in
erroneous gas readings. During normal operation, all sampled gas flows out of the
sample gas outlet. Room air is used as reference gas for the oxygen measurement
and it is mixed with the sampled gas. The sampled gas is diluted by room air so
that the fraction of room air in the exhaust gas is about 20%.

Airway gases measurement setup

Airway gases equipment to patient connections with
CARESCAPE respiratory modules

1. CARESCAPE respiratory module

2. Gas sample, gas sampling line connector on the water trap

3. Gas sampling line

4. Gas sampling line connector on the airway adapter; place the connector upwards

5. Airway adapter with sampling line connector

6. Heat and moisture exchanger with filter (HMEF) (optional)

NOTE Place all D-lite/Pedi-lite ports upwards with a 20° to 45° tilt to
prevent condensed water from entering the sensor interior
and the tubings.

Always ensure the correct size and fit ot accessories according to patient type
and application, especially when monitoring pediatric and neonatal patients. The
size and fit of accessories may impact the measured gas concentration values at
low tidal volumes. It is recommended to have the gas sampling port close to the
proximal end of the endotracheal tube. Excessive dead space in the circuit, including
the accessories, may cause re-breathing of gases. Very low accessory dead space
between the breathing circuit Y-piece and the gas sampling site may impact the
measured gas concentration due to dilution of the sampled exhaled gas with fresh
gas from the ventilator. To confirm accurate correlation with measured gases and
blood check arterial blood gas values to confirm a suitable setup is used.
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Airway gases equipment to patient connections with
E-miniC, critical care setup

1. E-miniC module

2. Gas sampling line

3. Adapter with sampling line connector

4. Sampling line connector on the water trap

Setting up airway gases measurement
1. Make sure that the water trap container is empty and properly attached.

2. Connect the gas sampling line to the sampling line connector on the water trap.

3. Connect the sample gas outlet to gas scavenging if N2O or volatile agents are
used.

4. Turn on the monitor or connect the module to the monitor. The monitor performs
a self-check for the module when the module is connected. Automatic agent
identification is activated in those modules that have this feature.

5. Wait until the message Calibrating disappears.

6. Connect the sampling line to the airway adapter or the airway adapter to the
ventilator circuit. Position the adapter with the sampling port upwards to minimize
the amount of condensed water possibly entering the sampling line.

7. Check that the airway adapter connections are tight and that the adapter is
operating properly.

NOTE Check that the sample line is connected to the water trap
before connecting the module to the monitor or turning on
the monitor.

NOTE To minimize the amount of dust drawn into the gas sampling
system, always keep the water trap connected to the module.
When gas measurement is not in use, you can disconnect the
module from the monitor to eliminate the operating sound
of the gas pump.
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CARESCAPE respiratory module connectors

1. Spirometry keys (Save Loop, Change Loop)

2. Water trap release/locking latch

3. Gas sample, sampling line connector on the water trap

4. Water trap container

5. Connectors for spirometry tubes

6. Connector for fresh gas used in end-tidal control. For more information on the use
of the end-tidal control, refer to the Aisys CS2 user documentation.

NOTE Only qualified service personnel may remove the
protecting screw from the fresh gas connector and attach
the fresh gas sample tubing.

7. Gas exhaust, connector for the gas exhaust line

CARESCAPE respiratory modules, indications for use
The CARESCAPE Respiratory Modules (E-sCO, E-sCOV, E-COVX, E-sCAiO, E-sCAiOV,
E-sCAiOVX, E-sCAiOE, and E-sCAiOVE) are indicated for use with a host device for
monitoring respiratory parameters (CO2, O2, N2O, anesthetic agents, anesthetic agent
identification, and respiratory rate) and ventilatory parameters (airway pressure, flow
and volume) of adult, pediatric, and neonatal patients and gas exchange parameters
(VCO2, VO2) of adult and pediatric patients.

When monitoring neonatal or other patients that have high respiration rate or low
tidal volume these modules shall be used within the limits of respiration rates and tidal
volumes to ensure specified measurement accuracy.

These modules are intended for use by qualified medical personnel only.
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E-miniC module connectors

1. Water trap latch
2. Sampling line connector on the water trap
3. Sample gas outlet (gas exhaust)

E-miniC indications for use
E-miniC and accessories are indicated for monitoring CO2 and respiration rate of all
hospital patients. E-miniC is indicated for monitoring patients weighing more than 5
kg (11 lbs). The device is indicated for use by qualified medical personnel only.

Airway gases alternative patient connections
● With E-sCO, E-sCAiO, E-sCAiOE, and E-miniC, use an airway adapter and a sampling

line.
● With E-sCOV, E-sCOVX, E-sCAiOV, E-sCAiOVE, and E-sCAiOVX, use the

D-lite(+)/Pedi-lite(+) sensor and a gas sampling line with spirometry tubing. When
monitoring pediatric patients, remember to select the sensor type accordingly
from the monitor menu.

Tracheostomy

1. Tracheostomy tube with 15 mm connector
2. Heat and Moisture Exchanger (HME)
3. Airway adapter
4. Sample line
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Mask ventilation

1. Mask
2. Bacterial filter
3. Airway adapter
4. Sample line

Infant ventilation

1. Endotracheal tube
2. Pediatric airway adapter
3. Fresh gas inlet
4. Sample line

Checking the airway gases measurement
1. Check that the water trap container is empty.

2. Occlude the sampling line and check that the Sample line blocked message
appears within 30 seconds and gas waveforms are showing zero at the same time.

Airway gases parameters

Airway gases parameters, CARESCAPE respiratory modules
The CARESCAPE respiratory modules measure the following airway gas parameters:

Parameter E-sCO E-sCOV E-sCOVX

CO2 x x x

O2 x x x

N2O x
1

x
1

x
1

AA n/a n/a n/a
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Parameter E-sCO E-sCOV E-sCOVX

Agent ID n/a n/a n/a

Additional measurements

MAC n/a n/a n/a

MACage n/a n/a n/a

Balance gas n/a n/a n/a

Gas exchange n/a n/a x

Spirometry n/a x x

Respiration rate x x x

Aisys CS2 end-tidal control n/a n/a n/a

Sampling method

Sidestream x x x

Mainstream n/a n/a n/a
1 automatic compensation.

NOTE The measured N2O value is not displayed.

For more information on the use of the end-tidal control, refer to the Aisys CS2 user documentation.

Parameter E-sCAiO E-sCAiOE E-sCAiOV E-sCAiOVX E-sCAiOVE

CO2 x x x x x

O2 x x x x x

N2O x x x x x

AA x x x x x

Agent ID x x x x x

Additional measurements

MAC x x x x x

MACage x x x x x

Balance gas x x x x x

Gas exchange n/a n/a n/a x n/a

Spirometry n/a n/a x x x

Respiration rate x x x x x

Aisys CS2 end-tidal
control

n/a x n/a n/a x

Sampling method

Sidestream x x x x x

Mainstream n/a n/a n/a n/a n/a

NOTE The measured N2O value is not displayed.

For more information on the use of the end-tidal control, refer to the Aisys CS2 user documentation.
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Airway gases parameters, E-miniC
Parameter E-miniC

CO2 x

O2 n/a

N2O x
1

AA n/a

Agent ID n/a

Additional measurements

MAC n/a

MACage n/a

Balance gas n/a

Gas exchange n/a

Spirometry n/a

Respiration rate x

Sampling method

Sidestream x

Mainstream n/a
1 automatic compensation.

NOTE The measured N2O value is not displayed. E-miniC requires manual selection from the
monitor menu to compensate for N2O.

CO₂ measurement

Available menu selections
NOTE Available menu selections may differ according to the

modules and/or software packages. Please read the following
instructions carefully. If nothing is mentioned about the
availability of the selection, it is the same for all modules
and/or software packages.

Selecting the CO2 scale
If EtCO2 is above 6% (45 mmHg), change the scale for capnogram.

1. Select a gas related parameter window.

2. Select the CO2 tab > Setup.

3. Select an option from the Scale list.

Selecting the CO2 sweep speed
This selection affects the waveform.
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1. Select a gas related parameter window.

2. Select the CO2 tab > Setup.

3. Select an option from the CO2 Sweep Speed list. The options are 0.625 mm/s, 6.25
mm/s, 12.5 mm/s, 25 mm/s, and 50 mm/s.

The smaller the value, the slower the sweep speed.

Setting CO2 limit alarms
1. Select a gas related parameter window.

2. Select the CO2 tab > Alarms.

3. Set high and/or low limit values for EtCO2, FiCO2 and Respiration Rate: select
the parameter and then set the limits.

Deactivating the apnea alarm
NOTE This feature is meant to be used when ending CO2 monitoring.

It should not be used during active CO2 monitoring.

This setting can be enabled during configuration and it is password protected. If it
has been enabled, there will be a selection in the CO2 Setup menu that allows you
to deactivate the alarm:

1. Select a gas related parameter window.

2. Select the CO2 tab > Setup.

3. Select Deactivate Apnea Alarm.

WARNING With deactivated Apnea alarm, keep the patient under close
surveillance.

NOTE When the alarm is deactivated, there will be no audible or
visual Apnea alarm indications. The alarm is automatically
reactivated if CO2 vitals signs are detected and alarm
condition is met again.

NOTE The following parameters are not trended while apnea is
deactivated: EtCO2, FiCO2, EtO2, FiO2, EtN2O, FiN2O, EtAA, FiAA,
MAC, MACage, EtBal, and ambient pressure.

Apnea alarms’ deactivation with the pause audio key
Apnea alarms can be deactivated with the pause audio key if the Allow alarm
deactivation with the Audio Pause key for: setting Apnea (CO2/Imped) is enabled in
the Care Unit Settings. This setting is password protected.

NOTE The following parameters are not trended while apnea alarm
is deactivated: EtCO2, FiCO2, EtO2, FiO2, EtN2O, FiN2O, EtAA,
FiAA, MAC, MACage, EtBal, and ambient pressure.

For more information, see the supplemental information manual.

Selecting what to show with EtCO2
You can select which other gas measurement value appears in the parameter window
with the EtCO2.
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1. Select a gas related parameter window.

2. Select the CO2 tab > Setup.

3. Select an option from the Show with EtCO2 list.

Selecting the FiO2 level
NOTE E-miniC and OR, PACU, ED, and ICU software packages only.

NOTE FiO2 and N2O compensations must be selected manually
when E-miniC is used.

The presence of a large concentration of oxygen causes the CO2 level appear lower
than the actual value. Use this option to compensate for the presence of O2.

1. Select a gas related parameter window.

2. Select the CO2 tab > Setup.

3. Select an option from the FiO2 level list.

Selecting the N2O level
NOTE E-miniC and the anesthetic agent measurement license only.

Available for OR, PACU, or ICU software packages.

NOTE FiO2 and N2O compensations must be selected manually
when E-miniC is used.

The presence of N2O causes the CO2 value to appear higher than the actual value.
Use this option to compensate for the presence of N2O.

1. Select a gas related parameter window.

2. Select the CO2 tab > Setup.

3. Select an option from the N2O level list.

O₂ measurement with CARESCAPE respiratory
modules

Selecting the O2 scale
If the difference between FiO2 and EtO2 is more than 6%, change the O2 scale.

1. Select a gas related parameter window.

2. Select the O2 tab > Setup.

3. Select an option from the Scale list.

Selecting the O2 sweep speed
This selection affects the waveform.

1. Select a gas related parameter window.

2. Select the O2 tab > Setup.
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3. Select an option from the O2 Sweep Speed list. The options are 0.625 mm/s, 6.25
mm/s, 12.5 mm/s, 25 mm/s, and 50 mm/s.

The smaller the value, the slower the sweep speed.

Setting O2 alarms
1. Select a gas related parameter window.

2. Select the O2 tab > Alarms.

3. Check that the required alarm (EtO2 or FiO2) is on, and set its high and/or low
limit values.

AA and N₂O measurement with CARESCAPE
respiratory modules

Selecting the agent scale
Every anesthetic agent has its own default scale that the monitor uses when detecting
the agent. You can change the scale of an agent if the amount used is higher than the
default scale. Default scales are given in the supplemental information manual.

1. Select a gas related parameter window.

2. Select the Agent/N2O tab > Setup.

3. Select an option from the Agent Scale list.

Selecting the agent sweep speed
This selection affects the waveform.

1. Select a gas related parameter window.

2. Select the Agent/N2O tab > Setup.

3. Select an option from the Agent Sweep Speed list. The options are: 0.625 mm/s,
6.25 mm/s, 12.5 mm/s, 25 mm/s, and 50 mm/s.

The smaller the value, the slower the sweep speed.

Setting agent limit alarms
1. Select a gas related parameter window.

2. Select the Agent/N2O tab > Alarms.

3. Check that the required alarm (EtAA or FiAA) is on, and set its high and/or low
limit values.

Gases alarm priorities
You can select priorities for the CO2 high/low, FiAA high/low, RR (CO2) high/low, and
Apnea (CO2) alarms through Alarm Setup > Alarm Priorities > Other Parameters.
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Preventing operating room pollution
When N2O and volatile anesthetics are used, prevent operating room pollution by
connecting the sample gas outlet (gas exhaust) of the module to the scavenging
system.

Scavenging through the ventilator reservoir
1. Connect an exhaust line to the sample gas outlet (gas exhaust) on the module's

front panel.

2. Attach the other end of the line to the ventilator reservoir. Make sure that the
reservoir tube diameter is at least 2 to 3 times larger than the exhaust line.

Scavenging through the anesthesia gas scavenging system
Anesthesia machines are equipped with an anesthesia gas scavenging system (AGSS),
and in some machines you can connect the sample gas outlet directly to it. See the
anesthesia machine's user documentation to find out where and how the sample
gas can be connected.

Connecting directly to the scavenging system
1. Connect the exhaust line to the module's sample gas outlet.

2. Connect the exhaust line only to an open scavenging system where gas is
removed at room pressure.

NOTE Do not connect the module directly to a strong vacuum
scavenging system.

NOTE If the E-miniC is used, do not return sample gas to the patient
circuit.

Returning sampled gas to the patient circuit
Returning sampled gas to the patient circuit causes a risk of patient cross-infection.
To prevent patient cross-infection ensure that the anesthesia machine has a bacterial
filter between the module gas output and patient circuit. Always use a bacterial
breathing system filter proximal to the patient.

NOTE Refer to the anesthesia machine’s documentation to find out
where and how the sample gas can be returned.

Stopping the airway gases measurement
1. Remove the added adapters from the patient’s breathing circuit and gas

scavenging.

2. Check the patient’s breathing circuit.

3. Remove the gas module from the monitor when it is not used.
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Calibrating airway gases
To ensure that the measurement accuracy remains within specifications, follow the
recommended calibration check intervals: every six months when used several hours
a day on most days each week, and every two months in more continuous use.

NOTE Ensure that the calibration gas and regulator are functioning
properly before calibration. Perform annual maintenance of
the regulator as required.

NOTE Make sure that you are using a correct GE calibration gas, see
the supplemental information manual. Do not use any other
calibration gases.

NOTE Calibration gas bottles with anesthetic agents must be
disposed of in compliance with the guidelines regulating the
disposal of products containing anesthetic agents.

1. Turn on the monitor. For maximum accuracy, let the monitor warm up for 30
minutes.

2. Attach a regulator to the calibration gas cylinder.

3. Attach a new sampling line to the water trap. Connect the other end of the
sampling line to the regulator on the gas container.

4. Select a gas related parameter window > Calibration tab.

5. Wait until the messages Zero OK and Feed gas appear after each gas on the
screen.

6. Open the regulator and feed gas until the message Adjust appears, then close
the valve.

7. Check that the displayed values match the values on the calibration gas container.
Adjust if necessary:

a. Select the first gas to be adjusted.

b. Adjust the value until it matches the desired value on the gas container.

8. Confirm by selecting Accept

9. If the calibration is successful, the message Calibration OK is displayed for a few
seconds. If the calibration fails, the message Calibration error appears instead.
In this case, start a new calibration by selecting Recalibrate.

If the message Zero error appears, repeat the calibration procedure. If the problem
persists, contact qualified service personnel.

Basics of airway gases measurement

Airway gases measurement description, CARESCAPE
respiratory modules

With CARESCAPE respiratory modules, you can measure and monitor gases being
delivered to the patient and exhaled by the patient through the breathing circuit. The
modules consist of an infrared sensor for measuring CO2 and N2O,and paramagnetic
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O2 sensor. The E-sCAiO, E-sCAiOE, E-sCAiOV, E-sCAiOVX, and E-sCAiOVE also include
anesthetic agents measurement.

The gas sampling system samples the measured air to the module, and removes water
and impurities from it. The pump of the gas sampling system draws gas at a fixed rate
through the sampling line into the gas measuring units. The gas enters the module
through the water trap, where it is divided into two flows, a main flow and a side flow.
The main flow goes into the analyzers. This flow is separated from the patient side by a
hydrophobic filter. The side flow creates a slight sub-atmospheric pressure within the
water trap, which causes fluid removed by the hydrophobic filter to collect in the bottle.
After the measurement, gas is exhausted through the sample gas out connector.

Total sample size volume during one respiratory cycle depends on the respiration rate.
The following table shows different sample size volumes with a 120 ml/min sample
flow and I:E ratio of 1:2.

Respiration rate 10 30 50 70

Duration of
inspiration

2.0 seconds 0.7 seconds 0.4 seconds 0.3 seconds

Duration of
expiration

4.0 seconds 1.3 seconds 0.8 seconds 0.6 seconds

Volume
sampled during
inspiration

4 ml 1.3 ml 0.8 ml 0.6 ml

Volume
sampled during
expiration

8 ml 2.7 ml 1.6 ml 1.1 ml

Total volume
sampled

12 ml 4 ml 2.4 ml 1.7 ml

Airway gases measurement description, E-miniC
The E-miniC is designed for critical care environment to measure and monitor the
expired and inspired CO2 concentration (EtCO2, FiCO2) as well as the respiration rate
(RR) up to 80 breaths per minute. E-miniC has a sample flow of 150 ml/min.

Respiration rate from the CO2 parameter is counted from the frequency of end-tidal
(peak) CO2 measurements per minute. A sufficient respiration is defined as a
difference of at least 1% (at least 7 mmHg) between the measured inspired fraction
and end-tidal CO2.

Total sample size volume during one respiratory cycle depends on the respiration rate.
The following table shows different sample size volumes with a 150 ml/min sample
flow and I:E ratio of 1:2.

Respiration rate 10 20 40 60

Duration of
inspiration

2.0 seconds 1.0 seconds 0.5 seconds 0.3 seconds

Duration of
expiration

4.0 seconds 2.0 seconds 1.0 seconds 0.7 seconds

Volume
sampled during
inspiration

5 ml 2.5 ml 1.3 ml 0.8 ml
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Volume
sampled during
expiration

10 ml 5 ml 2.5 ml 1.7 ml

Total volume
sampled

15 ml 7.5 ml 3.8 ml 2.5 ml

Sidestream gas sampling
The E-modules use a sidestream gas sampling method. It means that a sample of
patient’s respired gases from the sampling site is transported through a sampling
line to the module for analysis.

A sidestream gas analyzer takes a constant sample from the patient airway adapter
at the following sample rates:

● CARESCAPE respiratory modules: 120 ml/min

● E-miniC: 150 ml/min

Total sample size volume during one respiratory cycle depends on the respiration rate.

Minimum Alveolar Concentration (MAC)
NOTE CARESCAPE respiratory modules only.

The use of either traditional MAC or MACage is selected during monitor configuration.
The MACage provides age and temperature compensated measurement. To enable
MACage calculations, enter patient’s age to the monitor and attach a temperature
sensor. If the patient’s age is not given, the monitor shows normal MAC even if
MACage has been selected.

NOTE The MAC value displayed by the monitor is that of exhaled
air, and it does not always correspond to the amount of
anesthetic in the patient’s organs.

CAUTION Patient-specific MAC is affected by several factors such as
patient age and body temperature.

MAC and MACage
The minimum alveolar concentration (MAC) concept is based on the assumption that
in a steady state, the alveolar partial pressure of a gas is equal to the partial pressure
in the effector organ of the central nervous system. MAC values are used to estimate
the level of anesthesia caused by volatile anesthetics.

The MAC value can be displayed in a numeric parameter window: 1 MAC is the alveolar
concentration (end-tidal) of the agent at which 50% of patients do not respond to
a noxious or surgical stimulus. The value is calculated from the actual measured
anesthetic agent and N2O values with empirical formulas based on statistical studies
with anesthetized patients.

The monitor can display two different MAC values, MAC or MACage, based on different
formulas. The use of MAC or MACage is selected during installation and configuration.

The MAC values correspond to those of healthy adults of about 40 years old, and
cannot be applied to children or elderly patients. Age and some other individual
factors influencing the effect of volatile agents are not taken into account.
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The other calculation method, MACage, takes the patient's age into account. The age
range is 0 to 150 years. The calculation uses 0 if age is less than 0, and 100 if age is
more than 100. In addition, MACage calculations include the atmospheric pressure
and the patient’s (highest measured) temperature values. If no patient temperature is
measured, 37°C is used instead. For volatile agents this calculation method means
about 6.7% decrease of MAC value with each increasing decade of life. MACage is
calculated if it is enabled in the care unit settings and the patient’s age is given on the
monitor. If no age is given, MAC is calculated despite the care unit setting.

References used for MAC and MACage values
The alveolar concentrations of traditional (MAC) and age dependent (MACage) values
are based on the following references:

● References for anesthetic agent MAC values:

￭ Mapleson W.W.: Effect of age on MAC in humans: a meta-analysis. Br. J. of
Anaesthesia 1996; 76: 179-185

￭ Rampil I.J.; Zwass M.; Lockhart S.; Eger E.I. II; Johnson B.H.; Yasuda N.; Weiskopf
R.B.: MAC of I653 in surgical patients, Anesthesiology. Tram-Rac71 (3A):A269,
September 1989

￭ Scheller M.S., Partridge B.L., Saidman L.J.: MAC of sevoflurane in humans and
the New Zealand white rabbit. Anesthesiology 1987; 67: A373

￭ ISO21647:2004 + C1:2005, Medical electrical equipment - Particular
requirements for the basic safety and essential performance of respiratory
gas monitors.

● References for MACage calculations:

￭ Eger, E.I. II.: Age, minimum alveolar anesthetic concentration, and minimum
alveolar anesthetic concentration-awake. Anesth. Analg. 2001; 93:947-953

￭ Rampil I.J.; Zwass M.; Lockhart S.; Eger E.I. II; Johnson B.H.; Yasuda N.; Weiskopf
R.B.: MAC of I653 in surgical patients, Anesthesiology. 71 (3A):A269, September
1989

MAC values of different anesthetics in oxygen
Normal values (40-year-old patient) and compensated values (65-year-old and
3-year-old patients):

1 MAC 1 MAC (65 yrs) 1 MAC (3 yrs)

Halothane 0.75% 0.63% 0.97%

Enflurane 1.70% 1.43% 2.2%

Isoflurane 1.15% 0.97% 1.5%

Sevoflurane 2.05% 1.73% 2.65%

Desflurane 6.00% 5.05% 7.80%

N2O 100% 82% N/A

The following illustration shows the Agent% corresponding to 1 MAC as function of age:

300 CARESCAPE Monitors B850, B650, B450 2105822-001



Airway gases

Agent%

Age (years)

Symbol Anesthetic

Desflurane

Sevoflurane

Enflurane

Isoflurane

Halothane

MAC values of different anesthetics in 65% N2O
Normal values (40-year-old patient) and compensated values (65-year-old and
3-year-old patients).

1 MAC 1 MAC (65 yrs) 1 MAC (3 yrs)

Halothane 0.27% 0.14% 0.51%

Enflurane 0.61% 0.31% 1.15%

Isoflurane 0.41% 0.21% 0.78%

Sevoflurane 0.73% 0.37% 1.40%

Desflurane 2.09% 1.1% 4.1%

ET balance gas, CARESCAPE respiratory modules
You can obtain a calculated value for balance gas, EtBal. End-tidal balance gas is the
percentage of gas concentration not measured by the gas sensors. It is displayed in a
parameter window with the MAC value.

An increased balance gas value may indicate the amount of nitrogen flushed out from
the patient into the circuit. The increase may be due to an accumulation of nitrogen
during low flow anesthesia.
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The monitor calculates end-tidal balance gas when oxygen and CO2 measurements
are active. If oxygen or CO2 status is invalid or agent identification fails, the monitor
displays the balance gas value as invalid.

Automatic agent identification with CARESCAPE
respiratory modules

The E-sCAiO, E-sCAiOE, E-sCAiOV, E-sCAiOVX, and E-sCAiOVE modules with agent
identification option will automatically identify and select Isoflurane, Desflurane,
Sevoflurane, Enflurane and Halothane. The modules are able to identify two
agents simultaneously and displaying them as primary and secondary agents. The
inspiratory and expiratory concentrations of the agent are displayed in a numeric
parameter window. Minimum concentration for the identification is 0.15 vol%. The
agent selection remains active even if the concentration decreases below 0.15 vol%.
Automatic agent identification is operational after the normal warm up of the module
(approximately five minutes).

● If rapid agent concentration changes are required, fresh gas flow must be
increased.

● Anesthetic agent concentration in the circuit is affected by patient uptake,
breathing system volume and the fresh gas flow. It quantifies the speed of wash-in
and wash-out anesthetic agents.

Basics of CO₂ measurement

Normal CO2 waveform
The CO2 waveform is referred to as capnogram and it reflects the different stages in
breathing. The capnogram of a healthy patient under controlled ventilation has a
normal shape. Changes in the CO2 waveform may indicate compromised patient
respiratory and/or circulatory function or improper mechanical ventilator functionality.

The origin of the CO2 waveform
The following illustration shows a normal capnogram. In this illustration, the letters
indicate the following:

● A: The gas first exhaled is from the anatomical and apparatus dead-space. It
contains no CO2 because it has not been in the alveoli and no gas exchange has
taken place.

● B: Briefly, the exhaled gas is a mixture of gas from the anatomical dead-space
and gas from the alveoli.

● C: A plateau is reached when the gas exhaled is entirely from the alveoli. The
end-tidal CO2 (EtCO2) concentration is measured at the end of this plateau.

● D: When the next inspiration starts the capnogram rapidly falls towards the
baseline. The minimum level of CO2measured during the inspiratory phase is called
the inspired CO2 concentration (normally 0.0%).

● E: With a scale, the height of the capnogram tells you the end-tidal CO2
concentration. The monitor automatically calculates and display the EtCO2 in
numbers. EtCO2 approximates the alveolar CO2 concentration because it is
measured when the patient exhales virtually pure alveolar gas.
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● 1a and 1c = inhalation
● 1b and 1d = exhalation

EtCO2 value % EtCO2 value mmHg Indicates

4.5% to 5.5% 34 mmHg to 41 mmHg normocapnia

< 4% < 30 mmHg hypocapnia

> 6% > 45 mmHg hypercapnia

Dips in capnogram
The dips seen in the capnogram during expiration are related to the sidestream gas
sampling, the continuous gas flow to the Y-piece, and patient’s cardiac contractions,
which cause intra-thoracic pressure changes and therefore flow variations.

The alterations in expired CO2 waveform are cardiogenic movements of exhaled and
circuit gas at the sidestream gas sampling site. When the respiratory gas flow drops
below the gas sampling rate, a variable mixture of CO2 free fresh gas and exhaled CO2
rich gas is sampled. This causes variations in sampled CO2 concentrations.

In the illustration below, CO2 waveform is the one on top, and flow is the lower
waveform.

1. Expiration
2. Cardiogenic oscillations

Cardiogenic oscillations appear when:
● A continuous fresh gas flow is fed into the patient Y-piece.
● Sidestream gas sampling is done at the Y-piece.
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● The patient is ventilated with a long expiration time or low respiration times, and
when there is a long zero flow at end-expiration for some other reason.

Oscillations can be eliminated by adding a spacer with a 5 ml dead space between
the Y-piece and the airway adapter. Increased dead space creates a buffer volume
between the Y-piece and the sampling point, preventing the inspiratory and expiratory
air from mixing during gas sampling. Misinterpretation of EtCO2 information can be
avoided through identifying cardiogenic oscillation and understanding the reasons
for it.

Airway gases CO2 unit conversions
Respiratory gases are in contact with lungs and become saturated with water vapor. The
module reports the patient gas concentrations relative to ambient pressure and temperature
as if the patient gas was without water vapor in dry conditions (ATPD). The monitor can
convert the ATPD CO2 partial pressures to be displayed in saturated water vapor conditions
(BTPS). The module provides the measured atmospheric pressure for the monitor to convert
ATPD to BTPS. SelectingWet (BTPS) humidity compensation type activates calculations
where the EtCO2 value is normalized to assume 100 %RH and 37 °C.Wet compensation
is not done if EtCO2 is shown in %. The humidity compensation type Dry (ATPD) orWet
(BTPS) is selected through Care Unit Settings > Parameters > CO2 Numbers. This setting is
password protected.

NOTE 47 mmHg is the partial pressure of the saturated water vapor at
37°C.

The following table lists the relationship between gas concentration and its partial pressure.

Reading in mmHg (dry gas) (ambient pressure in mmHg * gas concentration in %)/100

Reading in mmHg (water vapor
saturated gas)

((ambient pressure in mmHg – 47 mmHg) * gas concentration in %)/100

Reading in kPa (dry gas) (ambient pressure in mmHg * gas concentration in %)/750

Reading in kPa (water vapor
saturated gas)

((ambient pressure in mmHg – 47 mmHg) * gas concentration in %)/750

Oxygen measurement interpretation,
CARESCAPE respiratory modules

The CARESCAPE respiratory modules’ oxygen measurement provides:

● Inspired oxygen level, the actual inspired oxygen concentration

● End-tidal oxygen level, the expired oxygen concentration

● Inspiratory-expiratory oxygen difference reflects patient’s consumed oxygen
volume-percentage from the administered gas mix

● Oxygram, a diagnostic tool both in real time and as a trend

The patient oxygen provides breath-by-breath information about the breathing circuit,
alveolar ventilation and some vital indicators of adequate oxygenation.

Oxygram is a mirror image of a capnogram in a steady state in normal patient. It is a
graphic presentation of changes in O2 concentrations in the airway gas. The oxygram
reflects the oxygen uptake from the alveoli. To avoid patient administered hypoxic gas
mixes the inspired fraction of oxygen (FiO2) should never be lower that 21%.
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Airway gases practicalities

Ventilation management
Normoventilation (adequate alveolar ventilation of a patient) can be maintained
by monitoring the end-tidal carbon dioxide and oxygen concentrations, and
adequacy of ventilation can be maintained by monitoring airway pressures, volumes
and spirometry loops. Alveolar minute ventilation is usually adjusted to achieve
normocapnia, where EtCO2 is in the range of 4.5% to 5.5% (34 mmHg to 41 mmHg).
This is called normoventilation as it is the normal situation in healthy people.

A low EtCO2 concentration (EtCO2 < 4% / 30 mmHg) indicates hyperventilation.

NOTE A low EtCO2 value in itself is dependent from the ventilation
volume vs. circulation status (lung perfusion). This means that
in case of low blood pressure (e.g. shock) or shunting low
EtCO2 values may be observed while using a “normal” TV/MV.

Increased EtCO2 concentration (EtCO2 > 6.0% / 45 mmHg) indicates hypoventilation or
ineffective alveolar ventilation, which will lead to hypercapnia and respiratory acidosis.
Increased inspiratory CO2 (FiCO2) concentrations may also be caused by:

● Exhausted CO2 absorber.

● Malfunction of the breathing system valves.

● Rebreathing when a rebreathing system without a CO2 absorber is used with
inadequate fresh gas flows.

● Cross-effects of other gases (mainly anesthetic agents).

NOTE During some surgical procedures, e.g. laparoscopy, CO2 may
be used to inflate the abdomen which may result in rise of
PaCO2 due to the absorption of CO2 into the blood via the
vascular wound bed. This may lead to an increase in the
EtCO2.

Prevention of the breathing system contamination
You can use a microbial filter between the endotracheal tube and the airway adapter.
Change the filter for every patient. Change the patient circuit at intervals given in the
circuit manufacturer’s documentation, and according to your hospital protocols.

How to prevent effects of humidity
In anesthesia, the lower the fresh gas flow, the more rebreathed gas recirculates
through the CO2 absorber and the more humidity and heat is produced through the
chemical CO2 absorption process.

● If a moisture exchanger (HME) or moisture exchanger and bacterial filter (HMEF) is
used, place it between the endotracheal or intubation tube and the airway adapter.
In intensive care, follow the HME(F) manufacturer’s instructions for replacement
cycles and use during active humidification.

● Place all airway adapter ports upwards with a 20° to 45° tilt to prevent condensed
water from entering the sensor interior and the tubings.

● The airway adapter should be emptied of clearly visible water droplets, or replaced
with a dry and clean adapter.
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● If active humidification is used, extra water collectors may be placed between the
ventilator’s inspiratory and expiratory breathing tubings. They are also useful for
condensed water collection during long-lasting anesthesia.

Oxygen delivery, CARESCAPE respiratory modules

Oxygen uptake and consumption
Oxygen consumption is the difference between the amount of oxygen delivered to
the tissues by the arterial circulation and the amount of oxygen returned to the heart
by the venous system. The formula for oxygen consumption is a simple restatement
of the Fick equation, which identifies all of the pertinent variables of oxygen supply
and demand. VO2 = CO x Hb x 13.8 x (SaO2 - SvO2). Dependent from the patient’s
circulation status the mechanical ventilator settings for, amongst others, FiO2 in the
delivered gas mix (min. > 25%) should guarantee a sufficient PAO2 and PaO2. Patients
with fever may consume oxygen at considerably higher rates.

Oxygen supply to the breathing system must meet the metabolic need of the patient.

To prevent hypoxemia and to ensure safe and sufficient oxygen supply, the alveolar
oxygen concentration (EtO2) should be at the level of 25% minimum.

Nitrogen elimination
During the maintenance of minimal low flow anesthesia, a small amount of nitrogen
may accumulate in the circuit. It may be detected as decreased concentration of
other gases, and eliminated by temporarily increasing the fresh gas flow.

Flow reduction
Reduction of fresh gas flow may increase rebreathing in case of a CO2 absorber
malfunction or during the use of open anesthesia gas delivery systems.

The lower the fresh gas flow, the higher the oxygen concentration required in the
fresh gas.

Level of anesthesia: CARESCAPE respiratory modules with
agent identification option

Anesthetic agent uptake
Fresh gas flow reduction decreases the total amount of anesthetic agent fed into the
breathing system if agent concentration is maintained constant.

The lower the fresh gas flow rate, the longer the time required to reach the effect of a
change in the fresh gas settings.
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Airway gases troubleshooting
Problem Solution

Airway gas values seem too low ● Check the sampling line and connectors for
leakage.

● Check the patient status.

● Check the arterial blood gas values.

Airway gas values seem too high ● Check the sampling line for blockage.

● Check the patient status.

● Check the arterial blood gas values.

Module does not work ● Check and clean the filter if necessary.

● Check the water trap and water trap connectors..
If the water trap is too full, liquid may have entered
the module. Replace the module and have it
checked by qualified service personnel.

No airway gas values ● Check that the gas sampling line is connected to
the water trap.

EtCO2 value unexpectedly higher than the CO2 partial
pressure determined by blood gas analysis

CO2 unit is mmHg or kPa, and the EtCO2 value is close
to the arterial CO2 value.
● Gas sensor is measuring gases in Dry (ATPD)

conditions. Selecting Wet (BTPS) humidity
compensation type activates calculations where
the EtCO2 value is normalized to assume 100 %RH
and 37 °C.Wet compensation is not done if EtCO2
is shown in %.

● Check the humidity compensation type through
Monitor Setup > Default Setup > Care Unit
Settings > Parameters > CO2 Numbers. This
setting is password protected.
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Spirometry

Spirometry compatibility
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

Spirometry safety precautions

Spirometry warnings
WARNING The presence of Helium or Xenon in the breathing circuit

causes incorrect measurement values.

WARNING Make sure you select the correct sensor type for the patient:
D-lite(+) for adult patients, Pedi-lite(+) for pediatric patients.

WARNING Always check the sensor type selection from the monitor
(Sensor Type > Adult or Pediatric).

Spirometry cautions
CAUTION Never connect the loose end of the gas sampling line to the

spirometry connector as this may break the spirometry unit.
The spirometry connector is meant for the spirometry tube
only.

CAUTION Do not apply pressurized air or gas to any outlet or tubing
connected to the monitor. Pressure may destroy sensitive
elements.

Spirometry limitations
● With the NICU software package all spirometry parameters are available with

the CARESCAPE respiratory modules only with the Respiratory Module License.
Otherwise, some parameters are available through the Unity Network ID
connectivity device.

Spirometry points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.
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● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● Place an HME/HMEF/filter between the D-lite(+)/Pedi-lite(+) sensor and the patient.

● Disconnect the HME/HMEF/filter and D-lite(+)/Pedi-lite(+) during nebulization of
medications.

● The flow measurement should be calibrated once a year or when there is a
permanent difference between inspiratory and expiratory volume. For further
information, see the module service manual.

● Using a cuffless intubation tube may affect spirometry readings due to potential
leakages around the endotracheal tube.

● When anesthetic agents are used, use a module with anesthetic agent
identification (Ai) option.

● With the NICU software package, all spirometry parameters are available with
the CARESCAPE respiratory modules E-sCOV, E-sCOVX, E-sCAiOV, E-sCAiOVX, and
E-sCAiOVE only with the Respiratory Module License. Otherwise, some parameters
are available through the Unity Network ID connectivity device.

● The flow and volume measurement of the CARESCAPE respiratory module is
compensated for the density of the gas which is important for measurement
accuracy with heavy molecules of anesthetic agents like Desflurane. However,
using high concentrations of anesthetic agents may still affect flow and tidal
volume readings. In this case, the CARESCAPE respiratory module tends to
underestimate flow and volume.

● Depending on the type of patient circuit used, the temperature and humidity inside
the D-lite flow sensor vary between dry ambient temperature air and 100% humid
37 °C air. As the CARESCAPE respiratory module needs to convert the measured
volume/flow to ATPD or BTPS conditions, it needs to assume the temperature and
humidity of the gas that flows through the flow sensor. By default the module
assumes conditions equivalent to an HME patient circuit. If active humidification
is used, the module will therefore overestimate the measured volume/flow by
approx. 5%.

● When using active humidification, there might be condensation in the D-lite flow
sensor affecting flow and volume readings. In this case, the CARESCAPE respiratory
module tends to overestimate flow and volume.

Water droplets in spirometry tubes
Always check the spirometry tubes for water droplets. Water droplet(s) inside a
spirometry tube can block the whole cross-section of the tube and cause erroneous
measurement values. If a water droplet enters themodule and wets a pressure sensor,
the spirometry unit can fail. In this case, the monitor displays an error message .

A wetted pressure sensor can recover to its normal operation if it is allowed to dry for
a few hours without connecting the spirometry tubes to the module. You cannot use
spirometry and gas exchange measurements during this time.
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Spirometry measurement setup

Spirometry equipment to patient connection

1. E-sCOV, E-sCOVX, E-sCAiOV, E-sCAiOVX, or E-sCAiOVE module

2. Gas sample, gas sampling line connector on the water trap

3. Gas sampling and spirometry tubes

4. D-lite/Pedi-lite sensor, or D-lite+/Pedi-lite+ sensor for humid conditions

5. Gas sampling line connector

6. Heat and moisture exchanger with filter (HMEF)

NOTE Place all D-lite ports updwards with a 20° to 45° tilt to prevent
condensed water from entering the sensor interior and the
tubings.

Spirometry module keys
There are two keys on the CARESCAPE respiratory modules:

Save Loop Saves the currently active loop with corresponding numeric
data.

Change Loop Toggles between a Paw-Vol and a Flow-Vol loop.

Preparing the spirometry measurement
1. Take a new spirometry tube and connect the tube to the D-lite(+)/Pedi-lite(+)

sensor by inserting the angle connectors in the sensor connectors. Place all
D-lite(+)/Pedi-lite(+) ports upwards with approximately a 45° tilt to prevent
condensed water from entering the sensor interior and the tubings.

2. Connect the other end of the spirometry tube to the pressure connectors on the
module.

3. Connect a gas sampling line to the Luer connector on the other side of the
D-lite(+)/Pedi-lite(+) sensor.

4. Connect the other end of the gas sampling line to the sampling line connector on
the module’s water trap.

5. Make sure that the connections are tight.

6. Select the correct sensor type.
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7. Connect the D-lite(+)/Pedi-lite(+) between the Y-piece and the intubation tube
in the breathing circuit.

Checking the spirometry measurement
1. Check that the water trap is empty.

2. Occlude the sampling line and check that the Sample line blocked message
appears within 30 seconds and gas waveforms are showing zero at the same time.

3. Check that the loops are complete. A gap between the starting and ending points
may indicate a leak.

Using the spirometry measurement

Selecting the spirometry sensor type
When monitoring pediatric patients with tidal volumes of 15 ml to 300 ml, use the
Pedi-lite/Pedi-lite+ sensor. For other patients, use the D-lite/D-lite+ sensor. Select the
sensor type accordingly.

1. Select the spirometry parameter window.

2. Select Setup.

3. Select the sensor type (Pediatric or Adult) from the Sensor Type list.

Selecting the spirometry scaling type
This setting affects pressure (Paw) and flow waveform scales, and pressure-volume
(Paw-Vol) and flow-volume (Flow-Vol) loop scales.

Note that the Flow waveform can also be drawn as a mirror image according to what
has been selected in the Care Unit Settings > Parameters > Inspiratory Flow. This
selection is password protected.

Auto scaling adjusts the scales automatically. With Vol scaling type all scales will
change when you change one. With Independent, you can change each scale
separately.

1. Select the spirometry parameter window.

2. Select Setup.

3. Select an option from the Scaling list.

Selecting the spirometry scaling speed
This option is available with automatic scaling only. It determines how frequently the
scales are changed. Fast reacts quickly if current scales are not optimal. The minimum
time between scale changes is 2 seconds with Fast and 20 seconds with Slow.

1. Select the spirometry parameter window.

2. Select Setup.

3. Select an option from the Scaling Speed list.

312 CARESCAPE Monitors B850, B650, B450 2105822-001



Spirometry

Selecting the spirometry scales
You can change the Vol Scale ml, Paw Scale, and Flow Scale l/min unless the
automatic scaling is in use. Changing spirometry scales affects Paw and Flow
waveform scales, and Paw-Vol and Flow-Vol loop scales. With Vol scaling type in use
all scales will change when you change one. With Independent scaling type you can
change each scale separately.

1. Select the spirometry parameter window.

2. Select Setup.

3. Select suitable options from the lists Vol Scale ml, Paw Scale, or Flow Scale l/min.

Selecting the spirometry sweep speeds
This setting affects the sweep speed of Flow and Paw waveforms. It does not affect
the loops.

1. Select the spirometry parameter window.

2. Select Setup.

3. Select suitable options from the Paw Sweep Speed or Flow Sweep Speed list.

The smaller the value, the slower the sweep speed.

Selecting the displayed spirometry volume type
This setting determines which numeric data (tidal volumes TVinsp and TVexp, or
minute volumes MVinsp and MVexp) will appear in the Flow parameter window.

NOTE In OR and PACU software packages, this setting also affects
the Spiro 1 split screen accordingly.

1. Select the spirometry parameter window.

2. Select Setup.

3. Select an option from the Show Volume list.

Changing the spirometry loop type
To change the displayed loop from a Paw-Vol loop to a Flow-Vol loop or vice versa,
press the Change Loop module key, or:

1. Select the spirometry parameter window.

2. Select Loops.

3. Select Paw-Vol Loop or Flow-Vol Loop.

NOTE In OR and PACU software packages, the loop view shows
Ppeak, Pplat, Pmean and PEEPtot numbers. In other software
packages, the loop view shows Ppeak, Pplat, Pmean, PEEPe
and PEEPi numbers.

Saving spirometry reference loops
Save a loop for reference of the current lung mechanics, and whenever major changes
in the patient's status occur. Press the Save Loopmodule key, or:

1. Select the spirometry parameter window.
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2. Select Loops > Save Loop.

The monitor automatically displays the first saved loop as a reference loop. You can
save up to six pairs of loops. If you save another pair of loops after the sixth one, the
second oldest reference loop is automatically erased.

Selecting a spirometry reference loop
You can select a saved loop to the screen for reference.

1. Select the spirometry parameter window.

2. Select Loops.

3. Select a loop from the Reference Loop list.

Erasing a spirometry reference loop
You can erase unnecessary reference loops.

1. Select the spirometry parameter window.

2. Select Loops.

3. Erase the loop by selecting Erase Selected.

Printing a spirometry loop
You can print the currently displayed loop.

1. Select the spirometry parameter window.

2. Select Loops.

3. Select Print Loop.

Setting Paw alarm limits
You can set the limit alarms on or off, and adjust their activation limits according
to your needs.

1. Select the spirometry parameter window.

2. Select Paw Alarms.

3. Set the alarm limits: PEEPtot (OR and PACU software packages), PEEPi and PEEPe
(other software packages), Ppeak and MVexp.

NOTE If the feature is not active, the alarm limits are greyed out.
Select Alarm On to set the alarms.

Setting MV/Vent alarm limits
You can set the limit alarms on or off, and adjust their activation limits according
to your needs.

1. Select the spirometry parameter window.

2. Select MV/Vent Alarms.
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3. Set the alarm limits.

NOTE If the feature is not active, the alarm limits are greyed out.
Select Alarm On to set the alarms.

NOTE MV/Vent Alarms cannot be selected off except when an
interfaced device is used.

NOTE To enable apnea and technical alarms from the ventilator,
select the Ventilator Apnea and Technical Alarms check
box.

Spirometry measurement basics

Spirometry measurement description
The CARESCAPE respiratory modules E-sCOV, E-sCOVX, E-sCAiOV, E-sCAiOVX, and
E-sCAiOVE measure airway pressures, flow, volumes, compliance and airway
resistance breath by breath at the patient's airway. All parameters are measured
through D-lite(+)/Pedi-lite(+) flow sensor placed at the patient's airway.

D-lite(+)/Pedi-lite(+) flow sensor

1. For total pressure measurement

2. For static pressure measurement

3. For gas samples

The velocity of gas flow is obtained when the dynamic pressure is measured by the
two hollow tubes (1 and 2). On inspiration, gas moves from the anesthesia machine or
ventilator to the patient by point 1 which measures the total pressure, and at the same
time the pressure at tube 2 is measured as the static pressure. The static pressure at
2 is subtracted from the total pressure at 1 to give the dynamic pressure. Dynamic
pressure is proportional to the velocity of gas flow. D-lite(+)/Pedi-lite(+) is designed to
work in both directions; during expiration the process is reversed. Gas samples for
CO2, O2, N2O and anesthetic agent measurements are taken through port 3.

One end of the sensor has a 15 mm male connector for a Y-piece connection, while
the patient end consists of a 22 mm male connector for the ventilation mask and
a concentric 15 mm female connector for the endotracheal tube. A disposable
double-lumen tube conducts the flow signal as a pressure difference to the pressure
sensor inside the monitor. This measurement method means that there is no gas flow
in the double-lumen tube, but only pressure pick-up. A respiratory gas sampling line
connected to the D-lite(+)/Pedi-lite(+) completes the monitoring system. Gas sampling
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is important to enable compensation of the effect of different gas viscosities on tidal
and minute volume calculations.

Spirometry parameters
Measured spirometry parameters are the following:
● Inspiratory and expiratory tidal volumes (TVinsp/exp)
● Inspiratory and expiratory minute volumes (MVinsp/exp)
● Airway pressures
● Peak pressure (Ppeak): maximum pressure during one breath
● Plateau pressure (Pplat): pressure at the reversal point of the flow
● Mean pressure (Pmean): average pressure during one breath
● Real-time pressure waveform (Paw)
● Positive end expiratory pressure (PEEPtot) in OR and PACU software packages only:

the pressure in the lungs at the end of expiration, measured when expiratory phase
changes to inspiratory flow.

● Extrinsic positive end expiratory pressure (PEEPe) and intrinsic positive end
expiratory pressure (PEEPi) (not in OR and PACU software packages).

● Compliance (Compl): calculated for each breath, indicates the pressure difference
required to deliver a certain volume of gas into the patient.

NOTE Not measured with spontaneous breaths.

● Airway resistance (Raw): calculated from an equation describing the kinetics of gas
flow between the lungs and a flow sensor.

NOTE Not measured with spontaneous breaths.

● Real time waveform (Flow)
● Ratio of the inspiratory and expiratory time (I:E)
● Pressure-volume loop (Paw-Vol. loop)
● Flow-volume loop (Flow-Vol. loop)

Airway pressures
Airway pressure waveform on the right and pressure-volume loop on the left:

● x = Paw

● y = Vol

1. Ppeak

2. Pplat
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3. Pmean

4. PEEPe

5. PEEPtot

6. (PEEPi = PEEPtot — PEEPe)

NOTE PEEPe and PEEPi not available in OR and PACU software
packages.

PEEPtot
NOTE

The following loop illustrates how PEEPtot (=PEEPe + PEEPi) is displayed.

1. PEEPe

2. PEEPi

3. PEEPtot = PEEPe + PEEPi

PEEPi
NOTE Not available in OR and PACU software packages.

High respiration rate or short expiratory time may lead to the development of intrinsic
PEEP. It is detected when alveolar pressure at the end of the expiration is higher than
airway opening pressure. PEEPi is likely to occur in patients with airflow obstruction,
inverse ratio ventilation or patients with flow limitation.

Dynamic PEEPi is measured continuously and displayed as a digit, but it is also
presented graphically in the flow waveform and in loops:

x1 = Time

x2 = Vol

y = Flow

The clinical significance of PEEPi is in detecting both the respiratory and hemodynamic
side effects:
● Respiratory side effects

￭ Barotraumas
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￭ Muscle fatigue
￭ Decreased compliance
￭ Reduced oxygen delivery
￭ Increased ventilatory dead space

● Hemodynamic side effects:
￭ Impeded venous return
￭ Increased pulmonary vascular resistance
￭ Reduced left ventricular compliance

Static PEEPi measurement
In static PEEPi measurement, an end-expiratory pause (occlusion maneuver) of at
least four seconds is produced at the ventilator. When the airway is occluded at the
end-expiration, and if the patient is hyperinflated, alveolar pressures will equilibrate
with the airway pressure measured in D-lite(+)/Pedi-lite(+), which will rise until a
plateau is reached, corresponding to total PEEP or PEEPi, if set PEEP is 0.

NOTE If both the dynamic and static PEEPi are measured, the
dynamic values are usually slightly lower.

● x = Time
● y = Paw
1. PEEPtot
2. End-expiratory pressure hold
3. Expiratory flow

I:E ratio
I:E ratio is an expression of the relationship of inspiration time to expiration time. A
typical value 0.5 means that the expiration time is twice the inspiration time. The
following examples illustrate the difference between I:E durations of 1:2 and 1:3.

If respiration rate is 10 breaths/min (respiration cycle 6 seconds) and I:E is 1:2, then the
inspiration time is 2.0 seconds and the expiration time is 4.0 seconds:

● x = Time

● y = V

1. Inspiration

2. Expiration
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If respiration rate is 10 breaths/min (respiration cycle 6 seconds) and I:E is 1:3, then the
inspiration time is 1.5 seconds and the expiration time is 4.5 seconds:

● x = Time

● y =

1. Inspiration

2. Expiration

Compliance
The measurement of pressure and volume allows for the calculation of the lungs’
dynamic compliance - in other words, how well an additional volume enters the lungs
when pressure is exerted on the airway. Compliance describes the extensibility
of the lung-thoracic system but is dominated by alveolar (that is, purely peripheral)
properties.

Typical compliance for adults varies between 35 ml/cmH2O and 60 ml/cmH2O, and
typical compliance for children is more than 15 ml/cmH2O.

Decrease in compliance may indicate too high a PEEP level, acute lung injury, or
increased intra-abdominal pressure (bleeding, ascites). Decreased compliance
indicates a worsening ventilatory status.

Typical compliance

● x = Paw

● y = Vol

Low compliance

● x = Paw

● y = Vol

Airway resistance (Raw)
Airway resistance expresses the relationship between the pressure difference across
the airway (between the mouth and the alveoli) and the rate at which gas is flowing
through the airway. An increasing airway resistance usually indicates an airway
obstruction and may lead to barotrauma. In critically ill patients, factors causing
increased airway resistance should be identified as quickly as possible to avoid lung
overdistension or decreased oxygen delivery.
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NOTE An endotracheal tube greatly contributes to Raw. The
resistance of the tube is normally higher than that of the
remaining internal airways.

● x 1 = Time

● x 2 = Vol

● y = Flow

Spirometry loops and waveforms
Graphical flow and pressure waveforms and pressure-volume (Paw-Vol) and
flow-volume (Flow-Vol) loops enable immediate detection of changes in the patient’s
ventilatory status.

The Paw-Vol loop illustrates the dynamic relationship between pressure and volume.
The Flow-Vol loop indicates the relationship between flow and volume.

Paw-Vol phases
● x1 = Paw cmH2O

● y1 = Vol ml

● x2 = Time

● y2 = Paw

1. Start of inspiration

2. Inspiration

3. Pause

4. Expiration

Normal Paw-Vol loop
The shape of the Paw-Vol loop depends on the patient’s respiratory status and the
ventilation mode used. The “normal” Paw-Vol loop appears if only a small pressure is
required before volume starts entering the lungs.
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● x = Paw

● y = Vol

Typical pediatric Paw-Vol loop
In pediatric use, the scales for pressure and volume are different from those of the
adult use. Pediatric patients have relatively high airway pressures due to the very
small endotracheal tube. Using a proportionally higher scale for pressure than for
volume makes it possible to draw pediatric loops with a shape that is similar to that
of adult loops.

Typically:

● High airway pressure (small diameter of the tube)

● Low compliance

● Insp > Exp (leak around tube) - loop remains open

● x = Paw

● y = Vol

Flow-Vol phases
Flow-Vol loop illustrates the relationship between flow and volume. Inspiratory flow
shows the type of flow pattern used by the ventilator, and expiratory flow indicates
the resistance during expiration. All flow-restrictive incidents (airway obstruction,
intrinsic PEEP) are visible in the Flow-Vol loop.
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● x1 = Vol

● x2 = Time

● y = Flow

1. Start of inspiration

2. Inspiration

3. Pause

4. Expiration

Normal Flow-Vol loop
When using volume-controlled, constant-flow ventilation mode, normal Flow-Vol loop
reflects correct functioning of the ventilator and no airflow limitations of the patient.

● x = Vol

● y = Flow

Spirometry practicalities
● Correct placement of the spirometry accessories is essential for accurate and

trouble-free operation of the measurement.

● The D-lite(+)/Pedi-lite(+) sensor is placed close to the patient’s airway; remember to
use D-lite(+) for patients whose tidal volume is 150 ml to 2000 ml, and Pedi-lite(+)
for patients whose tidal volume is 15 ml to 300 ml. Remember to select the correct
sensor type.

● Humidity condensing in the spirometry ports of the D-lite(+)/Pedi-lite(+) sensor
may increase the measured volumes during longer low flow anesthesia. Position
the sensor in such a way that gravity can remove the condensed water from the
spirometry tubes.
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Spirometry troubleshooting
Problem Solution

Values seem erroneous ● Check the patient status.

● Check that you are using the correct sensor type:
D-lite(+) for adult patients, Pedi-lite(+) for pediatric
patients.

● Check the sensor type selection.

● Check that the spirometry tube connectors and
their connections are tight and not leaking.

● Check the arterial blood gas values.

● Check that the sampling line and spirometry
tubing are not kinked.

Values seem unstable ● Remove the D-lite(+)/Pedi-lite(+) and shake drops
away.

● Check that the connectors on the
D-lite(+)/Pedi-lite(+) are intact and that
connections are tight.

Strong vibrations in the loop ● Check the patient status.

● Check the patient and system for water or
secretions.
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Gas exchange compatibility limitations
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

Gas exchange safety precautions

Gas exchange warnings
Before using the gas exchange measurement, familiarize yourself with safety
precautions related to airway gases and spirometry measurements as they apply to
the gas exchange measurement also.

WARNING The presence of Helium or Xenon in the breathing circuit
causes incorrect measurement values.

WARNING Make sure you select the correct sensor type for the patient:
D-lite(+) for adult patients, Pedi-lite(+) for pediatric patients.

WARNING Always check the sensor type selection from the monitor
(Sensor Type > Adult or Pediatric).

WARNING If the expiration gas flow during the end phase of the patient’s
expiration is close to zero for more than two seconds before
the next inspiration starts, the ventilator’s bypass flow may
affect the measurement.

WARNING INACCURATE READINGS. As the gas exchange parameters
are calculated from O2, CO2, and airway flow data, any
conditions affecting the accuracy of these parameters will
also affect the accuracy of gas exchange parameters. To
avoid the risk of inaccurate gas exchange readings that
may result in compromised patient safety, adhere to the
given measurement guidelines for O2, CO2, and airway flow
measurements and check that these measurements are
functioning properly.
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WARNING INACCURATE READINGS. The following conditions affect
the accuracy and performance of the gas exchange
measurement:
● A leaking airway.
● The use of a sampling line other than a 2–meter non-nasal

sampling line.
● The use of high FiO2.
● The fluctuation of the delivered FiO2 level during inspiration.
● The use of N2O in ventilation.
● High pressure variation from PEEP to Ppeak.
● The use of Helium or Xenon in ventilation.
● High respiration rates.
● The use of high frequency ventilation (HFV).
● The use of bi-level positive airway pressure (BiPAP).
● Irregular airway flow pattern.
● High bias flow, especially when using ventilation settings

resulting in periods with no airway flow.
● Irregular CO2 amplitude.
If these conditions are present, there is a risk of inaccurate
readings, which may result in compromised patient safety.

WARNING INACCURATE READINGS. Increased inspiratory dead space in
breathing systems without expiratory by-flow through the
Y-piece may cause too large VCO2 and VO2 readings. To avoid
any risk to the patient, always take this into account when
interpreting the measurement results with such breathing
systems.

Gas exchange cautions
CAUTION Never connect the loose end of the gas sampling line to the

spirometry connector as this may break the spirometry unit.
The spirometry connector is meant for the spirometry tube
only.

CAUTION Do not apply pressurized air or gas to any outlet or tubing
connected to the monitor. Pressure may destroy sensitive
elements.

Gas exchange measurement limitations
● This measurement is not available in the NICU software package.

● E-modules can be used within their specified performance range with OR, PACU,
ICU, and ED software packages.

● Only the E-sCAiOVX and E-sCOVX modules measure gas exchange.

NOTE Routine calibration checks are required to ensure the
measurement accuracy.
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Gas exchange points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● Gas exchange measurement is for intubated patients only.

● Use only 2-meter (7-ft) gas sampling lines. Using other lines may cause inaccurate
readings.

● FiO2 delivery from the ventilator side should be stable.

● High PEEP or ventilating pressures may activate a message prompting to check the
water trap. In this case, you may consider decreasing the PEEP if possible.

● To ensure measurement accuracy, check the accuracy of airway gas measurement
every two months: feed calibration gas mixture to the monitor in the normal
operation mode (without entering the calibration menu) and check that the
readings on the monitor match those on the calibration gas bottle. If they do not
match, calibrate airway gases.

● When anesthetic agents are present, use the E-sCAiOVX module for monitoring
airway flow and gas exchange.

● Any acute change in alveolar ventilation will be immediately reflected in CO2
output, which will not measure the metabolic production of CO2 until a new steady
state has been achieved. The time required for the stabilization may vary widely,
ranging from 30 to 120 minutes.

Gas exchange measurement setup

Gas exchange equipment to patient connection
The equipment to patient connections for gas exchange are similar to those of
spirometry but there are also some connection-related issues to be noted. Only the
modules E-sCAiOVX and E-sCOVX measure gas exchange.

NOTE By-pass flow together with long expiration flow pause time
may disturb the measurement. Consider using shorter
expiration time to diminish the effect. In addition, you may use
a suitable spacer with a 5 to 10 ml dead space (e.g., a straight
T-adapter) between the Y-piece and D-lite(+)/Pedi-lite(+). The
by-pass flow effect may exist even in an adult setting, but it
is more emphasized when monitoring pediatric patients and
using the Pedi-lite(+).

NOTE Place all D-lite ports upwards with a 20° to 45° tilt to prevent
condensed water from entering the sensor interior and the
tubings.

NOTE When monitoring pediatric patients with tidal volumes of 15
to 300 ml, use the Pedi-lite(+) sensor. Remember to select the
sensor type accordingly.
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Gas exchange patient connections with HME/HMEF/filter

NOTE Always place the HME/HMEF/filter between the D-lite(+) sensor
and the patient.

Gas exchange patient connections with flexible tube

Checking the gas exchange measurement
1. Check that the water trap is empty.

2. Occlude the sampling line and check that the Sample line blocked message
appears within 30 seconds and gas waveforms are showing zero at the same time.

Using the gas exchange measurement

Selecting the gas exchange sensor type
Select the sensor type (Adult or Pedi) according to the sensor you are using.

1. Select the gas exchange parameter window.

2. Select the Setup tab.

3. Select the sensor type from the Sensor Type list.

Selecting EE and RQ averaging time
Averaged values of energy expenditure (EE) and respiratory quotient (RQ) update
every minute. The bar in the EE+RQ parameter window indicates with green color the
amount of data that the monitor uses for performing the average calculations.
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When a patient is admitted/a case is started, no averaged value is displayed until 10
minutes of valid EE and RQ data is available. After that, the EE and RQ values are gray
until there is enough (> 1/5 of the selected averaging time) data to perform reliable
calculations.

1. Select the gas exchange parameter window.

2. Select the Setup tab.

3. Select a value from the EE Average Time list.

NOTE The values in the parameter window turn gray whenever
there is not enough valid EE and RQ averaging data.

NOTE If the RQ is out of the physiological range (<0.6 or >1.3), the
monitor does not store the EE and RQ values in the trend
history or use them for average calculations.

Weighted VO2 and VCO2
To have weighted values for VO2 (VO2/kg or VO2/m2) and VCO2 (VCO2/kg or VCO2/m2),
you must enter the patient’s height and weight. For VO2/kg and VCO2/kg, measured
values are divided by the patient’s weight, and for VO2/m2 and VCO2/m2, measured
values are divided by the patient’s BSA.

Stopping the gas exchange measurement
1. Remove the gas exchange parameter windows from the screen.

You can continue measuring airway gases and spirometry with the same module.

Gas exchange measurement basics

Gas exchange measurement description
The E-sCOVX and E-sCAiOVX modules with gas exchange option enable monitoring of
O2 consumption (VO2), CO2 production (VCO2), energy expenditure (EE) and respiratory
quotient (RQ).

To provide an accurate breath-to-breath measurement of respiratory gas exchange,
the E-sCOVX and E-sCAiOVX modules algorithmically integrate sidestream gas
concentrations (CO2 and O2) as well as flows and volumes generated by each breath.
This is done with the D-lite(+)/Pedi-lite(+) flow sensor in conjunction with the fast
paramagnetic oxygen sensor and the infrared gas bench for CO2 measurement.
Due to the sidestream measurement principle, there is a delay of approximately 2.5
seconds in the measurement, caused by the traveling time of the sample through
the sampling line to the module. The module algorithmically synchronizes these
concentrations and flows.

To obtain the oxygen consumption of a patient, the gas exchange module measures
the amount of oxygen that is inhaled, and subtracts the exhaled amount from it.
Carbon dioxide production is measured by subtracting the amount of inhaled carbon
dioxide from the amount of exhaled. These amounts can be obtained by multiplying
each measured volume sample by the corresponding gas concentration.

To ensure volume measurement results that are less sensitive to errors, the Haldane
transformation is applied. The Haldane transformation is based on the assumption
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that nitrogen is an inert gas, and an individual will neither consume nor produce it,
except in the case of air emboli. Therefore, the amount of nitrogen inhaled is equal
to the amount exhaled.

How to interpret the gas exchange values
Though the measurements can be made easily, accuracy and reproducibility of
results requires understanding of the basic principles of the measurement and
related physiology. Furthermore, gas exchange, or indirect calorimetry, is sensitive to
measurement errors; the need for routine procedures of quality control is therefore
emphasized. Despite accurate measurement, several clinical and physiological factors
influence the results of gas exchange measurements and should be considered in
interpretation. In this respect, the relationship between ventilation and gas exchange
is of crucial importance. Any acute change in alveolar ventilation will be immediately
reflected in CO2 production, which will not measure the metabolic production of CO2,
until a new steady state has been achieved. Similar, but shorter, transient will also
be seen in O2 consumption. Analogously, acute changes in tissue perfusion may
influence both tissue oxygen uptake and removal of CO2 from the tissues.

Pulmonary gas exchange measurement means monitoring of oxygen consumption
(VO2) and carbon dioxide production (VCO2). Based on these measurements, it is
possible to calculate the respiratory quotient, RQ, which is the ratio between CO2
production and O2 consumption, as well as the energy expenditure, EE, which indicates
the number of calories of energy the patient is using. The measurement of pulmonary
gas exchange corresponds to the release of energy from the body in a steady state.
A steady state condition can be defined as a period of time after the patient has
stabilized from any changes and will not incur further changes in treatment that may
affect their gas exchange or increase metabolism. Whenever the homeostasis of a
patient is changed, the steady state condition is disrupted, and a certain period of
time has to pass before a new steady state is re-established. This should be noted
in short-time measurement. In continuous measurement, obtaining average results
over longer periods helps eliminating the effects of varying steady state.

Oxygen consumption (VO2)
Indirect calorimetry measures oxygen consumption as the uptake of oxygen from the
respiratory gases. Acute changes in ventilation, hemodynamics, and physical activity
may induce wide variations in the VO2 measured by any method. Since VO2 can be
measured continuously, the transient changes in the measured VO2 can be readily
observed in prolonged measurements.

Under aerobic conditions, VO2 depends on the metabolic activity of the tissues. At a
given metabolic rate, the substrates of energy metabolism also have an impact on
the VO2, since the amount of oxygen required to produce the same amount of energy
from different substrates varies. The amount of oxygen needed to produce 1 kcal of
energy from carbohydrate is 207 ml, from fat 213 ml, and from protein 223 ml.

If the amount of oxygen delivered to the tissues is inadequate for metabolic needs,
tissue oxygen consumption becomes dependent on oxygen delivery and anaerobic
metabolism with lactic acid production will ensue. During anaerobic metabolism, the
VO2 measured from the respiratory gases does not reflect the tissue oxygen needs,
since an oxygen debt develops in the tissues. When aerobic conditions are restored,
the oxygen debt will be reflected as increased oxygen consumption.
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Carbon dioxide production (VCO2)
Measurement of carbon dioxide production (VCO2) by indirect calorimetry is
susceptible to major errors unless the close relationship between VCO2, alveolar
ventilation (VA), and arterial CO2 (PaCO2) is taken into account. According to the
classical Bohr's equation, VCO2 = VA x PaCO2/k, where k is a constant that depends on
the units and the conditions (pressure, temperature, humidity) of the measurement.
The constant is equal to 0.1150 when:

● VCO2 is given in ml/min, standard temperature (0°C) and dry gas (STPD),

● VA is given in l/min, 37 °C, and fully saturated with water vapor (BTPS),

● and PaCO2 is given in kPa,

The Bohr's equation demonstrates that the measurement of VCO2 is sensitive to
changes in ventilation: any change in alveolar ventilation will be directly reflected in
VCO2 until a new steady state of PaCO2 has been achieved.

In steady state, VCO2 depends on the metabolic activity of the tissues and, similarly
to VO2, on the substrates of the energy metabolism. Production of 1 kcal of energy
from carbohydrate produces 207 ml of CO2, from fat it produces 151 ml, and from
protein it produces 181 ml. If any of the variables in the Bohr's equation changes,
the body CO2 pool will change. Under these circumstances, enough time should be
allowed for the body CO2 pool to stabilize if the measured VCO2 should reflect the
metabolic production of CO2. Continuous measurement of gas exchange facilitates
the verification of a steady state.

Respiratory quotient
The ratio between VCO2 and VO2 is called the respiratory quotient when measured
in steady state conditions. In steady state conditions, the RQ reflects the mixture of
substrates used by the energy metabolism. The RQ is 1 for carbohydrate, 0.7 for fat,
and approximately 0.81 for protein. Detailed analysis of substrate oxidation requires
measurement of urinary urea excretion for the assessment of protein oxidation and
calculation of the non-protein RQ.

For clinical purposes, major shifts in substrate oxidation are reflected in the total RQ,
as measured directly from the respiratory gases. Increased glucose oxidation may
be observed as an RQ approaching 1, whereas increased fat oxidation may result in
an RQ approaching 0.7.

A steady state RQ above 1 may indicate fat synthesis and is a clinical rarity, associated
with excessive carbohydrate feeding. Even in these conditions, the RQ rarely exceeds
1.3. A steady state RQ below 0.7 is also a rarity, but may occur during ketosis, if the
ketone bodies are incompletely oxidized and excreted into the urine. RQ values
exceeding 1 or below 0.7 should be carefully examined for measurement errors and
the lack of steady state. Typically the most common causes for unphysiological
or erroneous RQ values are changes in ventilation: hyperventilation increases RQ,
hypoventilation decreases it until a new steady state of body CO2 pool has been
achieved. Analogously, the development of an oxygen debt will increase the RQ,
whereas replenishment of an oxygen debt will reduce the RQ.

Energy expenditure
The energy expenditure cannot be directly measured by indirect calorimetry, but it is
calculated from the measured gas exchange variables.
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Resting normal values for VO2 and VCO2 vary according to the body size, age, and sex
of the patient. Rough estimates of normal values can be obtained for example by
using the Harris-Benedict formula.

An increase in energy expenditure will be reflected as a proportional increase in
both VO2 and VCO2. Temporary increase of up to 200% can occur due to shivering
and convulsions, for instance. Clinical conditions associated with hypermetabolism,
like injury or sepsis, may increase energy expenditure by up to 50% and in extreme
cases, even up to 100%.

Patients with severe pulmonary pathology and impairment of respiratory mechanics
may have markedly increased work of breathing: the oxygen cost of breathing can
be up to 20% of the whole body VO2, whereas it normally represents less than 5% of
the total VO2.

Hemodynamic catastrophes, like circulatory collapse, may acutely reduce both VO2
and VCO2, and a compensatory increase can be observed once adequate tissue
perfusion has been restored.

Various factors contribute to energy expenditure:

Injury, infection

Anxiety

Fever

Work of breathing

Thermogenic effect

0 10 20 30 40 50

% above predicted energy expenditure

Gas exchange practicalities
A steady state condition should be present to ensure that the gas exchange
measurement is equivalent to the tissue gas exchange. In addition, different
physiological factors may affect the stability of the patient: a change in the breathing
pattern, lung volume, dead space or circulatory status induces an abrupt change
in the inspiratory and expiratory gas concentrations. These factors also determine
how fast the measurement stabilizes. The patient should be motionless and with
consistent respiratory rates and volumes.

Although gas exchange can be measured over a short period of time, a period of at
least 20 to 30 minutes is preferable. By prolonging the measurement period, more
valid information on the average gas exchange can be obtained.

Several variables can contribute to inaccurate information. To ensure correct
measurement, keep these practical considerations in mind:
● Sampling line.

￭ To ensure correct module initialization, always connect the sampling line and
the D-fend to the module before turning on the monitor or connecting the
module to a monitor that is already on.

￭ Use a correct sampling line length. Sampling lines require specific lengths and
diameters for accurate reporting of gas and flow. GE recommends using only a
2-m (7-ft) sampling line.
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● Free tubing with no obstructions.

￭ Check that there is no water (active humidity, secretions) or kinked tubing in a
line.

● Measurement calibration and accuracy.

￭ To ensure measurement accuracy, check the accuracy of airway gas
measurement once a month.

￭ Make sure you are using correct calibration gas.

￭ Ensure that the calibration gas and regulator are functioning properly before
calibration. Do not wash or disinfect calibration gas sampling lines.

● Correct positioning of the sampling setup in the patient circuit.

￭ Straight Y-piece (physical dead space < 8 ml).

￭ If a heat and moisture exchanger (HME) or an HME with filter (HMEF) is used,
place it between the D-lite(+)/Pedi-lite(+) sensor and the patient.

￭ Use the D-lite+ sensor for continuous monitoring. Condensed water inside the
D-lite may distort the volume readings.

￭ Use a pediatric Pedi-lite or Pedi-lite+ sensor for pediatric patients (tidal volumes
15 ml to 300 ml) and remember to select the correct sensor type in the monitor
menu.

● Ventilator function.

￭ Check the circuit for any leaks as they may cause inaccurate volume
measurement.

￭ Use of by-pass flow may result in inaccurate volume measurement.

￭ Max. 85% FiO2 can be used, higher reading will increase the sensitivity of the
Haldane transformation to error.

Gas exchange troubleshooting
Problem Solution

Gas exchange values are too low. ● Check the sampling line and connectors for
leakage.

Gas exchange values seem unreliable. ● Check the ventilation settings.

● Check the inspired oxygen concentration and
correct if necessary (max. 85%).

● Check that pressure variation from PEEP to Ppeak
is not too high.

● Check the spirometry data to ensure that flow
measurement is functioning properly.

● If the expiration gas flow during the end phase of
the patient’s expiration is close to zero for more
than two seconds before the next inspiration
starts, the ventilator’s bypass flow may affect
the measurement. You can reduce this effect by
adding a suitable spacer with a 5 to 10 ml dead
space (e.g., a straight T-adapter) between the
Y-piece and the D-lite or the Pedi-lite adapter.

2105822-001 CARESCAPE Monitors B850, B650, B450 333



Gas exchange

Problem Solution

Module does not work. ● Check and clean the filter if necessary.

● Check the water trap. If it was too full, liquid may
have entered the module. Replace the module and
have it checked by qualified service personnel.

No gas exchange values. ● Check that the gas sampling line is not connected
to the sample gas out connector.

VO2 values are non-physiologic. ● Verify that the oxygram curve is stable.

● Change the sampling line.

● Check the D-lite placement.

Are gas exchange values accurate with 100%
oxygen?

No, gas exchange measurements are not possible
when the FiO2 > 85%. This is also indicated on screen
by the replacement of numbers by ---. Please also
note that full measurement accuracy is obtained
when FiO2 is less than 65%. Between 65% and 85%
FiO2, the accuracy is reduced to +/-15%

Can the gas exchange modules be used with active
humidification?

Yes, they can. Use the D-lite+/Pedi-lite+ flow sensor
for humid conditions. If HME is used, both the
D-lite/Pedi-lite and D-lite+/Pedi-lite+ can be used.

Can the gas exchangemodules be used with pediatric
patients?

Yes, for those pediatric patients whose respiration
rate is below 35 breaths/minute. When monitoring
pediatric patients, use the Pedi-lite sensor and select
the sensor accordingly from the monitor menu.

How can I ensure that the VCO2 and VO2 values are
correct?

Always make sure that you are using correct
accessories and that the measurement setup and
patient connections are correct.

Why does the RQ value rise above 1.0? The physiological range of RQ is usually between 0.7
and 1.0. If the value is out of this range, check the
measurement setup.

Why does the RQ value sometimes show
unphysiological values such as RQ < 0.6?

Usually this is due to a non-steady state: the
ventilator settings have been changed, FiO2 has
changed, the ventilation is irregular.
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Entropy compatibility
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

Entropy safety precautions

Entropy warnings

WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled
with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires. Using other cables or leadwires may
result in damage to the equipment and compromise patient
and user safety.

WARNING E-ENTROPY module is defibrillation proof up to 3 kV. Ensure
that the sensor is placed on the patient’s forehead according
to the instructions. Placing the sensor in a way other than
instructed might result in risks during patient defibrillation.

WARNING DEFIBRILLATOR PRECAUTIONS. Proper placement of
defibrillator pads in relation to the electrodes is required to
ensure successful defibrillation.

WARNING Make sure that the electrodes, sensor and connectors do not
touch any electrically conductive material, including earth.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.
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Entropy cautions
CAUTION Strong 30-40 Hz magnetic fields may cause erroneous

Entropy measurement. Do not use devices with such a field
close to the module or sensor.

CAUTION Diathermy and external interference may degrade the
performance.

CAUTION The Entropy measurement is always to be used only as an
adjunct to other physiological parameters. Clinicians are
advised to use their knowledge and experience when making
clinical judgements. Entropy values are not to be used as sole
indicators of the patient status.

CAUTION Check the sensor expiration date on the sensor package. Do
not use expired sensors.

CAUTION Do not use a sensor for more than 24 hours.

CAUTION Long-term use of the electrodes may degrade condition of the
skin especially on patients with liver diseases.

CAUTION Automatic sensor check may need to be disabled if the 70
Hz impedance check signal interferes with other equipment,
such as EEG module with evoked potentials measurement.

CAUTION Allow the cable to dry completely after cleaning. Moisture and
dirt on the connector can affect the measurement accuracy.

Entropy indications for use
The GE Entropy module, E-ENTROPY, and accessories are indicated for adult and
pediatric patients older than 2 years within a hospital for monitoring the state of the
brain by data acquisition of electroencephalograph (EEG) and frontal electromyograph
(FEMG) signals. The Entropy algorithm in the host monitor calculates the spectral
entropies, Response Entropy (RE) and State Entropy (SE), which are processed EEG
and FEMG variables. The Entropy measurement is to be used as an adjunct to other
physiological parameters.

In adult patients, Response Entropy (RE) and State Entropy (SE) may be used as an aid
in monitoring the effects of certain anesthetic agents, which may help the user titrate
anesthetic drugs according to the individual needs of adult patients. Furthermore
in adults, the use of Entropy parameters may be associated with a reduction of
anesthetic use and faster emergence from anesthesia.

The Entropy module is indicated for use by qualified medical personnel only.

Entropy measurement limitations
● This measurement is available in OR and PACU software packages only.

● Entropy measurement is not indicated for pediatric patients younger than two
years old.

● Entropy is not validated with patients undergoing sedation.

336 CARESCAPE Monitors B850, B650, B450 2105822-001



Entropy

● Potential artifact may be caused by unusual or excessive electrical interference,
high FEMG activity caused by shivering, coughing, muscle activity or rigidity,
sustained eye movements, head and body motion, or ECG in case of low EEG
signal amplitude. Also, improper sensor placement and poor skin contact (high
impedance) may cause artifact and interfere with the measurement.

● During extended periods of electrocautery there may not be any good EEG epochs,
and Entropy values will not be displayed.

● Entropy readings may be inconsistent when monitoring patients with epileptic
episodes, neurological disorders, traumas, or their sequelae.

● Entropy readings may be inconsistent when using benzodiazepines, nitrous oxide
or ketamine as anesthetics.

● Psychoactive medication or very high opiate doses may suppress EEG and cause
inconsistent Entropy readings.

● Cooling the patient may suppress their EEG and cause inconsistent Entropy
readings.

Entropy points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● A portion of the Entropy software is derived from the RSA Data Security, Inc. MD5
Message-Digest Algorithm.

● Entropy sensors are disposable, for single-patient use only, and not made with
natural rubber latex.

● Make sure that the sensor connectors of the sensor cable are not in contact with
fluids.

● Always ensure that the sensor is properly attached to the patient and connected
to the cable.

● Prior to using Entropy as an adjunct to guide anesthesia care, it is recommended to
review important situations and limitations that can influence the Entropy number.
GE recommends that clinicians review the following practice advisory that includes
a section on brain function monitoring: The American Society of Anesthesiologists,
Practice Advisory for Intraoperative Awareness and Brain Function Monitoring
(Anesthesiology 2006; 104: 847-64). Clinicians are also recommended to maintain
current knowledge of all required regulatory, practice or research information on
brain function monitoring and related topics.
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Entropy measurement setup

Entropy equipment to patient connection

1. Module with Entropy measurement capability

2. GE Entropy cable

3. GE Entropy sensor

4. Entropy EasyFit sensor

Entropy module keys
There are two keys on the module. Depending on the module version either the text
only or symbol only appear on the keys, and the table below covers both versions.
Note that elsewhere in this chapter only the symbol is used to refer to the key.

or Entropy
Opens or closes the Entropy menu on the screen.

or Check Sensor
Starts the manual sensor check.

Preparing the patient for Entropy measurement
1. Connect the Entropy sensor cable to the module.

2. Clean the application site according to the sensor’s instructions for use and let it
dry before attaching the sensor.

3. Place the Entropy sensor on the patient's forehead; see sensor package for
instructions.

4. Connect the sensor to the Entropy cable.

5. Observe the results of the automatic sensor check in the parameter window.

6. The measurement starts automatically after the sensor has passed the check.
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Checking the Entropy measurement
1. Check that the sensor/electrode passes the sensor/electrode check when you

are starting to monitor a new patient.

Using the Entropy measurement

Selecting the display format for Entropy
You can select which Entropy parameters are shown in the parameter windows.

1. Press the module key, or select the Entropy parameter window.

2. Select Setup.

3. Select an option from the Display Format list:

● RE = Response Entropy

● SE = State Entropy

● RE+SE = both of the above

● All = RE, SE and Burst Suppression Ratio (BSR)

Selecting the Entropy scale
This selection affects the Entropy waveform and snapshots.

1. Press the module key, or select the Entropy parameter window.

2. Select Setup.

3. Select a value from the Scale µV list.

Selecting the EEG sweep speed
This setting determines the drawing speed for the EEG waveform.

1. Press the module key, or select the Entropy parameter window.

2. Select Setup.

3. Select a value from the EEG Sweep Speed list.

The smaller the value, the slower the sweep speed.

NOTE This setting is available in BIS and Entropy setups. Regardless
of where you change it, it will affect both parameters.

Showing Entropy microtrend
You can select an Entropy microtrend to the screen together with numeric values.

1. Press the module key, or select the Entropy parameter window.

2. Select Setup.
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3. Select Show Entropy Microtrend.

Selecting the Entropy trend length
This setting affects the width of the Entropy microtrend in the parameter window.

1. Press the module key, or select the Entropy parameter window.

2. Select Setup.

3. Select a trend length from the Trend Length list.

Using the manual Entropy sensor check
Whenever required, you can perform the sensor check manually. Press the

module key, or:

1. Press the module key, or select the Entropy parameter window.

2. Select Setup > Check Sensor.

3. Observe the results on the screen. Do not press the sensor during the check to
avoid signal noise.

The measurement continues automatically after the sensor has passed the check.

Using the automatic Entropy sensor check
Sensor impedance check is performed at the start up whenever a sensor or an
electrode is attached. If the automatic sensor check has been selected on, the check
is also performed periodically every 10 minutes.

1. Press the module key, or select the Entropy parameter window.

2. Select Setup.

3. Select Check Sensor > Automatic.

Bypassing the Entropy sensor check
If the sensor does not pass the impedance check, this option becomes selectable. It
allows you to start the measurement without completing the sensor check. In this
case, the measurement may be unreliable.

1. Press the module key, or select the Entropy parameter window.

2. Select Setup.

3. Select Bypass Check.

Setting Entropy alarm limits
You can set the limit alarms on or off and adjust their activation limits according
to your needs.
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1. Press the module key, or select the Entropy parameter window.

2. Select Setup.

3. Select the parameter (RE or SE).

NOTE If the feature is not active, the alarm limits are greyed out.
Select Alarm On to set the alarms.

Stopping the Entropy measurement
1. Remove the Entropy sensor from the patient.

2. Disconnect the sensor from the sensor cable.

3. Discard the sensor.

Entropy measurement basics

Entropy measurement description
EEG signals reflect the underlying state of brain activity. As a person falls asleep or
is anesthetized, the brain function (activity) starts to decrease and becomes more
orderly and regular. EEG changes from irregular to more regular patterns when
anesthesia deepens. Similarly, frontal EMG quiets down as the deeper parts of the
brain are increasingly saturated with anesthetics.

Entropy measurement is based on processing of raw EEG and FEMG signals by
using the Entropy algorithm, a GE application of Spectral Entropy. The algorithm is
published: Viertiö-Oja H et al. Description of the Entropy algorithm as applied in the
Datex-Ohmeda S/5 Entropy Module. (Acta Anaesthesiologica Scandinavica 2004;
Volume 48: Issue 2:154-161, 2004).

Entropy measures irregularity of EEG and FEMG. The GE Entropy measurement devices
are responsible for EEG and FEMG signal acquisition, amplification, filtering and
digitization and electrode impedance measurement.

Entropy parameters
RE is a fast reacting parameter, which measures EEG and FEMG in the frequency
range 0.8 Hz to 47 Hz. Its reaction time is two seconds. It may give an indication
of the patient’s reaction to external stimuli, such as intubation and skin incision, if
neuromuscular blocking agents are not used.

SE is a more stable and robust parameter, which measures EEG in the frequency range
of 0.8 Hz to 32 Hz. Its reaction time is 15 seconds. SE may be used to assess the effect
of certain anesthetic drugs on the brain.

Entropy frequency and display ranges
Parameter Display range Cortical EEG,

frequency range
Facial EMG,
frequency range

RE 0 to 100 0 Hz to 32 Hz 32 Hz to 47 Hz

SE 0 to 91 0 Hz to 32 Hz no measurement
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How to interpret the Entropy values
High values of Entropy indicate high irregularity of the signal, signifying that the
patient is awake. A more regular signal produces low Entropy values, which can be
associated with low probability of consciousness. A decrease in Entropy may enable
the physician to observe the moment when the patient loses responsiveness. During
continued anesthesia, both Entropies stabilize.

During general anesthesia with adequate anesthesia and hypnosis the RE and SE
values will be within a narrow range or equal. The numbers will also merge during
profound neuromuscular paralysis with neuromuscular blocking agents since the
patient’s facial muscles are unable to react.

RE is typically higher during periods prior to induction and before wake-up. If the
numbers diverge (RE exceeds SE) during general anesthesia, it indicates that the facial
muscles are activated. This may happen due to noxious stimuli. SE value may remain
within a constant range if the level of hypnosis is adequate. A quick rise in RE may give
an early warning of impending wake-up.

Patients emerging from general anesthesia will demonstrate a rise in both the RE
and SE values.

Relation of Entropy values to EEG and patient status
● Entropy values: High Entropy values

● EEG: Irregular EEG

● Patient Status: Awake

● Graphical display:

● Entropy values: High Entropy values

● EEG: Irregular EEG

● Patient Status: Deepening sedation

● Graphical display:

● Entropy values: Low Entropy values

● EEG: Regular EEG

● Patient Status: Moderate anesthesia

● Graphical display:
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● Entropy values: Low Entropy values

● EEG: Regular EEG

● Patient Status: Very deep anesthesia

● Graphical display:

● Entropy values: Low Entropy values

● EEG: Regular EEG

● Patient Status: Suppressed EEG

● Graphical display:

Entropy range guidelines
NOTE Individual patients may show different values. These are only

guidelines.

RE SE Description

100 90 Awake

60–40 60–40 Low probability of recall, clinically adequate level for most surgical
operations

<40 <40 Deep anesthesia

0 0 Suppressed EEG

Burst suppression ratio (BSR)
BSR is defined as the percentage of time of suppressed (isoelectric, flatline) EEG
periods during the last minute of observation. Emergence of burst suppression pattern
may indicate very deep anesthesia, hypothermia or ischemia.

Typically, during general anesthesia, in the absence of requirements for profound
levels of anesthesia, BSR is 0%. Higher levels of burst suppression indicate very deep
hypnosis/unconsciousness level. Burst suppression generally emerges with Entropy
values below 40, but may not appear even with very low Entropy values.

Entropy practicalities
● It is very important to ensure good contact between the sensor electrodes and skin.

With careful skin preparation, correct sensor placement and use of correct cable,
the skull and sinuses between the electrodes and the brain interfere minimally
with the signal acquisition. See the sensor instructions for use for more detailed
information.

● A high quality EEG signal is the prerequisite for successful Entropy calculation.
Displaying the raw EEG within the Entropy EEG waveform adjacent to the Entropy
values may help the user to confirm the signal quality. Raw EEG on the screen may
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also enable the clinician to view the EEG for recognizable and clinically relevant
patterns of EEG activity.

● Do not use other sensors than Entropy sensors by GE.

● Entropy is not a parameter for monitoring neuromuscular blockade. Though
RE may give an indication of the patient’s reaction to external stimuli, such as
intubation and skin incision, the level of neuromuscular blockade should be
assessed with NMT, which is an active assessment of the effects of neuromuscular
blockade agents on the neuromuscular junction.

● Neuromuscular blocking agents (NMBA) administered in surgically appropriate
doses are not known to affect the EEG, but are known to have an effect on the
EMG. RE values may drop in response to NMBA administration, due to paralysis
of facial muscles.

● The Entropy sensors and cable are designed to be defibrillation-proof.

Entropy troubleshooting
Problem Solution

Entropy values seem unstable ● Check that the sensor is not dried out.

● Check the sensor attachment and placement.

● Check the patient status.

● Check the difference between RE and SE. The
numeric RE-SE difference > 5 may be a sign
of significant FEMG activity potentially leading
to artificially high Entropy values. In case of
significant FEMG you may visually detect RE-SE
difference in graphical trend view.

Entropy EEG signal is noisy ● Remove disturbing equipment from the proximity
of the Entropy module or sensor.

● Check the sensor’s contact with skin.

● Check electrodes.

Entropy EEG signal is poor ● Check the sensor’s contact with skin.

● Check electrodes.

Entropy EEG waveform and numbers do not
correspond

● Check raw EEG as impedance check may cause a
temporary increase in the numeric values.

● Check the patient’s overall status.

● Check the difference between RE and SE. The
numeric RE-SE difference > 5 may be a sign
of significant FEMG activity potentially leading
to artificially high Entropy values. In case of
significant FEMG you may visually detect RE-SE
difference in graphical trend view.
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Problem Solution

Entropy readings seem inconsistent with the patient
status

● Check raw EEG for QRS or other artifact.

● Check electrode placement.

● Check the difference between RE and SE. The
numeric RE-SE difference > 5 may be a sign
of significant FEMG activity potentially leading
to artificially high Entropy values. In case of
significant FEMG you may visually detect RE-SE
difference in graphical trend view.

There is a sudden drop in values. A sudden drop in values can be caused by the
following:

● Bolus administration of intravenous anesthetics.

● Increase in inhalation anesthesia level.

● Administration of other medication affecting
EEG/FEMG.

There is an unexpected increase in values. ● Check the difference between RE and SE. The
numeric RE-SE difference > 5 may be a sign
of significant FEMG activity potentially leading
to artificially high Entropy values. In case of
significant FEMG you may visually detect RE-SE
difference in graphical trend view.

An unexpected increase in values can be caused by
the following:

● Change in infusion pump settings for intravenous
anesthetics.

● Change in vaporizer settings, or fresh-gas flow
rate.

● Volume loading with infused fluids.

● Fault in the operation of anesthetic delivery
systems.

● Impedance check.

Entropy reference studies

Entropy reference studies supporting reduction of drugs
The following studies support the indication for reducing the amount of certain hypnotic
drugs and enabling faster emergence from anesthesia:

● Vakkuri A, Yli-Hankala A, Sandin R, Mustola S, Hoymork S, Nyblom S, Talja P, Sampson T,
Van Gils M, Viertiö-Oja H: Spectral Entropy monitoring is associated with reduced propofol
use and faster emergence in propofol-nitrous oxide-alfentanil anesthesia Anesthesiology
2005, Volume 103, Issue 2:274-279, 2005
In the study reported by Vakkuri et al using propofol, Entropy monitoring helped
in determining the titration rates of propofol especially during the last part of the
procedures. This is indicated by higher entropy values, decreased consumption of
propofol (P<0.001), and shorter recovery times in the Entropy monitored group
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● Aimé I, Verroust N, Masson-Lefoll C, Taylor G, Laloe PA, Liu N, Fischler M (2006): Does
monitoring bispectral index or spectral entropy reduce sevoflurane use? Anesth Analg
103: 1469-77
In the study by Aimé et al, the authors reported that they were able to cut down the
sevoflurane usage by 29% in the Entropy monitored group, when compared to the
standard clinical practice.

Entropy reference studies supporting titration of drugs
The following studies support the indication that use of Entropy may help the user to titrate
certain anesthetic drugs according to the individual needs of adult patients:

● Vanluchene A.L.G., Vereecke H, Thas O, Mortier E.P, Shafer S.L, Struys M. M. R. F
Spectral Entropy as an Electroencephalographic Measure of Anesthetic Drug Effect: A
Comparison with Bispectral Index and Processed Midlatency Auditory Evoked Response
Anesthesiology 2004; Volume 101: Issue 1:34–42.
In this study by Vanluchene et al using propofol, the authors conclude that both SE and
RE seem to be useful measures for anesthetic drug effect, with low baseline variability
and accurate burst suppression detection.

● Vanluchene A.L.G, Struys M. M. R. F, Heyse B. E. K, Mortier E.P: Spectral entropy
measurement of patient responsiveness during propofol and remifentanil. A comparison
with the bispectral index. Br. J. Anaesth 2004; Volume 93: Issue 5: 645–54.
In this study by Vanluchene et al using propofol, the authors conclude that loss of
response to verbal command and loss of response to noxious stimulation were accurately
detected by Entropy and BIS.

● Vakkuri A, Yli-Hankala A, Talja P, Mustola S, Tolvanen-Laakso H, Sampson T, Viertiö-Oja
H: Time-frequency balanced spectral entropy as a measure of anesthetic drug effect in
central nervous system during sevoflurane, propofol, and thiopental anesthesia Acta
Anaesthesiologica Scandinavica 2004; Volume 48: Issue 2: 145-153, 2004.
In this study using sevoflurane, propofol and thiopental, the authors found that SE and
RE distinguished excellently between conscious and unconscious states. The authors
conclude that RE indicates emergence from anesthesia earlier than SE or BIS.

Reference studies regarding pediatric use of Entropy
Entropy has been used with pediatric patients in the following studies:

● Klockars JGM, Hiller A, Ranta S, Talja P, van Gils MJ, Taivainen T: Spectral entropy as a
measure of hypnosis in children. Anesthesiology 2006, 104: 708-17.
In the study by Klockars et al using sevoflurane, the authors used Entropy monitoring
on anesthetized children.

● Davidson A.J, Kim M.J, Sangolt G.K: Entropy and Bispectral Index During Anaesthesia in
Children. Anesthesia and Intensive Care 2004; Volume 32: Issue 4: 485-493.
In this study by Davidson et al used Entropy Module on toddlers and children during
isoflurane and nitrous oxide anesthesia.

● Davidson A, Huang G, Rebmann C, Ellery C: Performance of Entropy and Bispectral Index
as measures of anaesthesia effect in children of different ages. Br. J. Anaesth 2005,
95: 674-9.
In this study by Davidson et al using sevoflurane, the authors concluded that there was
no difference in performance of Entropy Module and BIS in children.

● Choi SR, Lim YH, Lee JH & Chung CJ: Spectral entropy monitoring allowed lower
sevoflurane concentration and faster recovery in children. Acta Anaesthesiologica
Scandinavica 54 (7): 850—862; Aug 10 2010.
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NMT compatibility
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

NMT safety precautions

NMT warnings
WARNING Make sure that the lead set clips or snaps do not touch any

electrically conductive material inlcuding earth.

WARNING Do not place the NMT stimulating electrodes on the patient's
chest. Application of the electrodes near the thorax may
increase the risk of cardiac fibrillation.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.

WARNING Never subject a patient with an implanted electronic device to
electrical stimulation without consulting a medical specialist
first.

WARNING If used in close proximity to shortwave or microwave therapy
equipment, stimulator output may become unstable.

NMT cautions
CAUTION Always stop the NMT measurement before handling the

stimulating electrodes.
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NMT measurement limitations
● This measurement is not available in the NICU software package.

● NMT measurement is not indicated for pediatric patients weighing less than 5
kg (11 lbs).

● Pediatric MechanoSensor is validated for children weighing 5 to 20 kg (11 to 44 lbs).

● Electrosurgery may cause incorrect measurement results.

● Refer to the accessory instructions for use for any limitation when defibrillating the
patient.

● NMT measurement is not indicated for patients with known abnormal function of
neuromuscular junction.

NMT points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● Start monitoring before the administration of a muscle relaxant drug (but after the
induction of sleep in general anesthesia) to prevent voluntary muscle contraction
and tension from interfering with the reference search.

● When placing the electrodes, make sure that they do not touch each other.

● Do not place electrodes on areas with excessive body hair or lesions.

● If the electrodes are placed incorrectly, wrong nerves are stimulated and this
causes wrong muscle response.

● When multiple nerves are stimulated, the measured response may be affected
by electrical activity of other muscles.

● If the stimulation electrodes are placed very close to the palm of the hand, the
muscles are stimulated directly by the stimulation pulses.

● Avoid trans-thoracic simulation.

● Do not apply stimulation across or through the head, directly on the eyes, covering
the mouth, on the front of neck (especially over the carotid sinus), or from electrodes
placed on the chest and the upper back or crossing over the heart.

● If the current is too strong, it may stimulate the muscles too much.

● Moving or touching the patient during measurement may cause incorrect results.

● For safe extubation, the TOF% should be higher than 90. Also assess other clinical
signs.
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NMT measurement setup

NMT equipment to patient connection

1. Module with NMT measurement capability

2. NMT sensor cable

3. MechanoSensor or Pediatric MechanoSensor lead wire set

4. Electrode, white lead connection site for nerve stimulation

5. Electrode, brown lead connection site for nerve stimulation

6. ElectroSensor leadwire set

7. White stimulating electrode

8. Brown stimulating electrode

9. Electrode, black lead connection site, ground

10. Electrode, green lead connection site, recording muscle-contraction effect

11. Electrode, red lead connection site, recording muscle-contraction effect

NMT module keys
There are two keys on the module:

Start-up ● Starts the search for supramaximal current and reference level.

● Proceeds with the selected measurement cycle.

Stop Continue ● Interrupts monitoring.

● Restarts monitoring of the same patient. If the module has
been disconnected, but you wish to continue the previous NMT
monitoring, select Recall reference.

Preparing the patient for NMT measurement
1. Connect the NMT sensor cable to the module.

2. Clean the skin at the NMT application area.

3. When applying the electrodes, make sure that the entire electrode surfaces make
an optimal contact to the skin.

4. Always connect the white NMT stimulation lead to the proximal electrode.

5. Connect the sensor cable to the MechanoSensor or ElectroSensor leadwire set.
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Preparing the ElectroSensor setup
1. Place two electrodes for white and brown lead connection along the ulnar nerve.

Prevent the electrodes from making contact with each other.

2. Place the electrodes for red and green lead connection as indicated in the
illustration above.

3. Place the electrode for black lead connection where convenient, preferably
between the stimulating and recording lead connection electrodes.

Preparing the MechanoSensor setup
1. Place the two electrodes along the ulnar nerve. Prevent the electrodes from

making contact with each other. Palpating the ulnar artery near the wrist area
may be helpful in identifying the ulnar nerve.

2. Attach the sensor in the groove between thumb and index finger. If necessary,
secure with narrow tape only.

3. Make sure that the sensor sets tightly in the groove and that the thumb can move
freely. Do not immobilize the hand.

Ulnar nerve and corresponding muscles
1. m. adductor pollicis

2. m. abductor digiti minimi (hypothenar)

3. m. flexor pollicis brevis (thenar)

4. n. ulnaris

5. medial epicondyle

Checking the NMT measurement
1. Always check the electrode quality.

2. Check that the electrodes are correctly positioned on the ulnar nerve and the
message Supramax search is displayed. Ensure that you get a stimulus response.
If the supramaximal stimulus current is not found, the message Supramax not
found is displayed.

NMT alternative connections
If the patient's arm and/or hand cannot be used for NMT measurement, the foot may
be an alternative measurement site. Place the electrodes for white and brown lead

350 CARESCAPE Monitors B850, B650, B450 2105822-001



Neuromuscular transmission

connection along the posterior tibial nerve (causing plantar reflexion of the great
toe and foot) or peroneal nerve (stimulated behind the head of fibula). Place the
electrodes for red and green lead connection site on the m. flexor hallucis brevis, and
the electrode for black lead connection (ground) as indicated in the figure.

1. Flexor hallucis brevis

2. Red measuring electrode

3. Green measuring electrode

4. Black ground electrode

5. Brown stimulating electrode

6. White stimulating electrode

7. Tibial nerve

NMT graphical trends on the monitor screen
Different NMT values have their own specific colors in the graphical trends. The values
are shown as follows:

● white bars = Ratio% (TOF)

● green dots = T1%

● cyan bars = PTC

● magenta dots = Count

Using the NMT measurement

Starting the NMT measurement
Press the Start-up module key, or:

1. Select the NMT parameter window > Setup.

2. Select Stimulus Mode > TOF, DBS or ST.

3. Select Start with > New patient.

4. Select Start-up.

Changing the NMT stimulus current
1. Select the NMT parameter window > Setup.
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2. Select a value from the Current list.

Changing the NMT cycle time
This selection also affects the recovery note.

1. Select the NMT parameter window > Setup.

2. Select a value from the Cycle Time list.

Changing the NMT pulse width
1. Select the NMT parameter window > Setup.

2. Select a value from the Pulse Width µs list.

Adjusting the NMT beep volume
You can set the beep value to best suit your care environment.

1. Select the NMT parameter window > Setup.

2. Set a value for the Stimulus Beep Volume.

Using the NMT recovery note
The recovery note alarms you with the Block recovery message when the count
reaches the value you have selected. It indicates that the patient is responding more
clearly to the stimuli and the neuromuscular block is decreasing.

The note is activated according to the count number and cycle time:

● Cycle time less than one minute: The count must be below the selected limit in
two consecutive measurements.

● Cycle time one minute or more, or manual measurement: At least one count must
be below the selected limit.

To take this feature into use:

1. Select the NMT parameter window > Setup.

2. Select Recovery Note.

3. Select the count limit that will activate the note.

Measuring deep relaxation
When no responses are detected for TOF stimulation, the post tetanic count (PTC) is
the only way to measure the neuromuscular block. A tetanic stimulation (50 Hz) is
generated for five seconds and post-tetanic responses to single-twitch stimulation
are counted. The larger the PTC (the number of detected responses), the sooner the
normal TOF responses return. To monitor the relaxation level, start a five-second
tetanic stimulation:

1. Select the NMT parameter window > Setup.

2. Select Start Tetanic/PTC.

Continuing the NMT measurement
To continue interrupted NMT measurement with the same patient and monitor, press
the Stop Continue module key, or:
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1. Select the NMT parameter window > Setup.

2. Select Start with > Current patient.

3. Select Continue.

Restarting the NMT measurement in OR after induction
When you move the patient with the module to the OR and want to continue the
measurement with the already found and determined current and reference values,
use the restart function. Connect the module to the monitor and:

1. Select the NMT parameter window > Setup.

2. Select Start with > Recall reference.

3. Select Restart.

Stopping the NMT measurement
Press the Stop Continue module key, or:

1. Select the NMT parameter window > Setup.

2. Select Stop.

NMT alternative uses

Local nerve and plexus localization
Single stimulation pulses may be helpful for determining the correct needle tip position
from a local nerve in plexus procedures. The NMT module delivers single stimulation
pulses at a selected rate until it is manually stopped. Muscle contractions from the
stimulated innervating motoric nerve(s) may be observed. Note that you need specific
accessories for this measurement.

1. Regional block adapter

2. Sensor cable
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3. Sterile needle

Preparing for local nerve or plexus stimulation
1. Connect the NMT regional block adapter to the sensor cable.

2. Place the electrode near the anesthetized nerve according to the the regional
block adapter’s instructions for use.

3. Connect the white adapter clip.

4. Connect a sterile needle and syringe set to the adapter.

5. Press the Start-upmodule key and select a suitable current from the Current mA
list that appears on screen. You can also do this by selecting the NMT parameter
window > Regional Block tab > Current mA.

6. Select a suitable cycle from the Stimulus Cycle list.

7. Start stimulation by selecting Start.

8. When the needle approaches the motor nerve, reduce the current. The pulse
width is 40 ms and somewhat higher currents may be needed than in other
similar systems.

9. When ready, stop the stimulation by pressing the Stop Continuemodule key, or
by selecting the NMT parameter window > Regional Block > Stop.

NMT measurement basics

NMT measurement description
The GE NMT measurement devices are used for monitoring the relaxation of the
patient and regional block stimulation for nerve location.

Neuromuscular transmission is the transfer of a motor nerve impulse over the
neuromuscular junction. The GE NMT devices deliver stimulating electrical pulses to a
motor nerve and the muscle response to these stimulations is measured.

Two electrodes are needed for electrical stimulation of a peripheral nerve. The
resulting response can be measured with either two electrodes and a MechanoSensor,
which measures movements between thumb and index finger, or an ElectroSensor
using three recording electrodes.

The monitor searches for the stimulus current needed to activate all the fibers of the
stimulated (recorded) muscles. The search begins with a 10 mA stimulus and the
response is measured. The current is increased in steps of 5 mA until the increase
in the current no longer increases the response. This maximal current is then
automatically increased by 15%, resulting in the supramaximal current.

If the supramaximal current is not found or the response is too weak for searching a
supramaximal current, the current is set to 70 mA.

MechanoSensor and kinemyography (KMG)
Measurement with MechanoSensor is based on kinemyography principle. Two
electrodes are placed on the ulnar nerve, and the innervating nerve is stimulated.
The core of the MechanoSensor is a strip of piezoelectric polymer, housed inside the
sensor. When this piezoelectric material changes shape due to muscle contraction
as a result of nerve stimulation, the electrical charge in the material is redistributed,
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causing an electron flow to balance the charges. This flow can be measured as a
potential change, which is proportional to the amount of material bending.

ElectroSensor and electromyography (EMG)
Measurement with ElectroSensor is based on electromyography. Three electrodes are
placed on the muscle, and the innervating nerve is stimulated. The recorded electrical
activity of the muscle is inversely proportional to the degree of block.

Stimulation modes
● Train of four, TOF: Recommended for most cases. It is also the default setting.

● Double burst stimulation, DBS: Useful when using the MechanoSensor. It enables
better visual observation of the fading in responses.

● Post tetanic count, PTC: Used for estimating the relaxation level with tetanic
stimulation.

● Single twitch, ST: Single twitch mode is practical when using depolarizing relaxants:
in these cases, TOF% does not give any additional information about the patient
status.

How to interpret the NMT values
When neuromuscular block deepens, different stimulation modes may be needed to
assess the relaxation status. The following table describes the depth of relaxation.

100 TOF% 20 4 Count 0 10 PTC 0

Light RELAXATION METER Deep

Train of four (TOF) mode
In TOF stimulus mode, four stimulation pulses are generated at 0.5 second intervals.
The response is measured after each stimulus and the ratio of the fourth to the first
response of the TOF sequence is calculated, resulting in TOF%.

With the ElectroSensor, T1% is displayed. If the reference is successfully found, a scale
is also included. Scale markers represent 0%, 30%, 60%, 90% and 120% reference
values. When no reference is available, no T1% value is displayed and the bars are
not scaled.

When relaxation deepens, the TOF% declines until the fourth response disappears and
no TOF% is available. The degree of neuromuscular block is then estimated from the
number of responses, the count, which represents the number of responses detected
to the four stimuli. The fewer the responses, the deeper the relaxation.

Number of responses, count Neuromuscular block Muscle power (% of control)

1 95% 5%

2 90% 10%

3 85% 15%

4 75% 25%
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Double burst stimulation (DBS) mode
DBS consists of two separate bursts. Each burst consists of three consecutive pulses
at a 50 Hz frequency. The response ratio of the second to the first burst is calculated,
resulting in DBS% (equivalent to TOF%).

Post tetanic count (PTC) mode
When the response to the fourth TOF stimulation pulse disappears or the first twitch is
very weak, the TOF% is not available and only the counts can be observed.

When the stimulation pulses no longer give any stimulation response, the count also
disappears. To monitor the relaxation level, you can then start tetanic stimulation and
estimate the relaxation level from the post tetanic count, PTC. Tetanic stimulation
is a continuous stimulation of five seconds. After tetanic stimulation, single twitch
stimulations are generated. The number of detected responses is counted and
expressed as PTC. The fewer the responses, the deeper the relaxation.

If the responses do not fade away, a maximum of 20 responses are counted and the
measurement value is replaced by >20.

After tetanic stimulation, NMT measurement is stopped for one minute. After that, the
monitor automatically continues with the previously selected cycle.

Single twitch (ST) mode
In single twitch stimulation one pulse is generated and its response is measured.

NMT practicalities
● Normally, defasciculating doses of non-depolarizing neuromuscular blocking

agents (precurarisation) do not affect the supramaximal current nor the reference
value.

● Average lifetime of a MechanoSensor is two years, depending on the use. The
sensor has been validated to last 700,000 twitches.

Inappropriate function of the measurement is often caused by incorrect accessory
connection or misuse of the products. Therefore, note the following:

● Handle the sensor and cables carefully to maximize their lifetime.

￭ Piezosensor inside the MechanoSensor is very sensitive to shocks.

● Attach the MechanoSensor correctly.

￭ It is recommended to secure the MechanoSensor with a narrow tape. Wide
tape might prevent adequate movement of the sensor with the thumb during
the measurement.

● Check the quality of the stimulation electrodes.

￭ Use GE approved NMT electrodes for stimulation. They are tested with the
module and provide low impedance, which is crucial for accurate measurement.

￭ Do not use the electrodes after their expiration date.

● Perform a visual check of the MechanoSensor or ElectroSsensor and cable.

￭ Regular visual checking of the cable and sensor is recommended. If you see any
signs of broken cables or joints of the MechanoSensor, replace those parts.
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NMT troubleshooting
Problem Solution

NMT reference search and measurement fail. ● Check the electrode quality and positioning.

● Replace stimulating electrodes.

Measurement is disturbed. ● Check the black ground electrode.

Difficulty in getting the response when locating the
nerve for plexus stimulation

● You may try using the local muscle response as an
indication of current in the needle. If there is no
response, the needle may be broken.

● Change the needle if necessary.

How can I verify the measurement reliability? ● The reliability of the response can be estimated by
observing the bar graph or the NMT trend.

● The bars of the bar graph should be in a smoothly
descending order from left to right, and the NMT
trend should indicate a fairly stable T1%. If this
is not the case, the latest response is unreliable.
Relaxation level does not usually decrease
significantly in one minute even with short-acting
relaxants.

● To verify your observations, start a new
measurement manually right after the completion
of the previous measurement. Sometimes
the selected cycle time has been so long that
the relaxation level has changed considerably
between the measurements.

What can I do if the monitor does not find the
supramaximal stimulation current?

● If the monitor is unable to find the supramaximal
stimulation current, check the electrode
placement. The nerve may be outside the dense
current flow or both the ulnar and median nerves
may be stimulated; progressively more muscle
activity is detected as the increasing stimulation
current activates new motor units. Consult the
figure below when placing the electrodes:

1. adductor pollicis

2. abductor digiti minimi (hypothenar)

3. flexor pollicis brevis (thenar)

4. ulnar medial
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Problem Solution

5. epicondyle

● Also, supramaximal current may not be found if
the patient has anatomical and/or physiological
anomalies.
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BIS compatibility
For detailed information regarding module, monitor, and accessory compatibility, see
the supplemental information manual.

BIS safety precautions

BIS warnings
WARNING DEFIBRILLATOR PRECAUTIONS. Patient signal inputs labeled

with the CF and BF symbols with paddles are protected against
damage resulting from defibrillation voltages. To ensure
proper defibrillator protection, use only the recommended
cables and leadwires.

WARNING Make sure that the electrodes, sensor and connectors do not
touch any electrically conductive material, including earth.

WARNING When using an electrosurgery unit, note that the
measurement cables do not incorporate means to protect
against burns in case of a defective ESU return electrode. To
avoid burns at the monitor measurement sites, ensure the
following:
● Proper contact of the ESU return electrode to the patient.
● ESU return electrode near the operating area.
● Measurement electrodes, leadwires and probes far from

the surgical site and the ESU return electrode.

WARNING Do not autoclave the signal processing unit (BISx) or the digital
signal converter (DSC). Do not open it for any reason.

WARNING The sensor must not be located between defibrillator pads
when a defibrillator is used on a patient connected to BIS
devices.
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WARNING This monitor uses a component modular device in deriving the
Bispectral index (BIS) purchased from Covidien. It is important
to recognize this index is derived using solely that company’s
proprietary technology. It is recommended that clinicians
have reviewed applicable information on its utility and/or risks
in published articles and literature/web site information from
Covidien (www.covidien.com) or contact that company itself if
they have clinical-based BIS questions relating to this module
portion of the GE monitor. Failure to do so could potentially
result in incorrect administration of anesthetic agents and/or
other potential complications of anesthesia or sedation. We
recommend that clinicians also review the following practice
advisory (that includes a section on BIS monitoring): The
American Society of Anesthesiologists, Practice Advisory for
Intraoperative Awareness and Brain Function Monitoring
(Anesthesiology 2006; 104:847-64). Clinicians are also
recommended to maintain current knowledge of government
regulatory, practice or research information on BIS and
related topics.

WARNING Misinterpretation of BIS can result in incorrect administration
of anesthetic agents and/or other potential complications of
anesthesia or sedation.

BIS cautions
CAUTION Due to elevated surface temperature, do not place the BIS

device in prolonged direct contact with the patient’s skin, as it
may cause discomfort.

CAUTION The BIS measurement based on measuring the EEG signal is
inherently very sensitive. Radiated electromagnetic fields may
cause erroneous measurements at various frequencies. Do
not use electrical radiating equipment close to the BISx or
DSC. Details regarding radiated field strengths are given in
the technical specifications.

CAUTION Automatic sensor check may need to be disabled if the 1
nA 128 Hz impedance check signal interferes with other
equipment, such as EEG module with evoked potentials
measurement.

CAUTION The BIS module has been designed to operate with a
disposable BIS sensor. Only use recommended sensors.

CAUTION Do not use the BIS sensor if the sensor gel is dry. To avoid
dryout, do not open the pack until you are ready to use the
sensor.

CAUTION Check the sensor expiration date on the sensor package. Do
not use expired sensors.

CAUTION If skin rash or any unusual symptom develops, discontinue the
BIS measurement and remove the sensor.
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CAUTION When connecting or disconnecting BIS, take care not to touch
the exposed contacts of either connector. Damage due to
electrostatic discharge may result to the equipment.

BIS indications for use
The BIS module is intended for use by personnel trained in its proper use. It is intended
for use on adult and pediatric patients within a hospital or medical facility providing
patient care to monitor the state of the brain by data acquisition of EEG signals.
The Bispectral index (BIS), a processed EEG variable, and one component of the BIS
module, may be used in adults as an aid in monitoring the effects of certain anesthetic
agents. The Bispectral index is a complex technology, intended for use only as an
adjunct to clinical judgement and training. In addition, the clinical utility, risk/benefit,
and application of BIS have not undergone full evaluation in the pediatric population.

BIS measurement limitations
● This measurement is not available in the NICU software package.

● E-modules used for this measurement are not suitable for use with neonatal
patients.

● BIS is a complex monitoring technology intended for use only as an adjunct to
clinical judgment and training. Clinical judgment should always be used when
interpreting BIS in conjunction with other available clinical signs. Reliance on BIS
alone for intraoperative anesthetic management is not recommended.

● BIS values should be interpreted cautiously with certain anesthetic combinations,
such as those relying primarily on either ketamine or nitrous oxide/narcotics to
produce unconsciousness.

● External radiating devices may disturb the measurement.

● Poor signal quality may lead to inappropriate BIS values.

● Artifact may lead to inappropriate BIS values. Potential artifact may be caused by
unusual or excessive electrical interference or high EMG activity like shivering,
muscle activity or rigidity, sustained eye movements, head and body motion. Also,
improper sensor placement and poor skin contact (high impedance) may cause
artifact and interfere with the measurement.

● Due to limited clinical experience in the following applications, the BIS value should
be interpreted cautiously in patients with known neurological disorders and those
taking psychoactive medications.

BIS points to note
● This equipment is suitable for use in the presence of electrosurgery, as tested

according to IEC 60601-2-49 clause 202.6.2.101 Electrosurgery interference.

● For information on materials used in accessories and their biocompatibility, refer
to the instructions for use in the accessory package.

● Make sure that the sensor connectors of the patient interface cable are not in
contact with fluids.

● BIS sensors are disposable, for single patient use only, and not made with natural
rubber latex.

● Check the sensor expiration date on the sensor package.
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● Do not use a sensor for more than 24 hours.

● Use only Covidien BIS sensors.

BIS measurement setup

BIS equipment to patient connection

1. Module with BIS measurement capability, E-BIS

2. Digital Signal Processing Unit, BISx

3. Patient Interface Cable, PIC Plus

4. BIS sensor

BIS module keys
There are two keys on the module:

Opens or closes the BIS menu on the screen.

Starts the manual sensor check.

Preparing the patient for BIS measurement
1. Connect the digital signal processing unit (BISx) cable to the module.

2. Connect the patient interface cable to the BISx.

3. Secure the BISx to a convenient location, preferably close to the patient’s head.

4. Clean the application site with alcohol and let dry.

5. Place the BIS sensor on the patient; see sensor package for instructions.

6. Connect the sensor to the patient interface cable.

7. Observe the results of the automatic sensor check in the parameter window.

8. The measurement starts automatically after the sensor has passed the check.

362 CARESCAPE Monitors B850, B650, B450 2105822-001



Bispectral index

Checking the BIS measurement
1. Check that the sensor/electrode passes the sensor/electrode check when you

are starting to monitor a new patient.

BIS measurement on the monitor screen
● Suppression ratio (SR) number indicates the percentage of suppressed (flatline)

EEG detected over the last 63 seconds

● Bar graphs:

￭ Signal Quality Index (SQI): the quality of the EEG signal. NOTE: When the SQI is in
the range 15% to 50% (low), the BIS number is displayed in gray

￭ Electromyograph (EMG): the absolute power in the 70 Hz to 110 Hz frequency
band

Using the BIS measurement

Selecting the BIS waveform size
This setting determines the maximum drawing scale for BIS waveforms.

1. Press the module key or select the BIS parameter window.

2. Select the Setup tab.

3. Select a value from the Scale µV list.

Selecting the EEG sweep speed
This setting determines the drawing speed for the EEG waveform.

1. Press the module key or select the BIS parameter window.

2. Select the Setup tab.

3. Select a value from the EEG Sweep Speed list.

The smaller the value, the slower the sweep speed.

NOTE This setting is available in BIS and Entropy setups. Regardless
of where you change it, it will affect both parameters.

Selecting the BIS smoothing rate
Smoothing rate affects the appearance of the BIS trend and the BIS value. It
determines the amount of artifact-free data that is required for calculating the BIS
value.

1. Press the module key or select the BIS parameter window.

2. Select the Setup tab.

3. Select a value from the Smoothing Rate list. The bigger the value, the “smoother”
the trend.
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Setting BIS filters
With BIS filters you can filter out disturbances from the EEG signal and improve the
signal quality.

1. Press the module key or select the BIS parameter window.

2. Select the Setup tab.

3. Select Filters. Set the filter option according to your needs: set the filters on by
selecting the check box, or set them off by deselecting the check box.

Setting BIS alarm limits
You can set the alarm limits according to your needs.

1. Press the module key or select the BIS parameter window.

2. Select the Alarms tab.

NOTE If the feature is not active, the alarm limits are greyed out.
Select Alarm On to set the alarms.

3. Set the high and low alarm limits with the arrows.

Using the automatic BIS sensor check
1. Press the module key or select the BIS parameter window.

2. Select the Setup tab.

3. Select Sensor Check > Automatic.

Using the manual BIS sensor check
Whenever required, you can perform the sensor check manually. Press the
module key, or:

1. Select the BIS parameter window.

2. Select the Setup tab.

3. Select Check Sensor.

4. Observe the results on the screen.

The measurement continues automatically after the sensor has passed the check.

Testing the BISx
In case the measurement does not work and checking the cables and sensors does
not help, make sure that the BISx functions properly.

1. Press the module key or select the BIS parameter window

2. Select the Setup tab.

3. Select Test DSC.

4. Observe the results on the screen.

After the test is completed, the result shown is PASS or FAIL.
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Stopping the BIS measurement
1. Remove the BIS sensor from the patient.

2. Disconnect the sensor from the patient interface cable.

3. Discard the sensor.

How to interpret the BIS values
The Bispectral Index is an absolute value, so baseline information about the patient
is not required for BIS monitoring. The following table lists the BIS values and their
significance.

BIS value Clinical endpoint Comments

100 Awake Patient responds to normal voice

80 Light/moderate sedation Patient responds to loud commands
or mild prodding/shaking

40 to 60 General anesthesia Patient has low probability of explicit
recall and is unresponsive to verbal
stimulus

20 Deep hypnotic state EEG suppression, or burst suppression
as it is sometimes referred to, is an
easily recognizable EEG pattern
characterized by bursts of activity
of varying shape alternating with
episodes of flatline activity.

0 Isoelectric EEG No brain activity detected

This chart reflects a general association between clinical state and BIS values. Ranges
are based on results from a multi-center study of the BIS involving the administration
of specific anesthetic agents. BIS values and ranges assume that the EEG is free of
artifact that can affect its performance.

Titration of anesthetics to BIS ranges should be dependent upon the individual goals
for hypnotic state that have been established for each patient. These goals and
associated BIS ranges may vary over time and in the context of patient status and
treatment plans.

Low BIS values (below 40) may indicate overdosing of hypnotic medication, and high
BIS (over 60 to 65) may indicate too low concentrations of the drug.

BIS troubleshooting
Problem Solution

Measurement does not start ● Check sensor attachment to the patient and the sensor placement.

● Check the sensor’s contact with skin.

● Check the sensor type.

● Check all cable connections.
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Problem Solution

● Check the digital signal processing unit.

BIS signal is poor ● Check the sensor’s contact with skin.

● Check the sensor.

● Ensure that the digital signal processing unit is not close to any
electrical radiating equipment.

What happens during the BISx self
test?

The BISx self test tests the digital signal acquisition and conversion
functions. The test reports pass/fail status, noise, high-pass blocked,
high-pass normal and gain values.

● If any of the self tests fail, contact qualified service personnel.

What if the sensor does not pass
the sensor check?

● The sensor check may fail for the following reasons:

￭ Impedance too high.

￭ Incorrect sensor application.

￭ Poor sensor connection.

￭ Defective patient interface cable or sensor.
To correct the situation:
● Recheck the sensor.

● Reapply the sensor according to instructions.

● Check sensor connection.

● Replace patient interface cable or sensor.
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About laboratory values
The Laboratory Data menu shows many laboratory values and you can manually
enter values needed for oxygenation and hemodynamic calculations (pH, PCO2, PO2,
HCO3-, BE, TCO2, SO2, FiO2 and Hb). The laboratory data menu also displays a set of
other laboratory data obtained through an interfaced device.

The message Lab data available is displayed when laboratory data is available from
an interfaced device. The interfaced values are updated automatically to the value
table. You can perform temperature correction to interfaced or obtained pH, PCO2, or
PO2 values, but other editing is prevented.

When entering laboratory values manually, make sure that the units are the same as
the ones on the screen. If they are not, convert the values before entering them. You
can also change the units on the screen. They are changed through Monitor Setup
> Default Setup > Care Unit Settings > Units > Laboratory Values and the settings
are password protected.

For more information, see the supplemental information manual.

Viewing laboratory data
You can view the most recently saved laboratory data.

1. Select Data & Pages.

2. Select Laboratory Data.

3. You can now see the values on the View tab.

In addition to the available laboratory values, you can see the following information:

● Sampling: The date and time of sampling, and how long ago the sampling took
place.

● Patient's temperature: This is shown if it is available.

● Temperature correction: No, Yes, or Laboratory.

● Sample site: Arterial, Venous, or Other.

Selecting the blood sample site for laboratory values
1. Select Data & Pages.

2. Select Laboratory Data.

3. Select the Enter Data tab.
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4. Select Sample Site list > Arterial, Venous, or Other.

Note that selecting Arterial or Venous affects the labels of pH, PO2, PCO2, and
SO2:
● Arterial changes the labels to pHa, PaCO2, PaCO2, and SaO2.
● Venous changes the labels to pHv, PvO2, PvCO2, and SvO2.

Selecting the blood sample time for laboratory values
1. Select Data & Pages.

2. Select Laboratory Data.

3. Select the Enter Data tab.

4. Set the Sample Time with arrows.

5. Select Save.

Temperature correction
In the laboratory, blood gas values are measured and calibrated at +37 °C (+99
°F). The pH, PCO2, and PO2 values may need to be corrected to the actual patient
temperature because an increase or decrease in temperature changes the amount of
dissolved blood gas molecules and pH.

While the Enter Data tab of the Laboratory Valuesmenu shows both the corrected
and uncorrected values, the View tab shows either the corrected or uncorrected
values depending on the Temperature Correction selection.

Formulas used to calculate the values when temperature correction is enabled are
given in the supplemental information manual.

Selecting the type of temperature correction
1. Select Data & Pages.

2. Select Laboratory Data.

3. Select the Enter Data tab.

4. Select an option from the Temperature Correction list:
● Laboratory: Temperature correction has been done in the laboratory and the

values have already been corrected to patient temperature. The entered pH,
PCO2, and PO2 values are stored without adjustment and they are shown in
the Temp corrected column.

● Yes: The monitor will perform correction calculations. Select a temperature
source from the Temperature Source list and the monitor recalculates the
entered blood gas values corrected to patient temperature. Both the corrected
and uncorrected values are shown.

● No: No temperature correction is needed or performed. The entered blood
gas values are shown as such.

Entering or loading laboratory values
1. Select Data & Pages.

2. Select Laboratory Data.

3. Select the Enter Data tab.
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4. Adjust the values with arrow selectors.

When you set a value, it first changes to its default value. Interfaced values are
shown with gray selectors and cannot be adjusted.

5. Ensure that you have set the Sample Time or it has been sent by the interfaced
device. If not, set it now.

6. Select Save to confirm the entered values.

If you do not select Save, new data is lost when you exit the menu.

Printing laboratory values
You can print the most recently saved laboratory data.

1. Select Data & Pages.

2. Select Laboratory Data.

3. Select the View tab.

4. Select Print.

2105822-001 CARESCAPE Monitors B850, B650, B450 369



Laboratory data

370 CARESCAPE Monitors B850, B650, B450 2105822-001



23
Calculations

About calculations

Ventilation calculations with the B850 and B650 only.

Calculations are used to derive calculated hemodynamic, oxygenation, and ventilation
values from actual measurements. Calculations also provide trending for the
calculated values.

Saved laboratory data can be used as input data for oxygenation and ventilation
calculations. The monitor marks the temperature corrected values in the oxygenation
and ventilation calculations with the letter c.

Viewing calculation values

Ventilation calculations with the B850 and B650 only.

A list of displayed input and calculated parameters is given in the supplemental
information manual.

1. Select Data & Pages.

2. Select Calculations.

3. Select Hemo, Oxy, or Vent tab.

4. Select View.

Parameter data is now displayed in two columns: Input Parameters and
Calculated Parameters.

Source data for calculations
Several types of data (blood gas, laboratory) are required to complete a calculation.
Data can be entered automatically using a network interface, or manually by the
clinician.

Source data means that the time of its collection will be used as the basis for collecting
additional data from the trends. The monitor uses the C.O. measurement as source
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data for hemodynamic calculations. However, C.O. or CCO and/or their indexed values
that are older than 15 minutes are not used as source data. Other input values (for
example, HR, PA Mean, CVP, Art Mean) used in the calculation are chosen from the
same time the sample is drawn or the cardiac output is measured.

For oxygenation calculations the monitor uses laboratory data as source data. You
can select any available arterial laboratory data samples or any C.O. measurement
(if no laboratory data but multiple C.O. values are available) from the current patient
case to be used as source data. Venous laboratory data or C.O. measurement are
used as other input data if the venous sample is drawn or the C.O. is measured within
±15 minutes from the arterial sample.

In ventilation calculations, you can select any arterial laboratory data samples from
the current patient case to be used as source data.

Selecting source data for oxygenation calculations
1. Select Data & Pages.

2. Select Calculations.

3. Select the Oxy tab.

4. Select Edit Input.

5. Select the desired sample with corresponding time and date from the Select Lab
Data list.

Selecting source data for ventilation calculations

B850 and B650 only.

1. Select Data & Pages.

2. Select Calculations.

3. Select the Vent tab.

4. Select Edit Input.

5. Select the desired sample with corresponding time and date from the Select Lab
Data list.

Estimated values in oxygenation calculations
In normal circumstances, about 3% of the total arterial oxygen content is dissolved in
the blood and 97% is hemoglobin bound. When no SaO2 laboratory result is saved
in the Laboratory Data menu, the measured SpO2 value is used to estimate the
clinically relevant SaO2 value. Also, the measured EtCO2 value is used to estimate the
PaCO2 value.

The monitor marks the estimated values by adding the letter e to the SaO2 and PaCO2
values in the Calculations > Oxy > Trend and Calculations > Oxy > View.
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Estimated values in hemodynamic calculations
You can select different sources for the PCWP. If you select LAP mean or PA, the PCWP
value in Hemo > Trend will be marked as an estimated value with the letter e. Instead,
the Hemo > Edit Input and Hemo > View show the actual selected label.

Selecting the PCWP source
1. Select Data & Pages.

2. Select Calculations.

3. Select the Hemo tab.

4. Select Edit Input.

5. Select the source from the PCWP Source list:

● PCWP

● LAP mean

● PA dia

Indexing parameters for hemodynamic and
oxygenation calculations

Indexed values are calculated only if the patient’s BSA (body surface area) value is
available at the time when the calculations take place.

1. Select Data & Pages.

2. Select Calculations.

3. Select Hemo or Oxy tab.

4. Select View.

5. Select the Indexed check box at the lower part of the view.

Those parameters that can be indexed are now displayed as indexed, and indexed
values are calculated.

Editing calculation input values

Ventilation calculations with the B850 and B650 only.

1. Select Data & Pages.

2. Select Calculations.

3. Select Hemo, Oxy, or Vent tab.

4. Select Edit Input.

5. Enter or edit the parameter values with the arrows of the Value column.
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6. To perform the actual calculation and save the values, select the View tab > Save.

If you select Previous Menu before saving the values, they are lost.

Saving calculation values

Ventilation calculations with the B850 and B650 only.

1. Select Data & Pages.

2. Select Calculations.

3. Select Hemo, Oxy, or Vent tab.

4. Select View.

5. Select Save to save the input parameter values and calculated parameter values
to the corresponding calculation trends.

Save is disabled if neither the input parameters nor the calculated parameters
have values available, or if the displayed values have already been saved.

Viewing saved calculations

Ventilation calculations with the B850 and B650 only.

1. Select Data & Pages.

2. Select Calculations.

3. Select Hemo, Oxy, or Vent tab.

4. Select Trend.

If you select Trend > Indexed, the monitor displays indexed values. The indexed values
are calculated and trended only if the patient’s BSA (body surface area) value is
available at the time when the calculations are performed.

To navigate between the pages of the Trendmenu, use the left or right arrow keys
in the lower part of the menu.

Printing hemodynamic, oxygenation, or
ventilation calculations

Ventilation calculations with the B850 and B650 only.

You must save the calculations before you can print them. If they have not been
saved, the Print selection is disabled.
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1. Select Data & Pages.

2. Select Calculations.

3. Select Hemo, Oxy, or Vent tab.

4. Select View.

5. Select Print.

Printing all calculation trends

Ventilation calculations with the B850 and B650 only.

You can print all calculation trends at once.

1. Select Data & Pages.

2. Select Calculations.

3. Select Hemo, Oxy, or Vent tab.

4. Select Trend.

5. Select Print.
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About drug calculations
The intravenous administration of medications is a common practice. Many drugs are
titrated based on the patient’s physiologic response to the medication or according to
the patient’s weight. Accuracy and safety are always important in drug therapy, and
precise control of drug administration is essential. The drug calculator provides an
accurate and safe method of determining drug dosage.

An order for a medication is either written by the physician or is a standing protocol
in the unit based on the patient’s condition. The order will specify the drug and the
dose to be administered. The clinician and/or pharmacy will mix the drug in solution,
and then determine how fast to administer the drug in order to deliver the proper
drug dosage.

Neonates present a different approach to drug administration because the amount
of fluid to be administered is vital. Usually, the drug dosage is ordered and the flow
rate in ml/h or cc/hr is prescribed. The clinician must determine the amount of drug to
place in the solution in order to meet the rate/dose combination.

In other cases, the physician may order a drug dosage to be infused over a period of
time. The amount of drug in solution may or may not be specified. In this situation,
the clinician must determine the rate that is needed to infuse the proper drug dosage
over the period of time ordered.

Still another situation occurs in cases where drugs are administered to resuscitate the
patient, and then the dose is determined after the response. The clinician considers
the solution volumes and drug quantities and the rate of the infusion to determine the
dose that the patient is actually receiving.

The drug calculator can be used in all of these situations. In addition, it also provides a
titration table that can be used as the dosages are increased or decreased, based
on the patient’s physiologic response. The titration table displays drug dosage
information that can be used to help the clinician determine the dosing effects of
intravenous pump setting and infusion rate changes.
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Calculations menu description

1. Calculator tab: Allows you to set various drug settings like Drug Amount, Dose,
etc.

2. Titration Table tab: Allows you to set the Dose Increment for a drug you select
from the Drug Name list. From this tab you can also print a titration table listing
the doses and infusion rates for the selected drug.

3. Resuscitation Medications tab: This tab is only visible in the NICU software
package. It allows you to calculate, view, and print resuscitation medication
information for neonates.

4. Drug Name list: The contents of this list are configured through the Care Unit
Settings and they are password protected.

5. Additional Drug: Allows you to enter a new drug name to the Drug Name
list temporarily. Any drugs added will only be on the list until the patient is
discharged/case is ended.

6. Patient's Weight: Allows you to enter the patient’s weight if the selected Dose
Unit requires it.

7. Selections for entering drug specification information from the drug order.
Concentration is automatically calculated.

8. Selections for entering drug dose administration information.
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9. Print: Allows you to print the calculated drug dose and infusion rate.

10. Previous Menu: Allows you to return to the previous menu.

Drug calculator

Calculating drug doses
The drug calculator allows you to calculate and print the doses and infusion rates for
intravenous medications.

1. Select Data & Pages.

2. Select Drug Calculations.

3. Select the Calculator tab.

4. Select a drug from the Drug Name list.

If necessary, you can also add a new drug to the list through selections available
when selecting Additional Drug.

5. If the patient’s weight was not entered at the time of admission and the selected
Dose Unit requires it, set the Patient's Weight.

NOTE Changing the weight in the drug calculator menu does
not change the weight in the patient demographics.
Changing the patient’s weight in the Calculator, Titration
Table, or Resuscitation Medications tab will change the
displayed value in all of them.

6. Set the Solution Volume.

7. Set the Drug Amount.

Concentration level is automatically calculated.

8. Set the Dose Unit if appropriate.

9. Set the Dose.

The Infusion Rate ml/h, Infusion Time h, and Infusion Time min are automatically
calculated.

Adding a new drug name
You can add a new drug name and calculate drug doses for that drug. The drug name
is deleted when the patient is discharged from the monitor.

1. Select Data & Pages.

2. Select Drug Calculations.

3. Select the Calculator tab.

4. Select Additional Drug.

5. Enter the drug name with the on-screen keyboard.

The name can contain a maximum of 20 characters and it is case-sensitive (for
example, Insulin and insulin would be two different drug names).

6. Select Add.
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The drug name is now added to the Drug Name list and can be selected as any other
drug until the patient is discharged.

Printing drug dose calculations
You can print the calculated drug dose and infusion rate.

1. Select Data & Pages.

2. Select Drug Calculations.

3. Select the Calculator tab.

4. Select Print.

5. You can stop printing by selecting Stop Printing or Cancel Printing.

Titration table

Calculating drug titrations
The titration table calculator allows you to calculate and print titration information
for a selected drug.

1. Select Data & Pages.

2. Select Drug Calculations.

3. Select the Titration Table tab.

4. Select the Drug Name.

5. If the patient weight was not entered during admission and the selected Dose
Unit requires it, set the Patient's Weight.

NOTE Changing the weight in the drug calculator menu does
not change the weight in the patient demographics.
Changing the patient’s weight in the Calculator, Titration
Table, or Resuscitation Medications tab will change the
displayed value in all of them.

6. If needed, change the Dose Increment.

The titration table now shows the doses (50 rows) in the Dose column, and
corresponding infusion rates in the Infusion Rate (ml/h) column.

Printing the titration table
1. Select Data & Pages.

2. Select Drug Calculations.

3. Select the Titration Table tab.

4. Select the Print.

5. You can stop printing by selecting Stop Printing or Cancel Printing.
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Resuscitation medications

Calculating resuscitation medication doses
NOTE NICU software package only.

1. Select Data & Pages.

2. Select Drug Calculations.

3. Select the Resuscitation Medications tab.

4. If the patient weight was not entered during admission, set the Patient's Weight.

NOTE Changing the weight in the drug calculator menu does
not change the weight in the patient demographics.
Changing the patient’s weight in the Calculator, Titration
Table, or Resuscitation Medications tab will change the
displayed value in all of them.

5. Select Confirm.

The monitor will not calculate the dose values until the patient’s weight value has
been confirmed.

Printing resuscitation medication doses
You can print a list of resuscitation medications and their concentration level, delivery
method, and dose value.

1. Select Data & Pages.

2. Select Drug Calculations.

3. Select the Resuscitation Medications tab.

4. Select Print.

5. You can stop printing by selecting Stop Printing or Cancel Printing.
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Trends

Trend licenses and saved data
You can have a 24 hour or a 72 hour trend license. The license affects the time
limit for saved snapshots and events, and the data included in the graphical and
numerical trends.

● With the 24 hour license all trend, snapshot, and event data is synchronized with
time, therefore any events or snapshots older than 24 hours will not be saved
on a bedside monitor.

● With the 72 h licenses the data is saved up to 72 hours, up to 999 events, up to 400
parameter snapshots, or up to 10 ST snapshots.

Trend views
Different trend views display various types of trend data: graphic, numeric, event,
snapshot, ST snapshot, and gas consumption data. All views have default parameter
content. Trend views can be configured through Monitor Setup > Default Setup >
Profile Settings > Trends & Snapshot. These selections are password protected.

For more information, see the supplemental information manual.

When entering the trends menu after ending a case/discharging the patient or when
the monitor has been powered down for longer than 15 minutes, the displayed menu
and trend view are the configured graphic or numeric ones. Displayed trend data and
views are updated if there is an active case on the monitor or at least one vital sign
parameter is connected. This applies to all trend, event and snapshot views.

You can also split the normal screen page so that the left side of the screen
continuously shows graphic minitrends beside waveforms.

The numeric trends include a predefined set of parameters. The graphic trend
selections include all parameters that can be used. If you are viewing trends for
parameters for which you do not have a license, trend labels are shown, but no new
data is collected. Therefore, no data is shown in the trend view or printouts. You can
view data that was loaded from previous cases where the parameters were available.

Graphic trends

Viewing graphic trends
Graphic trends contain 24 or 72 hours of trend data depending on the trend license.
They contain four trend pages, each having up to six fields, with different parameters
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already preconfigured in the defaults. Five fields can be displayed and six fields
printed. The top of each page can be configured to show the highest priority realtime
waveform.

1. Select Trends.

2. Select View > Graphic.

● To see more parameters, select tabs 1 to 4.

● To see numeric values of a certain time, move the cursor to that point of time.
The numeric values are displayed next to the cursor.

Graphic trend symbols
In printouts the graphic presentation formats are replaced by symbols. The following
are some examples of these.

CO2

SpO2

Art (sys/dia/mean): The gap shows the blood pressure mean value.

NIBP (sys/dia/mean): The gap shows the blood pressure mean value.

Changing the time scale of graphic trends
The time scale setting is dependent on the cursor time. When the cursor position is
more than 30 minutes from the current time, the Time Scale list does not show the 20
minute option. With the high-resolution trends license enabled, the 20 minute option
is visible even if the cursor is as far as 1 hour from the current time. High-resolution
trends contain 24 hours of trend data. This means that when the cursor position is
more than 24 hours from the current time, the Time Scale list does not show the 2
minute, 4 minute, and 20 minute options.

1. Select Trends.

2. Select View > Graphic.
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3. Select a time value from the Time Scale list.

The available selections depend on the license in use:

● Basic settings for all software packages are 20 minutes, 1 h, 2 h, 4 h, 6 h, 8 h,
10 h, 12 h, and 24 h.

● The 72 h license provides the basic settings and additionally 36 h, 48 h, and
72 h selections.

● The high-resolution license provides basic settings and additionally 2 minute
and 4 minute selections.

Changing the graphic trend scales
1. Select Trends.

2. Select View > Graphic.

3. Select Trend Scales.

4. Select the General, IP/NIBP, Cardiac Output, or Temp tab.

5. Set the trend scales for required parameters.

Printing currently viewed graphic trends
1. Select Trends.

2. Select View > Graphic.

3. Select Print Page.

4. You can stop printing by selecting Cancel Printing.

Printing all graphic trend data
1. Select Monitor Setup > Printing.

2. Select Reports > Trends.

3. Select Print.

4. You can stop printing by selecting Cancel Printing.

Graphic trend resolution and the high-resolution license
The graphic trend resolution depends on the time scale of the trend. Graphic trends
are updated once a minute when the time scale is 1 hour or more. For the 20 minute
scale, the update rate is 10 seconds.

High-resolution trends is a licensed graphic trend option that provides an increased
resolution of 2 seconds for the 2, 4, and 20 minute scales. The high resolution graphic
trend is updated on user request. This trend also contains CRG trends for compressed
CO2 and impedance respiration waveforms as well as beat-to-beat ECG heart rate,
mean arterial pressure MAP, SpO2, and SpO2(2).

High-resolution trend data is not saved over power down situations. This means that
data in the 2, 4, and 20 minute time scales is erased.

High-resolution trend data is neither sent nor loaded to/from the network (central
station) or acquisition modules (PDM).
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Numeric trends

Viewing numeric trends
Numeric trends contain nine pages with 24 or 72 hours of trend data depending on
the trend license. The top of the view shows the highest priority realtime waveform.
The lowest row,Mark, shows snapshot event numbers. If more than one snapshot has
been created in a one-minute period, only the last snapshot event number is shown.
You cannot configure the layout of the Numeric trend view.

1. Select Trends.

2. Select View > Numeric.
● To see other parameters, select their tabs in the Numeric trend view.
● To see more numeric trend data, use the cursor to scroll the data in horizontal

direction.

Changing the time interval of numeric trends
Numeric trends display values according to the selected time interval. Numeric
trends are updated with averaged measurement data once a minute independent of
the selected time scale.

1. Select Trends.

2. Select View > Numeric.

3. Select a value from the Time Interval list.

For example, a 5 minute interval will show data for every 5 minutes, and a 30 minute
interval will show data for every 30 minutes. The data is displayed in columns on the
screen. NIBP, PCWP, cardiac output, NMT, and manual SPV measurements will always
add one column independent of the Time Interval setting.

Printing numeric trends
1. Select Trends.

2. Select View > Numeric.

3. Select Print Page (Recorder).

4. You can stop printing by selecting Stop Printing.

Depending on what has been configured, either the data currently on screen or all
data will be printed. This configuration is done throughMonitor Setup > Default Setup
> Care Unit Settings > Printer >Numeric Trends Printing and it is password protected.

For more information, see the supplemental information manual.

Invasive pressure trends
The following invasive pressure trend data is collected:
● PDM:

￭ Systolic, diastolic, and mean pressure data for Art 1 to Art 8, Fem, PA, and UAC.
￭ Mean pressure data for FemV, CVP, LAP, RAP, ICP 1 to ICP 8, P1 to P8, RVP,

and UVC.
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● E-modules:

￭ Systolic, diastolic, and mean pressure for all labels except UAC and UVC.

The invasive pressure trends will only be stored for those channels that have been
zeroed.

Heart rate (HR) trends
Only the measured values from the primary heart rate or pulse rate source are trended
to the HR graphic and numeric trends. Pulse rate sources that can be selected are
the monitored and zeroed invasive pressure (IP) channels labeled with Art 1 to Art
8, Fem, UAC, and the SpO2 parameter.

Gas consumption
NOTE This feature is only available through the Unity Network

Interface Device (ID) v6 or later.

Viewing gas consumption data
TheMachine Gas Cons. view shows the amount of Air, O2, N2O, and anesthetic agents
used by an interfaced anesthesia machine during the ongoing patient case.

If the values for Air, O2, or N2O exceed the range limit, the text >32767 l appears
instead of the value. For the anesthetic agents, the text is >999 ml.

1. Select Trends.

2. Select View > Machine Gas Cons..

Printing gas consumption data
You must print the report before discharging the patient/ending the case.

1. Select Trends.

2. Select View > Machine Gas Cons..

3. Select Print Page to print the currently viewed page.

Minitrend split screen

Minitrend view
You can split the normal screen page so that the left side of the screen continuously
shows graphic minitrends beside waveforms. Minitrend is a license providing
components for minitrend and minitrend length. The high-resolution license
additionally provides compressed waveforms for CO2 and respiration.

Minitrends follow graphic trend scale settings. Use the same scale for waveforms
and trends. IP minitrends are an exception: they follow the IP waveform scales and
not the IP trend scales.
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1. Indication of the selected minitrend length (for example, 1 minute)

2. Trend scales

3. Graphic minitrends; visualization according to the parameter

4. Compressed waveform

You can also have minitrends on other pages than the normal screen. This setting is
configured through Monitor Setup > Default Setup > Profile Settings > Pages and it
is password protected.

For more information, see the supplemental information manual.

Selecting the minitrend to screen
1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select the Split Screen tab.

4. Select Show > Minitrend.

Modifying the minitrend length
You can select the minitrend length from a selection varying from 1 minute to 120
minutes. The 1 minute and 2 minute selections are available with the high-resolution
license only.

1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with the Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select Split Screen tab.
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4. Select a value from the Minitrend Length list.

● The 1 minute and 2 minute minitrends (high-resolution license) are updated
every 2 seconds.

● The 5 minute and 10 minute minitrends are updated every 10 seconds.

● Other lengths are updated once a minute.

Selecting high-resolution contents to minitrend
If the high-resolution license is enabled and the minitrend length is 1 minute normal or
2 minutes wide, you can select compressed waveform (CRG) or respiration rate for
CO2 Minitrend and Imp. Resp Minitrend.

1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select the Split Screen tab.

4. Select Show > Minitrend.

a. Select CO2 Minitrend or Imp. Resp Minitrend > Resp Rate.

b. Select CO2 Minitrend or Imp. Resp Minitrend > Compressed Waveform.

Removing minitrend from the screen
1. Select Monitor Setup > Screen Setup.

2. B850 and B450 with the Dual Video license: Select Screen 1 or Screen 2 tab.

3. Select the Split Screen tab.

4. Select Show > None.

Time change during a patient case
CAUTION System time changes will result in time differences between

stored and realtime data.

Time adjustment is allowed during a patient case if the monitor is configured to the
CARESCAPE Network. When the time is adjusted, the monitor shifts the timestamps of
continuous trend data and of discrete data, except NIBP and wedge measurements.

After time adjustment continuous and discrete data cannot be compared to each
other because their timestamps no longer match.
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Snapshots and events

Trend licenses and saved data
You can have a 24 hour or a 72 hour trend license. The license affects the time
limit for saved snapshots and events, and the data included in the graphical and
numerical trends.

● With the 24 hour license all trend, snapshot, and event data is synchronized with
time, therefore any events or snapshots older than 24 hours will not be saved
on a bedside monitor.

● With the 72 h licenses the data is saved up to 72 hours, up to 999 events, up to 400
parameter snapshots, or up to 10 ST snapshots.

Description of snapshots
A snapshot is a set of measured data saved from a certain moment of time. Snapshots
can contain waveform clips and graphic trends. You can take up to 400 snapshots
depending on the data load.

The duration of the stored snapshot may not contain the entire duration of the
physiological event that triggered it. If the snapshot was triggered by the monitor,
there will be about 11.5 seconds of waveform data displayed in the waveform box. If
the snapshot was converted from a telemetry transmitter or PDM alarm history, there
will be 10 seconds of waveform data displayed.

Snapshot configuration
Snapshots are configured through Profile Settings > Trends & Snapshot > Snapshot
and these settings are password protected.

For more information, see the supplemental information manual.

Manually created snapshots
You can create a snapshot manually by selecting Freeze/Snapshot. The monitor saves
the image of preconfigured waveforms or trends at that moment in time.

When a snapshot is taken manually, it is automatically numbered. A Mark xxx
message is shown in the message field (xxx = the sequence number of the snapshot).
This number also appears in the numeric trend view.
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Creating automatic snapshots
You can select alarms that will automatically create a snapshot independent of their
alarm priority.

1. Select Trends.

2. Select View > Snapshot.

3. Select Snapshot Setup.

4. Select which alarms will automatically create a snapshot:

● Tachy/Brady (PDM, E-modules) or HR High/Low (telemetry).

● ST High/Low: An ST snapshot will be created for ST Ant high, ST Ant low, ST Inf
high, ST Inf low, ST Lat high, ST Lat low, ST xxx high and ST xxx low (xxx = lead).

● PVC

● SVC

● Art/Fem/UAC High/Low

● SpO2 High/Low

● Apnea

You can also define automatic snapshot creation for each arrhythmia alarm
separately through the ECG menu.

Viewing snapshots
1. Select Trends.

2. Select View > Snapshot.

In the upper right hand corner of the Snapshot view, you can see the time the
snapshot was created. Five fields can be displayed on the snapshot page, and six
fields can be printed.

The lowest field in the Snapshot view shows the event time scale and indication box.
The snapshots are shown with color coded vertical lines. A yellow line indicates the
chosen snapshot and its exact time is shown in digits.

Event indicators are drawn in the time indication box as vertical lines according to
the time of the event and shown in the following colors:

● White: a snapshot event and during standby. Event indicators will be displayed for
standby periods at one minute intervals (time scale other than 2 minutes) or two
second intervals (time scale 2 minutes).

● Red: a high priority alarm event

● Yellow: a medium priority alarm event

You can select snapshots either by using the arrows in the scroll bar, or with the Trim
Knob by selecting the scroll bar and then turning the Trim Knob. When the cursor is
scrolled in the event time scale and indication box of the Snapshot view, it moves
between the snapshot indicators only and skips the ST snapshot indicators. Note that
when viewing the ST snapshots, the cursor moves between the ST snapshots only.

When you select the Snapshot view and there are snapshots, the snapshot closest
to the trend cursor's time is displayed. The snapshot cursor’s time is set to the time
of that snapshot.
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You can scroll waveform snapshots with the arrows in the lower part of the waveform
field you are viewing. The time period you are viewing is indicated beside the arrows.

Selecting snapshot sweep speed
You can select the sweep speed for all snapshots.

1. Select Trends.

2. Select View > Snapshot.

3. Select Snapshot Setup.

4. Select the snapshot Sweep Speed.

Selections are 12.5 mm/s, 25 mm/s, and 50 mm/s. The default is 12.5 mm/s.

Changing the snapshot time scale
1. Select Trends.

2. Select View > Snapshot.

3. Select a time value from the Time Scale list.

Changing snapshot trend scales
1. Select Trends.

2. Select View > Snapshot.

3. Select Trend Scales.

4. Select a parameter tab: General, IP/NIBP, Cardiac Output, or Temp.

5. Select scales for parameters as required.

Printing snapshot pages
1. Select Trends.

2. Select View > Snapshot.

3. Select Print Page.

The number of pages depends on the selected Sweep Speed:
● 12.5 mm/s: one page
● 25 mm/s: two pages
● 50 mm/s: four pages

4. You can stop printing by selecting Cancel Printing.

Selecting snapshots to print automatically
You can select certain snapshots to print automatically.

1. Select Trends.

2. Select View > Snapshot.

3. Select Snapshot Setup.
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4. Select the snapshots to print from the Automatic Printing list:
● No: No snapshots print automatically.
● Alarms: Snapshots created by alarms print automatically.
● All: All snapshots print automatically.

Selecting spirometry loops to print with snapshots
1. Select Trends.

2. Select View > Snapshot.

3. Select Snapshot Setup.

4. Select Print Loop > Yes or No.

Erasing snapshots and trends
Snapshots and trends are erased when you end a case / discharge a patient, when
the monitor has been off for more than 15 minutes, or automatically after 24 hours
or 72 hours depending on the license. If the monitor has been off for less than 15
minutes, the snapshots are stored and remain unchanged.

Erased snapshots cannot be recovered. The memory is automatically checked every
time a snapshot is created. When the memory is too full, the message Snapshot
memory full. Oldest snapshot erased. is displayed in the message field for five
seconds. If the contents of the snapshot have been changed, a new snapshot may
need more memory than the previous ones. Therefore, more than one snapshot
may have to be erased.

To erase snapshots, you must discharge the patient/end a case. Note that this will not
erase just the snapshots but also all other patient and trend data from the monitor
and a connected PDM, and will also return monitor settings to their defaults.

1. Select the patient information area on screen, or select Data & Pages > Start
/ Reset Case (OR and PACU software packages) or Admit/Discharge (other
software packages).

2. Select Patient > Discharge Patient.

3. Select Yes.

Snapshots and alarm history
CAUTION MEASURING DATA STORED IN ALARM HISTORY. Waveform data

is stored in the alarm history using compression technology
that may not allow perfect reconstruction of the waveform
data when subsequently viewed. Although differences occur
relatively frequently and are usually very minor, users are
urged to verify diagnostic waveform measurements with the
waveform data from realtime graph strips.

When a PDM or telemetry transmitter is connected to the monitor, the saved alarm
history and ST history will be transferred to the monitor. One snapshot is created
for each alarm history.

The PDM or a telemetry transmitter alarm history has 10 seconds of waveform data
from two or three ECG leads and the first arterial invasive pressure line. The snapshot
will display waveforms only if the snapshot field configuration includes the same
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ECG waveforms and/or arterial invasive pressure channel. Otherwise, no waveform
data is displayed.

A snapshot is sent to the CARESCAPE Network if it contains one of the following
waveforms: ECG lead I, II, III, or Va, or any arterial invasive pressure.

Snapshot transfer to PDM
Telemetry transmitters store snapshots independently. They are stored on the PDM
when they are transferred by the monitor. Only snapshots created by arrhythmia
alarms are transferred. Manual snapshots and snapshots triggered by SpO2 high/low
and arterial IP high/low alarms are not stored to the PDM.

ST snapshots

Creating ST snapshots manually
An ST snapshot displays QRS complexes.

1. Select Monitor Setup > Parameter Setup.

2. Select ECG > ST.

3. Select Realtime View.

4. Select Save Reference.

The monitor saves an image of preconfigured waveforms or trends. You can take up
to 10 ST snapshots depending on the data load. If there is not enough free memory in
the database to create the next ST snapshot without deleting old ST snapshots, the
message ST snapshot memory full. Oldest ST snapshot erased. is displayed.

Viewing ST snapshots
1. Select Trends.

2. Select View > ST-Snapshot.

On the upper right corner of the ST-Snapshot view, you can see the time the ST
snapshot was created. The ST-Snapshot view displays 11 QRS complex windows. The
bottom field shows the event time scale and indication box.

Printing ST snapshots
1. Select Trends.

2. Select View > ST-Snapshot.

3. Select Print Page.

4. You can stop printing by selecting Cancel Printing.

Erasing ST-snapshots
You cannot erase the initial reference complex.

1. Select the ST parameter window.

2. Select the reference to be erased in the Erase Reference list.
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Events

Trend licenses and saved data
You can have a 24 hour or a 72 hour trend license. The license affects the time
limit for saved snapshots and events, and the data included in the graphical and
numerical trends.

● With the 24 hour license all trend, snapshot, and event data is synchronized with
time, therefore any events or snapshots older than 24 hours will not be saved
on a bedside monitor.

● With the 72 h licenses the data is saved up to 72 hours, up to 999 events, up to 400
parameter snapshots, or up to 10 ST snapshots.

Description of events
Events are timestamps that are shown in their own list. An event is created
automatically upon an alarm. An event records the time of and reason for its creation.
Some events may also record a snapshot. Manually created events contain only the
time and a manually added reason for the event. You cannot configure the Event
trend pages.

Automatic events
An event is created automatically from:

● Medium and high priority physiological or technical alarms.

● Low priority alarms that have a snapshot.

● Manually created snapshots or ST snapshots.

An event is also created automatically when alarm history is transferred from PDM
or telemetry transmitter to the monitor and corresponding snapshots are created
at the monitor.

Viewing events
The Event trend view shows event data on horizontal axis and time on vertical axis.
The top of the view shows the highest priority realtime waveform and the bottom of
the view shows a sample waveform if an event has a snapshot.

1. Select Trends.

2. Select View > Event.

● The Priority column shows an alarm priority symbol for events created
automatically from an alarm.

● The Event column shows the reason the event was created for. If the event was
created automatically, the alarm message is shown. If the event was created
manually, a possible manually added text is shown. If there is a manual annotation
added to the event, this text is shown in quotation marks with the prefix NOTE.

● The Snapshot column shows a snapshot symbol if there is a snapshot attached
to an event.
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Sorting events
You can select how the events are sorted: by Time with the newest event on top, or by
Priority with the highest priority alarm on top in chronological order. Manually created
events and snapshots have the lowest priority.

1. Select Trends.

2. Select View > Event.

3. Select Sort by > Time or Priority.

Creating events manually
The manual creation of an event enables you to add a special situation to the Event
trend view and to describe its reason in the desired way.

1. Select Trends.

2. Select View > Event.

3. Select Create Event.

4. Type the text in the Event field with the on-screen keyboard. Maximum number of
characters is 50.

5. Select Add to add the event to the event list.

The time stamp of the event is the time you select Add.

Annotating events
You can add an annotation to an existing event to describe the event in more detail.

1. Select Trends.

2. Select View > Event.

3. Select the desired event from the Event trend view.

4. Select Annotate Event.

5. Type the text in the Annotation field with the on-screen keyboard. The maximum
number of characters is 50.

6. Select Add to add the annotation text to the event.

Deleting events
1. Select Trends.

2. Select View > Event.

3. Select the desired event from the Event trend view.

4. Select Delete Event.

Undeleting events
1. Select Trends.

2. Select View > Event.

3. Select the Show Deleted check box.

4. Select the deleted event you wish to undelete and select Undelete Event.
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Printing events
You can print alarms and user event in event history reports. Depending on the
number of saved events, one or more pages are printed.

1. Select Trends.

2. Select View > Event.

3. Select Print Page.

4. You can stop printing by selecting Cancel Printing.
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Printing options
Depending on the system configuration, the following printing capabilities are
available:

● Printing to a recorder connected directly to one of the M-ports.

● Printing to a built-in recorder (B450 and B650).

● Printing to a remote recorder connected to another networked bedside monitor
(except a B650 or a B450) or a central station in the CARESCAPE Network.

● Printing to a bedside printer connected via the IX network interface. In this case the
IX Network interface cannot be used for other network purposes.

● Printing to a network printer connected to the IX Network.

You can print realtime waveforms (generated by a manual request or by an arrhythmia
or non-arrhythmia alarm) and numeric trends to a recorder or a printer. In addition,
you can print different types of reports to a printer.

Laser printers
WARNING EXCESSIVE LEAKAGE CURRENT. Laser printers are UL

60950/IEC 60950 certified equipment, which may not
meet the leakage current requirements of patient care
equipment. This equipment must not be located in the patient
environment unless the medical system standard IEC 60601-1
is followed. Do not connect a laser printer to a multiple socket
outlet supplying patient care equipment. The use of multiple
socket outlet for a system will result in an enclosure leakage
current equal to the sum of all the individual earth leakage
currents of the system if there is an interruption of the multiple
socket outlet protective earth conductor. Consult your local
service representative before installing a laser printer.

WARNING EXCESSIVE LEAKAGE CURRENT. A secondary display or printer
that is a non-medical grade device and is used within the
patient environment, must always be powered from an
additional transformer providing at least basic isolation
(isolating or separating transformer). Using without an
isolating transformer could result in unacceptable enclosure
leakage currents.
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1. Cancel Print key: Press to cancel print request.
This is only an example of a printer. In other models, the key may be located
elsewhere.

A laser printer may be connected to the monitor via network, or to a central station on
the network. A bedside printer may be directly connected to the monitor’s network
port with a crossover cable or via a network hub.

A laser printer manages multiple laser printouts at a time by queuing them. If one
printout is being processed and another is initiated for the same laser printer, the
second printout will be queued and printed after the first one. An exception is
continuous printing. If waveforms are being printed continuously (max. duration
5 minutes) and another printout is initiated for the same laser printer, continuous
printing is stopped and the second printout is printed. After the second printout is
finished, the continuous waveform printing is restarted.

When a print job is canceled from the monitor, no more data is sent to the printer.
However, the printer will finish printing all the data it had received before the
stop/cancel request

Recorders
NOTE Recorders print on thermal paper. The data printed on thermal

paper may be destroyed by exposure to light, heat, acids,
PVC, and alcohol. Make a photocopy of the printout for your
archives.

You can connect a recorder directly to the monitor (B850) or use the built-in recorder
option locally (B650, B450). You can also use a recorder over the network connected to
a central station or connected to a remote monitor (other than B650 and B450).

PRN 50–M+ recorder for B850
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1. Paper out indicator: Illuminates when you need to replace the recorder paper.
2. Power on indicator: Illuminates when connected to power.
3. GRAPH STOP key: Press to stop printing.
4. M-port connector: Connect to the CARESCAPE Monitor B850.
5. Power switch: Press to turn on or turn off the recorder.
6. Power connector: Connect the recorder’s power cable.

XE-50 recorder for B650 and B450
B650 B450

1. Built-in recorder option

NOTE Remote recording is only possible from the B650 or B450 to a GE
monitor or a central station; remote recording is not possible to the
B650 and B450.

Printing device selections

Changing printer
1. Select Monitor Setup > Printing.

2. Select the Devices tab.

3. Select Setup.

4. Select the printout type from the Printout list.

You may assign one printout type to one print location only.

5. Select the location for the printout:

If you are printing to this
location

Select this option Printout types for this
location

Local recorder XE-50 or PRN
50-M+ (connected directly
to or built in the monitor).

Local ● Waveforms

● Alarm Waveforms

● Telemetry Waveforms
(PRN 50–M+ only)

● Numeric Trends

Remote recorder or printer
(a recorder in another
monitor in the CARESCAPE

Remote ● Waveforms

● Alarm Waveforms
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If you are printing to this
location

Select this option Printout types for this
location

network, or a recorder
or a printer connected to
a central station in the
network).

● Telemetry Waveforms
(PRN 50–M+ only)

● Numeric Trends

Network printer (a printer in
the IX Network).

Network ● Waveforms

● Alarm Waveforms

● Numeric Trends

● Reports (including
events)

Changing the print location does not affect printing currently in progress.

Printing location for Telemetry Waveforms will only be sent to the telemetry when
starting the combination monitoring mode with a non-admitted telemetry patient.

6. According to your location selection above:

a. If you selected Network: Select the print device from the Network Device list.

b. If you selected Remote: Choose the monitor or central station from the Unit
list, and then select the print device from the Remote Device list.

Checking the print status
You can view the assigned print locations for each type of printout and check the
printer status for each print device.

1. Select Monitor Setup > Printing.

2. Select the Devices tab > Status.

Printing waveforms

Printing waveforms for an arrhythmia alarm
NOTE Automatic printing of waveforms is always initiated by an

alarm.

1. Select Alarm Setup from the main menu.

2. Select the Arrhythmia tab.

3. Select Print on Alarm for the arrhythmias you would like to print.

For arrhythmia alarm waveform printing, the printing will continue until 20 seconds
has passed from the clearance of the last active arrhythmia alarm (e.g., 10 seconds
saved data, arrhythmia alarm duration + 20 seconds data).

Printing waveforms for other than arrhythmia alarms
The following are the default settings for other than arrhythmia alarm waveform
printouts:

● The print delay is 10 seconds.
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● The print duration is 30 seconds.

● The waveform speed is 25 mm/s.

Other than arrhythmia alarms that print are the high/low alarms for the following: HR,
Art/Fem/UAC sys/dia/mean, SpO2, and ST.

1. Select Monitor Setup > Printing.

2. Select theWaveforms tab.

3. Choose a value from the Print on Alarm list:

● No: No alarm waveforms print during an alarm condition.

● High: Alarm waveforms print during high priority alarm conditions only.

● All: Alarm waveforms print during any alarm condition.

Starting a waveform printout
1. Select one of the following options to start a waveform printout:.

a. Select Print Waveforms from the main screen.

b. Select Monitor Setup > Printing >Waveforms > Print Waveforms.

If print length has been configured for Continuous, you will be required to stop or
cancel the print request.

Stopping a waveform printout
1. Select one of the following options to stop printing a waveform:.

a. B850 only: Press the GRAPH STOP key on the PRN-50M+ recorder.

b. Select Stop Printing from the main screen.

c. Select Monitor Setup > Printing >Waveforms > Stop Printing or Cancel
Printing.

Setting the print delay
NOTE Alarm waveforms (arrhythmia and non-arrhythmia) start

by printing 10 seconds of the most recently saved data,
regardless of the Delay setting.

1. Select Monitor Setup > Printing.

2. Select theWaveforms tab.

3. Select a value from the Delay list:

a. 0 s: Manual waveform printing starts with real time data.

b. 10 s: Manual waveform printing starts with 10 seconds of the most recently
saved data first. After that, the real time data begins to print.

Setting the print duration
NOTE Non-arrhythmia alarms print 30 seconds of waveforms

regardless of the Print Length setting.
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NOTE An arrhythmia alarm waveform continues to print up to 20
seconds after the arrhythmia resolves or a new arrhythmia
has been identified. The length of the event shall determine
the length of the printout.

1. Select Monitor Setup > Printing.

2. Select theWaveforms tab.

3. Choose a time value from the Print Length list: 10 s, 30 s or Continuous.

NOTE If you select Continuous, waveforms continue to print
until you stop the printing.

Setting the print speed
NOTE Alarm waveforms will print at 25 mm/s regardless of the

Paper Speed setting.

To select the sweep speed for a laser printed report, or the actual paper speed of a
recorder:

1. Select Monitor Setup > Printing.

2. Select theWaveforms tab.

3. Select a time value from the Paper Speed list.

Selecting waveforms to print
1. Select Monitor Setup > Printing.

2. Select theWaveforms tab.

3. Choose the desired ECG lead/parameter for waveforms 1-4.

Printing trends and reports

Configuration of numeric trends for printing
The data printout type for numeric trends is selected throughMonitor Setup > Default
Setup > Care Unit Settings > Printer. This setting is password protected. You need
to configure the printer to print either currently viewed numeric trend data (Data on
Screen) or all numeric trend data (All Data) relating to the currently viewed page.

For mor information, see the supplemental information manual.

Automatic printing of events and snapshots
Event, snapshot and ST snapshot printouts can be printed automatically by an alarm.

Printing trends manually
Manual printing is possible only when the printing device is not processing another job
at the same time.

1. Select Trends.
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2. Select trend type from the View list: Graphic, Numeric, Event, Snapshot,Machine
Gas Cons., and ST-Snapshot.

3. Select desired Time Scale.

Time Scale is not selectable in the Numeric, Event, andMachine Gas Cons. views.
You can, however, select the Time Interval for printing the Numeric trends.

4. Select Print Page.

Printing and patient discharge
If allowed through Profile Settings > Print on Discharge, discharging a patient
generates the automatic printing of care reports (ICU, ED, and NICU software
packages), and cancels all other recording and laser printing. Print on Discharge
setting is password protected.

For more information, see the supplemental information manual.

Configuring a trend report
NOTE Before printing a report, ensure that you have selected the

proper settings.

1. Select Monitor Setup > Printing.

2. Select the Reports tab > Trends.

3. Select the desired print length.

4. Select the desired hour and minutes using the up and down arrows.

5. Select trend pages 1-4.

6. Select hours per page.

Printing a trend report
NOTE Before printing a report, ensure that you have selected the

proper settings.

1. Select Monitor Setup > Printing.

2. Select the Reports tab.

3. Select Trends > Print.

Printing individual reports
1. Select Monitor Setup > Printing.

2. Select the Reports tab > Individual Reports.

3. Select the report type you wish to print: QRS/ST, Loops, AEP, Calculation Trends,
and Patient Information.

Care report printouts
Care reports are predefined through Profile Settings > Care Report setup. These
settings are password protected.

You can print care reports that include graphic trends printouts, calculation trends
printouts, saved spirometry loops printouts, and/or AEP printouts.
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For more information, see the supplemental information manual.

Printing care reports manually
1. Select Monitor Setup > Printing.

2. Select the Reports tab.

3. Select Care Report > Print.

Automatic care report printouts
The automatic printing of care reports is possible only in the ICU, ED and NICU
software packages, and it is initiated when a patient is discharged. An automatically
initiated care report consists of a cover page and reports selected in the Profile
Settings > Care Reportmenu. The care report setup allows you to select the content,
duration, and resolution of the reports.

NOTE For details, see the supplemental information manual.

Printing calculations

Printing Hemo, Oxy, or Vent calculations
Before printing calculation printouts or calculation trends, you need to enter the
calculation values in the Edit Inputmenu and save them in the Viewmenu.

To print the currently viewed calculation page:

1. Select Data & Pages > Calculations.

2. Select Hemo, Oxy or Vent.

3. Select View > Print.

Printing Hemo, Oxy, or Vent calculation trends
To print all calculation trends in the currently selected calculations menu:

1. Select Data & Pages > Calculations.

2. Select Hemo, Oxy or Vent.

3. Select Trend > Print.

4. To stop printing, select Cancel Printing.

Printing drug calculations

Printing drug calculator
1. Select Data & Pages.

2. Select Drug Calculations.

3. Select Calculator > Print.
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Printing titration table
1. Select Data & Pages.

2. Select Drug Calculations.

3. Select Titration Table > Print.

Printing laboratory data and parameter
printouts

Printing laboratory data
The Laboratory Datamenu is accessible also through the Calculations > Hemo, Oxy
and Vent menus.

1. Select Data & Pages.

2. Select Laboratory Data.

3. Select View > Print.

Parameter printouts
You can print parameter printouts from the parameters' own menus. You can get
printouts of:
● ECG waveforms, 12SL reports, ST trends
● QRS/ST
● C.O. reports
● Spirometry loops
● EEG
● Catheter insertion waveforms, PA wedge waveforms, PA wedge reports

Print header information

Laser printer print header
You can print parameter printouts from the parameters' own menus. You can get
printouts of:
● Patient name (displayed if configured in the care unit default settings)
● Second ID
● Medical record number
● Bed number
● Unit name (if the monitor is on the MC Network)
● Hospital name
● Date and time of the printout
● Current page/total number of pages (e.g., 1/12)
● Printout title (e.g., alarm, waveforms, and reports)
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● Identification field for a patient identification sticker

● Notes field for manually written notes

Recorder print header
● Patient name

● Second ID

● Medical record number

● Bed number

● Unit name

● Date and time of the printout

● Printout title
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About viewing other monitored patients
When the monitor is on the network, you can open a bed-to-bed view of other remote
patient beds that are on the same network. You can choose to view a remote patient
bed under an alarm condition, or simply view any available bed on your network.

The numeric values, up to six waveforms, alarms, and location information are
displayed inside a separate bed-to-bed window. The bed-to-bed window is located on
the left side of the display screen.

Function Network features

View on alarm notification CARESCAPE Network: Monitor alarms for up to 40 beds.

View remote beds CARESCAPE Network: View one bed from up to 1023 beds.

NOTE When using the B650 or B450 with WLAN connection, the
maximum number of remote beds is ten.

Some settings related to remote alarm configuration are given through Care Unit
Settings > Alarms > Remote Alarms, and they are password protected:

● Enabling or disabling audio pausing remotely for another monitor (Allow Audio
Pause: For Remote Bed). Choices are Yes and No. CARESCAPE Network only.

● Selecting which remote locations are allowed to pause audio alarms on this
monitor (Allow Audio Pause: From Remote Location). Choices are Not Allowed,
Central, or Central and Remote Beds. CARESCAPE Network only.

● Selecting alarm priorities that can be paused remotely (Allow Remote Pausing of).
Choices are: Low Alarms, Low & Medium, or All Alarms.

● Display of the remote patient name (Show Remote Patient Name check box).

● Use of the alarm light for a remote alarm (Remote Alarm Light). Choices are On
or Off.

● Selecting the remote alarm tone (Remote Alarm Tone). Choices are Off, Single,
Repeat, or Local.

● Enabling or disabling the restoring of the remote bed selections after discharge
(select or deselect the Restore after Discharge check box for Remote Bed
Selections).

For more information, see the supplemental information manual.
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Automatic view of remote beds in alarm
Automatic viewing of remote alarms is a licensed feature.

You can set the monitor to automatically notify you with an alarm message or with a
bed-to-bed window when selected remote patient beds go into an alarm condition.
All automatically viewable alarming beds display in order from the highest to lowest
alarm priority and from the newest to oldest alarms.

You can configure how the monitor notifies you of a remote patient bed alarm
condition, and which remote patient alarm priority levels you want notification of. You
can do this for individual beds, or for all remote beds of a selected care unit at once.

Selecting the alarm notification type
1. Select Data & Pages.

2. Select Other Patients.

3. Select the Receive Alarms tab.

4. Select a care unit from the Unit list.

5. Select a patient bed from the displayed list.

6. Select the type of alarm notification desired from the Alarm Notification list:

● Off: Remote alarm notification is turned off.

NOTE All new monitors appear on the list automatically with
the notification setting Off (default).

● Message: Remote alarm messages display in the alarm area. At any time,
you can select a remote alarm message to open a bed-to-bed window and
view the remote patient’s data.

● Auto View: Bed-to-bed window opens immediately if no other procedure or
setup window is currently open. Otherwise, a remote alarm message displays
in the alarm message area. To open the bed-to-bed window and view the
remote patient’s data, close the currently open menu, or select the remote
alarm message.

● Auto View Always: Immediately closes any open procedure or setup windows
and opens a bed-to-bed window with the remote patient’s data.

Selecting the notifying alarm priority level
1. Select Data & Pages.

2. Select Other Patients.

3. Select the Receive Alarms tab.

4. Select a care unit from the Unit list.

5. Select a patient bed from the displayed list.
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6. Select which alarm priority levels you want notification of:

● High: Opens a bed-to-bed window for remote patients in a high alarm priority
condition.

● High, Med: Opens a bed-to-bed window for remote patients in a high or
medium alarm priority condition.

● High, Med, Low: Opens a bed-to-bed window for remote patients in a high,
medium, or low alarm priority condition.

Changing the settings for multiple beds
You can select a care unit and change all of the listed remote patient beds to a single
notification setting and/or a single alarm priority setting. If there are more than 40
beds in the unit, the settings will be changed for the first 40 beds only.

1. Select Data & Pages.

2. Select Other Patients.

3. Select the Receive Alarms tab.

4. Select a care unit from the Unit list.

5. Select a setting from the Change All Notifications list:

● Off: Remote alarm notification is turned off.

● Message: Remote alarm messages display in the alarm area.

● Auto View: Bed-to-bed window opens immediately if no other procedure or
setup window is currently open. Otherwise, a remote alarm message displays
in the alarm message area.

● Auto View Always: Immediately closes any open procedure or setup windows
and opens a bed-to-bed window.

6. Select a setting from the Change All Priorities list: High; High, Med; High, Med,
Low.

Next alarming remote bed to screen
If you have a bed-to-bed window open and another Auto View or Auto View Always
bed goes into alarm, the selection View Next Patient becomes selectable. It allows
you to open the bed-to-bed window to view the next highest and newest alarming
patient bed.

Viewing remote patient beds
You can select and view a networked alarming or non-alarming remote patient bed.

1. Select Data & Pages.

2. Select Other Patients.

3. Select the View Patients tab.

4. Select a care unit from the Unit list.

A list of remote patient beds is displayed for the selected care unit.
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5. You can select to see a list of all patient beds in the care unit or a list of remote
patient beds configured for alarm notification. Select an option from the Show list:

● To show a list of all the remote beds in the care unit, select All Patients.

● To show the list of remote patients configured for alarm notification, select
Notification Patients Only.

6. Select a patient bed from the displayed list.

7. Select View.

8. You can stop viewing the selected patient bed and close the bed-to-bed window
by selecting Close View.

NOTE Selecting the home key will not close any open bed-to-bed
view of an alarming or non-alarming patient bed.

Audio pause for a remote patient bed alarms
NOTE This feature is available with the CARESCAPE Network only.

You can pause active alarms for the remote bed viewed by selecting Remote from
the bed-to-bed window. If the selection is not selectable, this option has not been
enabled during configuration. It is enabled in the Care Unit Settings and it is password
protected. In addition, the remote monitor’s settings may prevent remote silencing
from taking place.

Manual printing of remote bed waveforms
NOTE CARESCAPE Network only.

Waveform data of a remote monitor can be manually printed by selecting Print
from the bed-to-bed window. With the B850, waveforms are printed using the
local PRN-50M+ recorder if available, otherwise the printer is determined by the
remote monitor’s print configuration. The waveforms that appear on the printout are
determined by the remote monitor’s print configuration.
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Interfacing safety precautions

Interfacing warnings
WARNING SINGLE PATIENT USE. All eight serial ports of the Unity Network

Interface Device (ID) must only be used on one patient.

WARNING INTERFACING OTHER EQUIPMENT. Connect only items that are
specified as part of the system and as compatible. For more
information, see the supplemental information manual.

WARNING If a ventilator and a gas acquisition module are connected
to the same monitor, the monitor issues some respiratory
alarms based on the module alarm limits and not those of
the ventilator. Make sure that the alarm limits on the module
are set to match the patient’s ventilation requirements to
avoid delayed or suppressed ventilator alarm annunciation at
the central station and to ensure timely clinical response to
important changes in the patient’s condition or the ventilator’s
status.

Interfacing cautions
CAUTION Always verify the compatibility of the software versions before

use; refer to the Unity Network Interface Device (ID) Operator’s
Manual.

CAUTION INSTALLATION. To avoid accidental ingress of liquids, always
mount the Unity Network Interface Device (ID in a vertical
position with the connectors at the bottom.

CAUTION INSTALLATION. Qualified technical personnel must connect
the interface adapter to the peripheral device and make any
necessary adjustments to the peripheral device (baud rate,
parity, etc.) as described in the specific installation instructions
for the interface adapter. Insert cabling from the connectivity
device only into specified interface adapters and specified
peripheral devices. To avoid inadvertent disconnection, route
all cables in a way to prevent a stumbling hazard. Wrap and
secure excess cabling to reduce risk of entanglement by
patients and personnel. Do not install in a location where the
device may drop on a person.
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CAUTION The use of the wrong interface adapter may cause improper
operation of the supported peripheral device.

CAUTION TREATMENT. Do not treat the patient based solely on the
alarm messages and/or numerics presented via the Unity
Network Interface Device (ID). You must verify the accuracy of
the alarm message and/or numerics at the peripheral device
itself before initiating treatment, treatment should be based
on the information presented at the peripheral device.

Compatible peripheral devices
For a list of compatible peripheral devices, see the Unity Network Interface Device
(ID) Operator’s Manual.

Unity Network Interface Device (ID)

Software compatibility
For software compatibility information, see the Unity Network Interface Device (ID)
manuals.

About the Unity Network Interface Device (ID)

The monitor can interface with peripheral medical devices, such as ventilators and gas
delivery systems, to centralize patient data on one device. A Unity Network Interface
Device (ID) is used with the monitor to communicate with peripheral devices. It
acquires digital data from eight individually isolated serial ports. The data is collected
from up to eight peripheral devices (not necessarily manufactured by GE), and then
the interface device transmits the formatted data to the monitor.

The monitor can only display information that the peripheral device sends. The
parameters sent vary with each peripheral device and are subject to change. It is also
important to note that alarms vary according to the primary interfaced device.

In some cases, the peripheral device may impose alarm control parameters that you
may not be able to change or silence with the monitor’s controls.

Unity Network Interface Device (ID) interconnection
The Unity Network Interface Device (ID) connects to the monitor via one of the M-port
connectors on the front of the processing unit (B850), or via the Ethernet port labeled
ID on the back of the monitor (B650, B450).
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A factory-programmed adapter is required for each peripheral device to communicate
with the connectivity device. Refer to the instructions provided with the interface
adapter for adapter setup and installation instructions.

1. Interface adapters

Once the interface adapter is permanently connected to the peripheral device, the
cable can be plugged into any one of the eight serial ports on the Unity Network
Interface Device (ID).

CAUTION The use of the wrong interface adapter may cause improper
operation of the supported peripheral device.

Unity Network Interface Device (ID) serial port indicator
lights

Each serial port on the connectivity device has an indicator light located directly
above it. The light indicates the status of the serial port.

1. Indicator lights

2. Serial ports
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Green indicator Yellow indicator Serial port status Description

Off Off No connection Nothing is connected to the
associated serial port or the
interface connector is not
operational.

Off On Communication pending Cable and interface adapter are
connected, but the supported
device communication is not yet
established.

Off Slow blinking
(once every 2
seconds)

Communication error Connected, but communications
error with supported device.

Off Fast blinking
(twice every
second)

Other errors Indicates:

● Too many supported devices
of one type are connected.

● Interface adapter is
malfunctioning.

● Supported device software
is not compatible with the
monitor software.

● Interface adapter is not
supported by the monitor
software.

.

On Off Working Communication with the
supported device is good.

Peripheral device limit alarms
The limit alarms are not adjustable when the measurement source is from an external
device connected to the Unity Network Interface Device (ID). Limit alarms can be
turned on or off only.

Alarm limits or absolute alarm limits set for any parameter have no effect as only the
limit alarms from the interfaced device are shown. In addition, they are shown only for
those parameters that have their Alarm On activated.

It should also be noted that if a ventilator and a gas acquisition module are
simultaneously connected to the monitor, the monitor will use the module’s alarm
limits and not those of the ventilator. In addition, the monitor uses the measurement
data of the connected modules as the basis for its alarms.

Peripheral device parameter data
The data from a peripheral device that is displayed at the monitor varies with each
device. The chart below gives some general information as to what data is available
to the monitoring system and how it is handled (trending, alarm broadcast, etc.).
See the Unity Network Interface Device (ID) operator and service manuals for more
detailed information regarding waveforms and alarms.
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Device type Waveforms 1 Parameter
windows

Trends Alarm
broadcast

Printouts Real-time data
to central
station2

Pulse
oximeters

No Yes Yes Yes Yes No

Transcuta-
neous moni-
tors

No Yes Yes Yes Yes No

Ventilators Yes Yes Yes Yes Yes Limited

Gas analyzers No Yes Yes Yes Yes Yes

Continuous
cardiac output

No Yes Yes Yes Yes No

Anesthesia
machines

Yes Yes Yes Yes Yes Limited

POC blood gas
monitors

No No3 Yes No No No

1 Unity Network Interface Device (ID) supports only digital waveforms.
2 CIC Pro version 4.0.7 and subsequent. CARESCAPE Central Station software version 1.0 and subsequent.
3 POC blood gas monitor data is displayed in Data & Pages > Laboratory Data.

Peripheral device data presentation and menus
The data displayed in the parameter window may vary with each device. Not all
menu options are available with all devices, and some menu options are not available
with interfaced devices at all. Ventilators, gas analyzers, continuous cardiac output
devices, and anesthesia machines are capable of sending a number of parameters
to the monitor. In some cases, not all are supported, or the monitor’s software
package may determine the set of parameters. See the Unity Network Interface
Device (ID) Operator’s Manual and the peripheral device manufacturer’s manuals for
more information.

● Pulse oximeters

￭ The SpO2 parameter window displays a saturation value and a pulse rate.
The Ext indicates the data is from an external source. There is no associated
waveform or parameter menu. Only one SpO2 measurement from an external
source can be actively displayed on the monitor.

● SvO2

￭ The SvO2 parameter window displays SvO2 index data and a signal quality
indicator (None, *, **, ***). For reliable saturation values, the signal strength
indicator should be higher than one asterisk. The measurement range of SvO2 is
from 0 to 100%. The Ext indicates the data is from an external source.

● Transcutaneous pO2/pCO2

￭ The TC parameter window displays a pCO2 value, pO2 value, site temperature
value, and probe power value. The Ext indicates the data is from an external
source. There is no associated waveform. Only one TC measurement from an
external source can be connected and active simultaneously.

● Spirometry data from ventilators and anesthesia machines
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￭ The monitor displays Ppeak, Pplat, Pmean, PEEPtot, PEEPi, PEEP, TVexp, TVinsp,
MVexp, MVspont, Compl, Raw, I:E ratio, and static Compl measurement data.

￭ If there is a compact airway module measuring spirometry in the monitor, it is
used as the measurement source instead of the interfaced device.

● Gas data from ventilator, anesthesia machines, and gas analyzers

￭ The monitor displays CO2, Resp Rate, O2, N2O, Halothane, Desflurane, Enflurane,
Isoflurane and Desflurane measurement data.

￭ If there is a compact airway module in the monitor, it is used as the
measurement source instead of the interfaced device.

● Laboratory data

￭ The monitor provides Laboratory Data > View and Enter Datamenus.

● Continuous cardiac output

￭ The interfaced continuous cardiac output measurement provides C.O., blood
temperature, CCO, SVV, GEDI, ELWI and SVR measurements depending on
the interfaced device. The Ext indicates the data is from an external source.
The following conditions apply with the interfaced continuous cardiac output
measurement:

♦ The C.I. value for interfaced device is computed using the following equation
C.I. = C.O. / BSA.

♦ The C.I. value for interfaced device is invalid if BSA from the monitor is not
available.

♦ The CCI value for interfaced device is computed using the following equation
CCI = CCO / BSA.

♦ The CCI value for interfaced device is invalid if BSA from the monitor is not
available.

♦ The SVR value for the interfaced device shall be computed using the
following equation SVR = ((MAP - CVP) / CCO) * 79.92.

♦ The SVR value for the interfaced device shall be invalid if MAP, CVP or CCO
from the monitor are not available.

♦ The SVRI value for interfaced device shall be computed using the following
equation SVRI = ((MAP - CVP) / CCI) * 79.92.

♦ The SVRI value for the interfaced device shall be invalid if MAP, CVP or CCI
from the monitor are not available.

♦ Tblood value is displayed. The Tblood - T1 temperature alarm limit is
adjustable.

● Ventilator/anesthesia machine settings and technical alarms

￭ The settings are displayed in numeric trends.

￭ Technical alarms and settings are displayed and trended even when there is a
gas module connected to the monitor.
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Cleaning and care safety precautions

Cleaning and care warnings
WARNING Before cleaning or disinfecting, disconnect the monitor from

the power supply.

WARNING Regular preventive maintenance should be carried out
annually unless otherwise indicated in the device service
manual. Failure to implement the recommendedmaintenance
schedule may cause equipment failure and possible health
hazards.

WARNING The user may only perform maintenance procedures
specifically described in this manual.

WARNING Non-medical equipment does not provide the same level of
protection against electrical shock. Do not touch the patient
and any part of non-medical equipment at the same time.
Some examples of non-medical equipment are laser printers
and non-medical computers.

WARNING Avoid use of cleaners, materials or chemicals that may
damage device surfaces, labels, or cause equipment failures.

WARNING To prevent liquids from entering the display casing, do not tilt
the display more than +/-15 degrees.

WARNING B650, B450: To prevent liquids from entering the monitor, do
not tilt the monitor more than +/-15 degrees. If the monitor
is used as a stationary bedside monitor with CARESCAPE
respiratory modules or PDM, do not tilt it at all.

WARNING ELECTRIC SHOCK. If liquid has accidentally entered the system
or its parts, disconnect the power cord from the power
supply and have the equipment serviced by qualified service
personnel.

WARNING Use only washable keyboard with at least IPX1 protection
against ingress of water.
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WARNING Cleanup and disposal of broken display monitors must be
in compliance with the safety and waste control guidelines
regulating this product.

WARNING Never immerse any part of the device, cables, or leadwires in
liquids or allow liquid to enter the interior of the device.

WARNING Do not autoclave any part of the system with steam (including
cables or leadwires) or sterilize with ethylene oxide, unless
specifically allowed for that part or accessory.

WARNING Do not pour or spray any liquid directly on cables or leadwires
or permit fluid to seep into connections or openings.

WARNING Never use conductive solutions, solutions that contain
chlorides, wax, or wax compounds to clean devices, cables
or leadwires.

WARNING Since calibration gas contains anesthetic agents, always
ensure sufficient ventilation of the room during calibration.

Cleaning and care cautions
CAUTION Do not apply pressurized air or gas to any outlet or tubing

connected to the monitor. Pressure may destroy sensitive
elements.

CAUTION Do not use or store equipment outside the specified
temperature, humidity, or altitude ranges.

Disposal safety precautions

Disposal warnings
WARNING EXPLOSION HAZARD. Do not incinerate a battery or store at

high temperatures. Serious injury or death could result.

Disposal cautions
CAUTION DISPOSAL. At the end of its service life, the product described

in this manual, as well as its accessories, must be disposed of
in compliance with the guidelines regulating the disposal of
each product. If you have any questions concerning disposal
of a product, please contact GE or its representatives.

CAUTION PACKAGING DISPOSAL. Dispose of the packaging material,
observing the applicable waste control regulations.

Cleaning and care schedules
See the service manuals for more comprehensive checks.

For details about cleaning, disinfecting and sterilizing the accessories, see the
instructions for use in the accessory package.
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Follow your hospital guidelines for cleaning and disinfection cycles and other related
practices as applicable to GE devices. GE devices must be cleaned and disinfected
within the environmental parameters indicated in the device-specific operating
temperature, pressure, and humidity specifications.

Do not reuse single-use disposable accessories.

Daily checks
● Check that the accessories, cables, cable connectors, monitor, modules, and

display parts are clean and intact.
● B650, B450: Check the charge of the monitor battery. (Battery is optional in B650.)

Monthly checks
● Check the gas exchange calibration.

Check every two months
● Change the water trap.
● Check the airway gases calibration if the measurement is in continuous use.

Check every six months
● Check the airway gases calibration if the measurement is used several hours a day

on most days each week (not continuous use).

Once a year checks
● Check the calibration of temperature, NIBP and invasive blood pressure.

NOTE The invasive blood pressure transducers should be
calibrated whenever a transducer error occurs.

● Check the spirometry flow calibration.

Regular calibration checks
The following parameters require calibration checks at regular intervals, in addition
to the calibration performed while monitoring patients.

● Airway gases
￭ To ensure that the measurement accuracy remains within specifications, follow

the recommended calibration check intervals: every six months when used
several hours a day on most days each week, and every two months in more
continuous use.

● Spirometry
￭ If the difference between the inspiratory and expiratory volumes is permanent,

a flow calibration is required. For calibration instructions, see the Module
Frames and Modules Service Manual.

● Gas exchange
￭ The recommended gas exchange calibration interval is once a month to ensure

that the measurement accuracy remains within specifications. For calibration
instructions, see the Module Frames and Modules Service Manual.

● Temperature, NIBP, and invasive pressures
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￭ A calibration check of temperature, NIBP and invasive blood pressures should
be performed at least once a year to ensure that the measurement accuracy
remains within specifications. For calibration instructions, see the Module
Frames and Modules Service Manual.

Cleaning and care points to note
● Do not let liquid pool around connection pins. If this should happen, blot dry with a

soft, lint-free cloth.
● Do not use excessive drying techniques, such as oven, forced heat, or sun drying.
● Do not spray cleaner directly on the display screen.
● Never connect any device or applied part to a patient until it is thoroughly dry.

Permitted detergents
● Water.
● Mild soap.

Permitted disinfectants
● Ethanol (max. 99.7% by volume), excluding B850 CPU and USB remote surfaces.
● Ethanol (max. 70% by volume) for B850 CPU and USB remote surfaces.
● Isopropyl alcohol (max. 60% by weight).
● Chloramine (max. 5% by volume).
● Glutaraldehyde (max. 2% by volume).
● Phenol (max. 2% by volume).
● Tartaric acid (75 mg per 100 ml solution).
● Sodium hypochlorite (max. 5.25% by volume mixed with H2O in ratio of 1:10). Do

not use this disinfectant for touch screen panels.

Cleaning and care instructions

Setting the touchscreen off for cleaning
You can set the touchscreen feature off for 30 seconds at a time when you need to
clean the screen. The countdown timer appears on the screen.

1. Select Monitor Setup.

2. Select Touchscreen Off.

3. You can enable the touchscreen immediately by pressing any monitor hardkey or
the Trim Knob, or by selecting Touchscreen Off > Cancel.

Cleaning non-applied parts, general instructions
Follow these instructions to clean the monitor, modules, display screen surfaces,
EEG headbox, and other non-applied parts unless there are separate part-specific
instructions.

1. Turn off the power to the equipment.

2. Disconnect the equipment from the power supply.
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3. Remove all cables and batteries (if applicable) and close battery door(s).

4. Dampen a soft lint-free cloth with one of the permitted detergents or disinfectants.

5. Wring excess liquid from the cloth and wipe the exterior surface.

Any contact of disinfectant solutions with metal parts may cause corrosion.

Do not damage or bend connector pins when cleaning or drying.

6. Allow solution to remain on device for a minimum of one minute or per hospital
guidelines.

Do not let fluid pool around connection pins. If this happens, blot dry with a cotton
swab or soft cloth.

7. Wipe off the cleaning solutions with a clean, lightly moistened cloth.

8. Dry thoroughly with a dry, lint-free cloth and let air dry for at least 30 minutes.

Drying times may vary based on the environmental conditions.

9. Insert batteries (if applicable) and close battery doors.

10. Reconnect the equipment to the power supply.

11. Turn on the power to the equipment.

Barcode reader cleaning instructions
Do not submerge the barcode reader in water. Do not use abrasive wipes or tissues
on the barcode reader’s window – abrasive wipes may scratch the window. Never
use solvents (e.g., acetone, benzene, ether, or phenol-based agents) on the housing or
window as solvents may damage the finish or the window.

Reading performance may degrade if the reader’s window is not clean. If the window
is visibly dirty, or if the reader isn’t operating well, clean the window with a soft cloth or
lens tissue dampened with water (or a mild detergent- water solution). If a detergent
solution is used, rinse with a clean lens tissue dampened with water only.

The reader’s housing may also be cleaned the same way.

Keyboard and mouse cleaning instructions
Refer to the user documentation provided with the keyboard and mouse for
instructions on how to clean them. Always consider your hospital guidelines as well.

Cleaning applied parts, general instructions
Follow these instructions to clean applied parts unless there are separate part-specific
instructions. Always refer to the accessories’ own instructions for use for detailed
information.

Cables and leadwires can be cleaned with a warm, damp cloth and mild soap. Consult
manufacturer instructions for recommended cleaning methods and products.

For other applied parts such as temperature sensors, catheters, pulse oximetry
probes, and other reusable accessory parts, consult the manufacturer instructions for
cleaning, sterilization, or disinfecting methods.

To clean ECG trunk cables, NIBP cuff and cables, reusable sensors:

1. Remove cables and leadwires from the handheld device or system before cleaning.
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2. Use care in cleaning leadwires to prevent pulling the long wires from the
connector ends. Metal connections can be pulled away from the connectors.

3. For general cleaning of cables and leadwires, wipe using a lightly moistened cloth
with a mild soap and water solution.

4. For disinfecting the cables and leadwires, wipe exterior with a soft lint-free cloth,
using a chemical disinfectant. Refer to the cables’ and leadwires’ own instructions
for use for detailed information regarding allowed substances.

Wring excess disinfectant from wipe before using.

Any contact of disinfectant solutions with metal parts may cause corrosion.

Do not immerse either end of a cable or leadwire connector. Immersing or soaking
the connector ends may corrode metal contact ends and affect signal quality.

5. Wipe off cleaning solutions with a clean, lightly moistened cloth.

6. Dry thoroughly with a dry, lint-free cloth and let air dry for at least 30 minutes.

Drying times may vary based on the environmental conditions. Do not apply heat.

Reusable D-lite and Pedi-lite sensor cleaning instructions
Reusable D-lite and Pedi-lite sensors can be washed, disinfected, or steam autoclaved.
Make sure that the sensor is dry and the connectors are not damaged. A tight
connection is essential for correct measurement.

Water trap care instructions
● In anesthesia: Replace the D-fend Pro or Mini D-fend water trap when the message

Replace Water Trap appears. The maximum lifetime of a water trap is two months.
● In critical care: It is recommended to replace the D-fend Pro+ or Mini D-fend water

trap for each new patient, when the message Replace Water Trap appears, or
every 24 hours.

● Attach the water trap by pushing it firmly to its place, so that the locking latch
makes a clicking sound.

● Remove the water trap by pressing the release latch and pulling the water trap out.
● Empty the container whenever it is more than half full by disconnecting it from the

water trap cartridge. Do not use a syringe.
● The water trap cartridge is disposable. Do not dry, wash, or reuse an exhausted

or occluded water trap.
● When taking a new water trap into use, mark the date on the appropriate label on

the water trap cartridge:
● Read the water trap instructions for use in the accessory package.

How to store PDM and PSM
● Remove PDM batteries when the device is not in use, even for short periods of time.
● Store in a dry well-ventilated area.
● Hang the device using a holder if available.
● If leadwires or cables are attached, hang them straight.
● Do not coil leadwires or cables tightly around the device.
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Monitor battery care

Replacing the monitor battery

B650 and B450 only.

WARNING The B450 must always be used with a battery inserted. This
will ensure the functioning of the monitor and prevent data
loss during possible supply mains interruptions.

WARNING EXPLOSION OR FIRE. Using non-recommended batteries
could result in injury/burns to the patients or users. Only use
batteries recommended or manufactured by GE. The warranty
can be voided if non-recommended batteries are used.

WARNING PHYSICAL INJURY. Make sure the battery is completely
inserted and the battery door is completely closed. Falling
batteries could seriously or fatally injure neonatal or other
vulnerable patients.

1. B650: Open the battery slot by gently turning the lock counter-clockwise. B450:
Open the battery cover by pressing the battery cover release latch down and
pulling the battery door open.

2. Pull the battery out using the battery strap.

3. Insert a new battery all the way with the test button facing up.

4. B650: Close the battery slot by turning the lock clockwise. B450: Close the battery
door carefully.

Battery recycling
WARNING EXPLOSION HAZARD. Do not incinerate a battery or store at

high temperatures. Serious injury or death could result.

This product contains Lithium-Ion batteries. At the end of their service life, batteries
in this product must be recycled or disposed in accordance with local or national
regulations. Do not dispose of batteries as trash or unsorted municipal waste.
Requirements and services for recycling of batteries vary between countries.

● USA: You may follow the battery manufacturers instructions on the battery
to recycle it. Alternatively, you may return GE product batteries to GE for
recycling. For information about returning batteries to GE, contact your authorized
GE Service representative or contact GE Equipment Services at 1-800-437-1171.

● Canada: Contact the approved battery stewardship program in your province for
information on recycling your batteries.
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● Other countries: Recycle batteries through your local, regional or national collective
scheme in accordance with your local or national regulations.

PDM battery care
The PDM uses one rechargeable lithium-ion battery. For more information, see the
service manual.

About PDM battery charging
B850: The PDM battery is charged whenever the PDM, with its battery installed, is
connected to a monitor that is connected to an AC-derived power source. The battery
capacity gauge (labeled with text PDM) indicates the battery’s charge level.

B650 and B450: The PDM battery is normally charged whenever the PDM, with its
battery installed, is connected to the monitor unless the monitor battery is being
charged or printing to a recorder is active.

You can also charge PDM on an external charger. Refer to the charger’s instructions
for use.

Replacing the PDM battery
WARNING EXPLOSION OR FIRE. Using non-recommended batteries

could result in injury/burns to the patients or users. Only use
batteries recommended or manufactured by GE. The warranty
can be voided if non-recommended batteries are used.

WARNING PHYSICAL INJURY. Do not install the PDM above a patient.
Make sure the battery is completely inserted and the battery
door is completely closed. Falling batteries could seriously or
fatally injure neonatal or other vulnerable patients.

WARNING PHYSICAL INJURY Do not install the PDM above a patient.
Leaks from the battery cells can occur under extreme
conditions. The liquid is caustic to the eyes and skin. If the
liquid comes in contact with eyes or skin, flush with clean
water and seek medical attention.

1. Open the battery door by gently pulling on the battery door pull tab.

2. Pull the battery tray out of the PDM using the battery tray strap and remove the
battery from the battery tray.

3. Insert the new battery with the test button facing up and the arrow pointing into
the PDM.

4. Press the battery door closed until it seals the battery compartment.

5. Connect the PDM to the monitor.

6. Confirm the PDM battery capacity gauge displays on the monitor.

Battery recycling
WARNING EXPLOSION HAZARD. Do not incinerate a battery or store at

high temperatures. Serious injury or death could result.
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This product contains Lithium-Ion batteries. At the end of their service life, batteries
in this product must be recycled or disposed in accordance with local or national
regulations. Do not dispose of batteries as trash or unsorted municipal waste.
Requirements and services for recycling of batteries vary between countries.

● USA: You may follow the battery manufacturers instructions on the battery
to recycle it. Alternatively, you may return GE product batteries to GE for
recycling. For information about returning batteries to GE, contact your authorized
GE Service representative or contact GE Equipment Services at 1-800-437-1171.

● Canada: Contact the approved battery stewardship program in your province for
information on recycling your batteries.

● Other countries: Recycle batteries through your local, regional or national collective
scheme in accordance with your local or national regulations.

About the internal lithium battery
The monitor contains a lithium battery. This battery retains the correct time and date
on the monitor.

If the lithium battery charge becomes low during normal operation, the message
Service Monitor Error Code 0xHOST1100 appears near the middle of the screen. If
this happens, contact authorized service personnel.
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Messages related to ECG measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● report = report view

● wavef. = waveform area

Message Location Explanation What to do

● 12 diagnostic leads
needed

● report Some of the ECG leads are
disconnected.

● Check that all ECG leads are
connected to the patient.

● ACI-TIPI on - age less
than 16

● report The setting is ON but the patient
is under 16 years old.

● Set the ACI-TIPI to off to
create 12SL reports.

● Adjust the patient age on the
monitor if it is not correct.

● ACI-TIPI on - chest
or left arm pain not
entered

● report The setting is ON but chest or
left arm pain information has
not been entered.

● Set the ACI-TIPI to off.

● Enter chest or left arm pain
information.

● A Fib ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Accel. Ventric. ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Arrh off ● param. The arrhythmia detection level
is set to Off.

● If arrhythmia detection is
needed, set the detection
level to Full or Lethal.
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Message Location Explanation What to do

● Arrhythmia paused

● Arrh paused

● al. area

● wavef.

ECG channels have not been
available for analysis for the
last 20 seconds or the internal
HR calculation has not been
updated for the last 30 seconds
due to excessive artifact.

● Check the patient status.

● Check electrode placement.

● Prepare the patient’s skin at
electrode sites.

● Change or move electrodes.

● Artifact ● wavef. Muscle artifact or high or low
frequency noise.

● Check electrode contact.

● Check lead placement.

● Perform skin preparation.

● Reposition/replace
electrodes.

● Request the patient to remain
still.

● Asystole ● al. area,
param.,
wavef.

Physiological alarm. ● Check the patient status.

● Bigeminy ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Brady ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Cable off ● report ECG cable is off. ● Connect the cable.

● Change telemetry
battery

● al. area The telemetry transmitter’s
battery has little charge left.

● Change the battery.

● Duplicate TTX ● al. area Multiple patients have been
admitted using the same TTX
number.

● Contact qualified service
personnel.

● ECG error ● al. area The module has a
communication error.

● Check the module.

● Replace the module if
necessary.

● ECG measurements
removed

● al. area Acquisition module has lost ECG
communication.

● Remove the module and then
reconnect it.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● Failure connecting to
transmitter

● al.area Connection to the telemetry
transmitter could not be
established.

● Retry connecting.

● If the problem persists,
contact qualified service
personnel.

● Frequent PVCs ● al. area Physiological alarm. ● Check the patient status.

● Frequent SVCs ● al. area,
wavef.

Physiological alarm. ● Check the patient status.
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Message Location Explanation What to do

● Gender is not defined ● report ACI-TIPI has been selected on,
but the patient’s gender has not
been entered.

● Enter the patient’s gender.

● HR(ECG) high /
HR(ECG) low

● al. area Measurement values are equal
to or outside the basic or critical
alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● HR high / HR low ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Irregular ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● LA/L lead off

● LL/F lead off

● RA/R lead off

● RL/N lead off

● wavef. An electrode is disconnected. ● Check the electrodes.

● Lead changed ● wavef. The monitor automatically
switches the ECG1 waveform
selection to a measurable ECG
Lead (I, II, III, aVR, aVL, aVF,
V1, V2, V3, V4, V5 or V6) if the
current ECG1 waveform is not
measurable.

● Note that the ECG waveform
changes according to the
lead it is measured from.
Check the lead.

● Leads off ● al. area,
wavef.

One or more of the connected
electrodes is disconnected and
arrhythmia detection is not
possible.

● ECG: Check the connections.

● Learning ● wavef. ST algorithm is in learning phase,
message shown e.g. when ECG
measurement is started.

● No action required.

● Missing beat ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Multifocal PVCs ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● No 10 or 6 lead cable ● report No 6- or 10-lead ECG cable is
attached.

● Connect a 6- or 10-lead cable.

● No 12RL license ● report No 12RLTM 12 lead ECG license. ● Contact your GE
representative to purchase
this feature.

● No 12SL license ● report No 12SL ECG with ACI-TIPI
license.

● Contact your GE
representative to purchase
this feature.
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Message Location Explanation What to do

● No telemetry ● al. area The server cannot communicate
with the telemetry transmitter.

● Make sure the transmitter is
not out of range.

● Check the telemetry
transmitter’s battery.

● Wait to see if the problem
resolves. If the problem
persists, contact authorized
service personnel.

● Noise ● wavef. Arrhythmia alarm category has
been set to Off in the ECG, and
the ECG channels have not been
available for analysis for the
last 20 seconds or the internal
HR calculation has not been
updated for the last 30 seconds
due to excessive noise which
compromises the accuracy of
detecting events.

● Remove the source of
excessive noise if possible.

● Noisy ECG ● al. area Arrhythmia alarm category has
been set to Off through ECG >
Arrhythmia > Lethal Alarms,
and the ECG channels have
not been available for analysis
for the last 20 seconds or the
internal HR calculation has
not been updated for the last
30 seconds due to excessive
noise which compromises the
accuracy of detecting events.

● Check and remove sources of
excessive noise.

● Pause ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Please wait -
collecting waveform

● report There is not enough ECG sample
data to run the algorithm.

● Wait for about 10 seconds.

● QT high ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● QTc high ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● R on T ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Remove one ECG
module

● al. area There are two ECG modules in
the system.

● Remove one ECG module.

● Single PVC ● al. area,
wavef.

Physiological alarm. ● Check the patient status.
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Message Location Explanation What to do

● ST Ant high / ST Ant
low

● ST Inf high / ST Inf low

● ST Lat high / ST Lat
low

● al. area,
param.

Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● ST XXX high / ST XXX
low

where XXX = ECG lead
label

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● SV Tachy ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Telemetry patient: No
12SL available

● param. 12SL is not available with
telemetry.

● If 12SL is required, use
a module that is directly
connected to the monitor
instead of a telemetry
transmitter.

● Tachy ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● Telemetry battery
empty

● al. area The telemetry transmitter’s
battery has no charge left.

● Change the battery.

● Trigeminy ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● TTX Off Network ● al. area No parameter or waveform
data has been received from the
telemetry transmitter for more
than 5 seconds.

● Wait to see if the condition
resolves. If the problem
persists, contact authorized
service personnel.

● V Brady ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

● V Fib/V Tach ● al. area,
param.,
wavef.

Physiological alarm. ● Check the patient status.

● V lead A is not V1 or V
lead B is not V5

● report Va lead is not V1 and/or Vb lead
is not V5.

● Check the settings and
correct if necessary.

● V leads off ● report All V leads are off. ● Connect the V leads to the
patient.

● V Tach

● VT off

● al. area,
param.,
wavef.

● param.
(NICU
only)

Physiological alarm. ● Check the patient status.
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Message Location Explanation What to do

● V2/C2 lead off

● V3/C3 lead off

● V4/C4 lead off

● V5/C5 lead off

● V6/C6 lead off

● V/C lead off

● Va/Ca lead off

● Vb/Cb lead off

● wavef. An electrode is disconnected. ● Check the electrodes.

● VT>2 ● al. area,
wavef.

Physiological alarm. ● Check the patient status.

Messages related to impedance respiration
measurement

For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area

Message Location Explanation What to do

● Apnea (Imped) ● al. area,
wavef.

No breathing detected. ● Check the patient status.

● Check the ventilator and
breathing status.

● Apnea deactivated ● param. The case has just been
started/patient admitted on the
monitor, or the measurement
has just been started.

● Wait. The message
disappears after the monitor
detects 3 breaths (E-modules)
or the respiration rate is ≥3
(PDM).

● Artifact ● param.,
wavef.

Cardiac artifact has been
detected.

● Check the patient status.

● Select alternate leads to
monitor.

● Increase sensitivity settings.

● Select alternate lead
placement.

● Relearn respiration.

434 CARESCAPE Monitors B850, B650, B450 2105822-001



Messages

Message Location Explanation What to do

● Cardiac artifact ● al. area Cardiac artifact has been
detected.

● Check the patient status.

● Select alternate leads to
monitor.

● Increase sensitivity settings.

● Select alternate lead
placement.

● Relearn respiration.

● LA/L lead off

● Lead I failed

● Lead II failed

● Lead RL-LL failed

● LL/F lead off

● RA/R lead off

● param.,
wavef.

One of the electrodes is off. ● Check the electrodes and
their connections.

● Measurement off ● param.,
wavef.

ECG leads not connected to the
patient.

● Connect the ECG leads to
the patient to start the
impedance respiration
measurement.

● Relearning ● param.,
wavef.

The patient’s breathing pattern
is being relearned or a lead has
been changed.

● Wait until the message
disappears.

● Remove one ECG
module

● al. area There are two ECG modules in
the system.

● Remove one ECG module.

● RR (Imped) High / RR
(Imped) Low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Small resp curve ● param. Signal amplitude < 0.4 ohm. ● Check the patient status.

● Check electrode placement.

● Change or move electrodes.

Messages related to SpO2measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● Artifact ● param. Artifact detected. ● Check sensor contact.

● Reposition/replace sensor.

● Request the patient to remain
still.

● Check device ● param. The acquisition module has
failed.

● Replace the acquisition
module.

● Check Ext device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Check probe ● param. There is no detectable SpO2
signal, the sensor is faulty or
detached from the patient.
The pulse cannot be found for at
least 20 seconds at a time.
E-NSATX, PDM Nellcor: There is
a detectable SpO2 signal, but it
is continuously too weak for at
least 20 seconds at a time.

● Check the sensor and
connections.

● Check SpO2 probe /
Check SpO2(2) probe

● al. area There is no detectable SpO2
signal, the sensor is faulty or
detached from the patient.
The pulse cannot be found for
20 seconds or more.
E-NSATX, PDM Nellcor: There is
a detectable SpO2 signal, but
it is continuously too weak for
at least 20 seconds (low signal
quality).

● Check the sensor and
connections.

● Connecting ● param. Connection to the interfaced
device is being established.

● No action required.

● Faulty probe ● param. The sensor has failed. ● Replace the sensor.

● Identical SpO2
modules

● al. area There are two or more identical
SpO2 modules in the system.

● Remove all but one SpO2
module.

● Incompatible probe ● param. The sensor is not compatible. ● Replace the sensor. See the
supplemental information
manual.

● If the problem persists,
contact qualified service
personnel.

● Incompatible SpO2
probe / Incompatible
SpO2(2) probe

● al. area The sensor is not compatible. ● Replace the sensor. See the
supplemental information
manual.

● If the problem persists,
contact qualified service
personnel.
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Message Location Explanation What to do

● Interference ● param. The measurement is disturbed. ● Check the sensor.

● Learning ● param. SpO2 algorithm is in learning
phase.

● No action required.

● Low battery ● param. The interfaced device has low
battery charge.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Low perfusion ● param. Low perfusion at the
measurement point.

● Check the sensor and sensor
positioning.

● Relocate the sensor to a
better measurement site, if
possible.

● Make sure the patient is not
shivering.

● Low signal ● param. The quality of the signal is
questionable.

● Check the sensor placement
and the patient status.

● Low signal quality ● param. The quality of the signal is
questionable.

● Check the sensor and sensor
positioning.

● Relocate the sensor to a
better measurement site, if
possible.

● Make sure the patient is not
shivering.

● Motion detected ● param. Patient movement detected. ● Reposition sensor.

● No ext device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● No probe ● param. Sensor is not connected to the
acquisition module.

● Check connection between
the sensor and the acquisition
module.

● No pulse ● param. Pulse signal is poor. ● Try other measurement sites.

● No SpO2 probe / No
SpO2(2) probe

● al. area Sensor is not connected to the
acquisition module.

● Check connection between
the sensor and the acquisition
module.

● No SpO2 pulse / No
SpO2(2) pulse

● al. area Pulse signal is poor. ● Try other measurement sites.

● PR(SpO2) high /
PR(SpO2) low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Probe off ● param. The sensor may be defective. ● Check the patient status.

● Reposition the SpO2 sensor.

● Replace the SpO2 sensor.
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Message Location Explanation What to do

● Pulse search ● param. Defective or damaged sensor
or cable. Sensor is off of
the patient. Detection of a
repeatable pulse has stopped.

● Check the sensor and cable.

● Reposition or replace sensor.

● SpO2 alarm setup
changed

● al. area Acquisition module has been
moved to another channel and
the alarm limits or the alarm
on/off status of this new channel
are different from the previous
channel.

● You can remove the message
from the screen with the
pause audio key.

● SpO2 faulty probe /
SpO2(2) faulty probe

● al. area The sensor has failed. ● Replace the sensor.

● SpO2 high / SpO2 low

● SpO2(2) high / SpO2(2)
low

● al. area Measurement values are equal
to or outside the basic or critical
alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● SpO2 measurement
removed

● al. area A secondary SpO2 source
becomes the primary source as
a result of removing PDM or PSM.

● Connect a module to the
same channel.

● SpO2 probe off
/SpO2(2) probe off

● al. area The finger or earlobe may be
too thin or the sensor is off the
patient.

● Check the patient status.

● Reposition the SpO2 sensor.

● Replace the SpO2 sensor.

● Wrong cable ● param. You have connected a Masimo
SETt cable to the PDM Nellcor,
or a Nellcor OxiMax cable to the
PDM Masimo.

● Check and use the correct
cable.

● Wrong cable. Use
Masimo Set

● al. area,
param.

You have connected a Nellcor
OxiMax cable to the PDM
Masimo.

● Use a Masimo SET cable.

● Wrong cable. Use
Nellcor OxiMax

● al. area,
param.

You have connected a Masimo
SET cable to the PDM Nellcor.

● Use a Nellcor OxiMax cable.

Messages related to NIBP measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● Air leakage ● param. Loose cuff or cuff hose. ● Check the cuff and cuff hose.

● Artifacts ● param. Measurement is disturbed by
artifact (e.g. patient movement,
shivering, deep breathing,
marked arrhythmia or irregular
beats).

● Calm the patient and retry.

● Calibrated ● param. Channel calibrated successfully. ● Wait until the message
disappears before starting a
measurement.

● Calibrating ● param. Calibration of a channel is in
progress.

● No action required.

● Calibration switch ON ● param. The calibration switch is on. ● Contact qualified service
personnel.

● Call service ● param. Technical fault. ● Contact qualified service
personnel.

● Call service: Error x

● where x = 0 - 99

● param. 0 = RAM failure
1 = ROM checksum failure
2 = +15V failure
3 = -15V failure
6 = ADC error
7 = Watchdog time too short
8 = Watchdog time too long
9 = Watchdog activated
10 = EEPROM checksum error
11 = Autozero range exceeded
12 = Communication watchdog
activated
13 = Not in use
14 = Too early autocycle start

● Contact qualified service
personnel.

● Check NIBP ● al. area Systolic and/or diastolic results
missing.

● Check the patient status.

● Check NIBP cuff and hoses.

● Repeat the measurement.

● Control measurement ● al. area Pressure alarm limit exceeded. ● Allow measurement to
complete.

● Check the patient status.

● Cuff occlusion ● param. Occlusion during measurement
or overpressured cuff.

● Check the cuff.

● Cuff loose ● param. Loose cuff or cuff hose. ● Check the cuff and cuff hose.

● Cuff overpressure ● param. NIBP cuff is squeezed during
measurement.

● Check NIBP cuff and hoses.

● Repeat the measurement.
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Message Location Explanation What to do

● Incorrect infl. limits ● param. Adult or child cuff is used, but the
selected infant mode restricts
the inflation pressure too low to
be able to measure the blood
pressure.

● Adjust NIBP setup.

● Long meas. time ● param. The measurement time is long.
The triggering values vary
according to the module and
inflation limits in use:

● PSM: >2 min for adult/ child,
75 s to 80 s for infant

● PDM: >2 min for adult/ child,
85 s for infant

● Check the patient status.

● Check the cuff and hose
connections.

● Restart the measurement.

● If the problem persists,
contact qualified service
personnel.

● NIBP air leakage /
NIBP auto stopped

● al. area Loose cuff or cuff hose. ● Check the cuff and cuff hose.

● NIBP cuff occlusion ● al. area Occlusion during measurement
or overpressured cuff.

● Check the cuff.

● NIBP cuff loose ● al. area Loose cuff or cuff hose. ● Check the cuff and cuff hose.

● NIBP Dia high / NIBP
Dia low

● NIBP Mean high /
NIBP Mean low

● NIBP Sys high / NIBP
Sys low

● al. area,
param.

Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● NIBP auto stopped ● al. area NIBP Auto mode has been
stopped. Loose cuff or cuff hose.

● Check the cuff and cuff hose.

● NIBP measurement
removed

● al. area Acquisition module has lost NIBP
communication.

● Remove the module and then
reconnect it.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● NIBP STAT stopped ● al. area NIBP STAT mode has been
stopped. Loose cuff or cuff hose.

● Check the cuff and cuff hose.

● Protect calibration ● param. Calibration is not protected. ● Contact qualified service
personnel.

● Select cuff size ● al. area,
param.

Cuff does not have an
automatically detectable
cuff ID.

● Select a cuff size from the
NIBP setup menu.

● Select inflation limits ● al. area,
param.

Cuff does not have an
automatically detectable
cuff ID.

● Select an inflation limit from
the NIBP setup menu.

● Unable to meas. Dia ● param. Accurate diastolic pressure is
difficult to measure because of
artifacts, weak pulsation etc.

● Assess the patient and check
inflation limits.

● Performa newmeasurement.
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Message Location Explanation What to do

● Unable to meas. Sys ● param. Systolic pressure probably
higher than maximum inflation
pressure or artifacts interfere in
the systolic area.

● Assess the patient and check
the cuff placement.

● Performa newmeasurement.

● Unstable zero press. ● param. Pressure is unstable at start of
the NIBP measurement.

● Check the patient status.

● Check hose and cuff position.

● Repeat the measurement.

● If the problem persists,
contact qualified service
personnel.

● Weak pulsation ● param. Weak or unstable oscillation
signal.

● Check the patient status.

● Reposition the cuff.

● Repeat the measurement.

● Zero failure ● param. Zeroing has failed. ● Check the patient’s pressure
by alternative means.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● Zeroing ● param. Zeroing is in progress. ● Wait until the zeroing is
completed.

● Zero OK ● param. Zeroing was successful. ● No action required.

Messages related to invasive pressures
measurement

For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● > 320 mmHg or > 43
kPa

● param. Measurement is over range, or
the sensor is faulty.
If you pre-zero a line with the
stopcock closed, it creates a
high fluid bag pressure and
triggers this message. In this
case, you can acknowledge the
alarm with the pause audio key.

● Check the patient’s pressure
by alternative means.

● Check the cable and
connections.

● Rezero the transducer.

● Replace the sensor.

● Replace the transducer.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● < -40 mmHg or < -5
kPa

● param. Measurement is under range, or
the sensor is faulty.

● Check the patient’s pressure
by alternative means.

● Check the cable and
connections.

● Rezero the transducer.

● Replace the sensor.

● Replace the transducer.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● Art disconnect ● al. area Invasive pressure line is
disconnected.

● Check the patient status.

● Check connections.

● If pressure drops because of
zeroing, perform the zeroing
process.

● Art sys high / Art sys
low

● Art mean high /
Art mean low

● Art dia high / Art dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Artifact ● param. If Smart BP is enabled, this
is normal behavior when
zeroing, flushing, or sampling is
performed.
If Smart BP is not enabled, this
message indicates that the
measurement is disturbed by
artifact.

● Check the patient status.

● Check cable contact.

● Minimize tubing length.

● Rezero the transducer.

● Calibrated ● param. Channel calibrated successfully. ● Wait until the message
disappears before starting a
measurement.
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Message Location Explanation What to do

● Calibrating ● param. Calibration of a channel is in
progress.

● No action required.

● Calibration failed ● param. Unsuccessful calibration. ● Check the connections and
recalibrate.

● CPP high / CPP low ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● CVP sys high / CVP sys
low

● CVP mean high /
CVP mean low

● CVP dia high / CVP dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Disconnected ● param. Pressure is below physiological
detection threshold.

● Check the patient status.

● Check the cable and
connections.

● If pressure drops because of
zeroing, perform the zeroing
process.

● Fem disconnect ● al. area Invasive pressure line is
disconnected.

● Check the patient status.

● Check connections.

● If pressure drops because of
zeroing, perform the zeroing
process.

● Fem sys high /
Fem sys low

● Fem mean high /
Fem mean low

● Femdia high / Femdia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● FemV sys high /
FemV sys low

● FemV mean high /
FemV mean low

● FemV dia high
/FemV dia low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● ICP sys high / ICP sys
low

● ICP mean high /
ICP mean low

● ICP dia high / ICP dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.
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● Identical IP1 modules

● Identical IP2 modules

● al. area There are two or more IP
modules in the system.

● Remove all but one IPmodule.

● Identical IP3 modules
to

● Identical IP8 modules

● al. area There are two or more IP
modules in the system.

● Remove all but one IPmodule.

● Identical IP RAC
modules

● al. area There are two or more IP RAC
modules in identical slots in the
system.

● Remove all but one IP RAC
module.

● Identical PP modules ● al. area There are two or more E-PP
modules in the system.

● Remove all but one E-PP
module.

● Identical PT modules ● al. area There are two or more E-PT
modules in the system.

● Remove all but one E-PT
module.

● IP's not zeroed ● al. area The invasive pressure lines have
not been zeroed.

● Perform zeroing.

● LAP sys high / LAP sys
low

● LAP mean high /
LAP mean low

● LAP dia high / LAP dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● No P1 transducer to

● No P8 transducer

● al. area No transducer connected to
the channel indicated in the
message, or the sensor is faulty.

● Connect a transducer.

● Check the cable and
connections.

● Replace the sensor.

● Replace the transducer.

● If the problem persists,
contact qualified service
personnel.

● P1 over range to P8
over range

● P1 under range to P8
under range

● al. area The measurement value is over
or under range, or the sensor is
faulty.

● Check the patient status.

● Check the cables.

● Rezero the transducer.

● Replace the sensor.

● Replace the transducer.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● P1 standby to P8
standby

● param. The IP channel has been set to
standby.

● Reactivate the channel by
selecting Activate P1 to
Activate P8.
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● P1 sys high / P1 sys
low

● P1 mean high /
P1 mean low

● P1 dia high / P1 dia
low

to
● P8 sys high / P8 sys

low

● P8 mean high /
P8 mean low

● P8 dia high / P8 dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● P1 zeroing failed to

● P8 zeroing failed

● param. The channel has not been zeroed
successfully.

● Repeat the zeroing.

● P7 connected ● al. area The channel has been
connected.

● No action required.

● P8 connected ● al. area The channel has been
connected.

● No action required.

● PA sys high / PA sys
low

● PA mean high /
PA mean low

● PA dia high / PA dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● PR(ABP) high / PR(ABP)
low

● PR(Art 1) high toPR(Art
8) high / PR(Art 1) low
to PR(Art 8) low

● PR(Fem) high /
PR(Fem) low

● PR(UAC) high /PR(UAC)
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Pressure
measurement
removed

● al. area The acquisitionmodule has been
removed.

● Reconnect if necessary.

● Pressure Sensed ● param. Pressure has been sensed during
zeroing.

● Open the venting stopcock to
air.
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● RAP sys high /
RAP sys low

● RAP mean high /
RAP mean low

● RAP dia high / RAP dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● RVP sys high /RVP sys
low

● RVP mean high /
RVP mean low

● RVP dia high / RVP dia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Sensor P1 failed to
Sensor P8 failed

● al. area Faulty or disconnected sensor. ● Check the cable and
connections.

● Replace the transducer.

● Sensor ● param. Faulty or disconnected sensor. ● Check the cable and
connections.

● Replace the transducer.

● UAC disconnect ● al. area Invasive pressure line is
disconnected.

● Check the patient status.

● Check connections.

● If pressure drops because of
zeroing, perform the zeroing
process.

● UAC sys high /
UAC sys low

● UAC mean high /
UAC mean low

● UACdia high /UACdia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● UVC sys high /
UVC sys low

● UVC mean high /
UVC mean low

● UVCdia high /UVCdia
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Zero adj >100 mmHg ● param. IP channel zeroed to over 100
mmHg pressure.

● Repeat the transducer
zeroing.

● Replace the sensor.

● Replace the transducer.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.
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Message Location Explanation What to do

● Zeroed ● param. Zeroing was successful. ● No action required.
Message is automatically
removed after 10 seconds.

● Zeroing ● param. IP channel is currently being
zeroed.

● No action required.
Message is automatically
removed and replaced with the
zeroing results after completion.

● Zero ICP separately ● al. area The ICP channel must be
zeroed separately from all other
invasive pressures.

● Zero the channel using the
Zero option found under the
ICP channel setup menu.

Messages related to temperature measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area

Message Location Explanation What to do

● Calibration check ● param. There is a 0.1°C difference
between the measured
temperature and the internal
calibration for the indicated
channel.

● Change the cable.

● Change the module.

● If the problem persists,
contact qualified service
personnel.

● Calibration fail ● param. Calibration on the indicated
channel failed.

● Check connections.

● Replace the transducer.

● If the problem persists,
contact qualified service
personnel.

● Identical temperature
modules

● al. area There are two or more identical
temperature modules in the
system.

● Remove all but one
temperature module.

● No sensor detected ● param. No sensor detected. ● Check the sensor and
connections.

● Performing temp test ● param. Module is calibrating. ● No action required.

● T1 Calibration check /
T2 Calibration check

● al. area There is a 0.1°C difference
between the measured
temperature and the internal
calibration for the indicated
channel.

● Change the cable.

● Change the module.

● If the problem persists,
contact qualified service
personnel.
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● T1 Calibration fail /
T2 Calibration fail /
Tblood Calibration
fail

● al. area Calibration on the indicated
channel failed.

● Check connections.

● Replace the transducer.

● If the problem persists,
contact qualified service
personnel.

● T1 high / T1 low

● T2 high / T2 low

● T3 high / T3 low

● T4 high / T4 low

● Tblood high / Tblood
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● T2-T1 high

● T4-T3 high

● Tblood-T1 high

● Tblood-T3 high

● al. area Measured delta value is equal to
or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● T1 temperature error /
T2 temperature error /
T3 temperature error /
T4 temperature error
/ Tblood temperature
error

● al. area Hardware or calibration test
failure in the measurement
device.

● Change the cable.

● Change the module.

● If the problem persists,
contact qualified service
personnel.

● Temperature error ● param. Hardware or calibration test
failure in the measurement
device.

● Change the cable.

● Change the module.

● If the problem persists,
contact qualified service
personnel.

● Temp measurement
removed

● al. area Acquisitionmodule, temperature
cable, or temperature probe(s)
have been removed.

● Check all connections and
reconnect as required.

Messages related to cardiac output
measurement

For information regarding alarm priorities and escalation times, see the supplemental
information manual.
Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area

● C.O. menu = cardiac output menu, Measurement tab
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Message Location Explanation What to do

● Calibrating ● param. Calibration is in progress. ● No action required.

● Calibration fail ● param. Unsuccessful calibration. ● Authorized service personnel
should repeat the calibration
procedure.

● CCI high / CCI low ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● CCO high / CCO low ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Check Ext Device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● C.O. Complete ● C.O.
menu

Successful cardiac output
determination has been
performed, but the module
is not yet ready for a new
measurement. Also when the 15
minute timeout for confirming
the C.O. measurement expires
with the Cardiac Output >
Measurementmenu open.

● Wait until the message
disappears.

● CO measurement
removed

● al. area Acquisition module has been
removed.

● Connect the module if
you want to restart the
measurement.

● C.O. out of range ● C.O.
menu

The measurement results are
invalid.

● Performa newmeasurement.

● Confirm C.O. ● al. area,
param.

Measurement data has not
been confirmed before trying
to exit the Cardiac Output >
Measurementmenu.
If more than 15 minutes have
passed since the start of the C.O.
measurement, this message
resets automatically.

● Select Confirm C.O.

● Curve over range ● C.O.
menu

Thermodilutionwaveform values
are over the valid range.

● Wait for the blood
temperature to stabilize
and retry the measurement.

● Curve under range ● C.O.
menu

Thermodilutionwaveform values
are under the valid range.

● Wait for the blood
temperature to stabilize
and retry the measurement.

● Identical C.O.
modules

● al. area There are two or more identical
C.O. modules in the system.
Also when there are more than
one active C.O. sources.

● Remove all but one C.O.
module.
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Message Location Explanation What to do

● Inject now! ● C.O.
menu

A prompt text during theManual
C.O. measurement.

● Inject the injectate solution
smoothly within 4 to 5
seconds.

● Inject When Ready ● C.O.
menu

A prompt text during the
Automatic C.O. measurement.

● Inject the injectate solution
smoothly within 4 to 5
seconds.

● Irregular curve ● C.O.
menu

Thermodilution waveform is
irregular.

● Performa newmeasurement.

● Irregular HR ● C.O.
menu

HR measurement values are
irregular.

● Check the patient status.

● Measuring ● C.O.
menu

Determining the C.O. value. ● Wait until the message
disappears.

● No catheter ● C.O.
menu

No catheter connected. ● Connect a catheter.

● No Comp Constant.
Check C.O. setup

● C.O.
menu

The computation constant is
not available for the selected
catheter, injectate volume, and
injectate probe combination.

● Check the C.O. setup
selections.

● No ext device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● No injectate temp
probe

● C.O.
menu

No injectate temperature probe
connected.

● Connect an injectate
temperature probe.

● No HR for REF ● C.O.
menu

REF measurement cannot be
done.

● Check that the patient’s heart
rate is being monitored.

● Add HR measurement if
needed.

● No module ● C.O.
menu

No C.O. module connected. ● Connect a C.O. module to
measure cardiac output.

● Noisy baseline ● C.O.
menu

Changes in patient’s blood
temperature affect C.O.
measuring.

● Check the patient status.

● Check the blood temperature
connector.

● Please wait ● C.O.
menu

A failed, canceled, or stopped
C.O. determination and the
module not yet ready for the
next measurement.

● Wait until the message
disappears.

● Press Start C.O. ● C.O.
menu

Prompt text during the Manual
measurement mode.

● Proceed with the
measurement by selecting
Start C.O. With E-modules,
you can also use the Start
C.O. module key.

● Press Start C.O. Serial ● C.O.
menu

Prompt text during the
Automatic measurement
mode.

● Proceed with the
measurement by selecting
Start C.O. Serial.
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Message Location Explanation What to do

● REF out of range ● C.O.
menu

The result of the REF
measurement is invalid.

● Check cables and
connections.

● Performa newmeasurement.

● If the problem persists,
contact qualified service
personnel.

● Signal Adapting ● param. Interfaced device signal is being
processed.

● Wait until the message
disappears.

● Tblood over range ● C.O.
menu

Blood temperature is over the
limit: 43°C with E-modules, 44°C
with PDM.

● Check the catheter position.

● Check that there is no heat or
cold source near the catheter.

● The temperature sensor may
be damaged; replace the
catheter.

● Tblood sensor failed ● al. area Blood temperature sensor
failure.

● Replace the catheter.

● Tblood under range ● C.O.
menu

Blood temperature is under the
limit: 17.5°C with E-modules,
28°C with PDM.

● Check the catheter position.

● Check that there is no heat or
cold source near the catheter.

● The temperature sensor may
be damaged; replace the
catheter.

● Tinj high ● C.O.
menu

Injectate temperature is too
close to blood temperature or
too warm.

● Use colder injectate.

● Tinj low ● C.O.
menu

Injectate temperature is too
close to blood temperature or
too cold.

● Use warmer injectate.

● Tinj sensor failed ● C.O.
menu

Injectate temperature sensor
failure.

● Replace the sensor.

● Unstable Tblood ● param.,
C.O.
menu

● Measurement in auto mode
detects the unstable baseline
patient temperature.

● Check the patient status.

● Change C.O. measurement to
manual mode and repeat the
measurement.

Messages related to SvO2measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● Calibrating ● param. Calibration factors are being
calculated and stored to the
module.

● No action required.

● Check cath. position ● param. Low signal quality. ● Check the connections and
catheter.

● Check Ext Device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Connecting ● param. Connection to the interfaced
device is being established.

● No action required.

● Damped Intensity ● param. There may be problems with
connections.

● Check the catheter.

● Check the cable and
connections.

● Recalibrate in vivo.

● If the problem persists,
contact qualified service
personnel.

● Draw blood ● param. An advisory prompt. ● Draw blood as indicated on
screen.

● Enter lab results ● param. Calibration sequence requires
lab results.

● Enter laboratory results as
indicated on screen.

● High Intensity ● param. Catheter floated or up against
vessel wall.

● Check the optical module and
connections.

● Check the catheter
placement.

● Only authorized medical
personnel should adjust
catheter placement.

● In vitro calibrating ● param. In vitro calibration is in process. ● Wait until the message
disappears.

● In vitro failed ● param. Unsuccessful calibration. ● Check connections and
catheter.

● Change optical module and
recalibrate.

● If the problem persists,
contact qualified service
personnel.

● In vivo calibrating ● param. In vivo calibration is in process. ● Wait until the message
disappears.
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Message Location Explanation What to do

● In vivo poor signal ● param. The measurement cannot be
performed because the signal is
too weak.

● Check connections and
catheter.

● Change optical module and
recalibrate.

● If the problem persists, the
catheter could be faulty;
replace the catheter.

● Insufficient signal ● param. The measurement cannot be
performed because the signal is
too weak.

● Check the patient status.

● Check connections and
catheter.

● If the problem persists,
contact qualified service
personnel.

● Intensity shift ● param. The measurement cannot be
performed because the signal
intensity changed.

● Check the patient status.

● Check connections and
catheter.

● If the problem persists,
contact qualified service
personnel.

● Low Intensity ● param. Catheter floated or up against
vessel wall.

● Check the optical module and
connections.

● Check the catheter
placement.

● Only authorized medical
personnel should adjust
catheter placement.

● Low Light ● param. Catheter floated or up against
vessel wall.

● Check the optical module and
connections.

● Check the catheter
placement.

● Repeat in vivo calibration.

● No Light ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Re-calibrate SvO2 ● al. area,
param.

The calibration is over 24 hours
old.

● Perform in vivo calibration.

● Start SvO2 ● param. Displays when the catheter has
been inserted into the patient
after in-vitro calibration.

● Select the Start SvO2 option
from the SvO2 menu.

● SvO2 cable off ● al. area The cable is disconnected from
the module.

● Re-connect the cable to the
module.

● SvO2 faulty cable ● al. area,
param.

The optical module has failed. ● Check the optical module and
connections.

● Replace the optical module.
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Message Location Explanation What to do

● SvO2 high / SvO2 low ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● SvO2 measurement
removed

● al. area Acquisition module has been
removed.

● Connect the module if
you want to restart the
measurement.

● SvO2 not calibrated ● al. area,
param.

The optical module is connected
to the monitor and the catheter
has not been calibrated.

● Perform in vivo calibration.

● SvO2 out of range ● param. Values are above or below the
range the monitor can process.

● Check cables and
connections.

● Repeat in vivo calibration.

● Change the optical module.

● If the catheter is faulty,
replace it.

● If the cable or module is
broken, contact authorized
service personnel.

● SvO2 signal poor ● al. area,
param.

There is signal pulsation, the
catheter is touching the wall,
or there is an intensity shift in
signal quality level.

● Flush the catheter.

● Check the optical module and
connections.

● Check the catheter
placement.

● SvO2 temp error ● al. area The temperature of the optical
module is out of range for more
than 10 minutes.

● Check the optical module and
connections.

● Replace the optical module.

● Contact qualified service
personnel.

● Wait, initializing ● param. Optical module signal is being
processed.

● Wait until the message
disappears.

● Warming up ● param. The optical module is warming
up.

● Wait until the module has
warmed up and the message
disappears.

Messages related to gases measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● Agent mixture ● al. area,
param.

Mixture of halogenated agents
is detected.

● Check the ventilator and
agent vaporizer settings.

● Apnea (CO2) ● al. area,
wavef.

No breathing detected. ● Check the patient status.

● Check the ventilator and
breathing status.

● Apnea deactivated ● param. A new case has just been
started/a new patient admitted,
or the measurement has just
been started and the apnea
alarm is not active yet.

● Wait. The message
disappears after the monitor
detects 3 breaths during the
last minute.

● Calibrate sensor ● param. A new sensor is introduced
or there is a signal drift in the
electronics.

● Perform sensor calibration.

● Calibrate system ● param. Interfaced device should be
calibrated.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Calibrating ● param. Calibration is in progress. ● No action required.

● Calibrating gas
sensor

● wavef. The measurement has been
started and calibration is in
progress.

● Wait until the calibration is
completed and the message
disappears.

● Calibration error ● param. Unsuccessful calibration. ● Authorized service personnel
should repeat the calibration
procedure.

● Check/calibr. adapter ● al. area,
param.

The adapter is missing,
obstructed, or of a different
type than in the last calibration.

● Check that there is an adapter
in the system.

● Check the adapter for
blockages.

● Calibrate the adapter.

● Check ext device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Check sample gas out ● al. area The water trap is not connected,
the sample gas outflow is
blocked, or there is a leak inside
the module.

● Check water trap connection.

● Remove the blockage from
the sample gas outlet.

● Change module if needed.

● Check sample line ● al. area,
param.

The sample line is disconnected,
or of a different type than the
last one used.

● Reconnect the disconnected
sample line.

● Calibrate the sample line.

● Check water trap
and sample gas out.
Press Normal Screen
to continue.

● wavef. The water trap is not connected,
the sample gas outflow is
blocked, or there is a leak inside
the module.

● Check water trap connection.

● Remove the blockage from
the sample gas outlet.

● Change module if needed.
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Message Location Explanation What to do

● Check Water Trap ● al. area,
param.

Water trap connection is not
correct, or there is a leak in the
sampling line inside the module.

● Check the patient status.

● Check the water trap and its
connection.

● Continuous blockage,
check sample line.
Restart pump.

● wavef. Nasal cannula, moisture filter,
sidestream adapter tube, or
exhaust line is blocked.

● Check all parts of the
equipment to patient
connection and remove
any blockages.

● If necessary, change the line.

● Continuous blockage.
Check sample line
and water trap.

● wavef. The gas sampling line is blocked
or the water trap is occluded.

● Change sampling line and
water trap.

● ETAA HIGH

● ETAA LOW
where AA = Hal, Enf, Iso,
Sev or Des

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● EtCO2 high

● EtCO2 low

● EtN2O high

● EtN2O low

● EtO2 high

● EtO2 low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Ext:Apnea ● al. area No breathing detected. ● Check the patient status.

● Check the ventilator and the
breathing status.

● Check the interfaced device.

● Ext not supported ● param. Interfaced device is not
supported.

● See the Unity Network
Interface Device (ID)
Operator’s Manual for
supported devices.

● If the problem persists,
contact qualified service
personnel.

● Failure in Agent ID ● param. An unknown agent or three or
more agents detected. Vaporizer
may contain amixture of agents.

● Flush the breathing circuit
with O2 flush (O2 +, 100% O2).

● Empty the vaporizer and refill
from an unopened container.

● FIAA HIGH

● FIAA LOW
where AA = Hal, Enf, Iso,
Sev or Des

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.
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Message Location Explanation What to do

● FiCO2 high

● FiCO2 low

● FiN2O high

● FiN2O low

● FiO2 high

● FiO2 low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Gas measurements
removed

● al. area Acquisition module has been
removed.

● Connect the module if
you want to restart the
measurement.

● Gas module standby ● al. area Acquisition module has shut
down the pump.

● No action required.

● Gas module standby.
Touch any button/key
to activate.

● wavef. Acquisition module has shut
down the pump.

● To exit the standby mode,
touch any button or key.

● No action required.

● Identical gasmodules ● al. area There are twoormore E-modules
with gas measurement in the
system.

● Remove all but one E-module
with gas measurement.

● Incompatible gas
module

● al. area The module is not compatible. ● Replace with compatible
gas module. See the
supplemental information
manual.

● If the problem persists,
contact qualified service
personnel.

● Incompatible sensor ● param. The sensor is of wrong type. ● Check and change the sensor
to a correct type. See the
supplemental information
manual.

● Interface Failed ● param. Interfaced device and Unity
Network Interface Device (ID)
should be checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Low gas sample flow ● al. area Sample flow is less than 80% of
the module’s nominal flow value.
This can happen if nebulized
medications are given without
disconnecting the sample line.

● Check the sample line.

● If the problem persists,
contact qualified service
personnel.

● No ext device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Over range ● param. Measured FiO2 is more than
103%.

● Calibrate airway gases.
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● Over scale ● wavef. Gas signal exceeds the
maximum waveform area.

● Check the patient status.

● Select a larger scale for
waveform.

● Purging ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Replace Water Trap ● al. area,
param.

Water trap is partially blocked. ● Replace the water trap.

● RR (CO2) High / RR
(CO2) Low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Sample line blocked ● al. area The gas sampling line is blocked
or the water trap is occluded.

● Change sampling line and
water trap.

● Sample gas out ● param. The water trap is not connected,
the sample gas outflow is
blocked, or there is a leak inside
the module.

● Check water trap connection.

● Remove the blockage from
the sample gas outlet.

● Change module if needed.

● Service CO2 module ● param. Technical failure in the module. ● Contact qualified service
personnel.

● Service gas module

● Service gas module
- and specific error
indication

● al.area,
param.,
wavef.

The measuring sensor is
inoperative or the temperature
in the module has increased.

● Contact qualified service
personnel.

● Service ext device ● param. Interfaced device should be
checked.

● Contact qualified service
personnel.

● Service Mode ● param. Interfaced device should be
checked.

● Contact qualified service
personnel.

● Standby ● param. Acquisition module has shut
down the pump.

● No action required.

● Warming up ● param. The sensor is warming up. ● Wait until the message
disappears.

● Zero error ● param. Zeroing has failed. ● Repeat the zeroing.

● Zeroing ● param. Zeroing is in progress. ● Wait until the zeroing is
completed.
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Messages related to spirometry measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area

Message Location Explanation What to do

● Connecting ● param. Connection to the interfaced
device is being established.

● No action required.

● Ext not supported ● param. Interfaced device is not
supported.

● See the Unity Network
Interface Device (ID)
Operator’s Manuall for
supported devices.

● If the problem persists,
contact qualified service
personnel.

● Low volumes ● param. The water trap may not be
properly connected, or there
may be a leak in the breathing
circuit.Tidal volumes detected
are so small that inspiration
and expiration cannot be
distinguished from each other.

● Check the patient status.

● Check the water trap and its
connection.

● Check the breathing circuit
for leaks.

● Check the loops on screen to
locate the problem.

● MVexp << MVinsp ● param. Exhaled volume is markedly
smaller than inhaled.

● Check the patient status.

● Check the ventilatory system
for leaks.

● If the problem persists,
contact qualified service
personnel.

● MVexp high / MVexp
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● No ext device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Over scale ● wavef. Gas signal exceeds the
maximum waveform area.

● Check the patient status.

● Select a larger scale for
waveform.
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Message Location Explanation What to do

● PEEP low

● PEEPe high / PEEPe
low

● PEEPi high / PEEPi low

● PEEPtot high /
PEEPtot low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Ppeak high / Ppeak
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Saving Loop ● al. area A loop is being saved. ● Wait until the message
disappears.

● Scale changed ● wavef. The Auto scaling mode has
changed the Flow, Paw or Vol
scale.

● Wait until the message
disappears.

● Service gas module

● Service gas module
- and specific error
indication

● al.area,
param.,
wavef.

The measuring sensor is
inoperative or the temperature
in the module has increased.

● Contact qualified service
personnel.

● TVexp low ● al. area Measured value is outside or
equal to the alarm limit.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Vent: Apnea ● al. area No breathing detected. ● Check the patient status.

● Check the interfaced device.

● Vent: Check
ventilator

● al. area The interfaced device needs to
be checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Vent: Connecting ● al. area Interfaced device is being
connected to the monitor
through Unity Network Interface
Device (ID).

● No action required.

● Vent: Disconnect ● al. area Interfaced device needs to be
checked.

● Check the patient status.

● Check the ventilator tubing
and patient connection.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.
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Message Location Explanation What to do

● Vent: Ext not
supported

● al. area Interfaced device is not
supported.

● See the Unity Network
Interface Device (ID)
Operator’s Manual for
supported devices.

● If the problem persists,
contact qualified service
personnel.

● Vent: In Alarm ● al. area Interfaced device needs to be
checked.

● Check the patient status.

● Check the ventilator tubing
and patient connection.

● Check the interfaced device.

● Vent: Low battery ● al. area Interfaced device needs to be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Vent: No ext device ● al. area Interfaced device is not detected
by Unity Network Interface
Device (ID).

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Ventilator interface
removed

● al. area The cable between the Unity
Network Interface Device (ID)
and the interfaced device has
been removed.

● Reconnect the cable if you
want to restart the interface.

● Zeroing error ● param. Zeroing has failed. ● Repeat the zeroing.

● Zeroing ● param. Zeroing is in progress. ● Wait until the zeroing is
completed.

Messages related to gas exchange measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● Artifact ● param. The sample line length is not
correct.

● Check that the sample line
length is 2 meters.

● Change sample line if
necessary.

● Bypass flow high ● param. The module is unable to
synchronize flow and CO2 due to
bypass flow.

● Add a 5 ml spacer to the
patient circuit between the
Y-piece and D-lite.

● Shorten the expiration time to
avoid expiratory flow pause.

● No VO2, FiN2O high ● param. Module has detected N2O. ● Gas exchange cannot
be measured if N2O is
used. If you wish to
measure gas exchange,
use another anesthetic. If the
measurement is not used,
you may consider removing
gas exchange numbers from
the screen.

● No VO2, FiO2 >85% ● param. Measured FiO2 is more than
85%.

● Gas exchange cannot be
measured if FiO2 is more than
85%. If the patient’s oxygen
values are consistently high,
you may consider removing
gas exchange numbers from
the screen.

● Out of range ● param. VO2 or VCO2 is below 0 ml/min
or above 999 ml/min.

● Check that the gas sampling
line and spirometry lines are
correctly connected to the
patient airway and to the gas
module.

● Check that the correct sensor
type (D-lite/Pedi Lite) has
been selected from the
monitor menu.

● Service gas module

● Service gas module
- and specific error
indication

● al.area,
param.,
wavef.

The measuring sensor is
inoperative or the temperature
in the module has increased.

● Contact qualified service
personnel.

Messages related to Entropy measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● Artifacts ● param.,
wavef.

Signals contain noise or artifact. ● Check sensor contact.

● Remove sources of excessive
noise.

● Automatic check off ● param. Automatic sensor check has
been turned off.

● If required, activate the
automatic check.

● Cable off ● param. Entropy cable is off. ● Connect the cable.

● Checking sensor ● param.,
wavef.

Sensor check is in progress. ● Wait until the check is over.
Check results are displayed.

● Confirm electrode 1

● Confirm electrode 2

● Confirm electrode 3

● param. One of the sensor electrodes has
poor contact.

● Confirm proper sensor
electrode 1, 2 or 3 contact as
indicated in the message.

● Confirm electrodes ● param. More than one of the sensor
electrodes have poor contact.

● Confirm proper electrode
contact.

● Entropy cable off ● al. area The Entropy sensor cable is
not connected to the Entropy
module.

● Connect the Entropy cable to
the Entropy module.

● Entropy
measurement
removed

● al. area Acquisition module has been
removed.

● Connect the module if
you want to restart the
measurement.

● Entropy RE high
/Entropy RE low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Adjust drug titration.

● Entropy SE high
/Entropy SE low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● Adjust drug titration.

● Entropy sensor check
failed

● al. area The sensor has not passed the
impedance check.

● Check sensor placement and
attachment.

● Confirm proper contact of
each electrode in the sensor.

● Replace the sensor.

● Entropy sensor off ● al. area The sensor is connected to the
cable but not attached to the
patient, or the sensor type is not
correct.

● Check that the sensor is
properly attached to the
patient.

● Check that the sensor is an
Entropy sensor.

● Identical Entropy
modules

● al. area There are two or more Entropy
modules in the system.

● Remove all but one Entropy
module.

● Isoelectric EEG ● param.,
wavef.

Isoelectric (flatline) EEG detected
in Entropy measurement.

● Check the patient status. The
patient’s anesthetic status
may be unnecessarily deep.
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Message Location Explanation What to do

● Low signal ● param. Measured EEG signal is too low
for reliable Entropy calculation.

● Check sensor placement.

● The patient may be in total
suppression; check the
patient status.

● No Entropy sensor ● al. area The sensor is not connected to
the cable, or the sensor and
cable are not compatible.

● Check connection between
Entropy sensor and cable.

● Check that the cable and
sensor are compatible.

● No sensor ● al. area The sensor is not connected to
the cable, or the sensor and
cable are not compatible.

● Check connection between
Entropy sensor and cable.

● Check that the cable and
sensor are compatible.

● Noise ● wavef. Unreliable Entropy calculation
or distorted EEG waveform may
appear during electrosurgery or
other high frequency noise.

● Interpret Entropy values with
caution.

● Sensor check failed ● param. The sensor has not passed the
impedance check.

● Check sensor placement and
attachment.

● Confirm proper contact of
each electrode in the sensor.

● Replace the sensor.

● Sensor off ● param. The sensor is connected to the
cable but not attached to the
patient, or the sensor type is not
correct.

● Check that the sensor is
properly attached to the
patient.

● Check that the sensor is an
Entropy sensor.

● Starting up ● param. The monitor is collecting data to
start the measurement.

● Wait for about one minute.
Entropy values appear
automatically.

Messages related to NMT measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area
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Message Location Explanation What to do

● Block recovery ● al. area Count number has reached the
value you have selected for the
recovery note function.

● Check the patient status.

● Check electrodes ● param. Adjusted stimulus current could
not be delivered properly due
to a broken connection of the
stimulating electrode or cable.

● Check the white and brown
stimulating electrodes and
their connections.

● Check the cable.

● Change the cable if
necessary.

● EMG electrodes off ● param. The EMG recording electrodes
are off.

● Attach the electrodes
to continue or start the
measurement.

● Identical NMT
modules

● al. area There are two or more NMT
modules in the system.

● Remove all but one NMT
module.

● Measurement off ● param. The measurement has been
stopped.

● Restart the measurement if
required.

● NMT cable removed

● Cable off

● al. area

● param.

The cable has been
disconnected from the module.

● Reconnect the cable if
you want to restart the
measurement.

● NMT measurement
removed

● al. area Acquisition module has been
removed.

● Connect the module if
you want to restart the
measurement.

● Reference not stable ● param. The deviation between the four
reference search twitches is too
big.

● Stop measurement,
reposition electrodes and
restart the measurement.

● Regional Block ● param. Regional block stimulation is in
progress.

● Wait until the stimulation is
completed.

● Response too weak ● param. The measurement cannot
be performed because the
response is too weak.

● Check electrode placement
and connections.

● Replace dry electrodes.

● Check that the stimulus
current is not too weak.

● Setting reference ● param. Automatic reference search is in
progress.

● Wait until the reference
search is completed.

● Supramax not found ● param. Supramaximal stimulus current
was not found. 70 mA is used as
stimulus current.

● Stop measurement,
reposition the stimulating
or recording electrodes and
restart the measurement.

● Supramax search ● param. Supramaximal stimulus current
search is in progress.

● Wait until the search is
completed.

● TETANIC ● param. Tetanic stimulation is in progress. ● Wait until the stimulation is
completed.
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Messages related to BIS measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area

Message Location Explanation What to do

● Apply sensor ● param. The sensor connection to the
patient may be loose.

● Press the BIS sensor
electrodes to improve
connection.

● Artifact ● param.,
wavef.

Signals contain noise or artifact. ● Check sensor contact.

● Remove sources of excessive
noise.

● Automatic check off ● param. Automatic sensor check has
been turned off.

● If required, activate the
automatic check.

● BIS cable off ● al. area Cable is disconnected from the
module.

● Connect the cable.

● BIS DSC error ● al. area The BISx is not communicating
or operating properly.

● Test the BISx.

● If the problem persists,
contact qualified service
personnel.

● BIS high / BIS low ● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Check the dosage of
anesthetics.

● Adjust alarm limits if
necessary.

● BIS measurement
removed

● al. area The module or BISx is
disconnected.

● Connect the module or BISx
to start the measurement.

● BIS module error ● al. area The module is not working
properly.

● Check cable and connections.

● Replace the BISx.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● BIS sensor check
failed

● al. area The sensor has not passed the
impedance check.

● Check sensor placement and
attachment.

● BIS sensor expired ● al. area The sensor date has expired, the
sensor has been used too many
times, or the validity time for the
sensor cannot be determined.

● Replace the sensor.
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Message Location Explanation What to do

● Cable off ● param.,
wavef.

Cable is disconnected from the
module.

● Connect the cable.

● Checking sensor ● param.,
wavef.

Sensor check is in progress. ● Wait until the check is over.
Check results are displayed.

● DSC error ● param.,
wavef.

The BISx is not communicating
or operating properly.

● Test the BISx.

● If the problem persists,
contact qualified service
personnel.

● High BIS impedance ● al. area Electrode impedance is too high. ● Check electrode connections.

● Identical BIS modules ● al. area There are two or more BIS
modules in the system.

● Remove all but one BIS
module.

● Incompatible DSC ● param. The hardware/ software is not
compatible with the BISx.

● Check and change the BISx.

● Incompatible sensor ● param.,
wavef.

The sensor used is not a BIS
sensor.

● Make sure that you are using
a Covidien BIS sensor.

● Module error ● param.,
wavef.

The module is not working
properly.

● Check cable and connections.

● Replace the BISx.

● Replace the module.

● If the problem persists,
contact qualified service
personnel.

● No BIS sensor

● No sensor

● al. area

● param.,
wavef.

BIS: The sensor is not connected
to the digital signal processing
unit BISx.

● Check the connection
between sensor and BISx,
and sensor and PIC (patient
interface cable).

● Poor signal ● param.,
wavef.

The BIS cannot be calculated
because the SQI is below 50.

● Check electrode connections.

● Replace sensor ● param. The sensor date has expired, the
sensor has been used too many
times, or the validity time for the
sensor cannot be determined.

● Replace the sensor.

● Sensor check failed ● param.,
wavef.

The sensor has not passed the
impedance check.

● Check sensor placement and
attachment.

● Press each electrode in the
sensor.

● Replace the sensor.

● Testing DSC ● param.,
wavef.

The BISx test has been activated. ● Wait until the check is
completed.
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Messages related to TC measurement
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area

Message Location Explanation What to do

● Calibrating ● param. Calibration is in progress. ● No action required.

● Calibration error ● param. Unsuccessful calibration. ● Authorized service personnel
should repeat the calibration
procedure.

● Connecting ● param. Connection to the interfaced
device is being established.

● No action required.

● Ext device error ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● No ext device ● param. Interfaced device should be
checked.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Not calibrated ● param. Measurement needs to be
calibrated.

● Perform calibration.

● Ready ● param. Measurement is ready. ● No action required.

● TC measurement
removed

● al. area Interfaced module has been
removed.

● Connect the module if
you want to restart the
measurement.

● TC pCO2 high / TC
pCO2 low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● TC pO2 high / TC pO2
low

● al. area Measurement values are equal
to or outside the alarm limits.

● Check the patient status.

● Adjust alarm limits if
necessary.

● TC timer expired ● al. area The time set on the interfaced
device after a successful
calibration has now expired.

● Change the sensor site and
reset the timer.

● TC Tsensor high

● Tsensor high

● al. area

● param.

Limit for sensor temperature is
set on the interfaced device.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.
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Messages related to trends, snapshots, and
laboratory data

For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● report = report view

● wavef. = waveform area

Message Location Explanation What to do

● End of 20 min trend
data

● End of High
Resolution trend

● al. area There is more trend data
available but not with this
resolution.

● Change the time resolution
in graphic trends to be more
than 20 minutes (e.g., 1 hour,
2 hours).

● Scroll the trends to see past
data.

● Lab data available ● al. area Unity Network Interface Device
(ID): Interfaced device has sent
a new set of laboratory data to
the monitor.

● Save the new data.

● Lab data interface
failed

● al. area Unity Network Interface Device
(ID): There is a communication
failure or error between the
Unity Network Interface Device
(ID) and the interfaced device.

● Check the interfaced device.

● If the problem persists,
contact qualified service
personnel.

● Mark xxx

● where xxx = snapshot
sequence number

● alarm
area

A snapshot has been taken
manually.

● No action required.

● Snapshot created ● al. area A snapshot has been created. ● No action required.

● Snapshot memory
full. Oldest snapshot
erased.

● al. area You are trying to save a snapshot
but the memory capacity is full.

● No action required.

● ST snapshot created ● al. area ST snapshot created. ● No action required.

● ST snapshot memory
full. Oldest ST
snapshot erased.

● al. area You are trying to save an ST
snapshot but the memory
capacity is full.

● No action required.

● Sweep Speed
Changed

● wavef. Sweep speed of the realtime
waveform has changed.

● No action required.

● Waveform available
only for 2min and
4min time scales

● wavef. High Resolution trends license
is configured for HR, Resp, CO2
and MAP.

● Change trend resolution to 2
minute or 4 minute time scale
for the affected parameter.
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Messages related to various situations
For information regarding alarm priorities and escalation times, see the supplemental
information manual.

Make sure you are familiar with the generic layout of the screen. This will help you identify
where on screen the following messages appear. The message location is indicated with the
following abbreviations:

● al. area = alarm area

● param. = parameter window

● wavef. = waveform area

Message Location Explanation What to do

● ADT server
communication
failure

● al. area An error occurred when trying
to search for patient on the ADT
server.

● Check the network
connectivity.

● Retry loading from the
network.

● If the problem persists,
contact qualified service
personnel.

● Alarm setup changed
remotely

● al. area The alarm setup is retrieved from
the telemetry server or central
station.

● Check the alarm settings and
adjust if necessary.

● Alarm volume
changed

● al. area The network connection is lost,
and the local alarm volume is
increased.

● Readjust volume if desired.

● Alarms acknowl-
edged remotely

● al. area The alarms have been
acknowledged from the central
station.

● No action required but you
may wish to confirm in alarm
history which alarm has been
acknowledged.

● Alarms audio paused
remotely

● al. area The alarms were remotely
paused from the central station.

● You can activate the alarms
by pressing the audio pause
key.

● Alarms audio paused
from telemetry

● al. area The alarms were remotely
paused from the telemetry
transmitter.

● You can activate the alarms
by pressing the audio pause
key.

● All monitors
disconnected

● al. area The monitor is disconnected
from the network.

● Re-establish connection.

● If the problem persists,
contact qualified service
personnel.

● Application
error: iPanel

● al. area Connection to iPanel was lost. ● Re-establish the connection.

● If the problem persists,
contact qualified service
personnel.
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Message Location Explanation What to do

● Application error: pdf ● al. area PDF viewer closes unexpectedly. ● Try to open the MUSE 12SL
report again.

● If the problem persists,
contact qualified service
personnel.

● Application
error: Webmin

● al. area Webmin application closes
unexpectedly.

● Try to open Webmin again.

● If the problem persists,
contact qualified service
personnel.

● Audio set OFF
remotely

● al. area The alarms have been turned off
from the central station.

● You can change the selection
through Alarm Setup >
Audible & Visual.

● Barcode scanned ● al. area All data has been successfully
stored to the monitor.

● No action required.

● Barcode too long ● al. area The maximum length of the
barcode has been exceeded.

● Verify the information read by
the barcode reader and edit if
necessary.

● Battery A failure

● Battery B failure

● al. area Battery A or B is faulty. ● Replace the battery if
necessary.

● Battery failure ● al. area The monitor battery is faulty. ● Replace the battery if
necessary.

● Battery A
temperature high

● Battery B
temperature high

● al. area Battery A or B temperature is too
high.

● Replace the battery.

● If the problem persists,
contact qualified service
personnel.

● Battery temperature
high

● al. area The battery’s temperature is too
high.

● Replace the battery.

● If the problem persists,
contact qualified service
personnel.

● <Bed> Monitor
disconnected

● al. area The monitor with alarm
notification enabled is
disconnected from the network.

● Re-establish the connection.

● Call service: Check
WLAN certificate.

● al. area Wireless network certificate(s)
are going to expire. WLAN may
stop working within 15 days.

● Contact qualified service
personnel.

● Call service: WLAN
certificate expired.

● al. area Wireless network certificate(s)
have expired. WLAN may not
work.

● Contact qualified service
personnel.

● Call Service: Text(s)
missing

● al. area The software text is missing in
this language; the text file may
be corrupted.

● Contact qualified service
personnel.

● Case ended ● al. area OR and PACU software
packages: The current case
has just been ended.

● No action required.
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Message Location Explanation What to do

● Case started ● al. area OR and PACU software
packages: A new case has
just been started.

● No action required.

● Check PDM battery ● al. area PDM battery is not working
properly.

● Check and replace or remove
the battery.

● Condition battery A

● Condition battery B

● al. area Battery A or B is not working
properly.

● Contact qualified service
personnel.

● Condition monitor
battery

● al. area Battery is not working properly. ● Contact qualified service
personnel.

● Configuration
change(s)

● al. area The loaded configuration has
changed from the previous one.

● No action required, but
you may wish to check the
settings.

● Configuration
changes. Restart
required.

● al. area The configuration has changed. ● Restart the monitor.

● Configuration error(s) ● al. area One or more errors have been
detected in the configuration.

● Contact qualified service
personnel.

● Connecting
Measurement

● al. area An acquisition module has been
connected.

● No action required.

● Connecting telemetry
transmitter

● al. area The monitor is connecting to a
telemetry transmitter.

● No action required.

● Countdown timer
expired

● al. area User set countdown timer has
expired.

● Reset the timer if required.

● Entering standby ● al.area Activate standby has been
selected.

● No action required.

● Error 1: PMC update
failed. Turn the
monitor off and then
on again.

● start-up
screen

Unsuccessful PMC update. ● Turn the monitor off and then
on again.

● If the problem persists,
contact qualified service
personnel.

● Error 2: PMC update
requires a mains
supply. Plug in the
power cord and turn
the monitor off and
then on again.

● start-up
screen

Unsuccessful PMC update. ● Plug in the power cord and
turn the monitor off and then
on again.

● If the problem persists,
contact qualified service
personnel.

● External alarm light
disconnect. Check
USB connection.

● al.area There is a communication error. ● Wait and see if the message
disappears.

● Try selecting audio pause
and see if the message
disappears.

● If the problem persists,
contact qualified service
personnel.
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Message Location Explanation What to do

● Identical IP address
noticed

● al. area Two or more monitors have the
same IP address.

● Contact qualified service
personnel.

● Identical unit & bed
name noticed

● al. area Two or more monitors have the
same unit and bed name.

● Contact qualified service
personnel.

● Incompatible Module ● al. area The module is not compatible. ● Replace with compatible
module. See the
supplemental information
manual.

● If the problem persists,
contact qualified service
personnel.

● Incorrect barcode
value

● al. area The barcode string differs from
the defined values.

● Contact qualified service
personnel.

● Invalid barcode
configuration

● al. area The barcode configuration is not
correct.

● Contact qualified service
personnel.

● License(s) expired ● al. area One or more trial licenses have
expired.

● Contact qualified service
personnel.

● Loading failed ● al. area Loading a case/patient from an
acquisition module or network
has been interrupted.

● Check device or network
cable connections.

● Loading from
network

● al. area Patient data is being loaded
from the network.

● No action required.

● Loading from PDM ● al. area Patient data is being loaded
from an acquisition module.

● Wait.

● Module voltage low ● al. area Parameters may not be working
properly due to a technical fault
in the monitor.

● Check the patient status.

● Contact qualified service
personnel.

● Monitor battery
empty!

● al. area The monitor is used on battery
power, and there is less than 5
minutes of charge left.

● Charge the battery by using
the monitor on mains power.

● Monitor battery low ● al. area The monitor is used on battery
power, and there is less than 20
minutes of charge left.

● Charge the battery by using
the monitor on mains power.

● Monitor disconnected ● al. area The alarming monitor is
disconnected from the network.

● Re-establish the connection.

● Monitor powering
down!

● al. area The monitor is used on battery
power and there is less than 10
seconds of charge left.

● Charge the battery by using
the monitor on mains power.

● Network down ● al. area Network connection has failed.
B650, B450: If the monitor
is used with WLAN option, it
is in shadow region and not
connected to the network.

● Try to re-establish the
connection.

● Contact qualified service
personnel.

● No battery backup in
monitor

● al. area The monitor has the battery
option but there is no battery
inserted.

● Insert a battery.
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Message Location Explanation What to do

● No patients found ● al. area No patients were found when
searching the ADT server.

● Verify or change search
criteria.

● Manually enter demographic
information.

● No printer selected ● al. area There is no printer selected on
the monitor.

● Select a printer.

● Patient admitted ● al. area ICU, NICU and ED software
packages: The current patient
has just been admitted.

● No action required.

● Patient discharged ● al. area ICU, NICU and ED software
packages: The patient has just
been discharged.

● No action required.

● PDM battery low ● al. area PDM: The PDM battery cannot
be charged due to a power fault.

● Allow PDM battery to charge.

● If message persists, change
battery.

● If the problem persists,
contact qualified service
personnel.

● PDM battery temp
high

● al. area PDM: PDM battery temperature
is over the limit.

● Contact qualified service
personnel.

● PDM charging is
denied

● al. area The PDM battery cannot be
charged because the internal
temperature of the monitor is
too high.

● Contact qualified service
personnel.

● PDMmodule removed ● al. area Acquisition module has been
removed.

● Connect the module if
you want to restart the
measurements.

● PSM/PRESTN module
removed

● al.area Acquisition module has been
removed.

● Connect the module if
you want to restart the
measurements.

● Power management
failure

● al. area There is a problem with
communication to the power
management controller.

● Wait and see if the message
disappears.

● If the problem persists,
contact qualified service
personnel.

● Printer error ● al. area Printer: A printer is not present
or the printer needs paper.

● Select Monitor Setup >
Printing to choose a different
printer.

● Add paper to the printer.

● Printing Alarm ● al. area Recorder: An alarm has
triggered printing.

● Wait for the printing to finish.

● Printing ready ● al. area Your printing request has been
forwarded to the printer.

● No action required.
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Message Location Explanation What to do

● Printing... ● al. area Printer: Printing is occurring.
Recorder: Manual printing is
initiated for Print Waveforms,
ALL ECG, PA Waveform, or
Catheter Insertion.

● Wait for the printing to finish.

● Reconnect PDM ● al. area Disconnecting and then
reconnecting the PDM
too quickly may cause a
communication error between
the module and the monitor, and
result in duplicate waveform
data.

● Disconnect the PDM, wait
a few seconds, and then
reconnect.

● If the problem persists,
contact qualified service
personnel.

● Recorder cover open ● al. area The recorder cover is open. ● Close the recorder cover.

● Recorder input
voltage high /
Recorder input
voltage low

● al. area There are problems with the
recorder input voltage.

● Contact qualified service
personnel.

● Recorder out of paper ● al. area The recorder is out of paper or
the recorder cover is open.

● Replace recorder paper.

● Close the recorder cover.

● Recorder system
error

● al. area The local recorder is not working. ● Reset the local recorder by
turning the monitor’s power
off and on again. If this does
not help, contact authorized
service personnel.

● Recorder thermal
array overheat

● al. area There are problems with the
recorder temperature.

● Try stopping the recording as
it may help.

● If the problem persists,
contact qualified service
personnel.

● Replace battery A

● Replace battery B

● al. area Battery A or B is not working
properly.

● Replace the battery.

● Replace monitor
battery

● al. area Monitor battery is not working
properly.

● Replace the battery.

● Saving ● al. area The recorder is unavailable
while printing manual or alarm
waveform recording, and the
recording is saved for later
printing.
No recording location has been
selected.

● Check the recorder.

● Select a recording location.

● Service Monitor —
and specific error
indication

● al. area Technical fault in the monitor. ● Contact qualified service
personnel.

● Service the PDM —
and specific error
indication

● al. area Technical fault in the PDM. ● Contact qualified service
personnel.
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Messages

Message Location Explanation What to do

● Setting activation
after next case end

● al. area There is a pending setting
activation that will take place
after you end the case.

● If necessary, cancel the
activation.

● Setting activation
after next discharge

● al. area There is a pending setting
activation that will take place
after you discharge the patient.

● If necessary, cancel the
activation.

● Software activation
after next case end

● al. area There is a pending software
activation that will take place
after you end the case.

● If necessary, cancel the
activation.

● Software activation
after next discharge

● al. area There is a pending software
activation that will take place
after you discharge the patient.

● If necessary, cancel the
activation.

● Speaker failure ● al. area The speaker is not working as it
should.

● Contact qualified service
personnel.

● Unable to read
licenses

● al. area The system cannot use the
correct license file.

● Contact qualified service
personnel.

476 CARESCAPE Monitors B850, B650, B450 2105822-001



32
Abbreviations

List of abbreviations
The abbreviations that appear in the monitor software are indicated with bold and italic
typeface. Other abbreviations listed in this table appear in the monitor manuals. Some
abbreviations listed have multiple meanings but are differentiated by the context in which
they appear.

/min beats per minute, breaths per minute

°C Celsius degree

°F Fahrenheit degree

µ micro

% PCV percent of packed cell volume

12RLTM twelve reduced leads

12SL twelve simultaneous leads

a arterial

A auricular

A Fib atrial fibrillation

A alveolar

a/AO2 arterio-alveolar PO2 ratio

AA anesthetic agent

AaDO2 alveoli-arterial oxygen difference

AAMI Association for the Advancement of Medical Instrumentation

AC alternating current

A/C assist control

Accel. Ventric. accelerated ventricular rhythm

ACI-TIPI acute cardiac ischemia - time insensitive predictive instrument

ACL access control list

ACS acute coronary syndrome

ACT activated clotting time

A/C TCPL assist control time-cycle pressure-limited

AEP auditory evoked potential
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Abbreviations

AGSS anesthetic gas scavenging system

AHA American Heart Association

AirW airway temperature

Alpha alpha frequency band

Alpha% alpha frequency band percentage

Amp amplitude

ANATEL Agência Nacional de Telecomunicações

ANSI American National Standards Institute

Ant. anterior

APN apnea

Arrh arrhythmia

Art arterial pressure

ASA American Society of Anesthesiologists

ASB assisted spontaneous breathing

ASY asystole

ATMP atmospheric pressure

ATPD atmospheric/ambient temperature and pressure, dry gas

ATPS ambient temperature and pressure, saturated gas

Auto continuous NIBP measurement mode

aVF left foot augmented lead

avg average

aVL left arm augmented lead

AVOA automatic view on alarm

aVR right arm augmented lead

Axil axillary temperature

BAEP brainstem auditory evoked potential

BE base excess

Beta beta frequency band

Be% beta frequency band percentage

BIPAP biphasic positive airway pressure

BIS bispectral index

BISx digital signal processing unit

Blad bladder temperature

BNP B-type natriuretic peptide

bpm beats per minute

Brady bradycardia

BSA body surface area
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Abbreviations

BSR burst suppression ratio

B-to-B beat-to-beat

BTPS body temperature and pressure, saturated gas

BUN blood urea nitrogen

C central

C (C1 - C6) chest

C(a-v)O2 arteriovenous oxygen content difference

C.I. cardiac index

C.O. cardiac output

C1 to C6 ECG lead C1 to ECG lead C6

cal. calibration

Calcs calculations

CaO2 arterial oxygen content

cc cubic centimeter

CCI continuous cardiac index

CCO continuous cardiac output

CcO2 capillary oxygen content

CCU cardiac (coronary) care unit

CIC Clinical Information Center

CIcalc cardiac index calculated by Fick equation

CICU cardiac intensive care unit

CISPR International Special Committee on Radio Interference

CK-MB cardiac muscle type creatine kinase

Cl chlorine

cmH2O centimeter of water

CMRR common mode rejection ratio

CNS central nervous system

CO2 carbon dioxide

COcalc cardiac output calculated by Fick equation

COHb carboxyhemoglobin

Compl; C compliance

Complstat static compliance

Contin Flow continuos flow

Contrl; Controlled controlled ventilation

Core core temperature

Count count of responses

CPAP continuous positive airway pressure
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Abbreviations

CPAP Contin continuous positive airway pressure continuous

CPAP Demand continuous positive airway pressure on demand

CPAP/ASB continuous positive airway pressure & assisted spontaneous breathing

CPAP/IMV TCPL continuous positive airway pressure & control time-cycle pressure-limited

CPAP/PPS continuous positive airway pressure & proportional pressure support

CPB cardiopulmonary bypass

CPP cerebral perfusion pressure

CPPV continuous positive pressure ventilation

CPPV/Assist continuous positive pressure ventilation & assisted

CPU central processing unit

Cr creatinine

CSA Canadian Standards Association

CSA compressed spectral array

CT computed tomography

CvO2 venous oxygen content

CVP central venous pressure

d day

dB decibel

DBS double burst stimulation

DC direct current

Delta delta frequency band

Delta% delta frequency band percentage

Des desflurane

Diagn. diagnostic

Dia; DIA diastolic pressure

DIDCA Device IDentification Cable Adapter

DIFF difference

DO2 oxygen delivery

DO2I oxygen delivery index

DS dead space ventilation

DSC digital signal converter

e estimated

ECG electrocardiogram

ED emergency department

EDV end-diastolic volume

EDVI end-diastolic volume index

EE energy expenditure (kcal/24h)
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Abbreviations

EEG electroencephalogram

EEMG evoked electromyogram

EEPROM electrically erasable programmable read only memory

EEtot total energy expenditure

EMBC Ethernet module bus converter

EMC electromagnetic compatibility

EMG electromyogram

EMI electromagnetic interference

EMMV extended mandatory minute ventilation

Enf enflurane

Entr. Entropy

EP evoked potential

ESD electrostatic discharge

ESD electrostatic sensitive devices

Eso esophageal temperature

ESU electrosurgical unit

ESV end-systolic volume

EDVI end-systolic volume index

ET endotracheal

ET; Et end-tidal concentration

EtAA end-tidal anesthetic agent

EtBal end-tidal balance gas

EtCO2 end-tidal carbon dioxide

EtN2O end-tidal nitrous oxide

EtO2 end-tidal oxygen

Exp; exp expiratory

f frequency

F foot (describing location)

F frontal

F(I-E)O2 inspiratory mixed expiratory oxygen fraction difference

FECO2 mixed expired carbon dioxide concentration

Fem femoral

FEMG frontal electromyogram

FemV femoral venous

FEO2 mixed expired oxygen concentration

FFT fast Fourier transform

FI; Fi fraction of inspired gas

2105822-001 CARESCAPE Monitors B850, B650, B450 481



Abbreviations

FiAA fraction of inspired anesthetic agent

Fib fibrillation

FiCO2 fraction of inspired carbon dioxide

FiN2 fraction of inspired nitrogen

FiN2O fraction of inspired nitrous oxide

FiO2 fraction of inspired oxygen

Flow; F flow

Flow-Vol Loop flow volume loop

Fp fronto-polar

Fr French (unit of measure for a Catheter diameter scale)

ft feet

ft foot

g gram

g/dl grams per deciliter

g/l grams per liter

GEDI global end-diastolic volume index

GND ground

Graph. graphical

h hour

Hal halothane

Hb hemoglobin

HbO2 oxyhemoglobin

HCO3- bicarbonate

Hct hematocrit

HDU high dependency unit

Hemo hemodynamic

Hemo Calcs hemodynamic calculations

HFV high frequency ventilation

HIS hospital information system

HME heat and moisture exchanger

HMEF heat and moisture exchanger with filter

hPa hectopascal

HR heart rate

HRdif heart rate difference

HW hardware

Hz hertz

I lead I
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Abbreviations

I.U. international unit

I:E inspiratory-expiratory ratio

IABP intra-aortic balloon pump

iCa ionized Calcium

ICASA Independent Communications Authority of South Africa

ICP intracranial pressure

ICU intensive care unit

ID identification

IEC International Electrotechnical Commission

II lead II

III lead III

IM intramuscular

Imped impedance

ImpResp impedance respiration

IMV intermittent mandatory ventilation

IMV Contin continuous intermittent mandatory ventilation

IMV Demand intermittent mandatory ventilation on demand

in inch

IND induction

Inf. inferior

Infl. inflation (limit)

INR international normalized ratio

Insp; insp inspiratory

Insp Pause inspiratory pause time

IntelliRate automatic heart rate source selection of PDM

IP internet protocol

IP invasive blood pressure

IPPV intermittent positive pressure ventilation

IPPV/ASSIST intermittent positive pressure ventilation & assisted

IrMod% infrared modulation percentage

Iso isoflurane

ISO International Standards Organization

IV intravenous

IVR idioventricular rhythm

J joule

K potassium

kbps kilobits per second
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Abbreviations

kcal kilocalorie

KCC Korea Communications Commission

kg kilogram

kJ kilojoule

kPa kilopascal

l liter

l/min liters/minute

LA left arm (describing location)

Lab laboratory

LAN local area network

LAP left atrial pressure

Lat. lateral

lb pound

LCD liquid crystal display

LCW left cardiac work

LCWI left cardiac work index

LED light emitting diode

LL left leg (describing location)

LVEDP left ventricular end diastolic pressure

LVEDV left ventricular end diastolic volume

LVSW left ventricular stroke work

LCWI left ventricular stroke work index

MAC minimum alveolar concentration

MACage MAC compensated with patient age, patient temperature, and
atmospheric pressure

Man manual

Man/Spont manual/spontaneous

MAP mean arterial pressure

Max. maximum

MB megabyte

mbar millibar

MBC module bus controller

mcg/l microgram per liter

mcmol/l micromole per liter

Mean; M mean blood pressure

mEq milliequivalent

mEq/l milliequivalent per liter
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Abbreviations

MetHb methemoglobin

MF median frequency

mg milligram

mg/dl milligram per deciliter

mI.U. milli International Unit

MICU medical intensive care unit

min minute

Min minimum

ml milliliter

MLAEP middle-latency auditory evoked potential

mm millimeter

mmHg millimeters of mercury

mmol millimol

mmol/l millimole per liter

MMV mandatory minute ventilation

MMV/ASB mandatory minute ventilation & assisted spontaneous breathing

Moder. moderate

mol mole

Monit. monitoring

MRI magnetic resonance imaging

MRN medical record number

ms millisecond

Multif. PVCs multifocal premature ventricular contractions

MV minute volume

MVexp expired minute volume (l/min)

MVexp (BTPS) expired minute volume in BTPS conditions

MVexp (STPD) expired minute volume in STPD conditions

MVinsp inspired minute volume (l/min)

MVspont spontaneous minute volume

Myo myocardiac temperature

N neutral

N/A not applicable

N2 nitrogen

N2O nitrous oxide

Na sodium

Naso nasopharyngeal temperature

Neo neonate
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Abbreviations

Net network

Neuro neurological

Neuro ICU neurological intensive care unit

ng/l nanogram per liter

ng/ml nanogram per milliliter

NIBP non-invasive blood pressure

NIC network interface card

NICU neonatal intensive care unit

NMBA neuromuscular blocking agent

NMT neuromuscular transmission

NTPD normal temperature and pressure, dry gas

O occipital

O2 oxygen

O2ER oxygen extraction ratio

OR operation room

Oxy Calcs oxygenation calculations

Oxy oxygenation

OxyCRG oxycardiorespirogram

P parietal

P partial pressure

P pressure

Pa Pascal

PA pulmonary arterial pressure

PAC premature atrial contraction

Paced paced beats

PaCO2 partial pressure of carbon dioxide in the arteries

PACU post anesthesia care unit

PaO2 partial pressure of oxygen in the arteries

PAO2 partial pressure of oxygen in the alveoli

Paw airway pressure

Paw-Vol Loop pressure volume loop

Pbaro barometric pressure

PC personal computer

pCO2; PCO2 carbon dioxide partial pressure

pcs pieces

PCV pressure controlled ventilation

PCV-A/C pressure controlled ventilation & assisted control
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Abbreviations

PCV-CMV pressure controlled ventilation – controlled mandatory ventilation

PCV-CPAP pressure controlled ventilation & continuous positive airway pressure

PCWP pulmonary capillary wedge pressure

PCV-SIMV pressure controlled ventilation & synchronized intermittent mandatory
ventilation

PDF portable document format

PDM patient data module

PE polyethylene

Pedi pediatric

PEEP positive end-expiratory pressure

PEEPe extrinsic positive end expiratory pressure (ICU, NICU, ED software
packages)

PEEPestat static extrinsic positive end expiratory pressure (ICU, ED software
packages)

PEEPe+PEEPi total positive end expiratory pressure (ICU, NICU, ED software packages)

PEEPi intrinsic positive end expiratory pressure (ICU, NICU, ED software
packages)

PEEPistat static intrinsic positive end expiratory pressure (ICU, ED software
packages)

PEEPtot total positive end expiratory pressure (OR, PACU software packages)

pg/ml picogram per milliliter

pH potential of hydrogen

pHa arterial pH

pHv mixed venous pH

pHv venous pH

PIC patient interface cable

PICU pediatric intensive care unit

Pinsp inspiratory (target) pressure

PIr perfusion index (relative)

Pleth plethysmographic pulse waveform

Pmean mean pressure

Pmin minimum pressure

PN part number

pO2; PO2 oxygen partial pressure

Ppeak peak pressure

Pplat plateau (pause) pressure

Pplatstat static plateau pressure

PPV pulse pressure variation

PR pulse rate

2105822-001 CARESCAPE Monitors B850, B650, B450 487



Abbreviations

PSM patient side module

PT prothrombin time

PTC post tetanic count

PVC polyvinyl chloride

PVC premature ventricular contraction

PvCO2 carbon dioxide partial pressure in mixed venous blood

PvO2 partial pressure of oxygen in (mixed) venous blood

PVR pulmonary vascular resistance

PVRI pulmonary vascular resistance index

QRS QRS complex

Qs/Qt venous admixture

QT Q-T interval

QTc corrected value of the QT interval

R right (describing location)

R on T early PVC, close to the T wave of the preceding normal beat

RA right arm (describing location)

RAM random access memory

RAP right atrial pressure

Raw airway resistance

RCW right cardiac work

RCWI right cardiac work index

RE response Entropy

Rect rectal temperature

ref reference

REF right ventricular ejection fraction

Resp Rate respiration rate (total) (measured)

RF radio frequency

RHb reduced hemoglobin

RL reduced leadset

RMS average (root mean square) power

ROM read only memory

Room room temperature

RQ respiratory quotient

RR respiration rate

RV residual volume

RVEDV right ventricular end-diastolic volume

RVEDVI right ventricular end-diastolic volume index
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Abbreviations

RVESV right ventricular end-systolic volume

RVESVI right ventricular end-systolic volume index

RVP right ventricular pressure

RVSW right ventricular stroke work

RVSWI right ventricular stroke work index

s second

SaO2 arterial oxygen saturation

SB spontaneous breathing

SDU step-down unit

SE state Entropy

SEF spectral edge frequency

SEMG spontaneous electromyogram

Sev sevoflurane

SI stroke index

SICU surgical intensive care unit

SIMV synchronized intermittent mandatory ventilation

SIMV/ASB synchronized intermittent mandatory ventilation & assisted spontaneous
breathing

SIMV/CPAP synchronized intermittent mandatory ventilation & continuous positive
airway pressure

SIMVPS synchronized intermittent mandatory ventilation & pressure support

SjO2 jugular bulb oxygen saturation

Skin skin temperature

SL simultaneous leads

SN serial number

SO2 saturated oxygen

Spiro spirometry

SpO2 oxygen saturation

Spont spontaneous

SPS samples per second

SPV systolic pressure variation

SQ subcutaneous

SQI signal quality index

SR suppression ratio

SRAM static random access memory

SSEP somatosensory evoked potentials

ST single twitch

ST ST segment
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Abbreviations

Stat five minute continuous NIBP measurement mode

STPD standard temperature and pressure, dry gas

Supra supramaximal

Surf surface temperature

SV stroke volume

SV supraventricular

SW software

SVC supra ventricular contraction

SVI stroke volume index

SvO2 mixed venous oxygen saturation

SVR systemic vascular resistance

SVRI systemic vascular resistance index

SV Tachy supra ventricular tachycardia

SVV stroke volume variation

Sync MAS Synchrom Master

Sync SLV Synchrom Slave

Sys; SYS systolic pressure

T temperature

T temporal

T(BTPS) temperature in BTPS conditions

T1 first twitch

T1% first stimulus as percent of the reference value NMT

Tab tabular

Tachy tachycardia

Tblood blood temperature

TC transcutaneous

TcCO2 transcutaneous carbon dioxide

TcO2 transcutaneous oxygen

TCO2 total carbon dioxide

Tcorr patient temperature used to correct pH, PCO2, PO2

TCP/IP transmission control protocol / internet protocol

Temp temperature

Texp expiratory time

Theta theta frequency band

Theta% theta frequency band percentage

Tinj injectate temperature

Tinsp inspiratory time
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Abbreviations

TOF train of four

TOF% train of four percentage

Torr Torr (unit of pressure)

Tpause pause time

TTX telemetry transmitter

TV tidal volume

TVexp expired tidal volume (ml)

TVinsp inspired tidal volume (ml)

Tx-Ty temperature difference

Tymp tympanic temperature

UAC umbilical arterial catheter

UCD user centered design

UI user interface

UVC umbilical venous catheter

V ventricular

V; Vent ventilation

V (V1-V6) chest

V Brady ventricular bradycardia

V Fib ventricular fibrillation

V Tach ventricular tachycardia

v venous

(V1 to (V1-V6) ECG lead V1 to ECG lead (V1-V6)

VA alveolar ventilation

VC vital capacity

VCO2 carbon dioxide production

Vd dead space

Vd/Vt dead space ventilation

Vent ventilator

Vent Calcs ventilation calculations

WLAN wireless local area network

VO2 oxygen consumption

VO2calc calculated oxygen consumption

VO2Icalc calculated oxygen consumption index

VO2 oxygen consumption index

Vol; V volume

Vol Assist volume assisted

VT > 2 ventricular tachycardia with more than two beats
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Abbreviations

yr year

yrs years
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A
Skills checklist

System introduction
To familiarize yourself with these functions and features, study the topics listed as the
recommended reading of this User’s Manual. The numbers in brackets refer to the
page numbers in the manual. As you proceed, mark your completed tasks in the table.

Recommended reading Completed Not applicable

SYSTEM SAFETY PRECAUTIONS

● System warnings (51)

● System caution (53)

B850 SYSTEM COMPONENTS

● B850 system components (55)

B650 SYSTEM COMPONENTS

● B650 system components (58)

B450 SYSTEM COMPONENTS

● B450 system components (62)

MONITOR BATTERY

● Monitor battery (65)

DISPLAYS

● Displays (76)

ACQUISITION MODULES

● Acquisition modules (69)

EQUIPMENT SYMBOLS

● Equipment markings (79)

USER INTERFACE SYMBOLS

● User interface indicators (92)

Starting and ending
To familiarize yourself with these functions and features, study the topics listed as the
recommended reading of this User’s Manual. The numbers in brackets refer to the
page numbers in the manual. As you proceed, mark your completed tasks in the table.
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Skills checklist

Recommended reading Completed Not applicable

CASE START / PATIENT ADMISSION

● Starting monitoring (107)

ROVING BEDS AND UNITS

● About the roving functionality (115)

● Roving between units (115)

● Roving between beds (115)

● Adding new units and beds (manual roving) (116)

LOADING PATIENT INFORMATION

● Loading patient information from the CARESCAPE Network
(ADT server) (109)

USING STANDBY

● Starting standby (113)

● End of standby (113)

CONTINUING MONITORING

● How to continue monitoring when a case is not active/patient
is discharged (111)

● How to continue monitoring when a case is active/patient
is admitted (112)

CASE RESET / PATIENT DISCHARGE

● Resetting a case/discharging a patient (110)

● Resetting a case/discharging a patient in combination
monitoring mode (110)

Monitoring basics
To familiarize yourself with these functions and features, study the topics listed as the
recommended reading of this User’s Manual. The numbers in brackets refer to the
page numbers in the manual. As you proceed, mark your completed tasks in the table.

Recommended reading Completed Not applicable

MAIN KEYS

● Main keys (88)

MAIN SCREEN LAYOUT

● Main screen layout (87)

OPERATION SAFETY PRECAUTIONS

● Operation warnings (53)

MONITOR INSTALLATION POINTS TO NOTE

● Monitor installation points to note (54)
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Skills checklist

Recommended reading Completed Not applicable

TURNING ON THE MONITOR

● Turning on the monitor (105)

PRE-MONITORING CHECKLIST

● Pre-monitoring checklist (107)

Alarms
To familiarize yourself with these functions and features, study the topics listed as the
recommended reading of this User’s Manual. The numbers in brackets refer to the
page numbers in the manual. As you proceed, mark your completed tasks in the table.

Recommended reading Completed Not applicable

SAFETY PRECAUTIONS

● Alarm warnings (117)

● Alarm cautions (120)

OVERVIEW

● Alarm types (120)

● Alarm conditions (120)

● Alarm priority levels (129)

● Selecting parameter alarm priority levels (130)

● Alarm priority escalation (130)

CHECKING THE FUNCTION

● Checking alarm function (123)

ALARM INDICATIONS

● Alarm icons on the screen (124)

● Setting the alarm light brightness (125)

● Adjusting the alarm volume (126)

● Visual alarm signals and priority levels (125)

● Audible alarm signals and priority levels (126)

● Turning off all local alarm indicators (sleep mode) (135)

ALARM DEACTIVATION

● Technical alarms’ deactivation with the pause audio key (134)

PAUSE AUDIO IN COMBINATION MONITORING (TELEMETRY)

● Pause audio with combination monitoring (134)

BREAKTHROUGH AND LATCHED ALARMS

● Breakthrough alarms (134)

● Latched alarms (135)
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Skills checklist

Trends
To familiarize yourself with these functions and features, study the topics listed as the
recommended reading of this User’s Manual. The numbers in brackets refer to the
page numbers in the manual. As you proceed, mark your completed tasks in the table.

Recommended reading Completed Not applicable

TREND VIEWS

● Trend views (383)

GRAPHIC TRENDS

● Viewing graphic trends (383)

● Changing the time scale of graphic trends (384)

● Changing the time scale of graphic trends (384)

● Graphic trend resolution and the high-resolution license (385)

NUMERIC TRENDS

● Viewing numeric trends (386)

● Changing the time interval of numeric trends (386)

IP TRENDS

● Invasive pressure trends (386)

HR TRENDS

● Heart rate (HR) trends (387)

GAS CONSUMPTION

● Viewing gas consumption data (387)

● Printing gas consumption data (387)

MINITRENDS

● Minitrend view (387)

● Selecting high-resolution contents to minitrend (389)

Snapshots and events
To familiarize yourself with these functions and features, study the topics listed as the
recommended reading of this User’s Manual. The numbers in brackets refer to the
page numbers in the manual. As you proceed, mark your completed tasks in the table.

Recommended reading Completed Not applicable

SNAPSHOTS

● Description of snapshots (391)

● Manually created snapshots (391)

● Creating automatic snapshots (392)

● Viewing snapshots (392)

● Erasing snapshots and trends (394)
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Skills checklist

Recommended reading Completed Not applicable

EVENTS

● Viewing events (396)

● Creating events manually (397)

● Deleting events (397)

ECG
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● ECG warnings (137)

● ECG cautions (139)

● ECG measurement limitations (139)

● ECG points to note (139)

● ECG equipment to patient connection (140)

● Checking the ECG measurement (144)

PREPARING THE PATIENT

● Preparing the patient’s electrode sites (140)

● Applying the electrodes to the patient (140)

● 3– lead or 5–lead ECG electrode placement (141)

● 6–lead ECG electrode placement (141)

● 10–lead ECG electrode placement for cardiac monitoring (142)

● Standard resting 10–lead ECG electrode placement (143)

SELECTING SOURCE

● Selecting the ECG source (147)

SELECTING LEADS

● The first three displayed ECG leads (147)

● Selecting the first displayed ECG lead (147)

● Selecting the second displayed ECG lead (147)

● Selecting the third displayed ECG lead (148)

USING THE MEASUREMENT

● Selecting the beat source (149)

● Setting the beep tone during bradycardia and HR low alarms
(149)

● Aspect ratio and different display sizes (150)
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Skills checklist

Recommended reading Completed Not applicable

● Selecting the ECG waveform size (150)

● Selecting the ECG waveform filter (151)

● Selecting the leads for ECG analysis (152)

● Relearning the patient’s QRS pattern (152)

ECG ALARM LIMITS

● ECG alarm limits (154)

12 LEAD ANALYSIS

● Intended use of 12RLTM Interpolated 12 lead ECG analysis (158)

● Intended use of 12SL ECG analysis (158)

● Intended use of ACI-TIPI (158)

● 12 lead ECG analysis points to note (159)

● Enabling and disabling the 12SL ACS (160)

PACEMAKER DETECTION

● Pacemaker detection warnings (165)

● Selecting the pacemaker detection (166)

ARRHYTHMIA DETECTION

● Arrhythmia monitoring warnings (168)

● Arrhythmia measurement limitations (169)

● Setting the arrhythmia category to alarm (170)

● Setting arrhythmia alarms (170)

● Arrhythmia alarm messages (173)

ST DETECTION

● ST detection measurement limitations (177)

● Starting the ST detection (177)

QT DETECTION

● QT/QTc measurement limitations (183)

● Starting the QT/QTc measurement (184)

Impedance respiration
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● Respiration warnings (185)

● Respiration cautions (186)
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Recommended reading Completed Not applicable

● Respiration measurement limitations (186)

● Respiration points to note (186)

● Respiration measurement checks (190)

● Respiration equipment to patient connection (187)

RESPIRATION LEADS

● Respiration lead and breath detection (187)

● Respiration lead I electrode placement (188)

● Respiration lead II electrode placement (189)

● Respiration lead RL-LL electrode placement (189)

USING THE MEASUREMENT

● Selecting the waveform sensitivity (191)

● Setting the respiration alarm limits (192)

● Turning on or off the respiration rate alarm (192)

● Setting the apnea alarm delay (192)

● Enabling the respiration cardiac artifact alarm (192)

● Respiration alarm priorities (193)

Pulse oximetry (SpO2)
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● SpO2 warnings (197)

● SpO2 cautions (200)

● SpO2 measurement limitations (200)

● SpO2 points to note (200)

● Checking the SpO2 measurement (208)

● SpO2 equipment to patient connection (207)

● Preparing the SpO2 connection (207)

MEASUREMENT GUIDELINES

● GE Ohmeda technology and sensor measurement guidelines
(205)

● Masimo SET technology and sensor measurement guidelines
(206)
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Recommended reading Completed Not applicable

● Nellcor OxiMax technology and sensormeasurement guidelines
(206)

USING THE MEASUREMENT

● Primary and secondary SpO2 measurement sources (208)

● Selecting the SpO2 as the primary heart rate source (209)

● Adjusting the SpO2 pulse beep tone volume (209)

● Masimo SET data averaging and updating (210)

● Nellcor OxiMax data averaging and updating (210)

● Setting the SpO2 alarms and alarm limits (213)

● Deactivating the SpO2 probe off alarm (213)

Non-invasive blood pressure
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● NIBP warnings (219)

● NIBP cautions (221)

● NIBP measurement limitations (221)

● NIBP points to note (221)

● Checking the NIBP measurement (223)

● NIBP equipment to patient connection (222)

CUFF APPLICATION

● Preparing the NIBP patient connection (223)

● NIBP cuff selection and placement (226)

SINGLE NIBP MEASUREMENT

● Starting or stopping a single NIBP measurement from the main
menu (224)

● Starting or stopping a single NIBP measurement from the NIBP
Setup menu (224)

● Starting or stopping a single NIBP measurement with the PSM
module key (224)

AUTOMATIC NIBP MEASUREMENTS

● Starting or stopping the NIBP Auto from the NIBP Setup menu
(224)

● Starting or stopping the NIBP Auto from the monitor’s main
menu (224)
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Recommended reading Completed Not applicable

● Starting or stopping the NIBP Auto with the PSM module key
(225)

STAT MODE

● Starting or stopping a Stat NIBP measurement (226)

VENOUS STASIS

● Venous stasis (226)

● Starting or stopping the venous stasis (226)

Invasive pressures
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● Invasive pressure warnings (235)

● Invasive pressure measurement limitations (235)

● Invasive pressure points to note (236)

● Checking the invasive pressure measurement (238)

● Invasive pressure equipment to patient connection (237)

ZEROING

● Zeroing the invasive pressure transducers (240)

USING THE MEASUREMENT

● Selecting an invasive pressure channel label (240)

● Selecting the size of the invasive pressure waveform (240)

● Optimizing the invasive pressure waveform scale (241)

SYSTOLIC PRESSURE VARIATION AND PULSE PRESSURE VARIATION

● Systolic pressure variation and pulse pressure variation (245)

PULMONARY CAPILLARYWEDGE PRESSURE (PCWP) MEASUREMENT

● Pulmonary capillary wedge pressure (PCWP) measurement
(247)

Temperature
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.
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Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● Temperature warnings (257)

● Temperature measurement limitations (257)

● Temperature points to note (258)

● Checking the temperature measurement (259)

● Temperature equipment to patient connection (258)

TEMPERATURE MEASUREMENT START

● Starting the temperature measurement (260)

TEMPERATURE SITE NAME CHANGES

● Changing the temperature site label (260)

Cardiac output
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● C.O. warnings (263)

● C.O. cautions (264)

● C.O. measurement limitations (264)

● C.O. points to note (264)

● Checking the C.O. measurement (267)

● C.O. equipment to patient connection with a bath probe (266)

● C.O. equipment to patient connection with an in-line probe (264)

C.O. SETUP

● Selecting a C.O. catheter from the list (270)

● Entering a user-defined C.O. catheter (270)

● Selecting the C.O. injectate probe type (270)

OBTAINING A C.O.

● Taking an automatic C.O. measurement (267)

● Taking a manual C.O. measurement (268)

EDITING C.O. TRIALS

● C.O. trial measurements (269)

● Editing the C.O. average (269)

HEMODYNAMIC CALCULATIONS

● Editing calculations (271)
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Mixed venous oxygen saturation (SvO2)
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● SvO2 warnings (277)

● SvO2 measurement limitations (277)

● SvO2 points to note (278)

● Checking the SvO2 measurement (278)

● SvO2 equipment to patient connection (278)

SvO2 CALIBRATION

● SvO2 calibration in vitro (279)

● Calibrating a new SvO2 catheter in vitro (279)

● Calibrating SvO2 in vivo (280)

SvO2 SIGNAL QUALITY INDICATORS

● SvO2 measurement on screen (279)

Airway gases
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● Airway gases warnings (283)

● Airway gases cautions (285)

● Airway gases measurement limitations (285)

● Airway gases points to note (285)

● E-miniC indications for use (289)

● Checking the airway gases measurement (290)

● Airway gases equipment to patient connections with
CARESCAPE respiratory modules (286)

● Airway gases equipment to patient connections with E-miniC,
critical care setup (287)

MEASUREMENT SETUP

● Setting up airway gases measurement (287)

USING THE MEASUREMENT
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Recommended reading Completed Not applicable

● Selecting what to show with EtCO2 (293)

● Selecting the FiO2 level (294)

● Selecting the agent scale (295)

SCAVENGING

● Scavenging through the ventilator reservoir (296)

● Scavenging through the anesthesia gas scavenging system
(296)

● Connecting directly to the scavenging system (296)

CALIBRATION

● Calibrating airway gases (297)

Spirometry
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● Spirometry warnings (309)

● Spirometry cautions (309)

● Spirometry limitations (309)

● Spirometry points to note (309)

● Checking the spirometry measurement (312)

● Spirometry equipment to patient connection (311)

USING THE MEASUREMENT

● Preparing the spirometry measurement (311)

● Selecting the spirometry scales (313)

● Selecting the spirometry sweep speeds (313)

Gas exchange
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● Gas exchange warnings (325)

● Gas exchange cautions (326)
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Recommended reading Completed Not applicable

● Gas exchange measurement limitations (326)

● Gas exchange points to note (327)

● Checking the gas exchange measurement (328)

● Gas exchange patient connections with HME/HMEF/filter (328)

● Gas exchange patient connections with flexible tube (328)

INTERPRETING GAS EXCHANGE VALUES

● How to interpret the gas exchange values (330)

USING THE MEASUREMENT

● Selecting the gas exchange sensor type (328)

● Selecting EE and RQ averaging time (328)

Entropy
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● Entropy warnings (335)

● Entropy cautions (336)

● Entropy measurement limitations (336)

● Entropy points to note (337)

● Entropy indications for use (336)

● Checking the Entropy measurement (339)

● Entropy equipment to patient connection (338)

PREPARING FOR THE MEASUREMENT

● Preparing the patient for Entropy measurement (338)

USING THE MEASUREMENT

● Selecting the display format for Entropy (339)

● Selecting the Entropy scale (339)

● Selecting the EEG sweep speed (339)

SETTING ALARM LIMITS

● Setting Entropy alarm limits (340)

Neuromuscular transmission
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
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numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● NMT warnings (347)

● NMT cautions (347)

● NMT measurement limitations (348)

● NMT points to note (348)

● NMT equipment to patient connection (349)

● Checking the NMT measurement (350)

PATIENT PREPARATIONS

● Preparing the patient for NMT measurement (349)

● Preparing the ElectroSensor setup (350)

● Preparing the MechanoSensor setup (350)

● NMT alternative connections (350)

NMT TRENDS ON SCREEN

● NMT graphical trends on the monitor screen (351)

STARTING THE MEASUREMENT

● Starting the NMT measurement (351)

CHANGING THE CYCLE TIME

● Changing the NMT cycle time (352)

NMT ALTERNATIVE USES

● NMT alternative connections (350)

BIS
To familiarize yourself with this parameter and its use with the CARESCAPE monitors,
study the topics listed as the recommended reading of this User’s Manual. The
numbers in brackets refer to the page numbers in the manual. As you proceed, mark
your completed tasks in the table.

Recommended reading Completed Not applicable

GENERAL MEASUREMENT OVERVIEW

● BIS warnings (359)

● BIS cautions (360)

● BIS indications for use (361)

● BIS measurement limitations (361)

● BIS points to note (361)

● Checking the BIS measurement (363)

● BIS equipment to patient connection (362)
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Recommended reading Completed Not applicable

● Preparing the patient for BIS measurement (362)

USING THE MEASUREMENT

● Selecting the BIS waveform size (363)

● Selecting the BIS smoothing rate (363)

● Using the automatic BIS sensor check (364)

● Using the manual BIS sensor check (364)

HOW TO INTERPRET THE VALUES

● How to interpret the BIS values (365)
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